IBM TRIRIGA
Version 10.3.2

Program and Project Management
User Guide
Note
Before using this information and the product it supports, read the information in “Notices” on page 473.

This edition applies to version 10, release 3, modification 2 of IBM® TRIRIGA® and to all subsequent releases and modifications until otherwise indicated in new editions.

© Copyright International Business Machines Corporation 2011, 2013. All rights reserved.

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
## Contents

ABOUT THIS GUIDE ......................................................................................................................................................... 1

Conventions...................................................................................................................................................................... 1

Intended Audience......................................................................................................................................................... 1

Prerequisites.................................................................................................................................................................. 1

Support......................................................................................................................................................................... 1

1. PROGRAM AND PROJECT MANAGEMENT PROCESS......................................................... 2

   Project Management ................................................................................................................................................. 2

   Program and Funding Management....................................................................................................................... 3

2. PROJECT SETUP ................................................................................................. 5

   Configuring Hierarchical Query........................................................................................................................... 5

      Child Column Display ................................................................................................................................... 5

      Project Context Switching ............................................................................................................................. 6

   Templates ............................................................................................................................................................... 7

   Automatic Associations .................................................................................................................................. 7

   Cost Codes.......................................................................................................................................................... 8

      Creating Cost Code Structures ....................................................................................................................... 10

      Accessing the Cost Codes ............................................................................................................................ 10

      Organization Cost Code .............................................................................................................................. 11

      Location Cost Code .................................................................................................................................. 19
3. PROJECT PORTALS AND RECORDS ................................................................. 40

Home Portals .................................................................................................................. 40
  Program Manager Portal ......................................................................................... 40
  Project Manager Portal ....................................................................................... 41
  Project Container Portal .................................................................................... 41

Funding Sources, Programs and Projects ................................................................. 42
  Accessing the Funding Sources, Programs and Projects ...................................... 43
  Funding Source ..................................................................................................... 43
  Program ................................................................................................................... 52
  Capital Project ........................................................................................................ 70
  Adding new funding to a project ............................................................................ 93
  Increasing or decreasing project funding .............................................................. 93
  Facilities Project .................................................................................................... 100

4. MANAGING PROJECTS ...................................................................................... 113

Project Management Tools ........................................................................................ 113
  Cost Management ................................................................................................ 113
Design Management.................................................................................................................................................... 114
Submittal Management................................................................................................................................................ 114
Procurement Management........................................................................................................................................... 114
Schedule Management................................................................................................................................................. 115
Risk Management........................................................................................................................................................ 115
Permit Management..................................................................................................................................................... 115
Accessing the Project Management Tools................................................................................................................... 115
More Details ................................................................................................................................................................ 116

Cost Management.......................................................................................................................................................... 116
Planning and Analysis ................................................................................................................................................. 116
Financial Processes ...................................................................................................................................................... 116
Tracking Costs............................................................................................................................................................. 117
Budget Management.................................................................................................................................................... 117
Accessing the Budget Page.......................................................................................................................................... 117
Project Original Budget ............................................................................................................................................... 118
Project Budget Forecast ............................................................................................................................................... 126
Project Budget Transfer ............................................................................................................................................. 129
Project Budget Change ............................................................................................................................................... 135

Design Management ...................................................................................................................................................... 140
Design Page ................................................................................................................................................................. 140
Accessing the Design Page ........................................................................................................................................ 141
Design Drawing ........................................................................................................................................................... 141
Design Specification .................................................................................................................................................... 147
Supplemental Design Document ................................................................................................................................. 153
Design Package ........................................................................................................................................................... 153
Design Review ............................................................................................................................................................. 162
Design Change Notice ................................................................................................................................................. 166
Value Engineering Proposal .................................................................................................................................. 175
5. TRACKING PROJECTS ................................................................. 275

Project Tracking Tools ............................................................................................................. 275

Checklist ........................................................................................................................................ 275
Meeting ......................................................................................................................................... 276
Correspondence .......................................................................................................................... 276
Daily Journal ............................................................................................................................... 276
Issue and Change ......................................................................................................................... 276
Inspections ................................................................................................................................. 276
Progress Reports ......................................................................................................................... 276
More Details ............................................................................................................................... 276

Checklist ......................................................................................................................................... 278

Business Objects ....................................................................................................................... 278
Accessing the Checklists Links ................................................................................................. 279
Contract Award Checklist ...................................................................................................... 279
Project Review Checklist ....................................................................................................... 285
Site Review Checklist ................................................................................................................ 292
Closeout Checklist .................................................................................................................... 300

Meeting ......................................................................................................................................... 303

Business Objects ....................................................................................................................... 304
Accessing the Meetings Links ................................................................................................. 304
Meeting Item ............................................................................................................................. 305
Meeting Record ........................................................................................................................ 308
Meeting Series .......................................................................................................................... 314

Correspondence .......................................................................................................................... 321

Business Objects ....................................................................................................................... 321
Accessing the Correspondence Links...................................................................................... 322
Accident Report ......................................................................................................................... 322
ABOUT THIS GUIDE

This guide includes an overview of the processes involved in creating a new project, managing the project, and tracking the execution of the project to a successful completion (close out). This guide also contains descriptions of the various forms, tabs, sections and their functions.

Conventions

This document uses the following conventions to ensure that it is as easy to read and understand as possible:

- **Note** - A Note provides important information that you should know in addition to the standard details. Often, notes are used to make you aware of the results of actions.

- **Tip** - A Tip adds insightful information that may help you use the system better.

- **Attention** - An Attention notice indicates the possibility of damage to a program, device, system, or data.

Intended Audience

This guide is for program managers, project managers, procurement managers, inventory managers, contract managers, purchasing managers, and system personnel responsible for setting up, tracking, and maintaining program and project details including cost codes, budgets, design documents, submittals, proposals, contracts, purchase orders, payables, schedules, risks, and permits.

Prerequisites

This guide assumes the reader has a basic understanding of the IBM® TRIRIGA® Application Platform and the fundamental concepts required to operate the Web-based IBM TRIRIGA system.

Support

IBM Software Support provides assistance with product defects, answering FAQs, and performing rediscovery. View the IBM Software Support site at [www.ibm.com/support](http://www.ibm.com/support).

© Copyright IBM Corporation 2011, 2013.
1. Program and Project Management Process

Project Management

IBM TRIRIGA offers a state-of-the-art solution for the Project Management process. The solution is built on the proven IBM TRIRIGA Application Platform, which delivers a suite of powerful tools that automate, streamline, and manage the full array of capital project processes, tasks, documents, design, changes, cost, risk, and schedule management.

*Project Management* is the ensemble of activities (such as tasks) concerned with successfully achieving a set of goals. This includes planning, scheduling, estimating, budgeting, resource allocation, collaboration, and tracking to complete the project portfolios efficiently and flawlessly.

Many industries utilize variations on these stages. For example, in architectural design, projects typically progress through stages such as Pre-planning, Conceptual Design, Schematic Design, Design Development, Construction Drawings (or Contract Documents), and Construction Administration.

The *IBM TRIRIGA 10 Program and Project Management User Guide* includes an overview of the processes involved in creating a new project, managing and tracking the execution of the project to a successful completion (closeout).

The process flow diagram for the Program and Project Management process is given below.
This process flow diagram depicts the various stages involved in the Program and Project Management process and the different elements that are addressed in each of these stages. The Project Setup chapter provides details about the various stages involved in the initial setup of projects.

**Program and Funding Management**

Program management provides a powerful process of managing multiple, inter-dependent Capital Projects, Facilities Projects, and Real Estate Projects. By providing a layer above project management, a program enables the tracking of a higher-level vision, goals, or objectives. While projects are the tools necessary to accomplish those higher goals, programs provide oversight to these projects and align project objectives with overall business goals.

As an element of program management, Funding Sources are budgetary resources for programs and projects that may be required by federal and state agencies, corporations, and not-for-profit organizations such as universities, libraries, and museums. As a result, Funding Sources are identified and accounted to ensure that they are committed for the purpose for which they were made available, and that the project is adequately funded.
The IBM TRIRIGA application offers the following relationships among Funding Source, Program, and Project records.

- A Funding Source can fund one or many Programs or Projects.
- A Project can be funded by one or many Funding Sources.
- A Program can be funded by one or many Funding Sources.
- In terms of making a Funding Request or Funding Allocation, only parent Programs and Capital Projects can obtain funding directly from a Funding Source. Meanwhile, Sub-Programs and Sub-Projects can only obtain funding directly from their parent’s Available Funding.

To illustrate, the following diagram depicts an example scenario of these relationships.

Sample Relationships among Funding Sources, Programs and Projects

The Project Portals and Records chapter provides further details about the various stages involved in the creation of Programs, Projects within a Program, and Funding Sources.
2. Project Setup

This chapter discusses the preliminary requirements for creating a project. It is mandatory for a Project Manager role to create templates and cost structures before estimating the budget for the project. The following sections explain these procedures in the order of their occurrence.

Configuring Hierarchical Query

Program management provides a powerful process of managing multiple, inter-dependent Capital Projects, Facilities Projects, and Real Estate Projects. By providing a layer above project management, a program enables the tracking of a higher-level vision, goals, or objectives. While projects are the tools necessary to accomplish those higher goals, programs provide oversight to these projects and align project objectives with overall business goals.

As part of the Program functionality, the My Reports (Report Manager) page offers several Hierarchical Query options to configure the display and usability of hierarchical queries seen in certain portal sections and query sections. These options are found in the following areas:

- Child Column Display
- Project Context Switching

For more information, go to the IBM TRIRIGA 10 Information Center and select Administering IBM TRIRIGA > Reporting.

Child Column Display

How child columns look is governed by a parameter in the Options tab within the General tab of the report, the Child Columns Display field.

Show Headers and Indent Columns

The default option of “Show headers and indent columns” displays the children rows indented (but not aligned), along with their corresponding column headers. In cases where the children rows display different data from the parent rows, this option is preferable. In the following example, the column headers are set so the children rows display varying data from the parent rows. Consequently, the parent-to-children column alignment is not a major concern.

For example:

- Implementation Plan Name | Status
  - Transaction Plan Name | Status | Priority | Country | State/Province | City
    - Rank | Scenario Name | Total Pretax NPV | Total Commitment | Proposed Space
Suppress Headers and Align Columns

However, in cases like Program and Project hierarchies, where the children rows display similar data to the parent rows at all levels in the hierarchy, another option is available. The option of “Suppress headers and align columns” displays the children rows aligned with their parent rows, yet suppresses (or hides) the duplicated column headers. In the following example, the parent rows are set so their children rows display similar and aligned data without the extra column headers. Consequently, the similar parent-to-children data is presented more cleanly.

For example:

- Type
- Capital Project
- Program
- Program
  - Program
  - Program
  - Program

- Name
- 4141 Office Parkway
- Capital Renewal Program
- Greenpoint 5 Year Environmental Initiative
- Emissions Reduction Environmental Program
- 2500 City West Blvd Houston - Boiler Replacement
- 3000 Executive Parkway - Relamping
- 3800 W. Royal Lane - HVAC Re-commissioning
- Atlanta Office - Cooling Tower
- LEED Certification Program
- 3000 Executive Parkway LEED Certification
- Recycling and Waste Control Program

Project Context Switching

The system offers two ways for users to change their project context.

Company|Project Toggle and Project Selector Icon

In the top-right corner of your Home portal, beneath the Welcome Bar, you will see the standard Company|Project Toggle and Project Selector icon 🔍.

Enable Project Switching

When Enable Project Switching is configured for a hierarchical query in the Options sub-tab in the General tab of the report, it offers a more efficient alternative in navigating these hierarchies. It enables the display of Project-switching “Arrow” icons 🔄 before the hyperlink, in the first column of the portal section. These icons are displayed only if the record corresponds to a Capital Project record and you are granted the proper project security privileges.
• When you click the “Arrow” icon for a record in a non-default Project, your Project context switches to that record’s Project.

• When you click the “Arrow” icon for a record in a default Project, your Project context switches to the Company Level, if not already there.

• The current Project Name is also updated beside the Company|Project Toggle in the top-right corner of your Home portal.

For example, the “Arrow” icons might be found before the Project Type hyperlinks, in the first column of the Portal Section. Consequently, Project-switching is reduced to a single-click step, instead of the multiple-click process via the standard Company|Project Toggle and Project Selector icon.

Templates

A template provides a repeatable pattern for a given type of project. Many projects are similar in their requirements and execution, and the establishment of templates capitalizes on those similarities by establishing a pattern that can be applied to all projects that meet the parameters of the template. Using Project templates to create a new Capital or Facilities project enables you to create new projects that follow established patterns in less time and ensures that the data is consistent for all projects that utilize the template. For example, if you create a template containing data that you want to apply to multiple Facilities Project records, all you would have to do is associate the template to the various Facilities Project records in order to prevent having to recreate the data from the template multiple times.

The templates required for the Project Management process are Capital Project template, Facilities Project template, Submittal Task template, and Punchlist Task template. The process of creating these templates is the same as the process of creating individual records. Creation of Capital Project and Facilities Project records is described in Chapter 3 of this document. Creation of Submittal Task records is described in Chapter 4. Creation of Punchlist Task records is described in Chapter 5.

Automatic Associations

The AUTO_PROJECT_ASSOCIATION_RESTRICTION property in the TRIRIGAWEB.properties file controls which automatic record-level associations are created between new records and the current Capital Project. The value of this property applies to every Capital Project on IBM TRIRIGA. For information about the properties files, go to the IBM TRIRIGA Application Platform 3 Information Center and select Installing IBM TRIRIGA Application Platform > Configuring the platform > Properties files.

The IBM TRIRIGA default is for no value to be specified, in which case when records are created in a non-default project, the system creates all record-level associations for corresponding association definitions defined between the Capital Project business object and the business object of the newly-created record.

If this property has a value, for example “Contains”, the system automatically creates only that record-level association. However, if the association definition does not exist from the Capital Project to the business object of the record being created, no automatic record-level association is created.
Cost Codes

A **Cost Code** structure is defined for an organization to track and streamline the financial activities that take place. Within an organization, each department or agency acts as a **Cost Center** in which all the transactions regarding that department or agency are captured and tracked. As the financial activities are diverse, they are categorized into hierarchical sub-levels. The cost code structure is a logical breakdown of the organization cost code into location-centric cost codes for the purpose of cost control and reporting. The breakdown is a numbered structure, organized in a logical manner.
Cost Code structure generally includes three levels of codes, as shown in the above diagram. The “first-level” code, usually called “Organization Cost Code”, represents the major organization cost category. The major components of cost for the organization are listed. These “first-level” codes are then broken down by location and it is assigned as “second - level” or “Location Cost Code”. The location cost code will list all the costs incurred at the location and the same will be broken down as “third-level” codes referred to as “Service Cost Code” and “Project Cost Code”.

The Hierarchy panel of the Contracts > Set Up > Cost Codes page displays the hierarchy of Cost Code records in a tree structure (see the example below). The system displays a closed folder icon for a parent business object, indicating that the business object contains child records within. The dot icon indicates a business object at the lowest level in the hierarchy (i.e., it does not contain further child records within).

For example:

- Cost Code
  - 0-Project Budget Only Template (Standard Capital Project Cost Code)
  - 10-GreenPoint GL (Organization Cost Code)
    - 10-1000-Cost Centers (Organization Cost Code)
      - 10-1001-Dallas TX - 3000 Executive Parkway (Location Cost Code)
        - 10-1001-2000-Utilities (Service Cost Code)
        - 10-1001-2010-Electric (Service Cost Code)
        - 10-1001-2020-ISP Service (Service Cost Code)
        - 10-1001-2040-Other Utilities (Service Cost Code)
        - 10-1001-2050-Telephone Service (Service Cost Code)
        - 10-1001-2060-Water and Sewer (Service Cost Code)
        - 10-1001-3000-Conference Services (Service Cost Code)
        - 10-1001-3010-Equipment Services (Service Cost Code)
        - 10-1001-3020-Food Services (Service Cost Code)
        - 10-1001-3030-Room Services (Service Cost Code)
Creating Cost Code Structures

In IBM TRIRIGA, the Contracts > Set Up > Cost Codes page enables you to designate single or multiple coding structures used to define budgets and commitments. A cost code structure is a logical breakdown of a project into controllable elements for the purpose of cost control and reporting. The breakdown is a numbered structure, organized in a logical manner. The Cost Codes page enables you to designate single or multiple coding structures used to define budgets and commitments. For example, a project may have budgets for developing the foundation of a building, for erecting the building, and for creating the interiors. The cost codes would help you track budgets and commitments for each of these activities. By default, the IBM TRIRIGA application contains code structures that allow you to build coding systems for budgets and commitments, but you can create as many other structure types as required.

The cost codes are displayed in a hierarchy. The cost code classification is basically the same type of classification that exists in the Classification hierarchy, except it is specifically designed for financial matters, thus it is only found in the Cost Codes page. The cost code classification is found at the top level of the hierarchy from which budget and commitment structures can be built. Project Management ships with a standard structure for both budget and commitment codes. However, you can modify this structure and include a different number of levels to meet your project’s requirements. This is accomplished with the Cost Codes page, which you can use to create, edit, and move records.

You can create any number of hierarchical levels within the cost code structure. By default, the IBM TRIRIGA application displays a three-level cost code structure. At the highest level, you can create a Cost Code Summary, which contains Organization cost codes as its first hierarchical level. The Organization cost code contains Location cost codes, which in turn contain Service cost codes and Project cost code at the next level.

Note - For more details about the Budget module, refer to Cost Management section.

Accessing the Cost Codes

The Contracts > Set Up > Cost Codes page enables you to create and maintain records regarding the cost codes involved in the financial planning of a project.

Use the following procedure to access the Cost Codes page.

To Access the Cost Codes

| Step 1 | Select Contracts > Set Up > Cost Codes from the Menu Bar.  
| Note | You also can select Cost Codes from the Sitemap. The system displays this option only if the SiteMap? check box is enabled in your My Profile record (in the People page). |
| Step 2 | Review the Cost Codes page. The system displays a tree-view structure of all of the existing Cost Codes records in the Hierarchy panel, as well as the list of records for the selected node in the main panel. |
Organization Cost Code

The Contracts > Set Up > Cost Codes page enables you to create an Organization Cost Code record. This record is created at the parent level in the hierarchical tree structure. The budget plan assumes that the life cycle will always begin with an organizational ‘owner’ and the recovery process will always end with an organizational ‘owner’. Therefore, the top tier of the cost code structure always refers to the organization (Organization Cost Code).

The organization is hierarchical, thereby providing a way to track the cost details at the desired level of granularity, as well as the ability to roll up costs to any level in the hierarchy. For instance, if a project budget is defined at the department level, but the expenditure is accumulated at the sub-department level. Since the sub-departments tend to be ‘children’ of the upper-level departments, the costs will roll up. You can view costs at any level in the hierarchy.

Creating an Organization Cost Code Record

Use the following procedure to create a new Organization Cost Code record.

<table>
<thead>
<tr>
<th>To Create an Organization Cost Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
</tbody>
</table>

**General Tab**

The General tab has sections that provide a brief description and general attributes of the Organization Cost Code record. Enter all general information and specifications regarding the Organization Cost Code record in these sections.

**General Section**

This section gives all the general information regarding the Organization Cost Code record.

**ID**

The system displays the cost center (as entered in the Details section) of the current Organization Cost Code record.

The system automatically generates this number at the time of creating the Organization Cost Code record.
### General Section

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Indicates that the Organization Cost Code record is yet to be created. The system generates the status when the user clicks the <strong>Create Draft</strong> action in the Action bar.</td>
</tr>
<tr>
<td>Review In Progress</td>
<td>Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the <strong>Activate</strong> action in the Action bar.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates that the record is added to the active management list. The system generates the status when the user clicks the <strong>Activate</strong> or <strong>Unretire</strong> action in the Action bar.</td>
</tr>
<tr>
<td>Retired</td>
<td>Indicates that the record is retired. The system generates the status when the user clicks the <strong>Retire</strong> action in the Action bar.</td>
</tr>
<tr>
<td>Revision in Progress</td>
<td>Indicates that the record is being modified. The system generates this status when you click the <strong>Revise</strong> action in the Action bar.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date</th>
<th>Use the Calendar icon to select the date on which the Organization Cost Code record was created. By default, the system displays the current date.</th>
</tr>
</thead>
</table>

| Name            | Enter a name that identifies the Organization Cost Code record being created. |

### Details Section

In this section, add the organization and define the cost center regarding the Organization Cost Code record being created.

<table>
<thead>
<tr>
<th>Parent Cost Center</th>
<th>This is supplied by the system based on the other information entered for this Cost code.</th>
</tr>
</thead>
</table>

| Separator         | Use the List icon to specify the separator for the Cost Center. The system displays all the available options (such as ‘-’, ‘+’, ‘,’ ‘*’) defined in the Tools > Lists page. |

© Copyright IBM Corporation 2011, 2013.
Details Section

Organization
Use the Search icon to select an organization for which the Organization Cost Code record is being created. The system displays all the records available in the Organization hierarchy. Select the respective record and click OK.

Cost Center
Enter the cost center for the Organization Cost Code record being created.

Cost Type
Use the List icon to identify whether this cost code represents a Capital or Operating expense.

Tip – Be sure the Cost Type for all child cost codes is the same as the Cost Type for the parent cost code.

Accounting Type
Use the List icon to specify whether this cost code is Accounts Payable (AP) or Accounts Receivable (AR).

Do not show in Query
Click the check box if this cost code should not show in the results of cost code queries.

Cost Code Level
Cost codes are hierarchical. The system displays where this cost code lies in its hierarchical structure.

Currency
The currency unit of measure (UOM) for this cost code. This is the same currency unit of measure that is used in the project container.

Sub-Tabs
In addition to these, the Organization Cost Code record also contains Summary, Scope, Graph, and Sub Codes sub-tabs. The following sections explain these sub-tabs.

Summary Sub-Tab - Summary Section
The Summary section displays the information from the budgets and commitments associated with this organization cost code. This budget data is auto-populated from the associated budget records while commitments data is auto-populated from Purchase Orders, Contracts, and Approved Change Orders.

If there are multiple records associated to the cost code, the sum of the cost codes is displayed.
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget</td>
<td>This section displays the budget amount details regarding a project associated with this organization. For example, if the current organization (for which the cost code record is being created) plans to initiate a construction project, then all the cost budgeted for this project (in the Budget page) are retrieved in this section.</td>
</tr>
<tr>
<td>Commitments</td>
<td>This section displays the breakdown of the amount committed for the project. The data displayed is retrieved from the associated Approved Change Order, Original Commitment, Executed Change Order, and Current Commitments records.</td>
</tr>
<tr>
<td>Incurred</td>
<td>This section displays the breakdown of money expended on the project. The data displayed is retrieved from the associated Purchase Order, Contract, Invoice and Paid records.</td>
</tr>
<tr>
<td>Forecast</td>
<td>This section displays the estimated cost details of the project. The data displayed is retrieved from the associated Project Budget, Forecast Final, and Actual Cost records.</td>
</tr>
</tbody>
</table>

**Scope Sub-Tab - Scope Section**

This section enables you to enter the information about the Cost Code, such as its purpose and utility.

**Graph Sub-Tab - Graph Section**

This section displays a graphical representation of the budget amounts allotted for all the sub cost codes.

Right-click within the graph to display the following menu options.

- **Save as Image** to save the graph image to a specific format.
- **Print Chart** to print a copy of the graph.

**Note** - Since Anychart is being used to graphically represent the data, there is no option in Anychart to view the details of the data utilized for the graph.
Sub Codes Sub-Tab

This section displays the list of all the child Cost Code records created for this parent Organization Cost Code along with the details of the budget amount breakup.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the <strong>Create Draft</strong> action to save all initial data entered in the new record. The system changes the status of the record to <em>Draft</em> and displays additional actions on the Action bar. The actions include <strong>Activate</strong>, <strong>Save</strong>, <strong>Save &amp; Close</strong>, <strong>More</strong>, <strong>Copy</strong>, <strong>Delete</strong>, and <strong>X</strong> (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td><strong>Click the Save action to save the changes made.</strong></td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td><strong>Click the Save &amp; Close action to save the changes and close the active window.</strong></td>
</tr>
<tr>
<td>X</td>
<td><strong>Click the X (Cancel) action to terminate the changes made and also to close the active window.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td><strong>Click the Copy action to create a copy of the selected record.</strong> On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Activate</td>
<td><strong>Click the Activate action to add the record to the active management list.</strong> On clicking Activate action, the system changes the status of the record to <em>Review In Progress</em> and after all the members in the distribution list have approved the record, the record status becomes <em>Active</em>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Transactions Tab**

This section displays the list of all financial transactions regarding the Organization Cost Code. This section displays the cost code ID along with the transaction ID, name of the organization, location, and date of the transaction. Thus an overall summary about the financial transactions involved in the cost code is displayed.

**Notifications Tab**

The Notifications tab contains basic information relating to the approval process, such as the entire list of individuals who should approve the record, the current individual reviewing the record, the date on which the record was sent for approval, status, and additional comments added by the reviewers while reviewing the record.

This tab displays the following sections - Manual Approvers (In Addition to Approval Requirements), Approval Reviews, and Status Change Notification. Each of these sections is explained below.

**Manual Approvers (In Addition to Approval Requirements) Section**

This section lists individuals who should approve the record, the role assigned to each approver, and the review type. The records are displayed in a line-item format.

You can add approver(s) to this section by clicking the Add Person action on the section bar. The system displays the available records that are retrieved from the People page. You can select the persons you want to add to the distribution list and click OK. The records that are selected will be added as line items to this section. You also can set advanced approval options by clicking any of the displayed hyperlinked text of the line item.

**Note** - For information about setting up advanced options for the approval process, go to the IBM TRIRIGA 10 Information Center and select Administering IBM TRIRIGA > Communicating with users > Creating approval processes.
Approval Reviews Section

This section gives information about the review, including the approval status of the record, approver’s name, review status of the record, date on which the record was sent for review, date on which the review was completed, comments added by the reviewer, and the type of review.

The information in this section is auto populated when persons are added to the distribution list using the Manual Approvers (In Addition to Approval Requirements) section.

Status Change Notification Section

Using this section, you can send notifications to selected individuals when the record changes to a specific status. For example, if a subcontractor wants to inform the Project Manager role about the completion of a project, he/she can send a notification when the record attains the Complete status. The notification is displayed in the Home portal of the Project Manager role.

To add a notification for a specific status, click the Add Status action on the section bar. Select the status/statuses in which you want the notification to be sent from the displayed options and click OK. The selected records will be added as line items to this section. Click the hyperlinked text of the On Status field to add the notification details. On clicking the hyperlinked text, a Notification Details window appears wherein you can add the persons to whom the notification should be sent. Enter all the necessary details in the Notification Details window and click the Save & Close action. The system auto populates the fields of the line items in this section with the details from the corresponding Notification Details records.

Note - To remove a line item from this section, click the hyperlinked text of the On Status field and click the Delete action in the Notification Details record Action bar. The system removes the selected line item from this section.

Setting Up Advanced Options for Approval

The approval process sometimes requires a group of individuals to review the record. The group reviewing the record is referred as the distribution group and each member of the group must approve the record before it is returned to the originator as Approved. If any individual in the distribution group rejects the record, it is returned to the originator as Rejected without being forwarded to the next person in the group.

Note - If no individuals are added to the distribution group, then the system automatically changes the record status to Approved.
Notes & Documents Tab

This tab enables you to associate additional information (as comments) or related documents with the record. The different sections under the Notes & Documents tab are explained below.

Comments Section

The Comments section displays the details regarding the comments associated with the record, as hyperlinked line items. By clicking the hyperlinked line item, you can view the Comment record details in a new window.

Use the Add action to create a new Comment record. The system displays the Comment page, wherein you can perform the following steps:

- Enter the comment details, which include the comment type, the date on which the Comment record is being created, etc.
- Click the Create action.

The new Comment record is displayed as a line item in this section.

The Remove action enables you to delete selected comment(s) from the list.

Related Documents Section

The Related Documents section displays the details regarding the documents associated with the record, as hyperlinked line items. By clicking the hyperlinked line item, you can view the Document record information in a new window.

Use the Find action in this section to select and associate documents with the record. The documents that you associate may refer to any drawing, specification, or other documents that are contained in the Document Manager.

Click the Upload action to upload documents. The Object Attachment Upload screen will display. In the screen, click the Browse button and select the file path (document). The path and filename will display in the Local File field. Type the name, number, description, and comments (if any) in the corresponding fields and click the Upload action. The document will be added as a record to the Document Manager and line item in the Notes & Documents tab.

The Remove action enables you to delete selected document(s) from the list.

Reports Tab

The Reports tab displays data regarding a record in a printable form. There can be multiple forms on which the data can be displayed. Forms are used to display the data in a format that makes it easy to
view and understand. If a form does not immediately display when clicking the Reports tab, it implies one of the following:

- A form does not exist for the specified record.
- Filters are available to further refine your report. Enter appropriate action and click Submit.
- Multiple forms are available. In this case, you must select the required form in which to display the data from the drop-down list.

Once the preset form displays the data, you can export the form in an editable format. You can edit this document and/or send it to individuals who are not using the application.

Location Cost Code

The Contracts > Set Up > Cost Codes page enables you to create a Location Cost Code record. This record is created at the child level in the hierarchical tree structure. Multiple Location Cost Code records can be created at this level. The main purpose of the accounting functionality is to manage expenses and recovery costs associated with the ‘Workplace’ (second tier in the Cost Code Structure), henceforth referred to as Locations or as Location Cost Centers. For example, if a company has different units like Manufacturing, Procurement, and Transportation, then each department or agency will be a cost center in which all the cost incurred in that particular department or agency will be tracked.

The Location Cost Code is hierarchical, providing a way to track cost details at the desired level of granularity while retaining the ability to roll up costs to any level up the Location hierarchy. For example, budget might be defined at the Property level, but the actual costs accumulate at the Floor level. Since the floors are child records of the Building, Structure, and Property business objects, the costs will roll up. You can view the cost defined at all the levels in the hierarchy above the level posted.

Creating a Location Cost Code Record

Use the following procedure to create a new Location Cost Code record.

To Create a Location Cost Code

<table>
<thead>
<tr>
<th>Step 1</th>
<th>In the Hierarchy panel, select the newly created Organization Cost Code record. Then click the New action and select Location Cost Code.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Review the form that appears, wherein you should specify the details regarding the new Location Cost Code record being created.</td>
</tr>
</tbody>
</table>
**General Tab**

The **General** tab has sections that provide a brief description of the general attributes of the *Location Cost Code* record. You can enter general information and specifications regarding the *Location Cost Code* record in these sections.

### General Section

This section gives all the general information regarding the *Location Cost Code*.

**ID**

The system displays the cost center as entered in the *Details* section of the current *Location Cost Code* record.

The *ID* displayed begins with organization cost center followed by the location cost center. These values are separated by the separator mentioned in the *Details* section.

The system automatically generates this number at the time of creating the *Location Cost Code* record.

**Status**

The system displays the current status of the *Location Cost Code* record being created. The different statuses of the *Location Cost Code* record are explained below.

- **Draft** - Indicates that the *Location Cost Code* record is yet to be created. The system generates the status when the user clicks the *Create Draft* action in the Action bar.

- **Review In Progress** - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the *Activate* action in the Action bar.

- **Active** - Indicates that the record is added to the active management list. The system generates the status when the user clicks the *Activate* or *Unretire* action in the Action bar.

- **Retired** - Indicates that the record is retired. The system generates the status when the user clicks the *Retire* action in the Action bar.

- **Revision in Progress** - Indicates that the record is being modified. The system generates this status when you click the *Revise* action in the Action bar.

**Date**

Use the *Calendar* icon to select the date on which the *Location Cost Code* record was created. By default, the system displays the current date.

**Name**

Enter a name that identifies the *Location Cost Code* record being created.
Details Section

In this section, you can add the location and define the cost center regarding the Location Cost Code record being created.

Parent Cost Center
The system displays the Cost Center assigned for the Organization Cost Code (parent cost code).

Separator
Use the List icon to specify the separator for the Cost Center. The system displays all the available options (such as ‘-’, ‘+’, ‘_’, ‘*’, etc.) defined in the Tools > Lists page.

Location Reference
Use the Search icon to select a location for the Location Cost Code record being created. The system displays all the records available in the Location hierarchy.

Cost Center
Enter the cost center specific for the Location Cost Code record being created.

Cost Type
Use the List icon to identify whether this cost code represents a Capital or Operating expense.

Tip – Be sure the Cost Type for all child cost codes is the same as the Cost Type for the parent cost code.

Accounting Type
Use the List icon to specify whether this cost code is Accounts Payable (AP) or Accounts Receivable (AR).

Do not show in Query
Click the check box if this cost code should not show in the results of cost code queries.

Cost Code Level
Cost codes are hierarchical. The system displays where this cost code lies in its hierarchical structure.

Sub-Tabs

In addition to these, the Location Cost Code record also contains Summary, Scope, Graph, and Sub Codes sub-tabs. Click the respective hyperlinks for details about these sub-tabs.

Form Actions

The following table lists the common actions available and a description of each.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Activate</td>
<td>Click the Activate action to add the record to the active management list. On clicking Activate action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Active. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Revise and Retire.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

Other Tabs

The details about the Transactions tab, Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Service Cost Code

The Cost Code page enables you to create a Service Cost Code. This record is created at the child level in the hierarchical tree structure. Under a Location Cost Code, you can create multiple service cost
codes to track the expenses incurred by a particular department or agency associated with the selected Location Cost Code.

The service classification is hierarchical in nature, providing a way of sub-dividing processes and activities into related operations, thereby allowing costs to be rolled up. For example, a high level service code can be created for Operations and Maintenance within which you can create sub-level service codes to track Facilities Operations, Preventive Maintenance, Corrective Maintenance, Grounds Maintenance, Security, Custodial, Interior Plants Maintenance, and Utilities. Utilities could be further sub-divided to separate out the costs associated with the individual utilities such as Natural Gas, Propane, Oil, Electricity, Water, and Sewage.

Note - The above mentioned sub codes will be rolled up to the main service code Operations and Maintenance.

Creating a Service Cost Code Record

Use the following procedure to create a new Service Cost Code record.

<table>
<thead>
<tr>
<th>To Create a Service Cost Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
</tbody>
</table>

General Tab

The General tab has many sections that give you a brief description about the general attributes of the Service Cost Code record. You can enter all general information and specifications regarding the Service Cost Code record in these sections.
## General Section

This section gives all the general information regarding the *Service Cost Code* record.

### ID

The system displays the cost center as entered in the *Details* section of the current *Service Cost Code* record.

The number displayed begins with organization cost center followed by the location cost center. These values are separated by the separator mentioned in the *Details* section.

The system automatically generates this number at the time of creating the *Service Cost Code* record.

### Status

The system displays the current status of the *Service Cost Code* record being created. The different statuses of the *Service Cost Code* record are explained below.

- **Draft** - Indicates that the *Service Cost Code* record is yet to be created. The system generates the status when the user clicks the *Create Draft* action in the Action bar.

- **Review In Progress** - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the *Activate* action in the Action bar.

- **Active** - Indicates that the record is added to the active management list. The system generates the status when the user clicks the *Activate* or *Unretire* action in the Action bar.

- **Retired** - Indicates that the record is retired. The system generates the status when the user clicks the *Retire* action in the Action bar.

- **Revision in Progress** - Indicates that the record is being modified. The system generates this status when you click the *Revise* action in the Action bar.

### Date

Use the *Calendar* icon to select the date on which the *Service Cost Code* record was created. By default, the system displays the current date.

### Name

Enter a name that identifies the *Service Cost Code* record being created.
Details Section

In this section, you can add the service code and define the cost center regarding the Service Cost Code record being created.

Parent Cost Center
The system displays the cost center of the parent Location Cost Code.

Separator
Use the List icon to specify the separator for the cost center. The system displays all the available options (such as ‘-’, ‘+’, ‘_’, ‘*’, etc.) defined in the Tools > Lists page.

Service Code Reference
Use the Search icon to select a service code for the Service Cost Code being created. The system displays all the records defined for Accounting Service Code business object in the Classification hierarchy.

Note - By clicking the Service Code Reference hyperlink, you can make changes in the selected Service Code record. The process involved in creating the Service Code record is explained in the Service Cost Code sub-chapter.

Cost Center
Enter the cost center for the Service Cost Code record being created.

Cost Type
Use the List icon to identify whether this cost code represents a Capital or Operating expense.

Tip - Be sure the Cost Type for all child cost codes is the same as the Cost Type for the parent cost code.

Accounting Type
Use the List icon to specify whether this cost code is Accounts Payable (AP) or Accounts Receivable (AR).

Do not show in Query
Click the check box if this cost code should not show in the results of cost code queries.

Cost Code Level
Cost codes are hierarchical. The system displays where this cost code lies in its hierarchical structure.

Sub-Tabs

In addition to these, the Service Cost Code record also contains Summary, Scope, Graph, and Sub Codes sub-tabs. Click the respective hyperlinks for details about these sub-tabs.
## Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the <strong>Create Draft</strong> action to save all initial data entered in the new record. The system changes the status of the record to <strong>Draft</strong> and displays additional actions on the Action bar. The actions include <strong>Activate</strong>, <strong>Save</strong>, <strong>Save &amp; Close</strong>, <strong>More</strong>, <strong>Copy</strong>, <strong>Delete</strong>, and <strong>X</strong> (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the <strong>Save</strong> action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the <strong>X</strong> (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record. On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <strong>Draft</strong> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Activate</td>
<td>Click the <strong>Activate</strong> action to add the record to the active management list. On clicking <strong>Activate</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Active</strong>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Note** - Clicking the **Cancel** action without saving the record will erase all the data you have entered in the record.
Other Tabs

The details about the Transactions tab, Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Creating an Accounting Service Code

Several IBM TRIRIGA Workplace Performance Management metrics depend on organizing Service Cost Codes by the type of service associated with a set of Service Cost Codes. First define the Accounting Service Codes that will contain Service Cost Codes and then define Accounting Service Groups containing sets of Accounting Service Codes. Each Service Cost Code shows the Accounting Service Codes to which it belongs in the Service Cost Code's Association tab.

Use the following procedure to create and set up a new Accounting Service Code.

To Create and Set Up an Accounting Service Code

Step 1  Select Tools > Administration > Classifications from the Menu Bar.

Step 2  Review the Classifications page. The system displays a tree-view structure of all of the existing Classification records in the Hierarchy panel, as well as the list of records for the selected node in the main panel.

Step 3  In the Hierarchy, select Accounting Service Code.

Step 4  In the Hierarchy panel, click the New action and select Accounting Service Code.

Step 5  Review the form that appears.
  ▪ Enter the Accounting Service Code data.
  ▪ In the Details section, enter the name of the Service Cost Code in Service Code and the Service Cost Center in Cost Center.
  ▪ In the Classification Notes section, enter relevant notes.
  ▪ Click Create to save the data and create a new record.

Creating an Accounting Service Code Group

Accounting Service Code Groups facilitate the creation of cost code structures. Accounting Service Codes are grouped together in Accounting Service Code Groups.

Use the following procedure to create and set up a new Accounting Service Code Group.

To Create and Set Up an Accounting Service Code Group

Step 1  Select Tools > Administration > Classifications from the Menu Bar.
To Create and Set Up an Accounting Service Code Group

Step 2  Review the Classifications page. The system displays a tree-view structure of all of the existing Classification records in the Hierarchy panel, as well as the list of records for the selected node in the main panel.

Step 3  In the Hierarchy, select Accounting Service Code Group.

Step 4  In the Hierarchy panel, click the New action and select Accounting Service Code Group.

Step 5  Review the form that appears.
- Enter the Accounting Service Code Group data.
- In the Accounting Service Codes section, click Find to list the Accounting Service Codes. Select one or more codes. Click OK to save the selections.
- In the Classification Notes section, enter relevant notes.
- Click Create to save the data and create a new record.

Project Cost Code

Within a Location Cost Code, you can create a project cost code that will control and track the cost details of a project. For example, if a Location Cost Code is defined for a Planning department, you can create a cost code for each of the projects executed by that department. You can create multiple Project Cost Code records at this level.

Creating a Project Cost Code Record

Use the following procedure to create a new Project Cost Code record.

To Create a Project Cost Code

Step 1  In the Hierarchy panel, select the newly created Location Cost Code record. Then click the New action and select Project Cost Code.

Step 2  Review the form that appears, wherein you should specify the details regarding the new Project Cost Code record being created.

General Tab

The General tab has sections that provide a brief description of the general attributes of the Project Cost Code record. You can enter general information and specifications regarding the Project Cost Code record in these sections.
### General Section

This section gives all the general information regarding the *Project Cost Code* record.

<table>
<thead>
<tr>
<th>ID</th>
<th>The system displays the cost center as entered in the <em>Details</em> section of the current <em>Project Cost Code</em> record. The ID displayed is a combination of all the parent cost codes’ cost centers, followed by the project cost center. These values are separated by the separator mentioned in the <em>Details</em> section. The system automatically generates this number at the time of creating the <em>Project Cost Code</em> record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The system displays the current status of the <em>Project Cost Code</em> record being created. The different statuses of the <em>Project Cost Code</em> record are explained below. Draft - Indicates that the <em>Project Cost Code</em> record is yet to be created. The system generates the status when the user clicks the <em>Create Draft</em> action in the Action bar. Review In Progress - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the <em>Activate</em> action in the Action bar. Active - Indicates that the record is added to the active management list. The system generates the status when the user clicks the <em>Activate</em> or <em>Unretire</em> action in the Action bar. Retired - Indicates that the record is retired. The system generates the status when the user clicks the <em>Retire</em> action in the Action bar. Revision in Progress - Indicates that the record is being modified. The system generates this status when you click the <em>Revise</em> action in the Action bar.</td>
</tr>
<tr>
<td>Date</td>
<td>Use the <em>Calendar</em> icon to select the date on which the <em>Project Cost Code</em> record was created. By default, the system displays the current date.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name that identifies the <em>Project Cost Code</em> record being created.</td>
</tr>
</tbody>
</table>
## Details Section

In this section, you can add the project and define the cost center regarding *Project Cost Code* record being created.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Cost Center</td>
<td>The system displays the cost center of the parent <em>Location Cost Code</em>.</td>
</tr>
<tr>
<td>Separator</td>
<td>Use the <em>List</em> icon to specify the separator for the Cost Center. The system displays all the available options (such as '-', '+', ',', '*', etc.) defined in the <em>Tools &gt; Lists</em> page.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Enter the cost center for the <em>Location Cost Code</em> being created.</td>
</tr>
<tr>
<td>Cost Type</td>
<td>Use the <em>List</em> icon to identify whether this cost code represents a Capital or Operating expense.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> - Be sure the Cost Type for all child cost codes is the same as the Cost Type for the parent cost code.</td>
</tr>
<tr>
<td>Accounting Type</td>
<td>Use the <em>List</em> icon to specify whether this cost code is Accounts Payable (AP) or Accounts Receivable (AR).</td>
</tr>
<tr>
<td>Do not show in Query</td>
<td>Click the check box if this cost code should not show in the results of cost code queries.</td>
</tr>
<tr>
<td>Cost Code Level</td>
<td>Cost codes are hierarchical. The system displays where this cost code lies in its hierarchical structure.</td>
</tr>
</tbody>
</table>

## Sub-Tabs

In addition to these, the *Project Cost Code* record also contains *Summary*, *Scope*, *Graph*, and *Sub Codes* sub-tabs. Click the respective hyperlinks for details about these sub-tabs.
**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Draft</strong></td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Activate</strong></td>
<td>Click the Activate action to add the record to the active management list. On clicking Activate action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Active. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Revise and Retire.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Note** – Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
Other Tabs

The details about the Transactions tab, Notifications tab, Notes & Documents tab, and Reports tab, are available in previous sections. Click the respective hyperlinks to read the details.

Using the Cut and Paste Actions

The Cut and Paste actions are available for all hierarchical business objects. While creating a new hierarchy, these actions enable you to cut and paste a child record from one parent hierarchy into another. For example, if you create a Department child record under a My Company parent record, you can cut and paste this child record (Department) into another My Company parent record. Or, if you create an Agency child record under a Government parent record, you can cut and paste this child record (Agency) into another Government parent record.

Use the following procedure to cut and paste.

To Cut and Paste

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Hierarchy panel, select the child record from the appropriate parent record.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the Cut action in the Action bar.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select the destination parent record to which the copied child record is to be pasted.</td>
</tr>
<tr>
<td>Step 4</td>
<td>At this stage, the Paste action will be available on the Action bar of the Hierarchy panel. Click the Paste action to paste the copied child record. The child record now forms a part of the new hierarchy under which it has been pasted.</td>
</tr>
</tbody>
</table>

Cost Code Templates

Creating and using cost code templates allows automation of the creation of an accounting cost code structure for a location and for a project once activated/approved. The predefined account structures are intended to be re-used, saving time and providing consistent structures to post costs against.

Location Cost Code Templates

Location Cost Code Templates are available for Buildings, Retail Locations, and Structures. The user selects Accounting Organizations on the Building, Retail Location, and Structure business objects. The Organization is used to find the Organization Cost Codes, and then Location Cost Code is auto-created under each. The associated Accounting Service Codes are built under the Location Code Codes.
Creating & Setting Up an Accounting Service Code Group

The purpose of creating an Accounting Service Code Group is to facilitate the creation of cost code structures. Accounting Service Codes are grouped together in an Accounting Service Code Group so that they can be used to auto-create cost code structures in the Cost Code page when Buildings and Retail Locations are created or activated.

Note - To create and set up a new Accounting Service Code Group, refer to the Creating an Accounting Service Code Group section above.

Activating a Building with Accounting Service Code Details

The purpose of activating a Building with Accounting Service Code Details is to track it as part of the Portfolio, at which time it will auto-create the Cost Code structure using the Accounting Service Code Details such as the Organization(s), Accounting Cost Code, and Accounting Service Codes as grouped in the associated Accounting Service Code Group.

Use the following procedure to activate a Building with Accounting Service Code Details.

To Activate a Building with Accounting Service Code Details

Step 1  Select Portfolio > Locations > Buildings from the Menu Bar.

Step 2  Review the Buildings page that appears. Click a Building to open its Building record.

Step 3  Once the record is open, click Revise. This opens the record for privileged users to make and save changes.
   ▪  Enter key data for accounting cost code structure automation.
   ▪  In the Accounting Cost Code Details section, enter the Accounting Cost Center.
   ▪  For Service Code Group, click the Search icon to search and select from Service Code Groups.
   ▪  In the Accounting Organizations section, click Find to list the My Company and Division levels within Organization. Select one or more Organizations. Click OK to save the selections.

Step 4  Click Activate to make the record available with the changes.
   ▪  IBM TRIRIGA asynchronously auto-creates the Cost Code structure in the Cost Code page. The Cost Code structure is built using each Organization’s associated Organization Cost Code(s), then the Account Cost Center entered on the Building, then Accounting Service Codes (via the associated Group on the Building).

Activating a Retail Location with Accounting Service Code Details

The purpose of activating a Retail Location with Accounting Service Code Details is to track it as part of the Portfolio, at which time it will auto-create the Cost Code structure using the Accounting Service...
Code Details such as the Organization(s), Accounting Cost Code, and Accounting Service Codes as grouped in the associated Accounting Service Code Group.

Note - For more information on Retail Locations, go to the IBM TRIRIGA 10 Information Center and select Managing portfolio data.

Use the following procedure to activate a Retail Location with Accounting Service Code Details.

**To Activate a Retail Location with Accounting Service Code Details**

**Step 1** Select Portfolio > Locations > Retail Locations from the Menu Bar.

**Step 2** Review the Retail Locations page that appears. Click a Retail Location to open the Retail Location record.

**Step 3** Once the record is open, click Revise. This opens the record for privileged users to make and save changes.

- Enter key data for accounting cost code structure automation.
- In the Accounting Cost Code Details section, enter the Accounting Cost Center.
- For Service Code Group, click the Search icon to search and select from Service Code Groups.
- In the Accounting Organizations section, click Find to list the My Company and Division levels within Organization. Select one or more Organizations. Click OK to save the selections.

**Step 4** Click Activate to make the record available with the changes.

- IBM TRIRIGA asynchronously auto-creates the Cost Code structure in the Cost Code page. The Cost Code structure is built using each Organization’s associated Organization Cost Code(s), then the Account Cost Center entered on the Retail Location, then Accounting Service Codes (via the associated Group on the Retail Location).

**Activating a Structure with Accounting Service Code Details**

The purpose of activating a Structure that has Accounting Service Code Details is to track it as part of the Portfolio, at which time it will auto-create the Cost Code structure using the Accounting Service Code Details such as the Organizations(s), Accounting Cost Code, and Accounting Service Codes as grouped in the associated Accounting Service Code Group.

Use the following procedure to activate a Structure with Accounting Service Code Details.

**To Activate a Structure with Accounting Service Code Details**

**Step 1** Select Portfolio > Locations > Structures from the Menu Bar.
To Activate a Structure with Accounting Service Code Details

**Step 2** Review the Structures page that appears. Click a Structure to open the Structure record.

**Step 3** Once the record is open, click Revise. This opens the record for privileged users to make and save changes.

- Enter key data for accounting cost code structure automation.
- In the Accounting Cost Code Details section, enter the Accounting Cost Center.
- For Service Code Group, click the Search icon to search and select from Service Code Groups.
- In the Accounting Organizations section, click Find to list the Government levels within Organization. Select one or more Organizations. Click OK to save the selections.

**Step 4** Click Activate to make the record available with the changes.

- IBM TRIRIGA asynchronously auto-creates the Cost Code structure in the Cost Code page. The Cost Code structure is built using each Organization’s associated Organization Cost Code(s), then the Account Cost Center entered on the Structure, then Accounting Service Codes (via the associated Group on the Structure).

---

**Project Cost Code Templates**

Use this feature to set up Standard Capital Project Cost Code structures within the Cost Code page. Also, Capital Project Templates and Original Project Budgets have Apply Template functionality so budgets can be set up and applied. These predefined structures and templates are intended to be reused to provide consistent structures against which to post project costs.

Initially, setup/auto-generation happens on activation of a Capital Project. At this time, a project cost code is created in the Cost Code page for the project. Following the associations via the project’s original budget, it automatically creates the cost code structure under the project. Thereafter, the project original budget can be opened (in the context of a project) and budget templates can be applied to it. Similarly cost code structures are generated in the Cost Code page for the new items.

**Creating & Setting Up a Standard Capital Project Cost Code**

A Standard Capital Project Cost Code is used to auto-create Project cost code structure in the Cost Code page when a Capital Project is activated.

Use the following procedure to create and set up a new Standard Capital Project Cost Code.

**To Create and Set Up a Standard Capital Project Cost Code**

**Step 1** Select Contracts > Set Up > Cost Codes from the Menu Bar.
To Create and Set Up a Standard Capital Project Cost Code

Step 2 Review the Cost Codes page. The system displays a tree-view structure of all of the existing cost codes records in the Hierarchy panel, as well as the list of records for the selected node in the main panel.

Step 3 In the Hierarchy panel, click the Cost Code root. Then click the New action and select Standard Capital Project Cost Code.

Step 4 Review the form that appears.
- Enter the Standard Capital Project Cost Code data.
- Click Create Draft to save the data and create a new record.
- To create descendants of this Standard Capital Project Cost Code record, repeat the previous steps.

Creating & Activating a Project Original Budget Template

The purpose of creating a Project Original Budget Template is to pre-define cost codes used for budgets. Further, they are associated to a Capital Project Template to be used for auto-generating a cost code structure.

Use the following procedure to create and activate a Project Original Budget Template.

To Create and Activate a Project Original Budget Template

Step 1 Select Tools > Administration > Templates from the Menu Bar.

Step 2 Review the Templates page. The system displays Templates for different categories.
- Click the Expand icon for General Templates to open up the various General Templates.
- Click Project Original Budget.

Step 3 Review the list of Project Original Budget Templates. Click Add.

Step 4 Review the form that appears.
- Enter the Project Original Budget Template data.
- In the Items section, click Find to list the Cost Codes. Select one or more codes. Click OK to save the selections.
- Click Create Template to save the data and create a new record.
Creating & Activating a Capital Project Template with Budget Setup

The purpose of creating a Capital Project Template with a Budget setup is that the Project Original Budget Template can be used for auto-generating a cost code structure.

Use the following procedure to create and activate a Capital Project Template with a Budget setup.

To Create and Activate a Capital Project Template with Budget Setup

Step 1  Select Tools > Administration > Templates from the Menu Bar.

Step 2  Review the Templates page. The system displays Templates for different categories.
  - Click the Expand icon for Project Templates to open up the various Project Templates.
  - Click Capital Project.

Step 3  Review the list of Capital Project Templates. Click Add.

Step 4  Review the form that appears.
  - In the General tab, enter the Capital Project Template data.
  - In the Budget tab, Summary section, for Project Original Budget Template, click the Search icon to list the available choices. Select the Project Original Budget Template to be used for auto-generating a cost code structure. Click OK.
  - Click Create Template to save the data and create a new record.

Creating & Activating a Capital Project with Budget Setup

Use the following procedure to create and activate a Capital Project with a Budget setup.

To Create and Activate a Capital Project with Budget Setup

Step 1  Select Projects > Capital from the Menu Bar.

Step 2  Review the Capital Projects page. The system displays various Capital Project portal sections.

Step 3  In the Related Links - Capital Projects portal section, click the Expand icon for Projects to open up the various Project-related links.
  - Click Create a Capital Project.

Step 4  Review the form that appears.
  - Enter the Capital Project data, including the Name and other relevant information.
  - Click Create Draft to save the data and create a new record.
To Create and Activate a Capital Project with Budget Setup

Step 5  Click Apply Template. The Capital Project Template PopUp form appears.

- Click the radio button to select the desired Capital Project Template.
- Click Continue.

Note - The Enable in Draft Mode field in the Project Security section of Application Settings must be selected in order for users to be able to select the Apply Template action.

- If a Capital Project Template and an existing Project both have budgets, the budget will be pulled from the existing Project.

Step 6  Click Activate to make the record available with the changes.

- IBM TRIRIGA asynchronously auto-creates the Project Cost Code structure and a Project Cost Code for this Project in the Cost Code page. The Project Cost Code structure is built beneath using the Project Original Budget setup that is associated to the Capital Project Template.

Estimating Original Budget

The budget estimate is normally prepared well in advance of the start of any project. Using the Budget page, you can efficiently handle the financial aspects of a project and create a budget to comprehensively cover the expenses expected in the project. The Budget page includes the following processes:

- Creating and associating the budget defined for the project with its cost codes
- Anticipating the changes and forecasting the budget
- Transferring the amount allocated for the cost codes within the project

The Budget page is used to create, manage, and track Budget records and organize them by business object. The four essential business objects in the Budget module are discussed below.

Project Original Budget

The Project Original Budget record is used to specify the amount that is initially earmarked for the project. This value is measured in the currency that is used for the overall capital project. You can define the overall cost of the project by associating the various Cost Code records. For instance, a sum of $1,000,000 is defined as the capital outlay for the project. This amount is broken into various components as per the requirements of the project. For example, $25,000 may be expended for buying the raw materials and $50,000 for the labor services involved. So these expenses can be brought under various cost codes created for this purpose. This breakdown enables you to effectively manage the stipulated amount defined for the project.
Project Budget Forecast

The Project Budget Forecast business object enables you to document the anticipated cost of completing the project. Forecasts may be made periodically throughout the course of the project, as conditions and expectations change. The forecast is based on analysis of the various factors involved in the project, and is used to track changing projections. All forecasts use the same currency that is used for the project that the budget belongs to.

Project Budget Transfer

The Project Budget Transfer business object enables you to reassign money among the cost codes within the budget based on need. For example, the amount expended for one cost code item may be less than initially anticipated; the differential value can be transferred to offset a budget deficit in other cost codes. All transfers occur in the currency that is used for the project that the budget belongs to.

Project Budget Change

The Project Budget Change business object enables you to modify the budget and request a change (increment or decrement) in the funding for the project. It is used to document changes requested after the commencement of the project. All budget change values are measured in the currency of the project that the budget belongs to.

Note - You must create the Cost Code structure for the Organization before you can create a Budget Forecast for the project. For more information, refer to the Budget Management section below.
3. Project Portals and Records

Home Portals

Your IBM TRIRIGA Home page is your entrance into the IBM TRIRIGA application. From your Home page, you can review your Home portal or use the menu system to navigate to process portals available to your role. Use your Menu Bar to navigate to other available portals. Based on your role, your IBM TRIRIGA application may consist of one or many portals.

When you sign into the IBM TRIRIGA application, you are taken to your Home portal.

- When you sign in as a Program Manager user role, your Home portal is the Program Manager portal.
- When you sign in as a Project Manager user role, the Home portal is the Project Manager portal.
- If your user role deals with creation and managing a project, the Home portal is set to Project Container Portal after selecting the desired project.

The setting of the Home page as well as the Project Home page is set in your My Profile record, in the Default Portal section. For example, your profile might contain the following Default Portal section settings:

- **Home Page:** Home - Program Manager Portal
- **Project Home Page:** Home - Project Container Portal
- **Menu:** TRIRIGA Global Menu
- **Project Menu:** TRIRIGA Project Container Menu
- **Sitemap?:** ☑ (Selected)
- **Disable Company Level?:** ☐ (Not selected)

**Note** - Based on your role in the company and your security and license access, your Home portal or process portals may look different from these examples. However, it will contain a combination of the components and section types described in this discussion.

In turn, each IBM TRIRIGA portal consists of Portal Sections. Each portal section performs a specific function and/or displays data pertinent to your business role. The portal sections you have in your portal have been configured by your Application Administrator for your role in the system.

Program Manager Portal

Here is an example of the Program Manager Home portal for a Program Manager user role.
Welcome Bar - Including “Welcome, HS Program” (a Program Manager role), Sign Out, Sitemap, Support, and Help links.

Company Logo - Including the “IBM TRIRIGA” company logo, Company | Project Toggle, and Project Selector.

Menu Bar - Including the Home, My Reports, Requests, Projects, Tasks, and Contracts first-level menu items.

Page Title Bar - Including the Home page title, Personalize link and My Bookmarks link.

Portal and Portal Sections - A Program Manager home portal, including the following portal sections: (1) Reminders – Program Manager, (2) Performance Metrics – Program Manager, (3) Related Links – Programs, (4) My Programs and Projects, (5) My Programs (Budget, Commitments, Commitments Pending Funding Requests), and (6) Current Budget to Forecast (Projects).

Project Manager Portal

Here is an example of the Project Manager Home portal for a Project Manager user role.

Welcome Bar - Including “Welcome, Max Project” (a Project Manager role), Sign Out, Sitemap, Support, and Help links.

Company Logo - Including the “IBM TRIRIGA” company logo, Company | Project Toggle, and Project Selector.

Menu Bar - Including the Home, My Reports, Requests, Projects, Tasks, Contracts, and Procurement first-level menu items.

Page Title Bar - Including the Home page title, Personalize link and My Bookmarks link.

Portal and Portal Sections - A Project Manager home portal, including the following portal sections: (1) Reminders – Projects, (2) Performance Metrics – Projects, (3) Related Links – Projects, (4) My Active Projects, (5) My Project Schedule Variance, and (6) My Current Budget to Forecast.

Project Container Portal

A typical Program Manager or Project Manager role must work within the context of a Project. The Project Container Home portal is used for this purpose. Your Menu Bar structure within this Project-level context is different from your Menu Bar structure within the Company-level context.

Here is an example of the Project Container Home portal for a user role having access to view or edit Project information.
Funding Sources, Programs and Projects

Projects. A project is a group of activities oriented towards accomplishing a common goal. While larger-scaled goals (e.g., construction of a building) are defined as Capital projects, smaller-scaled goals (e.g., moving cubicles from one location to another within an office building, painting a floor of a building, handling plumbing/electrical issues) are termed as Facilities project.

Consequently, the difference between the Capital Project record and Facilities Project record is the scope. The Capital Project record is intended for large, complex projects and utilizes multiple business objects within the IBM TRIRIGA application, while the Facilities Project record is intended for smaller projects and utilizes a self-contained business object. The Capital Project is geared towards the development of a finished product, for example the development and construction of a building, whereas the Facilities Project usually is limited to the completion of a smaller objective, such as a repair or minor renovation.

All the specifications that are related to the project and sub-projects are maintained in the project and they are accessible as records. Hence, you can create, track, and manage master projects and other sub-projects regarding the organization. You can create a master project using the Capital Project business object and by selecting the Facilities Project business object you can create sub-projects for various services that are involved within the master project.

Programs. Program management provides a more powerful process of managing multiple, interdependent Capital Projects, Facilities Projects, and Real Estate Projects. By providing a layer above project management, a program supports higher-level vision, goals or objectives. Programs provide oversight to these projects and align project objectives with overall business goals.

Funding Sources. As an element of program management, Funding Sources are budgetary resources for programs and projects that may be required by federal and state agencies, corporations, and not-for-profit organizations such as universities, libraries, and museums. As a result, Funding Sources are
identified and accounted to ensure that they are committed for the purpose for which they were made available, and that the project is adequately funded.

**Accessing the Funding Sources, Programs and Projects**

The *Capital Projects* page enables you to create and manage records regarding the business objects associated with Capital and Facilities project processes.

Use the following procedure to access the *Capital Projects* page.

<table>
<thead>
<tr>
<th>To Access the Funding Sources, Programs and Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
</tr>
</tbody>
</table>

To create a new record, you can click:
- Create a Program
- Create a Funding Source
- Create a Facilities Project
- Create a Capital Project

To view an existing record, you can click:
- View Programs
- View Funding Sources
- My Facilities Projects
- All Facilities Projects
- My Capital Projects
- All Capital Projects

**Note** - In addition to this Projects > Capital page, these Related Links also appear in the Projects > Funding Sources page, the Projects > Programs page and the main Projects page.

**Funding Source**

You can create/view a *Funding Source* record by accessing the Projects page or Funding Sources page. The *Funding Source* record provides details about the funding organization, start and end dates, as well
as the fund totals and allocations. For many cases, funding must be identified and approved before a program or project can begin. As budgetary resources for programs and projects, Funding Sources may be required by federal and state agencies, corporations, and not-for-profit organizations such as universities, libraries and museums. Consequently, Funding Sources are identified and accounted for to ensure a project is adequately funded and so that the funds are committed to the purpose for which they were made available. Funding types include grants, bonds, federal or state awards, private donations, or internal money that has been allocated as a company- or organization-level budget.

Funding sources for a project do not necessarily use the same currency as the project. Funding allocations from sources that use a different currency are converted to the currency used for the project when the funding allocations are approved.

The IBM TRIRIGA application offers the following relationships among Funding Source, Program, and Project records.

- A Funding Source can fund one or many Programs or Projects.
- A Project can be funded by one or many Funding Sources.
- A Program can be funded by one or many Funding Sources.
- In terms of making a Funding Request or Funding Allocation, only parent Programs and Capital Projects can obtain funding directly from a Funding Source. Meanwhile, Sub-Programs and Sub-Projects can only obtain funding directly from their parent’s Available Funding.

To illustrate, the following diagram depicts an example scenario of these relationships.
Creating a Funding Source Record

Use the following procedure to create a Funding Source record.

**To Create a Funding Source Record**

**Step 1** Select Projects > Funding Sources from the Menu Bar.

**Step 2** Review the Funding Sources page. The system displays various Funding Sources portal sections.

**Step 3** In the Related Links - Funding Sources portal section, click the Expand icon to open up the various Funding Sources links.

- Click Create a Funding Source.

Note - In addition to this Projects > Funding Sources page, many of these Related Links also appear in the Projects > Capital page, the Projects > Programs page and the main Projects page.
To Create a Funding Source Record

**Step 4** Review the form that appears.
- Enter the Funding Source data, including the Name and other relevant information.
- Click **Create Draft** to save the data and create a new record.

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number identifying the Funding Source record being created. If this field is left blank, the system automatically generates this number at the time of creating the Funding Source record.</td>
</tr>
<tr>
<td>Status</td>
<td>The system displays the current status of the Funding Source record being created. This field is a read-only field. The different statuses of the Funding Source are explained below.</td>
</tr>
<tr>
<td></td>
<td><strong>Draft</strong> - Indicates that the record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.</td>
</tr>
<tr>
<td></td>
<td><strong>Review In Progress</strong> - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Issue action in the Action bar.</td>
</tr>
<tr>
<td></td>
<td><strong>Issued</strong> - Indicates that the record is active. The system generates this status when the user selects the Issue action in the Action bar.</td>
</tr>
<tr>
<td></td>
<td><strong>Revision in Progress</strong> - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.</td>
</tr>
<tr>
<td></td>
<td><strong>Retired</strong> - Indicates that the record is retired. The system generates this status when the user selects the Retire action in the Action bar.</td>
</tr>
<tr>
<td></td>
<td><strong>Completed</strong> - Indicates that the record has been processed and all the tasks associated with the record has been completed. The system generates this status when the user selects the Complete action in the Action bar.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a unique name to identify the Funding Source record that is being created.</td>
</tr>
</tbody>
</table>
### General Section

**Funding Source Type**  
Use the Search icon to specify the category to which the Funding Source belongs.

In the search list, the system displays the different Funding Source categories, such as Bond, Corporate, Customer, and Manual, that are defined in the Funding Source Type business object under the Classification hierarchy.

**Start Date**  
Use the Calendar icon to select the date on which the Funding Source record starts.

If necessary, click the **Update Allocations** action to update the Funding Allocations section below, which displays the funding allocations, one line item per fiscal year.

**End Date**  
Use the Calendar icon to select the date on which the Funding Source record ends.

If necessary, click the **Update Allocations** action to update the Funding Allocations section below, which displays the funding allocations, one line item per fiscal year.

**ARRA Funds?**  
Check this box to include detailed information related to the American Recovery and Reinvestment Act (ARRA).

*Note* - When this check box is selected, the Federal Funding Details section appears below with the next refresh.

**Internal Account?**  
Check this box to include internal cost-center and accounting information.

*Note* - When this check box is selected, the Internal Account section appears below with the next refresh.

**Currency**  
Use the List icon to select the unit of measure that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros) that are defined for the Currency in the Tools > Lists page. By default, the system displays US Dollars.
Allocation Summary Section

The Allocation Summary section provides detailed information about the funds related to the Funding Source record. The information includes the following:

- Total Original Amount
- Total Adjusted Amount
- Total Funding
- Total Committed to Parent Programs
- Total Committed to Parent Projects
- Total Committed
- Total Available

These totals are displayed based on the values provided in the other sections of the General tab.

Funding Source Summary Section

This section displays a summary graph associated with this Funding Source record, based on the information gathered in the General tab. The information may include the following: Total Funding and Total Committed.

Funding Source Details Section

Use the Funding Source Details section to enter any additional funding details, related to the Funding Source record. Use the Select icon to specify the entity or organization. This information may include the following:

- Amount Authorized
- Amount Approved
- Funds Returned
- Funding Entity
- Authorizing Organization
- Responsible Organization
- Description
Internal Account Section

Note - When the Internal Account? check box is selected in the General section above, this section appears with the next refresh.

Use the Internal Account section to enter any internal cost-center and accounting information, related to the Funding Source record. Use the Calendar icon to select the relevant dates. This information may include the following:

- Cost Center
- Account Code
- Accounting Start Date
- Accounting End Date

Federal Funding Details Section

Note - When the ARRA Funds? check box is selected in the General section above, this section appears with the next refresh.

Use the Federal Funding Details section to enter any funding details on the federal level related to the Funding Source record. This information may include the following:

- DUNS Number (9-digit number issued by Dun & Bradstreet and required by the federal government)
- Year (use the Search icon to specify the year)
- CFDA Program Number (5-digit number assigned by the Catalog of Federal Domestic Assistance)
- CFDA Program Title
- Treasury Account Agency Code (2-digit code of full 9-digit Treasury Account Symbol)
- Treasury Account Code (4-digit code of full 9-digit Treasury Account Symbol)
- Treasury Sub-Account Code (3-digit code of full 9-digit Treasury Account Symbol)
- Recipient State
- Recipient Zip/Postal Code
Funding Pending Approval Section

Once the Funding Source record is Created, this section displays the funding allocations, one line item per fiscal year. Enter the Original Fund amount allocated for each fiscal year.

Note - One line item will be generated for each fiscal year that appears between the Start Date and End Date established in the General section above.

Note - For a discussion on the Funding Sources within a Program record, see the Program Funding section. For a discussion on the Funding Sources within a Capital Project record, see the Fund Allocations section. For a discussion on the Funding Sources within a Funding Request record, and information about creating and submitting a funding request, go to the IBM TRIRIGA 10 Information Center and select Maintaining operations and services.

Approved Funding Section

Once the Funding Source record is Issued and approved, this section displays the approved funding allocations, one line item per fiscal year, based on the Funding Pending Approval section above.

If necessary, select a line-item radio button, then click the Adjust Funding action to update these funding allocations, one line item per fiscal year.

Funding Allocations Section

Once the Funding Source record is approved, this section displays the funding allocations sought by and committed to projects, one line item per Fiscal Year, Program and Project.

Recorded By Section

This section displays the login ID of the current user who is creating the Funding Source record. The Search icon in this section allows you to select a different user ID, if required. On clicking the Search icon, the system displays a Query window that displays the list of available records in the People page. Select the required record and click OK. The system auto populates the name of the person with the information from the selected record.
### Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the <strong>Create Draft</strong> action to save all initial data entered in the new record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to <strong>Draft</strong> and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, Update Allocations, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the <strong>Save</strong> action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Copy</strong> action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking <strong>Issue</strong> action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record from Issued to Completed.</td>
</tr>
<tr>
<td>Update Allocations</td>
<td>Click the <strong>Update Allocations</strong> action to update the Fund Allocations by Fiscal Period section of the form.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <em>More</em> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Summary Tab**

The Summary tab displays a summary report associated with this *Funding Source* record. The specific section is explained below.

**Funding Source Summary Report Section**

This section displays a summary report associated with this *Funding Source* record, based on the information gathered in the General tab. The information may include the following: *Total Committed to Programs*, *Total Committed to Projects*, and *Total Available*.

**Contacts Tab**

The Contacts tab gives all the contact information regarding the Funding Source and members belonging to the Funding Source team.

**Contacts Section**

This section displays the contact persons associated with the *Funding Source* record along with their contact details.

Use the *Add Person* action in this section to select the contact persons. A *Query* window listing all the available *People* records will appear. Select the appropriate record(s) and click *OK*. The details regarding each selected record(s) will be displayed in the respective fields, which are retrieved from the *People* page.

**Other Tabs**

The details about the *Notifications tab*, *Notes & Documents tab*, and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.

**Program**

You can create a *Program* record by accessing the Program Page. The *Program* record provides details about the higher-level business vision, business goals or business objectives that govern and align the objectives across multiple inter-related projects. One example of how a Program might manage multiple, inter-related projects would be if a University receives funding to build a new library. This may require many related projects from beginning to end, such as (1) a project to demolish the
existing structure, (2) another project to complete environmental clean-up of the site prior to construction beginning, and (3) yet another project to design the new library. All of these projects could be managed under the Program, “Build New Library”. The Program would facilitate the overall planning, management, and oversight of the various projects. For example, the finances for all projects would roll-up under the Program, and the Program would maintain a master schedule comprised of the key project dates.

Creating a Program Record

Use the following procedure to create a Program record.

**To Create a Program Record**

**Step 1** Select Projects > Programs from the Menu Bar.

**Step 2** Review the Programs page. The system displays various Programs portal sections.

**Step 3** In the Related Links - Programs portal section, click the Expand icon to open up the various Programs links.

- Click Create a Program.

**Note** - In addition to this Projects > Programs page, many of these Related Links also appear in the Projects > Capital page, the Projects > Funding Sources page and the main Projects page.

**Step 4** Review the form that appears.

- Enter the Program data, including the Name and other relevant information.
- Click Create Draft to save the data and create a new record.

**Note** - A Program record also may be created via a Funding Request record. For information about creating and submitting a Funding Request, go to the IBM TRIRIGA 10 Information Center and select Maintaining operations and services.

**General Tab – Before Record Creation**

**General Section**

<table>
<thead>
<tr>
<th>ID</th>
<th>Enter a unique identifier for the Program record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this field is left blank, the system automatically generates the ID at the time of creating the Program record.</td>
</tr>
</tbody>
</table>
General Section

Status

The system displays the current status of the Program record being created. This field is a read-only field. The different statuses of the Program are explained below.

*Draft* - Indicates that the record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

*Review In Progress* - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Issue action in the Action bar.

*Issued* - Indicates that the record is active. The system generates this status when the user selects the Issue action in the Action bar.

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

*Retired* - Indicates that the record is retired. The system generates this status when the user selects the Retire action in the Action bar.

*Completed* - Indicates that the record has been processed and all the tasks associated with the record has been completed. The system generates this status when the user selects the Complete action in the Action bar.

<table>
<thead>
<tr>
<th>Program Name</th>
<th>Enter a unique name to identify the Program record that is being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Use the Search icon 🕵️️️ to specify the category to which the Program belongs. In the search list, the system displays the different Program categories, such as Cost Reduction, that are defined in the Program and Initiatives Categories business object under Classification hierarchy.</td>
</tr>
</tbody>
</table>
### General Section

<table>
<thead>
<tr>
<th>Type</th>
<th>Use the Search icon to specify the type to which the Program belongs. In the search list, the system displays the different Program types. The types may include the following:</th>
</tr>
</thead>
</table>
|      | - Capital Planning  
|      | - Environmental  
|      | - Facility Assessment  
|      | - Infrastructure  
|      | - Mobile Worker  
|      | - Renovation  
|      | - Stimulus |

| Description | Provide a brief description for the Program record being created. |

### Details Section

| Start Date | Use the Calendar icon to select the date on which the Program starts. |
| End Date | Use the Calendar icon to select the date on which the Program ends. |

| Approved Date | This date on which the Program is approved by the members in the approval distribution list. When the record is yet to be created or issued, this field is a read-only field. |
| Responsible Organization | The organization with overall responsibility for the Program. Click the Search icon and select from the organizations displayed by the system. |
| Customer Organization | If applicable, the customer organization associated with the Program. Click the Search icon and select from the organizations displayed by the system. |

| Parent Program | If applicable, the higher-level Program to which this Program belongs. |
Details Section

ARRA Funds? Select the check box if the Program is associated with the American Recovery and Reinvestment Act (ARRA).

Note - When this check box is selected, the Federal Funding Details section appears below with the next refresh.

Federal Funding Details Section

Note - When the ARRA Funds? check box is selected in the General section above, this section appears with the next refresh.

Use the Federal Funding Details section to enter any funding details on the federal level, related to the Funding Source record. This information may include the following:

- DUNS Number (9-digit number issued by Dun & Bradstreet and required by the federal government)
- Year (use the Search icon to specify the year)
- CFDA Program Number (5-digit number assigned by the Catalog of Federal Domestic Assistance)
- CFDA Program Title
- Treasury Account Agency Code (2-digit code of full 9-digit Treasury Account Symbol)
- Treasury Account Code (4-digit code of full 9-digit Treasury Account Symbol)
- Treasury Sub-Account Code (3-digit code of full 9-digit Treasury Account Symbol)
- Recipient State
- Recipient Zip

General Tab – Attention Section

When you click Create Draft on the Program form, the system may display an Attention message.

Use the following procedure to satisfy the missing requirement.

To Satisfy the Attention Requirement

Step 1 Review the Attention message for the missing requirement.
To Satisfy the Attention Requirement

**Step 2** To satisfy the requirement, click the Contacts tab and click the Program Manager role.

**Step 3** In the Contact section, enter a Name of the Contact and click Save & Close.

**Step 4** Return to the Program form.
- Click Create Draft to save the data and create a new record.
- The system creates the record in Draft status and exposes additional sections in the General tab and a new Summary tab.

**General Tab – After Record Creation**

**Note** - After the Program record is created, a new Sub-Programs section, Projects section, and Funding Requests section appear in the lower portion of the General tab, as described below.

**Note** - After the Program record is created, a new Summary tab appears to the right of the General tab. For a discussion on the Summary tab, see Summary Tab below.

**Note** - After the Program record is issued, a Bulk Create Projects action appears in the Action bar. Click this action to create and activate multiple child Projects within this Program, based on selectable Location templates, Capital Project templates and Funding Sources.

**General Section**

The General section contains the same fields after the creation of the Program record (discussed above), as the fields before record creation.

**Details Section**

The Details section contains the same fields after the creation of the Program record (discussed above), as the fields before record creation.
Federal Funding Details Section

If the ARRA Funds? check box is selected in the General section, this section contains the same fields after the creation of the Program record (discussed above), as the fields before record creation.

Sub-Programs Section

This section displays the details about the Sub-Programs associated with the current Program. Click the Add action in this section to add a new Program record. Select and enter the desired information and perform the following steps:

- Provide the necessary information regarding the Program you have added.
- Click the Create Draft action.

A new line item will be added to the Sub-Programs section.

You also can use the Find action in this section to select an existing Program as a Sub-Program. A Query window will appear, listing the available Program records (having no parent Program and no prior Funding Source). Select the appropriate Program record and click OK. The selection is displayed in this section as a line item.

Use the Remove action to delete the selected Sub-Programs. Only Sub-Programs whose prior funding has been returned can be removed.

Note - If necessary, you also can force a funding request for new Sub-Programs by hiding the Add action via the Setup Parameters tab. For more information, refer to the Setup Parameters tab of the Program record.
Projects Section

This section displays the details about the Projects associated with the current Program. Click the Add action in this section to add one of the following Project records from the popup list.

- Capital Project
- Facilities Project
- RE Project Acquisition
- RE Project Current Terms
- RE Project Disposition
- RE Project Expiration
- RE Project Lease
- RE Project Sublease
- RE Project Termination
- RE Project Transaction Plan

Select and enter the desired information and perform the following steps:

- Provide the necessary information regarding the Project you have added.
- Click the Create Draft action.

A new line item will be added to the Projects section.

You also can use the Find action in this section to select an existing Project. A Query window will appear, listing the available Project records (having no parent Project and no prior Funding Source). Select the appropriate Project record and click OK. The selection is displayed in this section as a line item.

Use the Remove action to delete the selected Projects. Only Projects whose prior funding has been returned can be removed.
**Funding Requests Section**

This section displays the funding requests associated with the Program record. The line-item information may include the ID, Name, Request Classification, Proposed Start Date, Proposed End Date, Net Investment Cost, and Status. Click the Add action in this section to add a new Funding Request record. Select and enter the desired information and perform the following steps:

- Provide the necessary information regarding the Funding Request you have added.
- Click the Create Draft action.

A new line item will be added to the Funding Requests section.

**Note** - If configured for access, you also can view these requests via the Request page.

You also can use the Request Analysis action in this section to compare multiple funding requests.

**Note** - For information about generating a Funding (Opportunity) Analysis and Funding Request, go to the IBM TRIRIGA 10 Information Center and select Maintaining operations and services.

**RPIM Tab**

The Real Property Information Model (RPIM) includes information about data setup, installations, properties, spaces, real estate leases, and capital projects. RPIM is used for reporting and tracking property information yearly to the US Department of Defense. For more information, search for Real Property Information Model in the IBM TRIRIGA 10 Information Center.

**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Draft</strong></td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Clicking the <strong>Cancel</strong> action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <strong>Draft</strong> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking <strong>Issue</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Issued</strong>.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td>Bulk Create Projects</td>
<td>After the <strong>Program</strong> record is issued, a new <strong>Bulk Create Projects</strong> action appears on the Action bar.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Bulk Create Projects</strong> action to create multiple child <strong>Projects</strong> within this <strong>Program</strong>, based on selectable <strong>Location</strong> templates, <strong>Capital Project</strong> templates and <strong>Funding Sources</strong>.</td>
</tr>
<tr>
<td></td>
<td>The system also issues the Projects that are bulk-created via this action. This reduces the time and effort to open and issue each of the bulk-created Projects individually.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record from <strong>Issued</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>
**Summary Tab**

Note - After the Program record is created, the Summary tab appears to the right of the General tab.

The Summary tab displays the Project records and two metrics associated with the Program record.

**Project List Section**

This section displays the Projects associated with this Program record. The line-item information may include the ID, Name, Type, Total Funding, Budget, Actual, Budget Variance, Plan Start, Plan End, Calculated End, and Estimated Days Late.

**Program Metrics Section**

This section displays a metric associated with the Program record.

Use the List icon next to Sub Queries in to specify one of the following metrics:

- Project Schedule Variance (default)
- Program Funding Summary
- Percent Projects Over Schedule
- Contract On-Time Completion Rate
- Percent Projects Over Budget
- Current Budget to Forecast
- Change Order to Budget

**Project Metrics (Selected Project) Section**

This section displays a metric associated with the Capital Project record selected from the Project List section.

Use the List icon next to Sub Queries in to specify one of the following metrics:

- Current Budget to Forecast (default)
- Change Order to Budget
- Change Order to Contract
- Percent RFI Overdue
**Scope Tab**

Use the Scope tab to provide a detailed description of the scope of the Program. Scope is defined as the comprehensiveness or breadth of the Program. The scope is defined based on the expectations of the budget and requirements from the Owner and/or Program Manager role.

For example, an individual wants to construct a hotel. He has a budget of $50,000,000.00. The size and type of hotel that he believes can be built, based on his budget, will be the initial scope. The scope will change throughout the Program depending on various factors, such as building costs or schedule. Moreover, this Program may require many related projects from beginning to end, such as (1) a project to demolish the existing structure, (2) another project to complete environmental clean-up of the site prior to construction beginning, and (3) yet another project to design the new hotel.

The sections in the Scope tab are explained below:

**Scope Section**

Use this section to provide an appropriate description regarding the record. The details about the Program record may be helpful in exchanging information between users viewing or reviewing a record.

*Note* - Formatting options are also available.

**Additional Details Section**

In this section, you can provide a brief description of the objectives, deliverables, measures, risks, assumptions, and issues associated with the Program in the respective fields.

**Objectives Tab**

Use the Objectives tab to provide the Objectives that define the goals that the Program must achieve.

Examples of Objectives might be to: (1) Reduce the energy consumption of owned office facilities by 5% by the end of 2011; (2) Improve customer satisfaction in all categories by the end of 2011; (3) Implement a mobile worker program by end of 2011 and increase average mobile worker percentage to 30%; (4) Improve or divest of facilities with a Facility Condition Index of less than 0.05 by the end of 2011; (5) Renovate all Retail Locations in the Portfolio Plan to implement the new brand color scheme, furnishings, equipment, and signage; or (6) Renovate school facilities to accomplish required Priority 1 and 2 ADA compliance objectives with funding from the school bond issue by the end of 2011.
### Objectives Section

This section details the Objectives associated with the current Program. Click the **Add** action in this section to add a new **Objective** record. Select and enter the desired information and perform the following steps:

- Provide the necessary information regarding the Objective you have added, including Name, Description, Objective Category, Objective Type, Start Date, End Date, Propagation Rule, and Use in Evaluation.

For the **Propagation Rule**, select the Program Type option (e.g., Environmental, Financial, Renovation, etc.) with which you prefer to propagate this Objective to any Sub-Programs. For example, if the Propagation Rule is “Environmental”, the Objective will propagate (be created) on all Sub-Programs having a Program Type of “Environmental”. If “All” is selected, then the Objective will be propagated to all Sub-Programs. If “No Propagation” is selected, then the Objective will not be propagated to any Sub-Program.

- For the **Use in Evaluation**, check the box (then click outside the check box) to refresh and display the Evaluation section and fill in the Importance Ranking field.

- Click the **Create** action.

A new line item will be added to the **Objectives** section.

Use the **Remove** action to delete the selected line item(s).

### Risk Planning Items Section

Similar to the Objectives section above, this section displays the details about the Risk Planning Items associated with the current Program. Click the **Add** action in this section to add a new **Risk Planning Item** record. Select and enter the desired information and perform the following steps:

- Provide the necessary information regarding the Risk Planning Item you have added, including Name, Description, Risk Category, Risk Type, Start Date, End Date, Propagation Rule, and Use In Evaluation.

For the **Propagation Rule**, select the Program Type option (e.g., Environmental, Financial, Renovation, etc.) with which you prefer to propagate this Risk Planning Item to any Sub-Programs. For example, if the Propagation Rule is “Environmental”, the Risk Planning Item will propagate (be created) on all Sub-Programs having a Program Type of “Environmental”. If “All” is selected, then the Risk Planning Item will be propagated to all Sub-Programs. If “No Propagation” is selected, then the Risk Planning Item will not be propagated to any Sub-Program.

- For the **Use in Evaluation**, check the box (then click outside the check box) to refresh and display the Evaluation section and fill in the Importance Ranking field.

- Click the **Create** action.

A new line item will be added to the **Risk Planning Items** section.

Use the **Remove** action to delete the selected line item(s).
**Schedule Tab**

Use the **Schedule** tab to review a list of all child *Projects* regarding the *Program* record (in the upper display), and based on the child *Project* selected, to review the relevant list of scheduled tasks (in the lower display). This tab displays four sections - **Summary**, **Projects** (with Project-level schedule display), **Project Tasks** (with task-level schedule display), and **Schedule Assumptions**. In these sections, you can review activity across multiple child projects within the program, schedule a specific activity within a child project, and record all the scheduled dates regarding the task.

**Summary Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Date</strong></td>
<td>Populated from the start date in the <em>General</em> tab.</td>
</tr>
<tr>
<td><strong>End Date</strong></td>
<td>Populated from the end date in the <em>General</em> tab.</td>
</tr>
<tr>
<td><strong>Calculated Start</strong></td>
<td>Calculated by the Gantt Scheduler.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - This field is set when the Gantt is saved. For example, if the user changes the start date to a month in the future, this does not cause the Calculated Start date and Calculated End date to change. Calculated Start date and Calculated End date are set to their new values only when the Gantt is saved.</td>
</tr>
<tr>
<td><strong>Calculated End</strong></td>
<td>Calculated by the Gantt Scheduler.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - This field is set when the Gantt is saved. For example, if the user changes the start date to a month in the future, this does not cause the Calculated Start date and Calculated End date to change. Calculated Start date and Calculated End date are set to their new values only when the Gantt is saved.</td>
</tr>
</tbody>
</table>

**Note** - For more information on the Gantt-view scheduling engine, refer to the *Gantt Scheduler* section of this document.

**Note** - For more information on scheduling tasks within a project record, refer to the **Schedule tab** of a capital project record.

**Note** - To import and/or export an MS Project file within a project record, refer to the **Schedule Tab - Import and Export** section below.
**Project Tasks Gantt Section**

Use this read-only Gantt-view section to review activity across multiple child Projects regarding the Program record. Select a particular child Project to review the relevant list of scheduled tasks in the subsequent Project Tasks section below.

**Project Tasks Section**

This Gantt-view section operates the same way as the Project Tasks Gantt section of a Capital Project record. For more information, refer to the Schedule tab of the Capital Project record.

**Schedule Assumptions Section**

Use this section to provide appropriate description regarding the Program record. The details about the schedule may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.

For more information on scheduling tasks within a Project record, click this hyperlink to read about the Schedule tab of a Capital Project record.

**Financials Tab**

Use the Financials tab to review the current fund allocations, outstanding funding requests, and approved funding sources regarding the Program record.

**General Section**

<table>
<thead>
<tr>
<th>Funding Type</th>
<th>Based on their primary purpose, funds can be categorized into two types, Capital and Operating.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use the List icon to specify the type of funding. The system displays all funding types that are defined for Funding Type in the Tools &gt; Lists page.</td>
</tr>
</tbody>
</table>
General Section

The remainder of the General section provides detailed information about the funds related to the Program record. The information includes the following: (A) Total Program Budget, (B) Funds Allocated to Parent Sub-Programs, (C) Funds Allocated to Parent Projects, (D) Total Funds Allocated, (E) Funds Available, (F) Total Pending Funding Requests, and (G) Total Available with Pending Funding Requests.

Program Funding Summary Section

This section displays a summary graph associated with this Program record, based on the financial information gathered in the General section. The information may include the following: Total Program Funds and/or Total Allocated Funds.

Program Funding Section

This section displays the funding allocations of each Funding Source for each fiscal year for the Program. This section also provides actions enabling you to add/transfer Funding Sources to/from the Program.

Click the Add Funding action in this section to add Funding Sources to this Program.

- If this is a parent Program, then the Fund Allocation popup form allows you to select from available Funding Sources to fund the Program.
- If this is a Sub-Program, the form allows you to select from its parent Program’s Available Funding.

From the popup form, Find and/or select the proper record, and click Continue. The selected record is displayed in this section as a line item. Moreover, the columns will auto-populate with the relevant data from the corresponding Funding Source record.
Program Funding Section

Use the Transfer Funds action to transfer Funding Sources from this Program to an alternate Program.

- If this is a parent Program, the Fund Transfer popup form allows you to increase or decrease Funding from its Funding Sources.
- If this is a Sub-Program, the Fund Transfer popup form allows you to increase or decrease Funding from its parent Program funding.

From the popup form, enter the required information, Find and/or select the proper From Program Item, Find and/or select the proper To Program Item, and click Create Draft. Once Issued and approved, the selected record is removed from this section.

Note - For a discussion on Fund Allocations, see the Funding Source Tabs section above.

Setup Parameters Tab

Use this tab to store additional financial, operational, and environmental parameters associated with the Program record.

Funding Request Requirement & Evaluation Section

| Require Program Request | Select this check box to force a funding request for new Sub-Programs, by hiding the Add action in the Sub-Programs section of the General tab. For more information, refer to the Sub-Programs section of the General tab (after record creation). |
Funding Request Requirement & Evaluation Section

The remainder of this section stores additional financial, operational and environmental parameters, associated with the Program record, as follows.

- Analysis Term (Years)
- Discount Rate (Percent)
- Capitalization Rate (Percent)
- Blended Energy Cost Per kWh
- Construction Cost Inflation Rate (Percent)
- Blended Energy Emission Conversion Factor (grams/kWh)

Note - These parameters are applied in the context of a Funding Request Analysis. For information about conducting a Facility Assessment and Funding Request Analysis, go to the IBM TRIRIGA 10 Information Center and select Maintaining operations and services.

Contacts Tab

The Contacts tab stores all of the contact information related to the Program and members belonging to the Program team.

Contacts Section

This section displays the Program members and other contact persons associated with the Program along with their contact details.

Use the Add Person action in this section to select the contact persons. A Query window listing all the available People records will appear. Select the required record and click OK. The details regarding the selected record display in the respective fields, which are retrieved from the People page.

Note - When adding contacts, the Program record includes an approval rule of requiring at least one Program Manager role.

Use the Remove action to erase the displayed information.
Other Tabs

The details about the Schedule tab, Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the information.

Capital Project

A Capital Project record contains basic information about the project, such as the project ID, type, and location. In addition, the Capital Project record also provides details about the persons who are involved in the project, people benefited by this project, scheduled date and time for start and completion of the project, budget details regarding the project, and information regarding the legal persons who are associated with the project. You can specify this information in the respective sections of the record while creating a Capital Project record.

Capital Projects manage and display project costs in the local currency of the project. The currency unit of measure (UOM) for the project is set by the person who is initiating the project. All of the project objects then inherit that currency UOM.

Selecting a Project

By default, IBM TRIRIGA Capital Projects Manager contains a Company Level within which you can create multiple projects. A project is a planned undertaking with an end goal in mind. A company may be managing multiple projects. Each project may have its own schedule, cost structure, change management, risk management, and documentation. A single repository for data for multiple projects would be confusing, so the IBM TRIRIGA application allows an organization to create multiple project environments or containers.

By default, the Company Level is selected. It is the highest level of the Project hierarchy. Any projects you create will be contained in the Company Level project. If a project other than the Company Level is selected, the Project Name displayed is also a link to open the record created for that project.

Use the following procedure to select a project.

<table>
<thead>
<tr>
<th>To Select a Project</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
</tbody>
</table>

**Note** - By default, the popup window appears without any projects. To see a full list of projects, click Clear Filters.
To Select a Project

**Step 3** Choose the radio button of the desired Capital Project and click **OK**.
- The selected project will be displayed beside the *Company|Project Toggle*.
- The *Project Name* displayed is also a link to open the record created for that project.

Returning to the Company Level

When a user signs into the system, they enter at the Company Level or at the Last Visited project, depending on where the user was when they signed out. You can enter a project within the Company Level by following the steps in the previous section. If you enter a project, you can use the following steps to return to the Company Level at any time.

Use the following procedure to return to the Company Level.

**To Return to the Company Level**

**Step 1** The project in which you are currently working is displayed beside the *Company|Project Toggle* above the *Menu Bar*.
- Click the *Company* side of the *Company|Project Toggle*.

**Note** - The *Company|Project Toggle* allows you to switch between the company-level and project-level context at any time. When you click the *Project* side of the toggle, the system takes you to the last project in which you worked.

**Note** - It is important to remember that, by default, once the toggle is set to a specific project, _any_ records that are displayed within, are records pertaining only to that project.

Creating a Capital Project Record

Use the following procedure to create a *Capital Project* record.

**To Create a Capital Project Record**

**Step 1** Select *Projects* > *Capital* from the *Menu Bar*.

**Step 2** Review the *Capital Projects* page. The system displays various Project portal sections.
To Create a Capital Project Record

**Step 3** In the *Related Links - Capital Projects* portal section, click the *Expand* icon to open up the various Projects links.
- Click Create a Capital Project.

**Step 4** Review the form that appears.
- Enter the Capital Project data, including the Name and other relevant information.
- Click *Create Draft* to save the data and create a new record.

**General Tab**

<table>
<thead>
<tr>
<th>General Section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
</tr>
<tr>
<td>Enter a unique number identifying the <em>Capital Project</em> record that is being created.</td>
</tr>
<tr>
<td>If this field is left blank, the system automatically generates this number at the time of creating the <em>Capital Project</em> record.</td>
</tr>
</tbody>
</table>
General Section

Status
Displays the current status of the Capital Project record being created. This field is a read-only field. The different statuses of the Capital Project record are explained below.

Draft - Indicates that the Capital Project record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Activate action in the Action bar.

Active - The system automatically changes the record from the Review In Progress state to Active state when all the members in the distribution list have approved the record.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

Completed - Indicates that the record has been processed and all the tasks associated with the record has been completed. The system generates this status when the user selects the Complete action in the Action bar.

Date
Use the Calendar icon to select the date on which the Capital Project record is being created.

Note - By default, the system displays the current date in this field.

Name
Enter a unique name to identify the Capital Project record that is being created.
## Details Section

In this section, provide project-specific details such as the type of project, classification of project, and project website.

<table>
<thead>
<tr>
<th>Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Type</strong></td>
<td>Based on their primary purpose, projects can be categorized into several types, such as Commercial, Hospital, or Retail. Use the List icon to specify the type of project. The system displays all project types that are defined for the Project Type business object in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td><strong>Project Classification</strong></td>
<td>Based on the sectors upon which they focus, projects are classified as Advisory Service, Energy Reduction, Education, Management, and the like. Use the List icon to specify the classification of the project. The system displays all options that are defined for the Project Classification business object in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td><strong>Project Website</strong></td>
<td>Normally, important details regarding any project (such as contact details or layout) are hosted on a website. Enter the URL to be used for accessing the project website. When you click the Go To URL icon, the system automatically displays the corresponding Web page in a browser window. <strong>Note</strong> - Ensure that the specified URL is always prefixed with “http://”.</td>
</tr>
<tr>
<td><strong>Accounting Cost Center</strong></td>
<td>Identify the Accounting Cost Center for this project.</td>
</tr>
</tbody>
</table>

© Copyright IBM Corporation 2011, 2013.
### Unit Section

<table>
<thead>
<tr>
<th>Currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>The local currency of the project. The currency unit of measure (UOM) for the project is based on the currency in the user profile of the person who is initiating the project. All of the project objects then inherit the currency UOM.</td>
</tr>
</tbody>
</table>

You can change the currency as long as the project is in draft status. If the project is not in draft status, this field cannot be modified.

### Environmental Section

<table>
<thead>
<tr>
<th>Environmental Project?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the check box if the project is Environmental.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Carbon Emission Reduction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the quantity of the carbon emissions savings expected to be realized by the project.</td>
</tr>
</tbody>
</table>

Use the **List** icon to specify the unit of measure for the carbon emission reduction. The system displays the available units as defined in the **Tools > Lists** page.

### Project Address Section

This section enables you to provide the address details regarding the place where you prefer to receive all correspondences regarding the project.

<table>
<thead>
<tr>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the address where you prefer to receive the project correspondences.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Zip/Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Geography Lookup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the hierarchical path of the geographic region where the above address is located.</td>
</tr>
</tbody>
</table>

Use the **Search** icon to select a specific region. In the **Query** window, the system displays the records that are retrieved from the **Geography** page.

<table>
<thead>
<tr>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the name of the city where the above address is located.</td>
</tr>
</tbody>
</table>
### Project Address Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the above address is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Enter the name of the country where the above address is located.</td>
</tr>
</tbody>
</table>

### Client Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Lookup</td>
<td>Use the Search icon to select the client for which the Capital Project record is being created. In the Query window, the system displays the available External Contact records from the People page. Select the required record and click OK. The selected record is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address regarding the client.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the client is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the client is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Enter the name of the country where the client is located.</td>
</tr>
</tbody>
</table>

### Primary Location Section

This section enables you to define the primary location of the project. Use the Find action in this section to select the desired location from the property Portfolio. A Query window listing the available Location records appears. Select the required Location record and click OK. The hierarchical path of the selected location displays in the Location Path field.

Use the Clear action to erase the displayed information.

### Primary Location Graphic Section

The graphical representation of the selected primary location displays in this section.
Site Address Section

In this section, you can provide the address details regarding the site where the project is being executed.

Address
Enter the address of the project site.

Zip/Postal Code
Enter the zip/postal code regarding the above address.

Geography Lookup
The system displays the name of the geographic region where the project site is located.

Use the Search icon to select a specific geographic region. In the Query window, the system displays the records that are retrieved from the Geography page.

City
Enter the name of the city in which the project site is located.

State/Province
Enter the name of the state/province in which the project site is located.

Country
Enter the name of the country in which the project site is located.

Child Projects Section

If applicable, this section displays the child Capital Project records associated with this Capital Project record. Use the Find action in this section to associate a child Project. A Query window will appear, listing the available Project records (having no parent Program or Project). Select the appropriate Project record and click OK. The selection is displayed in this section as a line item.

Use the Add action to include a new child Project record.

Use the Remove action to delete the selected line item(s).

Reporting Section

Parent Program
Displays the current parent Program record of the Capital Project record being created. This field is a read-only field.

Parent Project
If applicable, displays the current parent Capital Project record of the Capital Project record being created. This field is a read-only field.
Recorded By Section

This section displays the login ID of the current user who is creating the Capital Project record. The Search icon in this section allows you to select a different user ID, if required. On clicking the Search icon, the system displays a Query window that displays the list of available records in the People page. Select the required record and click OK. The system auto populates the name of the person with the information from the selected record.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Calculate, Apply Template, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.

| Copy | Click the Copy action to create a copy of the selected record. |

On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Apply Template** | Click the **Apply Template** action to copy the contents of the selected template to the current record.  
On clicking the **Apply Template** action, the system displays a list of templates retrieved from the associated business objects. Select a template and click the **OK** action. The system copies the contents of the selected template to the current record.  

---

The Enable in Draft Mode field in the Project Security section of Application Settings must be selected in order for users to be able to select the Apply Template action. |
| **Calculate** | On clicking the **Calculate** action, the system recalculates all cost items in the record and updates them to include any new changes incorporated. |
| **Activate** | Click the **Activate** action to add the record to the active management list.  
On clicking **Activate** action, the system changes the status of the record to **Review In Progress** and after all the members in the distribution list have approved the record, the record status becomes **Active**.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| **Complete** | Click the **Complete** action to complete the tasks associated with the record.  
The system changes the status of the record from **Active** to **Completed**. |
| **Delete** | Click the **Delete** action to remove the record permanently from the active management list. |
| **More** | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Scope Tab**

Use this tab to provide a detailed description of the scope of the project. Scope is defined as the comprehensiveness or breadth of the project. The scope is defined based on the limitations of the budget and requirements from the Owner and/or Project Manager role.

For example, an individual wants to construct a hotel. He has a budget of $50,000,000.00. The size and type of hotel that he believes can be built, based on his budget, will be the initial scope. The scope will change throughout the project depending on various factors, such as building costs or schedule.
In this section, you can specify the site information, parking requirements, and also the Building or Structure information of the Capital Project.

**Scope Section**

Use this section to provide an appropriate description of the scope of the Capital Project record. Such details about the project may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

**Site Information Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Gross Area</td>
<td>Enter the gross area of the project site. Use the List icon to specify the unit of measure for the gross area. The system displays the available units (such as acres, hectares, square-feet) as defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Site Usable Area</td>
<td>Enter the area of the usable space in the project site. Use the List icon to specify the unit of measure for the usable area. The system displays the available units (such as acres, hectares, square-feet) as defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Project Gross Construction Area</td>
<td>Enter the gross area of the construction project. Use the List icon to specify the unit of measure. The system displays the available units (such as acres, hectares, square-feet) as defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Project Usable Construction Area</td>
<td>Enter the area of usable space in the construction project. Use the List icon to specify the unit of measure. The system displays the available units (such as acres, hectares, square-feet) as defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Total Floor Area Ratio</td>
<td>Enter a number equal to the Gross Floor Area of the Building or Structure divided by the Net Area of the Site. This ratio may be needed to show regulatory compliance. Many jurisdictions limit the intensity of land use to regulate environmental or social impact of development.</td>
</tr>
</tbody>
</table>
### Parking Section

<table>
<thead>
<tr>
<th>Parking Design</th>
<th>Use the List icon to specify the design for the parking area. The system displays the available designs regarding the parking area (such as AT Grade and Structure) that are defined in the Tools &gt; Lists page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parking Ratio</td>
<td>Enter a number equal to the Number of Parking Spaces per 1,000 Square Feet of Building Gross Floor Area (or other relevant Building area measurement). This ratio may be needed to show regulatory compliance in some jurisdictions.</td>
</tr>
<tr>
<td>Total Parking Spaces</td>
<td>Enter the total number of parking slots.</td>
</tr>
<tr>
<td>Covered Parking Spaces</td>
<td>Enter the total number of covered parking slots.</td>
</tr>
<tr>
<td>Handicap Parking Spaces</td>
<td>Enter the number of parking slots that have been allocated for handicaps.</td>
</tr>
</tbody>
</table>

### Building Information Section

This section displays the details regarding a building or structure such as the construction type, number of stories, and rentable area available. Click the Add action in this section. The system displays the Building Information window, wherein you can perform the following steps:

- Provide the information such as building designation in the General section and construction type in the Details section.
- Click the Create action.

A new line item will be added to the Building Information section. Use the Remove action to delete the selected line item(s).

### Schedule Tab

Use the Schedule tab to schedule a specific task regarding the Capital Project record. This tab displays four sections - Summary, Project Tasks Gantt, Project Tasks, and Schedule Assumptions. These sections enable you to schedule a specific activity and record all the scheduled dates regarding the task.

For users who enabled the accessibility feature, the Schedule Assumptions section is not displayed. Instead, a Schedule Assumptions tab is displayed, as described in Schedule Assumptions tab.

Prior to scheduling tasks, you may need to establish availability calendars based on your business calendar. For a discussion on establishing availability calendars on the Calendar Details tab, see the Calendar Details tab section.

© Copyright IBM Corporation 2011, 2013.
### Summary Section

On the Summary section bar, you can choose to import or export a Microsoft Project file by clicking the Import From MS Project or Export To MS Project action.

**Note** - Refer to the Schedule Tab - Import and Export MS Project section below.

Below the Summary section bar, provide the planned and actual dates corresponding to the Capital Project record. Use the Calendar icon to select the date for the respective fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Start</td>
<td>The planned start date of the project.</td>
</tr>
<tr>
<td>Plan End</td>
<td>The planned end date of the project.</td>
</tr>
<tr>
<td>Actual Start</td>
<td>The actual start date of the project.</td>
</tr>
<tr>
<td>Actual End</td>
<td>The actual end date of the project.</td>
</tr>
<tr>
<td>Calculated Start</td>
<td>Calculated by the Gantt Scheduler.</td>
</tr>
</tbody>
</table>

**Note** - This field is set when the Gantt is saved. For example, if the user changes the start date to a month in the future, this does not cause the Calculated Start date and Calculated End date to change. Calculated Start date and Calculated End date are set to their new values only when the Gantt is saved.
### Summary Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculated End</td>
<td>Calculated by the Gantt Scheduler.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This field is set when the Gantt is saved. For example, if the user changes the start date to a month in the future, this does not cause the Calculated Start date and Calculated End date to change. Calculated Start date and Calculated End date are set to their new values only when the Gantt is saved.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Click the Search icon to select the time zone for the Gantt chart display in the Project Tasks Gantt.</td>
</tr>
<tr>
<td>Calculate Project From</td>
<td>Click the List icon and select Start, End, or Both.</td>
</tr>
</tbody>
</table>
**Project Tasks Gantt Section**

A *Gantt chart* is a type of bar chart that shows the duration of tasks/activities as they occur over time. Using a Gantt chart, you also can identify the timing and interdependencies between tasks.

**Note** - The Project Tasks Gantt section is not accessible by users with disabilities. All users can access the Gantt chart section information in text format in the [Project Tasks section](#) tabs.

Choose which type of Gantt section display you would like to see as follows:

- Click the *Expand Section* icon on the section bar to display the Gantt chart within the tab to which the section belongs. Conversely, you can collapse the section by clicking the *Collapse Section* icon on the section bar.
- Click *Open Gantt In New Window* on the section bar to display the Gantt chart in a separate window. The Gantt displayed is the same. This action is intended for larger projects.

**Note - By default, the Project Tasks Gantt section is collapsed for optimum performance.**

**Tip** - To enable caching to run the *Open Gantt In New Window* type of Gantt, go to your Windows Control Panel > Java > Temporary Internet Files > Settings, select the *Keep temporary internet files on my computer* check box, and then click *OK.*
Project Tasks Gantt Section

In a Gantt chart, each task occupies one row. Dates run along the top in increments of days, weeks, or months, depending on the total length of the project. The expected time for each task is represented by a horizontal bar. The left end of the bar marks the expected beginning of the task and the right end marks the expected completion date. Tasks may run sequentially, in parallel, or may overlap each other. The Gantt chart consists of an action bar, a toolbar, and two panels.

The left panel displays the ID, task name, planned start, planned end, planned duration, total planned working, task type, and status of the tasks in the Project Tasks section. The right panel displays a Calendar view that shows the start and end dates of the tasks that are in the Project Tasks section.

Clicking the Save action on the Gantt action bar only saves the Gantt data (the tasks). To save the project record, click Save & Close or Save on the project record action bar.

To add a task from the Gantt chart, select a task type from the drop-down list next to Create Task Type, right-click in the Gantt chart, enter the information for the task in the left side of the Gantt, and click Save on the Gantt action bar.

When using the Gantt chart that displays in the tab (from the Expand Section icon ), the new task displays in the Project Tasks section. When using the Gantt chart that displays in a separate window (from the Open Gantt In New Window action), the new task displays in the Project Tasks section after you click Refresh on the Project Tasks section bar.

The Gantt toolbar controls the visibility of the Gantt. For more information on the Gantt toolbar, refer to the Using the Gantt Scheduler Toolbar section.

Project Tasks Section

This section displays the tasks that are associated with the project, the critical path tasks, the task hierarchy, and the task dependencies. The information records in this section are reflected in the Project Tasks Gantt section.

Project Tasks tab

In the Project Tasks tab, you can view the tasks that are associated with the selected capital project. You can edit the ID and Task Name fields for the task records that are displayed in this tab, and view the changes in the Project Tasks Gantt section.

To edit the ID and Task Name fields in a task record, in the Related Reports field, select a task type and enter the edits. This feature works on task types other than All Tasks.

Select the Add action to include a new task record.
**Project Tasks Section**

Select the **Find** action to associate existing task records. On clicking the **Find** action, the system displays the available task records in a query window. Select the required task record and click **OK**.

To see the new task in the Project Tasks Gantt section, click the expand section icon or select the **Open Gantt In New Window** action. Either action saves the new task record and displays it on the Gantt chart.

Select the **Assign Task by Role** action to assign one or more selected line items to the person in the appropriate role in the **Contacts** tab.

Select the **Baseline** action to set the baseline for one or more selected line items.

Select the **Remove** action to delete one or more selected line items.

**Critical Path Tasks tab**

In the Critical Path Tasks tab, you can view the critical tasks that are associated with the selected capital project. The information that is displayed in this tab is reflected in the Project Tasks Gantt section.
Project Tasks Section

Task Hierarchy tab

In the Task Hierarchy tab, you can add or remove child tasks for a selected parent task that is associated with the selected capital project. The information you change is reflected in the Project Tasks Gantt section.

To add a child task to a parent task:

1. Select the parent task, and click the Manage Hierarchy link.

   Optional: You can select a different parent task in the Manage Task Hierarchy page by typing the parent task in the field, or by searching for the parent task.

2. In the Manage Task Hierarchy page, click the Find Child link.

3. To create a child task, click the Add link. Specify the information and activate the task record.

4. In the Manage Task Hierarchy page, select the child task to add to the parent task and click OK.

To delete a child task from a parent task:

5. Select the parent task, and click the Manage Hierarchy link.

6. In the Manage Task Hierarchy page, click the Remove Child link.

7. Click Save.

Dependencies tab

In the Dependencies tab, you can view the task dependencies that are associated with the selected capital project. The information that is displayed in this tab is reflected in the Project Tasks Gantt section.

You can change the lead and lag time for working days and working hours for tasks with dependencies. To edit the values, type the values into the Lead (-) / Lag (+) Working Days field and the Lead (-) / Lag (+) Working Hours field.

You can also change the dependency relationship by selecting a value from the drop-down list.

The information that is displayed in this tab is reflected in the Project Tasks Gantt section.
Schedule Assumptions Section

Use this section to provide an appropriate description regarding the Capital Project record. The details about the schedule may be helpful for exchanging information between users viewing or reviewing a record.

For users who enabled the accessibility feature, the Schedule Assumptions section is not displayed. Instead, a Schedule Assumptions tab is displayed, as described in Schedule Assumptions Tab.

Note - Formatting options are also available.

Schedule Tab – Import and Export MS Project

Import MS Project

Clicking Import From MS Project opens the Project Importer form.

Click the List icon to select the Task Type (for New Tasks), such as Schedule Task, Work Task or Inspection Task. Click the Upload Import File icon to browse for a local Microsoft Project file to be imported. Click the Import action to begin the import process.
Task Fields

For first-time imports, Microsoft Project Tasks become new Task records in the Project. These Task records include the following fields:

- **Name**
- **ID** - This ID is assigned by IBM TRIRIGA.
- **Sequence ID** - This internal ID is based on the Sequence Number auto-generated by MS Project.
- **Planned Start Date** - This is set to the Planned Start Date from the MS Project Task.
- **Planned Working Days/Hours/Total Hours** - These values are calculated based on the Planned Duration value from the MS Project Task. If the Duration is specified in Days, the “Planned Working Days” is populated. If the Duration is specified in Hours, the “Planned Working Hours” is populated. In either case, the “Total Planned Working Hours” is calculated based on the “Working Hours Per Day” from the Calendar.
- **Planned End Date** - This is calculated based on the “Total Planned Working Hours” and the Task’s Calendar.
- **Planned Duration** - This is calculated based on the “Total Planned Working Hours” and the Task’s Calendar.
- **Actual Start Date** - This is set to the Actual Start Date from the MS Project Task.
- **Actual Working Days/Hours/Total Hours** - These values are calculated based on the Actual Duration value from the MS Project Task. If the Duration is specified in Days, the “Actual Working Days” is populated. If the Duration is specified in Hours, the “Actual Working Hours” is populated. In either case, the “Total Actual Working Hours” is calculated based on the “Working Hours Per Day” from the Calendar.
- **Actual End Date** - This is calculated based on the “Total Actual Working Hours” and the Task’s Calendar.
- **Actual Duration** - This is calculated based on the “Total Actual Working Hours” and the Task’s Calendar.
- **Constraint Type & Date** - If the import encounters MS Project Constraint Types (e.g., “As Late As Possible”, “Finish No Earlier Than” and “Finish No Later Than”), a blank/empty value will be set, and the IBM TRIRIGA Gantt Scheduler will treat them as: “As Soon As Possible”.
- **Working Days/Hours**
Task Type

The Task Type option allows you to specify which form should be used for new Tasks. If a form is not found, the import process applies the “Schedule Task” form.

- For Capital Projects, the default Task Type is automatically set to “Schedule Task”.
- For all other projects (e.g., Facility Projects), the default Task Type is automatically set to “Work Task”.

Note - For more information on Task Types, refer to the Task Types section of this document.

Task Sequence

Within Microsoft Project, the Sequence Number is auto-generated as each new line (Task) is created. To maintain the same-sequence rendering of MS Project Tasks in the IBM TRIRIGA Gantt Scheduler, IBM TRIRIGA-created Tasks are assigned an internal Sequence ID of “0”. This results in IBM TRIRIGA-created Tasks appearing at the top of the IBM TRIRIGA Gantt Scheduler.

Note - If IBM TRIRIGA Tasks are exported to Microsoft Project and then re-imported into IBM TRIRIGA, the Sequence Number for these Tasks is reset, based on the values created within Microsoft Project.

Task Calendars

The system displays the Calendar Name and Working Hours Per Day based on the Calendar from the Project. If no Calendar exists on the Project, the Working Hours Per Day displays as “24”.
Task Re-Imports

The system also allows you to take a previously-imported Microsoft Project file that has had modifications and update the IBM TRIRIGA Project. While any new Tasks are created like a first-time import scenario, existing Tasks are updated to reflect any new field values from the MS Project Tasks. The following requirements are necessary for task re-imports:

- Subsequent imports must be made using the same (or a copied version of the) MS Project File from the first-time import.
- MS Project Tasks must be limited to the use the “drag” operation (not cut-and-paste) to ensure the “link” to an IBM TRIRIGA Task is maintained.

Round-Trip Imports

In addition to re-imports, the system allows you to take a previously-exported file from IBM TRIRIGA (in MPX, XML or PLANNER format), open/import that file into Microsoft Project, make any modifications to the list of Tasks, and then import that file back into IBM TRIRIGA.

For round-trip imports and the most-complete support for MS Project features, use XML format.

Export MS Project

Clicking Export To MS Project opens the Project Exporter form.

Click the List icon to select the Export Format, such as XML (default) or MPX. Click the Export action to begin the export process.

Schedule Assumptions Tab

The Schedule Assumptions tab is displayed only for users who have the accessibility feature enabled. This feature is enabled by selecting Enable Accessibility Mode in the Accessibility section of a user’s My Profile page.

When this tab is displayed, the Schedule Assumptions section in the Schedule tab is not displayed. The Schedule Assumptions tab contains the same information as a Schedule Assumptions section would.

Use this tab to provide an appropriate description regarding the Capital Project record. The details about the schedule may be helpful for exchanging information between users viewing or reviewing a record.
**Budget Tab**

The **Budget** tab contains auto-populated data from the cost codes associated with a budget. Budgets at various levels in the hierarchy will be rolled up to the highest level and the sum of all of the costs between budgets and associated cost codes will be displayed. When a cost code is associated with a **Budget record**, the budget data automatically will be associated to the cost code. Data from the associated budgets automatically will display in this section. In addition to the auto-populated cost data, you can type a general overview of the budget set forth for the particular project.

**Summary Section**

This section provides a summary of the budget and commitment details regarding the project.

The budget information is retrieved from the corresponding **Budget** records that are associated with the project cost code. The commitment data works the same way as the budget data except that the data auto-populates from commitment codes associated to purchase orders and contract records. The incurred data auto-populates from payment, invoice, and contract invoice.

Use the **Calendar** icon in this section to select the date for the **Last Update** field. Use the **Search** icon to select an **Employee** record for the **Updated By** field. These fields indicate the date on which the **Capital Project** record was last updated and person who updated the record.

**Cost Overview Section**

Use this section to provide additional information regarding the cost associated with the project. These details may be helpful for exchanging information between users while viewing or reviewing a record.
Fund Allocations Section

Adding new funding to a project

This section displays the funding allocations of each funding source for the project for each fiscal year.

Use the Add Funding Allocations action in this section to add a new funding allocation source to this project for a given time period (such as fiscal year).

- If this is a parent project, then the Fund Allocation popup form allows you to select from available funding sources to fund the Project.
- If this is a sub-project, the form allows you to select from its parent Project’s Available Funding.

From the popup form, find or select the project record and click Continue. The selected record is displayed in the Fund Allocations section as a line item with the funding source details.

Increasing or decreasing project funding

You only can add fund allocations for a given period (such as a fiscal year) one time. After a fund allocation has been added to a project for a given period, you use the Transfer Funds action to add more funds to the project from the parent program or project or to reduce funds and return them to the parent program or project.

- If this is a parent Project, the Fund Transfer popup form allows you to increase or decrease Funding from its Funding Sources.
- If this is a Sub-Project or Project with a parent Program, the Fund Transfer popup form allows you to increase or decrease Funding from its parent Project or Program funding.

From the popup form, enter the required information and click Create Draft. To increase funding, enter a positive value for the change amount. To decrease funding, enter a negative value for the change amount. Once the fund increase or decrease is issued and approved, the Fund Allocations section is updated to reflect the current Total Project Funds.

Note - For a discussion on Fund Allocations, see the Funding Source Tabs section above.
**Project Budget Section**

This section displays all types of budgets associated to the *Capital Project* record. This section also provides actions enabling you to add a Project Budget from within the record.

Click the **Add** action to display several menu options for which budget type to add to the project: *Project Budget Change*, *Project Budget Forecast*, *Project Budget Transfer* and *Project Original Budget*. Select the appropriate budget to create and associate to the project. Fill in the form that appears.

**Procurement Tab**

The **Procurement** tab allows you to conveniently review, add and/or access more information about the Contracts, Proposals and Billing that are performed within the context of the project. This tab displays four sections - *Proposals*, *Purchase Requisition*, *Contracts and Purchase Orders*, and *Billing*. The records available in this section can be directly accessed by clicking the hyperlinked record.

*Note* - For more information on the procurement management process, see the *IBM TRIRIGA 10 Procurement Management User Guide*.

**Proposals Section**

This section displays the proposals associated to the *Capital Project* record. The section also provides actions for enabling you to add new proposals from within the record.

Click the **Add** action to display several menu options for which proposal type to add to the project: *Bid Document*, *RFP* and *RFQ Document*. Select the appropriate proposal to create and associate to the project. Fill in the form that appears.

*Note* - All proposals which are not in the following status are displayed: *Retired*, *Upload Error*, *Template*, *History* and *Deleted*.
Purchase Requisition Section

This section displays the Purchase Requisitions associated to the Capital Project record. The section also provides actions for enabling you to add new Purchase Requisitions from within the record.

Click the Add action to add a new Purchase Requisition to the project. Fill in the form that appears.

Note - All Purchase Requisitions which are not in the following status are displayed: Retired, Upload Error, Template, History and Deleted.

Contracts and Purchase Orders Section

This section displays the Contracts and Purchase Orders associated to the Capital Project record. The section also provides action enabling you to add new contracts from within the record.

Click the Add action to display several menu options for which contract type to add to the project: Purchase Order, Standard Contract and Standard Contract Change Order. Select the appropriate contract to create and associate to the project. Fill in the form that appears.

Note - All contracts which are not in the following status are displayed: Retired, Upload Error, Template, History and Deleted.

Billing Section

This section displays the billing information associated to the Capital Project record. The section also provides actions for enabling you to add new invoices or payments from within the record.

Click the Add action to display several menu options for which invoice type to add to the project: Contract Invoice, Payment Release and PO Invoice. Select the appropriate invoice to create and associate to the project. Fill in the form that appears.

Note - All billing records which are not in the following status are displayed: Retired, Upload Error, Template, History and Deleted.

Cash Flow Tab

The Cash Flow tab displays the cash flow details for Planned Value, Actual Value, Working Value, Commitments, Estimate at Completion and Earned Value.

© Copyright IBM Corporation 2011, 2013.
Note - For related information on Spend Plans, refer to the Spend Plan Tab of the Project Original Budget.

This tab displays the following sections - Cash Flow Curves, Cash Flow Details and Cash Flow Graph. Each of these sections is explained below.

### Cash Flow Curves Section

This section provides several options to select which cash-flow curves to display.

<table>
<thead>
<tr>
<th>Cash Flow Curves Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned Value</td>
<td>This curve is based on the following planned values: (1) Original budget total amount, (2) Days from project plan start to current fiscal period end, and (3) Project planned duration. Select this check box to display the Planned Value curve.</td>
</tr>
<tr>
<td>Working Value</td>
<td>This curve is based on the following working forecast values: (1) Forecast final amount (from Capital Project record), and (2) Project calculated duration. Select this check box to display the Working Value curve.</td>
</tr>
<tr>
<td>Earned Value Forecast</td>
<td>This curve is based on the following earned forecast values: (1) Estimated final forecast (from Project Report record), (2) Days from project plan start to current fiscal period end, and (3) Estimated final duration (from Project Report record). Select this check box to display the Earned Value Forecast curve.</td>
</tr>
<tr>
<td>Progress Report</td>
<td>This curve is based on the following original and actual values: (1) Original budget total amount, and (2) Actual percentage complete (from Project Report record). Select this check box to display the Progress Report curve.</td>
</tr>
</tbody>
</table>
Cash Flow Details Section

This section provides additional cash-flow options.

Earned Value Forecast Adjust Only Uncommitted Amount? Select this check box to adjust only the uncommitted amount of the earned value forecast.

Enable Spend Plan Functionality For This Project? Select this check box to enable the graphs in the Spend Plan Tab of the Project Original Budget.

Cash Flow Graph Section

This section displays a graph of the cash-flow curves selected above.

Closeout Tab

The Closeout tab contains several sections and sub-tabs that cover elements regarding completion of the overall Project Management process.

When a sub-tab is selected, the system displays the details regarding the associated records as hyperlinked line items in the respective sections. You can view/modify the records by clicking the hyperlinked line item. You also can view the details of the work tasks regarding the Project Management process.

This tab also provides a consolidated view of the current status of the different records associated with the current project. Before closing the project, it is essential to ensure that the status regarding these records is Closed. If a different status is displayed in this tab, revisit the corresponding record and update the status.

Security Tab

Using the Security tab, you can set up the security levels for the users. Groups are set up to define access rights that can be applied to multiple users. For example, the Admin group gives universal access to all modules in the application. Each user associated with the Admin group has access to all application modules. Other groups can limit access to assigned users.

If all of the users related to a project are associated with a group already, then all you have to do is associate the group to the current Project record. Other individuals who are not associated with any
group can be added as well. They will have the same security rights as those determined by the group selected in the Group Access section.

**Group Access Section**

A group is defined in the Security Manager. A Group record contains security rights and the people associated with that group.

By adding a group to the Capital Project record, you apply the security rights assigned to the Group record and the people associated with it to the Capital Project record. If you make changes to the Group record, it affects all the persons who are associated with the group.

Use the Find action in this section to select the group. A Query window listing the available Group records in the Security Manager will appear. Select the required Group record and click OK. The selected group will be displayed as line items. Use the Linked Record icon to view and modify the record.

By selecting the Delete action you can remove a specific record from the list.

**User Access Section**

This section displays the security access provided to the user. Use the Find action in this section to select the user name. A Query window listing the available People records will appear. Select the required record and click OK. The selected person name will be displayed as the line items. Use the Linked Record icon to view and modify the record.

By selecting the Delete action you can remove a specific record from the list.

**Project Security Setting**

The Project Security section in Application Settings identifies whether you can access project records with security groups before the project is activated. If the USE_PROJECT_SECURITY property in the TRIRIGAWEB.properties file is enabled, and the Enable in Draft Mode check box is selected in the Project Security section of Application Settings, you can access the security of the project record in Draft status. For information about the properties files, go to the IBM TRIRIGA Application Platform 3 Information Center and select Installing IBM TRIRIGA Application Platform > Configuring the platform > Properties files.

**Calendar Details Tab**

The Calendar Details tab enables you to establish the scheduling availability of the tasks that need to be completed for this project. Once these task calendars are established, the Gantt Scheduler will calculate and display Gantt charts based on the available time within these calendars.
Note - Because the calendar is used to schedule availability, the Start Date and/or End Date may not necessarily coincide on an available work day (e.g., weekend, holiday, etc.). Hence, the next available day/hour in the calendar is applied.

Note - If the project has no set calendar, and is calculated from the “Start” date, then tasks are scheduled from the Start Date. If the project is calculated from the “End” date, then tasks are scheduled from the End Date.

For a discussion on the Project Tasks Gantt on the Schedule tab, see the Schedule tab section.

### Calendar Details Section

**Time Zone**

Click the Search icon to select the time zone for the Gantt chart display in the Project Tasks Gantt. For a discussion on the Project Tasks Gantt on the Schedule tab, see the Schedule tab section.

### Availability Calendar Section

In this section the scheduling calendars associated with the project are included.

Use the Find action in this section to select the scheduling calendar regarding the Capital Project record being created. On clicking the Find action a Query window listing the available Calendar records will appear. Select the required Calendar record and click OK. The selected records are displayed as the line items.

Note - Use the Add action in the Query window to include a new Calendar record.

The line items display the name and status of the Calendar created. Use the Remove action to delete the selected record(s).

### Other Tabs

The details about the Contacts tab, Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
Facilities Project

Note - For more information on move-related facilities projects, go to the IBM TRIRIGA 10 Information Center and select Planning facilities, spaces, and moves > Managing spaces and moves.

A Facilities Project record provides details about services or tasks performed within a Facilities Project (e.g., moving cubicles from one location to another location within the building, and painting the new location). The difference between a Facilities Project and a Capital Project is the scope of the project. A Capital Project is geared toward large, complex and costly endeavors (i.e., the development and construction of a building or a structure), whereas a Facilities Project usually refers to a smaller objective. The Capital Project uses multiple business objects to accomplish its objectives, while the Facilities Project consists of a self-contained business object.

Creating a Facilities Project Record

Follow the procedure below to create a Facilities Project record.

To Create a Facilities Project Record

Step 1 Select Projects > Facilities from the Menu Bar.

Step 2 Review the Facilities Projects page. The system displays various Project portal sections.

Step 3 In the Related Links - Facilities Projects portal section, click the Expand icon to open up the various Projects links.
   - Click Create a Facilities Project.

Step 4 Review the form that appears.
   - Enter the Facilities Project data, including the Name and other relevant information.
   - Click Create Draft to save the data and create a new record.

General Tab

General Section

ID

Enter a unique number identifying Facilities Project record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Facilities Project record.
General Section

Status

The system displays the current status of the Facilities Project record being created. This field is a read-only field. The different statuses of the Facilities Project are explained below.

*Draft* - Indicates that the Facilities Project record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

*Suspended* - Indicates that the Facilities Project record is suspended temporarily. The system generates this status when the user selects the Suspend action in the Action bar.

Note - You can reuse the suspended record by clicking the Resume action in the Action bar. The status of the record changes from Suspended to Draft state.

*Review In Progress* - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Activate action in the Action bar.

*Active* - Indicates that the record is active. The system generates this status when the user selects the Activate action in the Action bar.

*Retired* - Indicates that the record is retired. The system generates this status when the user selects the Retire action in the Action bar.

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the Unretire or Revise action in the Action bar.

*Completed* - Indicates that the record has been processed and all the tasks associated with the record has been completed. The system generates this status when the user selects the Complete action in the Action bar.

Date Created

Use the Calendar icon to select the date on which the Facilities Project record is created.

Note - By default, the system displays the current date in this field.

Name

Enter a unique name to identify the Facilities Project record that is being created.
<table>
<thead>
<tr>
<th><strong>Details Section</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Type</strong></td>
<td>Use the <em>List</em> icon to specify the type of project. The system displays all the available project types (such as <em>Commercial</em>, <em>Hospital</em>, <em>Home</em>, etc.) that are defined for the <em>Project Type</em> business object in the <em>Tools &gt; Lists</em> page.</td>
</tr>
<tr>
<td><strong>Project Classification</strong></td>
<td>Use the <em>List</em> icon to specify the project classification for the <em>Facilities Project</em> record being created. The system displays all the available options (such as <em>Advisory Service</em>, <em>Education</em>, <em>Management</em>, etc.) that are defined for the <em>Project Classification</em> in the <em>Tools &gt; Lists</em> page.</td>
</tr>
<tr>
<td><strong>Project Website</strong></td>
<td>Enter the URL to be used for accessing the project website. When you click the Go To URL icon, the system automatically displays the corresponding Web page in a browser window. <strong>Note</strong> - Ensure that the URL specified is always prefixed by “http://”.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Provide a brief description for the <em>Facilities Project</em> record being created.</td>
</tr>
<tr>
<td><strong>Service Plan</strong></td>
<td>Use the <em>Search</em> icon to associate a service plan with the <em>Facilities Project</em> record being created. In the search list, the system displays the different service plans that are retrieved from the <em>Service Plan</em> business object in the <em>Maintenance &gt; Set Up</em> page. Select the required record and click OK. The selected service plan will be displayed in this field. <strong>Note</strong> - Use the <em>Add</em> action in the <em>Query</em> window to include a new Service Plan.</td>
</tr>
<tr>
<td><strong>Work Class</strong></td>
<td>Use the <em>Search</em> icon to select a work class for the <em>Facilities Project</em> record being created. In the search list, the system displays the different work classes (such as <em>Building Class</em>, <em>Human Resources</em>, <em>Inspection Request</em>, etc.) that are retrieved from the <em>Request Class</em> business object in the <em>Classification hierarchy</em>. The selected work class will be displayed in this field.</td>
</tr>
</tbody>
</table>
Details Section

Work Type
Use the Search icon to select a work type for the Facilities Project record being created. In the search list, the system displays the different work types (such as Administrative Work, Corrective Work, Emergency Work, etc.) that are retrieved from the Work Type business object in the Classification hierarchy. The selected work type will be displayed in this field.

Note - If you select “Move” for Work Type, the Scope tab displays the Move Details and Requests sub-tabs.

Work Location
Use the Search icon to select a work location for the Facilities Project record being created. In the search list, the system displays the different work locations that are retrieved from the Space business object in the Location hierarchy. Select the required record and click OK. The selected work location will be displayed in this field.

Service Class
Use the Search icon to select a service class for the Facilities Project record being created. In the search list, the system displays the different service classes (such as Conference Services, Facilities, Inventory, etc.) that are retrieved from the Service Assignment Class business object in the Classification hierarchy. The selected service class will be displayed in this field.

Priority
Use the Search icon to assign a priority level to the project. The system displays the values (Emergency, High, Medium, and Low) that are defined in the Classification hierarchy for the Priority business object.

Priority Rating
Enter a numerical value representing the priority level for the Facilities Project record created.

Building System Class
If the Facilities Project record concerns a building system item, then the building system is categorized based on its utility.

Use the Search icon to select the building system class. The system displays the different building system classes (e.g., Interiors, Services, Building Site Work, etc.) that are retrieved from the Building System Class business object in the Classification hierarchy.

Currency
Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency in the Tools > Lists page.

By default, the system displays the currency set by your administrator.
Summary Section

The Summary section provides detailed information about the estimated cost and budget regarding the Facilities Project record. The information includes the estimated resource cost, actual resource cost, estimated material cost, actual material cost, estimated cost total, budget cost total, and actual cost total. By default the values are in US dollars. The % Complete field displays the amount of work that is currently complete.

Responsible Organization Section

This section displays the name of the organization, type, and hierarchical path for the Facilities Project record being created.

Use the Find action in this section to select an existing organization for creating the Facilities Project record. A Query window listing all available Organization records will appear. Select the required record and click OK. These records are retrieved from the associated business object in the Organization hierarchy.

Use the Clear action to erase the displayed information.

Responsible Person Section

This section displays the name of the person (who is responsible for answering/resolving all the issues related to the project), and his/her contact details such as functional role, email, and work phone number.

Use the Find action in this section to select the responsible person associated with the current Facilities project. In the Query window, the system displays all the available records retrieved from the associated business object in the People page. Select the required record and click OK. The system auto populates the fields of this section with the information from the selected record.

Note - Use the Add action in the Query window to create a new record.

Use the Clear action to erase the displayed information.
**Customer Organization Section**

This section displays the name of the customer organization (associated with the current project), type, and the hierarchical path of the organization.

Use the **Find** action in this section to select an existing organization for creating the **Facilities Project** record. A **Query** window listing all available **Organization** records will appear. Select the required record and click **OK**. These records are retrieved from the associated business object in the **Organization hierarchy**.

Use the **Clear** action to erase the displayed information.

---

**Customer Contact Section**

This section displays the contact details of the responsible person in the customer organization. The system displays the name, functional role, email, and work phone number of the contact person.

Use the **Find** action in this section to select the responsible person in the customer organization. In the **Query** window, the system displays all the available records retrieved from the associated business object in the **People** page. Select the required record and click **OK**. The system auto populates the fields of this section with the information from the selected record.

- **Note** - Use the **Add** action in the **Query** window to include a new record.

Use the **Clear** action to erase the displayed information.

---

**Child Projects Section**

If applicable, this section displays the child **Facilities Project** records associated with this **Facilities Project** record. Use the **Find** action in this section to associate a child **Project**. A **Query** window will appear, listing the available **Project** records (having no parent **Program** or **Project**). Select the appropriate **Project** record and click **OK**. The selection is displayed in this section as a line item.

Use the **Add** action to include a new child **Project** record.

Use the **Remove** action to delete the selected line item(s).
Reporting Section

Parent Program
Displays the current parent Program record of the Facilities Project record being created. This field is a read-only field.

Parent Project
If applicable, displays the current parent Facilities Project record of the Facilities Project record being created. This field is a read-only field.

Recorded By Section

This section displays the Name of the current user who is creating the Facilities Project record. The Search icon in this section allows you to select a different user ID, if required. On clicking the Search icon, the system displays a Query window that displays the list of available records in the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Apply Template, Suspend, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy         | Click the **Copy** action to create a copy of the selected record.  
On clicking the **Copy** action, a copy of the record is created (in the *Draft* status) and displayed in the appropriate page wherein the details can be modified as required. |
| Apply Template | Click the **Apply Template** action to copy the contents of the selected template to the current record.  
On clicking the **Apply Template** action, the system displays a list of templates retrieved from the associated business objects. Select a template and click the **OK** action. The system copies the contents of the selected template to the current record. |
| Suspend      | Click the **Suspend** action to temporarily remove the record from active management list.  
On clicking the **Suspend** action, the record which is in the *Draft* status is temporarily removed and held in suspended status.  
The system also displays the **Resume** action on the Action bar. |
| Resume       | Click the **Resume** action to reactivate the suspended record from the active management list.                                                                                                                                                                       |
| Activate     | Click the **Activate** action to add the record to the active management list.  
On clicking **Activate** action, the system changes the status of the record to *Review In Progress* and after all the members in the distribution list have approved the record, the record status becomes **Active**.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| Complete     | Click the **Complete** action to complete the tasks associated with the record.  
The system changes the status of the record from **Active** to **Completed**.                                                                                                                                  |
| Delete       | Click the **Delete** action to remove the record permanently from the active management list.                                                                                                                                                                        |
| More         | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action.                                                                                                    |
**Scope Tab**

Scope relates to the extent to which the project exists or is to be developed. Scope is defined as comprehensiveness or breadth of the project. The scope is defined based on what a group of individuals can do given a set budget and requirements from the Owner/Project Manager role.

For example, an individual wants to make changes to the interior of an office building with a budget of $25,000. These changes may include changing wall coverings, carpet, furniture, etc. The extent of the changes that he believes can be accomplished based on his/her allocated budget will be the initial scope. The scope will change throughout the project based on various factors, such as, building costs, raw material cost, schedule, etc.

---

**Note** - In the General tab, if you select “Move” for Work Type, the **Scope** tab displays the **Move Details** and **Requests** sub-tabs.

Depending upon your selections in the General tab, the **Scope** tab displays a different set of the following sub-tabs: **Locations**, **Move Details**, **Procedures**, **Regulations**, **Requests**, **Checklists**, and **Checklist Items**, which are explained below.

---

**Locations Sub-Tab**

The **Locations** sub-tab displays the locations associated with the **Facilities Project** record. On clicking the sub-tab the system displays the **Locations** section.

---

**Locations Section**

This section enables you to select the primary location where the project is being executed. Use the **Find** action in this section to select the desired location. A **Query** window listing the available **Location** records will appear. Select the required **Location** record and click **OK**. The selected location is displayed in this section as line item.

To delete a line item from this section, select the line item and click the **Remove** action in the Section bar.

On clicking the **Show Graphics** action in the Section bar, the system displays the **Graphic Location** section below the location section. The **Graphic Location** section portrays a graphical representation of the location which is being selected.

---

**Move Details Sub-Tab**

The **Move Details** sub-tab displays the move details associated with the **Facilities Project** record. On clicking the sub-tab, the system displays the **Move Details** section.
**Move Details Section**

This section displays the details about the move associated with the current Facilities project. Click the **Add**, **Add People** or **Add Room** action in this section to add a *Move Details* record. Select the desired information and perform the following steps:

- Provide the necessary information regarding the move you have selected.
- Click the **Create** action.

A new line item will be added to the *Move Details* section.

You also can use the **Find** action in this section to select the desired location. A *Query* window listing the available *Move Details* records will appear. Select the required *Move Details* record and click **OK**. The selection is displayed in this section as line item.

Use the **Remove** action to delete the selected line item(s).

---

**Procedures Sub-Tab**

The **Procedures** sub-tab displays the procedures associated with the *Facilities Project* record. On clicking the sub-tab, the system displays the *Procedures* section.

**Procedures Section**

This section displays the details about the procedures associated with the current Facilities project. Click the **Add** action in this section to add a *Procedure* record. The system displays the different types of procedures such as Inspection Procedure, Work Procedure, Safety Precaution Procedure, etc., in a window. Select the required procedure and perform the following steps:

- Provide the necessary information regarding the type of procedure you have selected.
- Click the **Create** action.

A new line item will be added to the *Procedures* section.

You also can use the **Find** action in this section to select the desired location. A *Query* window listing the available *Procedure* records will appear. Select the required *Procedure* record and click **OK**. The selected procedure is displayed in this section as line item.

Use the **Remove** action to delete the selected line item(s).
**Regulations Sub-Tab**

The **Regulations** sub-tab displays the regulations associated with the **Facilities Project** record. On clicking the sub-tab the system displays the **Regulations** section.

**Regulations Section**

This section enables you to provide the regulations (set of rules) associated with the project. Use the **Find** action in this section to select the desired regulation. A **Query** window listing the available **Regulation** records will appear. Select the required record and click **OK**. The selected regulation is displayed in this section as line item.

Use the **Remove** action to erase the displayed information.

**Requests Sub-Tab**

The **Requests** sub-tab displays the requests associated with the **Facilities Project** record. On clicking the sub-tab the system displays the **Requests** section.

**Requests Section**

This section enables you to provide the request associated with the project. Use the **Find** action in this section to select the desired request. A **Query** window listing the available **Request** records will appear. Select the required record and click **OK**. The selected request is displayed in this section as line item.

Use the **Remove** action to delete the selected line items from this section.

**Checklists Sub-Tab**

The **Checklists** sub-tab displays the Checklists associated with the **Facilities Project** record. On clicking the sub-tab the system displays the **Checklists** section.

**Checklists Section**

This section displays the Checklists associated with the project. Use the **Find** action in this section to select the desired Checklist(s). A **Query** window listing the available **Checklist** records appears. Select the required record(s) and click **OK**. The selected Checklist(s) are displayed in this section as line item(s).

Use the **Remove** action to delete the selected line items from this section.
Checklist Items Sub-Tab

The Checklist Items sub-tab displays the Checklist Items associated with the Facilities Project record. On clicking the sub-tab the system displays the Checklist Items section.

Checklist Items Section

This section displays the Checklist Items associated with the project. Use the Find action in this section to select Checklist Items. A Query window listing the available Checklist Item records appears. Select the required record(s) and click OK. The selected Checklist Item(s) are displayed in this section as line item(s).

Use the Remove action to delete the selected line items from this section.

The other sections in this tab are explained below.

Scope Notes Section

Use this section to provide appropriate description regarding the record. The details about the Facilities Project record may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Project Description Section

In this section, you can provide a brief description about the objectives, issues, risks, measures, assumptions, and deliverables associated with the project in the respective fields.

Budget Tab

In this tab, all the budget amounts are allocated to various charge accounts in the Facilities project. As the charges are made against those charge accounts, the original amount that is allocated for the project is reduced.
Summary Section

This section displays the summary of estimated, actual, and total cost involved in the project.

The Currency field displays the unit of measure for the above fields.

Use the List icon to specify the UOM. By default the system displays US Dollars.

Accounting Section

This section displays all the accounts associated with the Facilities Project records. Use the Find action in the Section bar to associate the related account. A Query window listing all Accounting records will be displayed. Select the required record and click OK. The details regarding the selected account are displayed, as line items.

Use the Linked Record icon to view and modify the record. Use the Remove action to delete the selected line item(s).

Other Tabs

The details about the Schedule tab, Contacts tab, Notifications tab, Notes & Documents tab, Calendar Details tab, Calendar tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the information.
4. Managing Projects

Project Management Tools

*Project Management* is the discipline of designing and achieving targets while optimizing the use of resources (such as time, cost, people, space, etc.) within financial, time and other constraints. IBM TRIRIGA offers a state-of-the-art solution for complete enterprise-wide capital project management. The application delivers a suite of powerful tools that automate, streamline, and manage the full array of capital project processes and tasks. The flexibility and customization of the platform provides the users to meet their actual needs and existing organizational processes.

This chapter covers the various aspects of managing projects that are utilized for organizing specific tasks or the entire project of an organization. The *Project Management* process is classified into several modules such as *Design*, *Cost*, *Risk*, *Schedule*, *Approval*, and *Permit*. The details regarding the above processes are explained in the forthcoming sections.

The following diagram depicts the various elements involved in managing projects:

![Diagram of project management elements](image)

Elements involved in managing projects

*Note* - While the diagram above depicts a general flow, the specific activities represented above can happen anytime within the scope of the project.

### Cost Management

*Cost Management* is the process of effectively controlling the finances of the project through evaluating, estimating, budgeting, monitoring, analyzing, forecasting, and reporting the cost information. This process also enables you to manage the cost code structure regarding the project.
Using this *Budget* page, you can estimate the original budget, notify all the changes regarding the budget, transfer funds from one cost code to another, and also provides information regarding the anticipated budget.

**Design Management**

*Design Management* process acts as a “threshold of possibility” in *Project Management* and plays a key role in the project lifecycle. The end-product of the design activity will be drawings, specifications, etc., that guide the subsequent project activities. Once Design Drawings have been completed the Design Package (a combination of one or more design drawings) is sent for Design Review. If a change is noted the Design Change Notice is included. Similarly, Value Engineering Proposal is used to evaluate proposals if there is any change in the cost associated with the project.

After the completion of the above process, the *Request For Information* record is used to deliver the design based on the requests received. By accessing the *Design* page you can manage the tasks involved in construction design.

**Submittal Management**

During the planning and execution of the project, it may be necessary for the appropriate professionals to certify the type and quality of the items being used in the project. For example, if a construction project requires the use of tiles for the floors, then the quality and type of tile to be used needs to be approved by the architect or other qualified professional.

IBM TRIRIGA Capital Projects Manager allows this process to be documented in the application through the use of *Submittals* within the *Design* page.

**Procurement Management**

*Procurement Management* is the process of obtaining materials and services that are required to execute the project. This process includes managing the bid process for a contract, managing the bid process for a purchase order, processing invoices, and releasing payments.

- **Note** - Any records created for procurement are always created within the context (scope) of the project into which you are signed.

- **Note** - For more information on the procurement management process, see the *IBM TRIRIGA 10 Procurement Management User Guide*. 
Schedule Management

One of the most important aspects of the progress of any project is that adherence to the planned schedule. To ensure that the project (which is a large goal) is running as per schedule, it is broken into many smaller tasks. These tasks can be effectively managed using the *Schedule Management* process.

The *Schedule* page within the project gives a quick snapshot of tasks such as: *All Tasks, Tasks Due This Week, Tasks Over Budget* and *Tasks Overdue*.

**Note** - The Schedule page within the project gives a quick snapshot overview of tasks.

For more information on tasks, refer to the *Schedule Tab* (of a Capital Project) and *Gantt Scheduler & Project Tasks* sub-chapters. You can also go to the IBM TRIRIGA 10 Information Center and select *Maintaining operations and services*.

Risk Management

Any factor (or threat) that may adversely affect the successful completion of the project is termed as risk. The *Risk Management* process enables you to monitor all the risks that are associated with the project. The Risk Item and Risk Review are the two methods which describe the processes associated with identifying, analyzing, and responding to project risks.

By efficiently managing risks, you can increase the chance of project success and thereby identify, address, and eliminate risks before they become threats to the growth of the project.

**Note** - In addition to this *Progress* page, these *Related Links* also appear in other portal pages.

Permit Management

The *Permit Management* process provides a comprehensive tool to effectively manage information related to government permits. It is used to provide the authorizations required for the project. Hence, this process details the licensing and access permissions assigned to every member involved in the project.

Accessing the Project Management Tools

Based on the project selected, the process of *Creating, Managing, Tracking* and *Closing* can be done.

Use the following procedure to access the Project Management Tools.
To Access the Project Management Tools

Step 1  First, select the Capital Project, as described in Selecting a Project.

Step 2  Once the project is selected, the following menu is available.

Note - All of the activities indicated below are always performed within the context (scope) of the project selected.

More Details

Additional details regarding Cost Management, Design Management, Submittal Management, Schedule Management, Risk Management, and Permit Management are explained in the following sections.

Cost Management

Cost Management is the process of reporting and controlling expenses in a project. The Cost Management process provides a platform to closely monitor the lifecycle of cost, both in and across projects, as it tends to serve as a centralized collection point for all transactional events that impact costs. It facilitates the users to scrutinize the estimates, cash flow (budgets), funding as well as view the liabilities throughout the project’s lifecycle.

The key functions involved in Cost Management are to define budgets and track the financial performance of a project. Supporting this central mission are three key activities as follows.

Planning and Analysis

Planning and analysis involves activities such as drafting and forecasting the budget, cost analysis, etc. It also involves managing the budget factor associated with various departments.

Financial Processes

The core financial processes focus on record keeping and accounting procedures, thereby making the organizations accountable for the expenses they incur.

The Cost Management process captures and streamlines the cost information flow from general ledger activities, which include activity-based costing, accounts payable, accounts receivables, etc., to financial reports consolidation.
Tracking Costs

The Cost Management facility captures all cost-related data in a centralized location, thus simplifying the task of identifying the general trends and thereby enabling the effective forecast of the budgets. To streamline the tracking process, the budgets and other commitments are monitored by utilizing the user-defined budget codes, purchase orders, contracts, change orders, and payment invoices.

In the IBM TRIRIGA application:

- **Cost Center** refers to the location in which costs are incurred (a unit within a company distinguished by area of responsibility, location, or accounting method).
- **Cost Code** is a unit defined to categorize the expense, which may be based on organization, location, service activity or any other such factor relevant to a particular requirement.

Using the Cost Management module, you can define the cost centers for the organization and also the related cost code hierarchy. Additionally, for Capital Projects, you can use the Project Cost Summary report and the Project Performance report.

Note - Before creating new Capital/Facilities projects, ensure that the required cost code structure is already available in the Cost Code module and budget estimation is already done in the Budget module.

Budget Management

- Using the Budget page with the Project container, you can efficiently handle the financial prospects of a project and also create a budget to comprehensively cover the expenses expected in the project.

Note - You must create the Cost Code structure for the Organization before you can create a Budget Forecast for the project. Refer to the Estimating Original Budget section above.

Accessing the Budget Page

The IBM TRIRIGA Budget page enables you to create and maintain records regarding the budget involved in the financial planning of projects.

Use the following procedure to access the Budget page.

To Access the Budget Page

**Step 1** To select a project, click the Project Selector icon (beside the Company|Project Toggle) above the Menu Bar. Then select the radio button for a project and click OK.

**Step 2** Review the page that appears. The page displays the selected Project and corresponding Project Menu Bar.

**Step 3** In the selected project, click Budget to view the Budget page.
To Access the Budget Page

Step 4  Review the Budget page that appears.

Project Original Budget

This selection enables you to draft the budget for a project. The Project Original Budget refers to the amount allocated for the various cost codes involved in the project. The original budget can be broken into smaller amounts for the various cost codes in the project.

For instance, a sum of $1,000,000 is defined as the capital outlay. This amount can be dispersed as per the requirements arising for the project in a well structured manner. A part of the capital can be reassigned towards the labor cost, materials cost, etc. This break up ensures a smooth completion of project within the stipulated amount. Thus a budget plays a critical role in the successful completion of a project.

Creating a Project Original Budget Record

Use the following procedure to create a Project Original Budget record.

To Create a Project Original Budget Record

Step 1  From the Budget page above, click Original Budget in the Related Links - Capital Project Budget portal section.

Step 2  Review the page that appears. The page displays a list of Project Original Budget records. Click Add to add a new Project Original Budget record.

Step 3  Review the form that appears. Specify the details regarding the Project Original Budget record.

General Tab

The General tab has many sections that give you a brief description about the general attributes of the Project Original Budget record. You can enter all general information and specifications regarding the Project Original Budget record in these sections.
General Section

This section gives all the general information regarding the *Project Original Budget* record.

**ID**

Enter a unique number identifying the *Project Original Budget* record being created.

If this field is left blank, the system automatically generates this number at the time of creating the *Project Original Budget* record.

**Revision**

The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the *Revise* action that is displayed on the Action bar.

*Note* - Each time you revise or modify the record, the value displayed in this field is incremented by one.

**Status**

The system displays the status of the *Project Original Budget* record. The various possible statuses of the *Project Original Budget* record are explained below:

- **Draft** - Indicates that the *Project Original Budget* record is yet to be created. The system displays this status when you click the *Create Draft* action in the Action bar.

- **Review In Progress** - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the *Issue* action in the Action bar.

On approval, the record goes to the *Issued* state, else the record returns to the previous state.

- **Retired** - Indicates that the record is removed temporarily from the active management list. The system generates this status when you click the *Retire* action in the *Project Original Budget* record Action bar.

- **Revision In Progress** - Indicates that the record is being revised to add/modify the existing details. The system generates this status when you click the *Revise* action in the *Project Original Budget* record Action bar.

- **Completed** - Indicates that all the processes associated with the record is complete. The system generates this status on clicking the *Complete* action in the Action bar.
General Section

Date

Use the Calendar icon  to select the date on which the Project Original Budget record was created. By default, the system displays the current date.

Name

Enter a name that identifies the Project Original Budget record being created.

Currency

The Project Original Budget uses the same currency that is used for the project that the budget belongs to.

Items Section

In this section, you can associate the cost code for which the budget amount has to be allocated. Use the Find action to select the Cost Code records. In the Query window, the system displays the available records that are retrieved from the Cost Code page. Select the required cost code(s) and click OK. The system generates the Project Original Budget Cost Item record and displays it as a line item.

Click the Linked Record icon  to enter the information such as cost code name, labor quantity, labor rate, labor total, material quantity, material rate, material total, other cost, and total cost. You can specify the amount applicable for the labor and material related expenses in the respective fields. The other expenses that cannot be accommodated under labor or material cost heads can be entered in the Other Cost field.

Note - The budget data entered here will be summed up and displayed in the Summary section of the respective Cost Code records.

To delete a record, select the check box of the respective record and click the Remove action in the section bar. The selected record(s) are removed.
**Recorded By Section**

Use the Search icon 📦 to identify the person for whom this Project Original Budget record is being created. In the search list, the system displays a list of People records from the People page. Select the record you want to add and click **OK**. The selected person will be displayed in this section.

---

**Note** - You can access the person’s record by clicking the hyperlinked Name field label.

---

**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

---

**Note** - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.

---

| Copy            | Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required. |

---

© Copyright IBM Corporation 2011, 2013.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list. On clicking <strong>Issue</strong> action, the system changes the status of the record to <em>Review In Progress</em> and after all the members in the distribution list have approved the record, the record status becomes <strong>Issued</strong>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record. The system changes the status of the record from <strong>Issued</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Spend Plan Tab**

The **Spend Plan** tab provides the user with a means to observe project planned, actual and projected performance.

**Note** - If the graphs do not display any information, navigate to the relevant Capital Project record, click the **Cash Flow Tab**, and verify that the **Enable Spend Plan Functionality For This Project** check box is selected.

This tab displays the following sections - **Spend Plan Details**, **Spend Plan Template**, **Spend Plan Breakdown** and **Spend Plan Cumulative**. Each of these sections is explained below.

**Spend Plan Details Section**

This section provides fields with which to adjust the spend plan S-curve.

- **Percent of duration when half the budget will be spent (0-100)**: Enter the number (0-100) to adjust the S-curve midpoint along the X-axis, closer or farther from the starting point.

- **Growth factor (greater than 0)**: Enter the number (greater than 0) to adjust the S-curve rising slope from the starting point.
Spend Plan Details Section

Calculate

Click this button to calculate and generate the graphs below.

Spend Plan Template Section

This section provides several convenient spend plan templates with which to populate default values for both fields in the Spend Plan Details section above.

Click a spend plan template to populate a set of default values: (1) 25 and 0.5, (2) 33 and 1, (3) 50 and 1, (4) 50 and 1.5, (5) 58 and 0.39, and (6) 67 and 1.

Spend Plan Breakdown Section

This section displays a graph of the planned value, per period. The default graph is a bar graph.

Right-click to select additional options: Save as image, Print chart etc.

Spend Plan Cumulative Section

This section displays a graph of the planned value, period cumulative. The default graph is a line graph.

Right-click to select additional options: Save as image, Print chart etc.

Notifications Tab

The Notifications tab contains basic information relating to the approval process, such as the list of individuals who should approve the record, the individual currently reviewing the record, the date on which the record was sent for approval, status, and additional comments added by the reviewers.

This tab displays the following sections - Manual Approvers (In Addition to Approval Requirements), Approval Reviewers, Status Change Notification, and Responses. Each of these sections is explained below.
Manual Approvers (In Addition to Approval Requirements) Section

This section lists individuals who should approve the record, the role assigned to each approver, and the review type. The records are displayed in a line item format.

You can add approver(s) to this section by clicking the Add Person action on the section bar. The system displays the available records that are retrieved from the People page. You can select the persons you want to add to the Notifications list and click OK. The records that are selected will be added as line items to this section. You also can set advanced approval options by clicking any of the displayed hyperlinked text of the line item.

Note – For information about setting up advanced options for the approval process, go to the IBM TRIRIGA 10 Information Center and select Administering IBM TRIRIGA.

Approval Reviews Section

This section gives information about the review, including the approval status of the record, approver’s name, review status of the record, date on which the record was sent for review, date on which the review was completed, comments added by the reviewer, and the type of review.

The information in this section is auto populated when persons are added to the distribution list using the Manual Approvers (In addition to Approval Requirements) section.
**Status Change Notification Section**

Using this section, you can send notifications to selected individuals when the record changes to a specific status. For example, if a subcontractor wants to inform the Project Manager role about the completion of a project, he/she can send a notification when the record attains the Complete status. The notification is displayed in the Home portal of the Project Manager role.

To add a notification for a specific status, click the Add Status action on the section bar. Select the status/statuses in which you want the notification to be sent from the displayed options and click OK. The selected records will be added as line items to this section. Click the hyperlinked text of the On Status field to add the notification details. On clicking the hyperlinked text, a Notification Details window appears wherein you can add the persons to whom the notification should be sent. Enter all the necessary details in the Notification Details window and click the Save & Close action. The system auto populates the fields of the line items in this section with the details from the corresponding Notification Details records.

**Note** - To remove a line item from this section, click the hyperlinked text of the On Status field and click the Delete action in the Notification Details record Action bar. The system removes the selected line item from this section.

**Responses Section**

This section displays the list of all Response Log records as hyperlinked line items. You can click the hyperlinked text of the line item to view the record.

On clicking the Complete action, system sends the record to selected individual(s) from whom a response is required (only if the record is approved). The record that is sent will appear as an Action Item in the individual(s)’ Home portal. On clicking the hyperlinked Action Item, the current record appears in a new window. To enter the comments regarding the record, click the Respond action in the Action bar. The Response Log window appears, wherein the individual(s) can enter his/her comments in the Comments section. The response that is sent by the selected individual(s)is added as a line item in this section of the Notifications tab.

**Other Tabs**

The details about the Notes & Documents tab and Reports tab are available in previous sections. Click the respective links to read the details.
Project Budget Forecast

This selection enables you to forecast the budget for the project based on the expenses and analysis. The Project Budget Forecast is an estimated amount, which can be above or below the original estimated cost of the project.

Creating a Project Budget Forecast Record

Use the following procedure to create a Project Budget Forecast record.

To Create a Project Budget Forecast Record

Step 1  From the Budget page above, click Budget Forecast in the Related Links - Capital Project Budget portal section.

Step 2  Review the page that appears. The page displays a list of Project Budget Forecast records. Click Add to add a new Project Budget Forecast record.

Step 3  Review the form that appears. Specify the details regarding the Project Budget Forecast record.

General Tab

The General tab has many sections that give you a brief description about the general attributes of the Project Budget Forecast record. You can enter all general information and specifications regarding the Project Budget Forecast record in these sections.

General Section

This section gives all the general information regarding the Project Budget Forecast record.

ID

Enter a unique number identifying the Project Budget Forecast record being created.

Note - The read-only fields in this section get populated only when you click the Create Draft action.

If this field is left blank, the system automatically generates this number at the time of creating the Project Budget Forecast record.
<table>
<thead>
<tr>
<th><strong>General Section</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Revision</strong></td>
</tr>
<tr>
<td><strong>Note</strong></td>
</tr>
<tr>
<td><strong>Status</strong></td>
</tr>
<tr>
<td><strong>Draft</strong></td>
</tr>
<tr>
<td><strong>Review In Progress</strong></td>
</tr>
<tr>
<td><strong>Retired</strong></td>
</tr>
<tr>
<td><strong>Revision In Progress</strong></td>
</tr>
<tr>
<td><strong>Completed</strong></td>
</tr>
<tr>
<td><strong>Date</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td><strong>Currency</strong></td>
</tr>
</tbody>
</table>
**Items Section**

In this section, you can associate the cost code(s) defined earlier with the *Project Budget Forecast* record. Use the *Find* action to select the *Cost Code* records. In the *Query* window, the system displays the records that are retrieved from the *Cost Code* page. Selected the required cost code(s) and click *OK*. The system generates *Project Budget Forecast Cost Item* record and displays it as line item.

Click the *Linked Record* icon to enter the information such cost code ID, cost code name, and the amount allocated. When these cost codes and the corresponding budget forecast amounts have been applied, you must click *Issue*, and then click *Complete* to apply the forecast amount to the *Cost Code* record.

**Note** - The amount(s) allocated in the *Project Budget Forecast* record will be automatically added to the *Summary* section in the *General* tab of the respective *Cost Code* record.

To delete a record, select the check box of the respective record and click the *Remove* action in the Section bar. The selected record gets deleted from the section.

**Recorded By Section**

Use the *Search* icon to identify the person for whom this *Project Budget Forecast* record is being created. In the search list, the system displays a list of *People* records from the *People* page. Select the record you want to add and click *OK*. The selected person will be displayed in this section.

**Note** - You can access the person’s record by clicking the hyperlinked *Name* field label.

**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the <em>Create Draft</em> action to save all initial data entered in the new record. The system changes the status of the record to <em>Draft</em> and displays additional actions on the Action bar. The actions include <em>Issue</em>, <em>Save</em>, <em>Save &amp; Close</em>, <em>More</em>, <em>Copy</em>, <em>Delete</em>, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the <em>Save</em> action to save the changes made.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the <strong>X</strong> (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record. On clicking the <strong>Copy</strong> action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Issue</strong></td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list. On clicking <strong>Issue</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Issued</strong>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td><strong>Complete</strong></td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record. The system changes the status of the record from <strong>Issued</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the **Notifications tab**, **Notes & Documents tab**, and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.

**Project Budget Transfer**

This selection enables you to reassign budget funds within the same Funding Source. The Project Budget Transfer record facilitates the transfer of money assigned to one Cost Code record to another.
A Project Budget Transfer record can be used to move funds between budget line items. The transferred budget, after approval, ends up as the revised budget.

For example, 5 million dollars is set aside as the original budget for the construction of a building, and a sum of $100,000 is allocated towards concrete and another $50,000 is allocated to iron/steel requirements. At some point, the Project Manager role realizes that only $75,000 will be required for concrete, but the steel will require an additional $25,000. A Project Budget Transfer record can be created to transfer the excess amount from the concrete cost code account to the steel cost code account.

Note - The projects affected by the budget transfer must belong to the same Funding Source.

Creating a Project Budget Transfer Record

Use the following procedure to create a Project Budget Transfer record.

To Create a Project Budget Transfer Record

Step 1 From the Budget page above, click Budget Transfers in the Related Links - Capital Project Budget portal section.

Step 2 Review the page that appears. The page displays a list of Project Budget Transfer records. Click Add to add a new Project Budget Transfer record.

Step 3 Review the form that appears. Specify the details regarding the Project Budget Transfer record.

General Tab

The General tab has many sections that give you a brief description about the general attributes of the Project Budget Transfer record. You can enter all general information and specifications regarding the Project Budget Transfer record in these sections.

General Section

This section gives all the general information regarding the Project Budget Transfer record.

ID Enter a unique number identifying the Project Budget Transfer record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Project Budget Transfer record.
**General Section**

**Revision**
The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the **Revise** action that is displayed on the Action bar.

![Note](image)

*Note* - Each time you revise or modify the record, the value displayed in this field is incremented by one.

**Status**
The system displays the status of the *Project Budget Transfer* record. The various possible statuses of the *Project Budget Transfer* record are explained below:

- **Draft** - Indicates that the *Project Budget Transfer* record is yet to be created. The system displays this status when you click the **Create Draft** action in the Action bar.

- **Review In Progress** - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the **Issue** action in the Action bar. On approval, the record goes to the **Issued** state, else the record returns to the previous state.

- **Completed** - Indicates that all the processes associated with the record is complete. The system generates this status on clicking the **Complete** action in the Action bar.

- **Retired** - Indicates that the record is removed temporarily from the active management list. The system generates this status when you click the **Retire** action in the *Project Budget Transfer* record Action bar.

- **Revision In Progress** - Indicates that the record is being revised to add/modify the existing details. The system generates this status when you click the **Revise** action in the *Project Budget Transfer* record Action bar.

**Date**
Use the **Calendar** icon to select the date on which the *Project Budget Transfer* record was created. By default, the system displays the current date.

**Name**
Enter a name that identifies the *Project Budget Transfer* record being created.
General Section

Transfer From Project
Use the Select icon to select the source Project record for the budget transfer. In the Query window, the system displays the available Project records. Select the preferred Project radio button and click OK.

Note - The selected Transfer From Project and selected Transfer To Project must belong to the same Funding Source.

Transfer To Project
Use the Select icon to select the target Project record for the budget transfer. In the Query window, the system displays the available Project records. Select the preferred Project radio button and click OK.

Note - The selected Transfer From Project and selected Transfer To Project must belong to the same Funding Source.

Currency
The currency fields of the Project Budget Transfer show the currency units of measure of the target and source projects involved in the transfer.

From Project Items Section

Use the Find action to select the source cost code records (specific to the Transfer From Project) for the budget transfer. In the Query window, the system displays the available records that are retrieved from the Cost Code page. Select the proper cost codes and click OK.

The system generates the Project Budget Transfer Cost Item record and displays it as a line item, including detailed cost code information such as ID, Name, original (current) amount allotted for the cost code and the amount for transfer.

The budget amount in this section (negative value) should be prefixed by the minus (‘-‘) sign.

Note - The sum of the From Project Items section (negative value) and the sum of the To Project Items section (positive value) must equal 0.

Note - The data entered here will be summed up and displayed in the Summary section of the respective Cost Code record.
To Project Items Section

Use the Find action to select the target cost code records (specific to the Transfer To Project) for the budget transfer. In the Query window, the system displays the available records that are retrieved from the Cost Code page. Select the proper cost codes and click OK.

The system generates the Project Budget Transfer Cost Item record and displays it as a line item, including detailed cost code information such as ID, Name, original (current) amount allotted for the cost code and the amount for transfer.

The budget amount in this section (positive value) should be prefixed by the plus ('+') sign.

Note - The sum of the From Project Items section (negative value) and the sum of the To Project Items section (positive value) must equal 0.

Note - The data entered here will be summed up and displayed in the Summary section of the respective Cost Code record.

Recorded By Section

Use the Search icon to identify the person for whom this Project Budget Transfer record is being created. In the search list, the system displays a list of People records from the People page. Select the record you want to add and click OK. The selected person will be displayed in this section.

Note - You can access the person’s record by clicking the hyperlinked Name field label.
Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list. On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete action to complete the tasks associated with the record. The system changes the status of the record from Issued to Completed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

**Project Budget Change**

This selection enables you to make changes in the budget defined for the project. The Project Budget Change record allows you to make modifications in the budget amount drafted for the project.

For instance, a project is initially defined with a budget of $3,000,000 for various activities. Over a period of time due to uncertain elements the cost of budget shoots up and the Project Manager role has to raise a request for an increase in the project amount allocated. This can be achieved by raising a Project Budget Change record specifying the revised amount required.

**Creating a Project Budget Change Record**

Use the following procedure to create a Project Budget Change record.

**To Create a Project Budget Change Record**

**Step 1** From the Budget page above, click Budget Changes in the Related Links - Capital Project Budget portal section.

**Step 2** Review the page that appears. The page displays a list of Project Budget Change records. Click Add to add a new Project Budget Change record.

**Step 3** Review the form that appears. Specify the details regarding the Project Budget Change record.

**General Tab**

The General tab has sections that provide a brief description of the general attributes of the Project Budget Change record. You can enter all general information and specifications regarding the Project Budget Change record in these sections.

**Note** - The read-only fields in this section are populated only when you click the Create Draft action.
### General Section

This section gives all the general information regarding the *Project Budget Change* record.

<table>
<thead>
<tr>
<th><strong>ID</strong></th>
<th>Enter a unique number identifying the <em>Project Budget Change</em> record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this field is left blank, the system automatically generates this number at the time of creating the <em>Project Budget Change</em> record.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Revision</strong></th>
<th>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the <strong>Revise</strong> action that is displayed on the Action bar.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="https://example.com" alt="Note" /></td>
<td>Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Status</strong></th>
<th>The system displays the status of the <em>Project Budget Change</em> record. The various possible statuses of the <em>Project Budget Change</em> record are explained below:</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Draft</em></td>
<td>Indicates that the <em>Project Budget Change</em> record is yet to be created. The system displays this status when you click the <strong>Create Draft</strong> action in the Action bar.</td>
</tr>
<tr>
<td><em>Review In Progress</em></td>
<td>Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the <strong>Issue</strong> action in the Action bar. On approval, the record goes to the <strong>Issued</strong> state, else the record returns to the previous state.</td>
</tr>
<tr>
<td><em>Retired</em></td>
<td>Indicates that the record is removed temporarily from the active management list. The system generates this status when you click the <strong>Retire</strong> action in the <em>Project Budget Change</em> record Action bar.</td>
</tr>
<tr>
<td><em>Revision In Progress</em></td>
<td>Indicates that the record is being revised to add/modify the existing details. The system generates this status when you click the <strong>Revise</strong> action in the <em>Project Budget Change</em> record Action bar.</td>
</tr>
<tr>
<td><em>Completed</em></td>
<td>Indicates that all the processes associated with the record is complete. The system generates this status on clicking the <strong>Complete</strong> action in the Action bar.</td>
</tr>
</tbody>
</table>

| **Date** | Use the Calendar icon [🔗](#) to select the date on which the *Project Budget Change* record was created. By default, the system displays the current date. |
General Section

**Name**
Enter a name that identifies the *Project Budget Change* record being created.

**Currency**
The *Project Budget Change* uses the same currency that is used for the project that the budget belongs to.

Items Section

In this section, you can retrieve the cost code(s) for which the budget amount has to be changed. Use the **Find** action to select the *Cost Code* records. In the **Query** window, the system displays the available records that are retrieved from the *Cost Code* page. Selected the required cost code(s) and click **OK**. The system generates *Project Budget Change Cost Item* record and displays it as line item.

The system displays the selected details such as ID, name of the cost code, and the revised amount. The **Changes** field lets you enter the revised budget for the *Cost Code* record.

**Note** - The data entered here will be summed up and displayed in the **Summary** section of the respective *Cost Code* record.

To delete a record, select the check box of the respective record and click the **Remove** action in the Section bar. The selected record gets deleted from the section.

Recorded By Section

Use the **Search** icon ![Search Icon](image) to identify the person for whom this *Project Budget Change* record is being created. In the search list, the system displays a list of *People* records from the *People* page. Select the record you want to add and click **OK**. The selected person will be displayed in this section.

**Note** - You can access the person’s record by clicking the hyperlinked **Name** field label.
Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list. On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete action to complete the tasks associated with the record. The system changes the status of the record from Issued to Completed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
</tbody>
</table>
### Calendar Tab

The Calendar tab is a system-generated tab that provides a calendar view of the planned, scheduled, and available hours of the record. You can view the calendar by months or weeks, and view calendar events by years, quarters, months, or weeks by selecting one of the calendar icons above the calendar. The double orange arrows enable you to display the previous or next week, month, quarter, or year. Planned, scheduled, and available hours are listed for each day, as well as by total for the week, month, quarter, or year you are viewing.

Scheduled events display on the calendar as active links. Any event scheduled for the record will show on the calendar day corresponding to the Event Start Date. You can click the link to open the Event record.

Use the following procedure to open the Event record.

#### To Open the Event Record

1. **Step 1** To view the schedule of all planned events for a specific day, click the Date link. The start time, end time, and description of the event are displayed in the Event record.

2. **Step 2** Use the double orange arrows to navigate to the complete schedule for the next or previous day.

3. **Step 3** Click the Description link to view the complete Event record.

### Other Tabs

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
Design Management

The Design Management process enables you to create a dynamic relationship between items, its attributes and components and maintain this relationship for the entire life of the project. Users can create and reuse specifications ranging from wall types to lighting fixtures. Item specifications can be published and shared with internal employees and departments, and with outside vendors, clients, or contractors to ensure that the same, accurate specification details, and data are utilized throughout the project and across the enterprise.

Design Page

The Design page is a place to create, manage, and track Design records. The Design page primarily focuses on the following Design related forms.

- Design Drawing
- Design Specification
- Design Package
- Design Review
- Design Change Notice
- Supplemental Design Document
- Value Engineering Proposal
- Request For Information

A design drawing gives a visual layout of the project. An example of a design drawing is an architectural plan. A specification is a document that outlines various details about a project. These details typically are not found in the drawing. Together, the drawing and specifications give great insight into the details, layout, and requirements of a project.

As a design document is created, you can use the Design Specification record to register data regarding the document. Additionally, you can associate the document with the record at any stage in its development. The Design Drawing record is used much in the same way, except that the record is used for drawings only. After the document is created, changes may need to be applied to it.

If there are multiple documents/drawings used for a design, you can associate multiple Design records to a Design Package record, which can be sent simultaneously to various individuals, if required. This prevents the sending of multiple copies of a document.

When the design is ready for review, you can create a package in the form of a Design Review record with all of the design documents associated with it. You can associate Design Document records, Design Drawing records, and/or Design Package records with the Design Review record. This record will be sent to the review group and each person will review it (the records associated with it) and send it back to the originator as approved or rejected.

The Design Change Notice record is used to distribute defined changes to a design document/drawing to a group for review. To incorporate the proposed changes, the Value Engineering Proposal record is
used. You can describe the advantages and disadvantages of making the changes and effect it will have on the design documents, which can then be associated with the record.

Finally, the Request For Information (RFI) plays an important role in the Project Management process. RFI is the process in which any clarification regarding a bid is obtained from the vendor before actual award of the bid. The Bid Clarification Form is used to obtain information before the contract has been awarded and the Request For Information form is used to obtain information after the contract has been awarded.

The next section explains the Design page in detail.

**Accessing the Design Page**

The Design page enables you to create, track, and manage all Design records. Using this page, you can create Design Drawing records, enter specifications regarding the items required for the project construction, notify all the changes regarding the design or drawing, attach supplements and create a Value Engineering Proposal, if required.

Use the following procedure to access the Design page.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>To select a project, click the Project Selector icon (beside the Company</td>
</tr>
<tr>
<td>2</td>
<td>Review the page that appears. The page displays the selected Project and corresponding Project Menu Bar.</td>
</tr>
<tr>
<td>3</td>
<td>In the selected project, click Design to view the Design page.</td>
</tr>
<tr>
<td>4</td>
<td>Review the Design page that appears.</td>
</tr>
</tbody>
</table>

**Design Drawing**

The Design Drawing record provides a visual description of selected elements of the proposed outcome of the project. The drawing provides details about specifications regarding the project design. The Design Specification record is used in conjunction with the drawing to give a detailed description about the drawing. Additionally, it gives you the capability of attaching the document to it and sending it to the review team.
Creating a Design Drawing Record

Use the following procedure to create a Design Drawing record.

<table>
<thead>
<tr>
<th>To Create a Design Drawing Record</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong>  From the Design page above, click Drawings in the Related Links - Capital Project Design portal section.</td>
</tr>
<tr>
<td><strong>Step 2</strong>  Review the page that appears. The page displays a list of Design Drawing records. Click Add to add a new Design Drawing record.</td>
</tr>
<tr>
<td><strong>Step 3</strong>  Review the form that appears. Specify the details regarding the Design Drawing record.</td>
</tr>
</tbody>
</table>

General Tab

<table>
<thead>
<tr>
<th>General Section</th>
</tr>
</thead>
</table>
| **ID**  Enter a unique number identifying Design Drawing record being created.  
If this field is left blank, the system automatically generates this number at the time of creating the Design Drawing record. |
| **Revision**  The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar. |

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.
## General Section

**Status**

Displays the current status of the *Design Drawing* record being created. This field is a read-only field. The different statuses of the *Design Drawing* are explained below.

*Draft* - Indicates that the *Design Drawing* record is yet to be created. The system generates this status when the user selects the *Create Draft* action in the Action bar.

*Retired* - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the *Retire* action in the Action bar.

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the *Unretire* or *Revise* action in the Action bar.

*Review In Progress* - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the *Activate* action in the Action bar.

*Active* - The system automatically changes the status of the record from *Review in Progress* to *Active* state when the person in the notification has approved.

**Date**

Use the *Calendar* icon to select the date on which the *Design Drawing* is created.

Note - By default, the system displays the current date in this field.

**Name**

Enter a unique name to identify the *Design Drawing* record that is being created.

## Details Section

The *Details* section contains fields in which you can select document paper size, viewing scale, and issue status. The issue status is defined by status of the approval process or project status (cancelled). Additionally, if there is a designer’s reference book used with the drawing, you can type the name of the reference in the *Designer’s Reference* field.
Details Section

Issue Status
Use the List icon to specify the issue status for the Design Drawing record. The system displays all the available issue statuses (such as Not Issued, For Approval, For Bid, For Comment, etc.) that are defined in the Tools > Lists page.

Designers Reference
Enter the reference name (e.g., name of the book) that is used by the designer for drawing.

Size
Use the List icon to specify the size for the Design Drawing record. The system displays all the available sizes that are predefined in the Tools > Lists page.

Scale
Use the List icon to select a specific scale for the Design Drawing record. In the search list, the system displays the available scales that are defined in the Tools > Lists page.

Reference Section

The Reference section displays the priority and classification information to assist the user in grouping the records. When you set the priorities and classifications in this section, you can generate reports based on the specified information.

Construction Class
In general, all the Design Drawing records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classifications hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section
The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.
Reference Section

Discipline

Use the Search icon to select a specific discipline for the Design Drawing record being created. In the search list, the system retrieves the available discipline (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

Work Location

Use the Search icon to select a specific work location for the Design Drawing record being created. On clicking the Search icon, the system displays a Query window that displays the list of available records that are retrieved from the Space business object in the Locations hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

Description Section

Use this section to provide an appropriate description about the Design Drawing record, which may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Submitted For Approval Section

This section auto-populates Design Drawing records that have been submitted for approval in the Items section of the Submittal Package record. The records are displayed as line items, the id, name, type, current status and review status of the Design Drawing record submitted are displayed in this section.
Related Documents Section

The Related Documents section displays details regarding the documents associated with the Design Drawing record.

Use the Find action in this section to select and associate documents with the Design Drawing record. The documents that you associate may refer to any drawing, specification, or other documents that are contained in the Documents.

Click the Upload action to upload documents. The Object Attachment Upload screen will display. In the screen, select the Browse button and select the file path (document). The path and filename will display in the Local File field. Type the name, number, description, and comments (if any) in the corresponding fields and click the Upload action. The details regarding the document will be displayed in the respective fields of the Document section.

By selecting the Clear action, you can remove details regarding the record selected.

Recorded By Section

This section displays the login ID of the current user who is creating the Design Drawing record. The Search icon in this section allows you to select a different user ID, if required. On clicking the Search icon, the system displays a Query window that displays the list of available records in the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Activate</strong></td>
<td>Click the Activate action to add the record to the active management list. On clicking Activate action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Active. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Revise and Retire.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

**Design Specification**

The Design Specification record gives you in-depth information about the design of the project. The Design Drawing record can be used in conjunction with the design specifications to provide more visual details. This record can be attached to the Design Change Notice record and sent for review to the distribution list.
Creating a Design Specification Record

Use the following procedure to create a Design Specification record.

**To Create a Design Specification Record**

**Step 1** From the Design page above, click Specifications in the Related Links - Capital Project Design portal section.

**Step 2** Review the page that appears. The page displays a list of Design Specification records. Click Add to add a new Design Specification record.

**Step 3** Review the form that appears. Specify the details regarding the Design Specification record.

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td>Enter a unique number identifying Design Specification record being created. If this field is left blank, the system automatically generates this number at the time of creating the Design Specification record.</td>
</tr>
<tr>
<td><strong>Revision</strong></td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar. Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.</td>
</tr>
</tbody>
</table>
General Section

Status
Displays the current status of the Design Specification record being created. This field is a read-only field. The different statuses of the Design Specification are explained below.

Draft - Indicates that the Design Specification record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Unretire or Revise action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Activate action in the Action bar.

Active - The system automatically changes the status of the record from Review in Progress to Active state when the person in the notification has approved.

Date
Use the Calendar icon to select the date on which the Design Specification record is being created.

Note - By default, the system displays the current date in this field.

Name
Enter a unique name to identify the Design Specification record that is being created.

Reference Section

The Reference section displays the priority and classification information to assist the user in grouping the records. When you set the priorities and classifications in this section, you can generate reports based on the specified information.
Reference Section

Construction Class  In general, all the Design Specification records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section  The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

Discipline  Use the Search icon to select a specific discipline for the Design Specification record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

Work Location  Use the Search icon to select a specific work location for the Design Specification record being created. On clicking the Search icon, the system displays a Query window that displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

Description Section

Use this section to provide appropriate description regarding the Design Specification record. The details about the design specification may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
Submitted For Approval Section

This section auto populates the Design Specification records which are submitted for approval in the Items section of the Submittal Package record. The records are displayed as line items in this section.

Related Documents Section

The Documents section displays the details regarding the documents associated with the Design Specification record.

Use the Find action in this section to select and associate documents with the Design Specification record. The documents that you associate may refer to any drawing, specification, or other documents that are contained in the Document Manager.

Click the Upload action to upload documents. The Object Attachment Upload screen will display. In the screen, select the Browse button and select the file path (document). The path and filename will display in the Local File field. Type the name, number, description, and comments (if any) in the corresponding fields and click the Upload action. The details regarding the document will be displayed in the respective fields of the Document section.

By selecting the Clear action, you can remove a record from the line item list.

Recorded By Section

This section displays the login ID of the current user who is creating the Design Specification record. The Search icon in this section allows you to select a different user ID, if required. On clicking the Search icon, the system displays a Query window that displays the list of available records in the People page. Select the required record and click OK. The selected record is displayed in this section.
**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Draft</strong></td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Activate</strong></td>
<td>Click the Activate action to add the record to the active management list. On clicking Activate action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Active. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Revise and Retire.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>
Other Tabs

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Supplemental Design Document

Supplemental Design Document record enables you to attach supplemental documents to the Design Package record and send it to the approvers for review.

Creating a Supplemental Design Document Record

Use the following procedure to create a Supplemental Design Document record.

To Create a Supplemental Design Document Record

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>From the Design page above, click Supplemental Design Documents in the Related Links - Capital Project Design portal section.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays a list of Supplemental Design Document records. Click Add to add a new Supplemental Design Document record.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Review the form that appears. Specify the details regarding the Supplemental Design Document record.</td>
</tr>
</tbody>
</table>

General Tab

The General tab in the Supplemental Design Document record is the same as the General tab in the Design Specification record.

Other Tabs

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Design Package

The Design Package record is used to group documents for review and approval. The package can contain drawings and/or specifications, which are created using the Design Drawing record and Design Specification record respectively.
When the Design Package record is created and the appropriate drawings are associated with it, the record is issued to the distribution list. This is accomplished using a Design Review record. Once the Design Review record is created, the Design Package can be associated with it, and Design Review record can be routed through the distribution list.

Additionally, the Permit records created for construction, demolition, elevator installation, mechanical equipments installation, and road construction projects can be associated with the Design Package record. These records give basic details regarding the selected permits. Schedule Task records related to the Design Package can be associated as well.

Creating a Design Package Record

Use the following procedure to create a Design Package record.

<table>
<thead>
<tr>
<th>To Create a Design Package Record</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
</tr>
</tbody>
</table>

General Tab

General Section

<table>
<thead>
<tr>
<th>ID</th>
<th>Enter a unique number identifying the Design Package record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>If this field is left blank, the system automatically generates this number at the time of creating the Design Package record.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Revision</th>
<th>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.</th>
</tr>
</thead>
</table>

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one.
General Section

Status

The system displays the current status of the Design Package record being created. This field is a read-only field. The different statuses of the Design Package are explained below.

*Draft* - Indicates that the Design Package record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

*Review In Progress* - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Activate action in the Action bar.

*Active* - The system automatically changes the status of the record from Review in Progress to Active state when all the persons in the distribution group have approved the record.

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

*Retired* - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Date

Use the Calendar icon to select the date on which the Design Package record is being created.

Note - By default, the system displays the current date in this field.

Name

Enter a unique name to identify the Design Package record that is being created.

Details Section

Package Type

Use the List icon to select a specific package type for the Design Package record being created. In the search list, the system displays the available package types (such as Both, Drawings, Specification, etc.) that are defined in the Tools > Lists page.
## Reference Section

The Reference section displays the priority and classification information to assist the user in grouping the records. When you set the priorities and classifications in this section, you can generate reports based on the specified information.

### Construction Class

In general, all the Design Package records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

**Note** - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

### Section

The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

### Discipline

Use the Search icon to select a specific discipline for the Design Package record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

### Work Location

Use the Search icon to select a specific work location for the Design Package record being created. In the Query window, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

## Recorded By Section

This section displays the login ID of the current user who is creating the Design Package record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records in the People page. Select the required record and click OK. The selected record is displayed in this section.
**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Create Draft** | Click the **Create Draft** action to save all initial data entered in the new record.  
The system changes the status of the record to **Draft** and displays additional actions on the Action bar. The actions include **Activate**, **Save**, **Save & Close**, **More**, **Copy**, **Delete**, and **X** (Cancel). |
| **Save**      | Click the **Save** action to save the changes made.                                                                                           |
| **Save & Close** | Click the **Save & Close** action to save the changes and close the active window.                                                            |
| **X**         | Click the **X** (Cancel) action to terminate the changes made and also to close the active window.                                             |
| **Copy**      | Click the **Copy** action to create a copy of the selected record.  
On clicking the **Copy** action, a copy of the record is created (in the **Draft** status) and displayed in the appropriate page wherein the details can be modified as required. |
| **Activate**  | Click the **Activate** action to add the record to the active management list.  
On clicking **Activate** action, the system changes the status of the record to **Review In Progress** and after all the members in the distribution list have approved the record, the record status becomes **Active**.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Revise** and **Retire**. |
| **Delete**    | Click the **Delete** action to remove the record permanently from the active management list.                                                 |
| **More**      | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Note** - Clicking the **Cancel** action without saving the record will erase all the data you have entered in the record.
Scope Tab

In this tab, you can define the scope of work contained within a particular design package. This is often work directed toward a particular subcontractor. You also can add the specifications of the project.

For example, the process of hiring a construction company for building a new restaurant for a budget of $5,000,000 by a hotel owner. Using the bidding process, the contractor is identified and the system generates Standard Contract agreement in such a way that one group is to build the restaurant and the other one has to pay $5,000,000. This scope tab defines the characteristics (like square feet, wood type, electrical, etc.) of the restaurant that is required by the owner.

The various sections in the Scope tab are described below.

Scope Section

Use this section to provide appropriate description regarding the scope of the project. Such details about the design package may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Inclusions Section

This section enables you to describe in detail the Design Package Scope specifications that must be included in the project. The Scope section is used to define the scope from a fairly high-level. So this section adds a level of granularity, if needed, to the scope.

You can add inclusions using the actions on the Action bar in the Design Package record. By clicking Add, action in this section. The system displays the Design Package Scope window, wherein you can perform the following steps:

- Provide the necessary information such as name and date in the General section.
- Click the Create action.

A new line item displaying the ID and Statement will be added to the Inclusions section. Use the Linked Record icon to view and modify the record.

Use the Remove action to delete the selected line item(s).
**Exclusions Section**

This section enables you to describe specific parts of the scope that you want to exclude from the record. Users will be able to view the scope exclusions and gain further understanding of the scope as already described.

You can add exclusions using the actions on the Action bar in the Design Package record. By clicking Add, action in this section. The system displays the Design Package Scope window, wherein you can perform the following steps:

- Provide the necessary information such as name and date in the General section.
- Click the Create action.

A new line item displaying the ID and Statement will be added to the Exclusions section. Use the Linked Record icon to view and modify the record.

Use the Remove action to delete the selected line item(s).

---

**Drawings & Specifications Tab**

*Drawings and Specifications* are documents that are used in the design process. Drawings (e.g., blueprints) are created regarding the project and then a Design Drawing record is created. The blueprints (drawings) are then associated to the Design Drawing record. Hence, when you open the drawing record, details about the drawing is also available.

A specification is a document that gives granular information about a project. These details are typically not available in a design drawing. A specification document is created, and then a Design Specification record is created to which the specification is associated. That way, when you open the record, details about the specification are available, and the specification document is available as well.

**Note** - The drawings and specifications must be added to the Document Manager in order to associate them to other records, such as the Design Drawing record.
Drawings Section

The Drawings section displays a list of all the Design Drawing records that are associated with the Design Package record. These records are displayed in a line item format.

Use the Add action in the Section bar to add the records to the Drawings section. On clicking the Add action the system displays the Design Drawing record in a new window, wherein you can perform the following steps:

- Provide the necessary information.
- Click the Create action.

The system displays the Design Drawing records as a line item in this section. You also can use the Find action in this section to select the existing Design Drawing records. The system displays the available records in a Query window. Select the required drawing and click OK. The selected drawing is displayed in this section as line item.

Use the Remove action to delete the selected line item(s).

Specifications Section

The Specifications section displays the list of all the Design Specification records that are associated with the Design Package record. These records are displayed in a line item format.

Use the Add action in the Section bar to add the records to the Specifications section. On clicking the Add action, the system displays the Design Specification record in a new window, wherein you can perform the following steps:

- Provide the necessary information.
- Click the Create action.

The system displays the Design Specification record as a line item in this section. You also can use the Find action in this section to select the existing Design Specification records. The system displays the available records in a Query window. Select the required specification and click OK. The selected specification is displayed in this section as line item.

Use the Remove action to delete the selected line item(s).

Permits Tab

The Permits tab displays a list of the Permit records that are associated with the Design Package record in the Required Permits section.
Required Permits Section

Permit records vary in type, i.e., Construction, Demolition, Elevator, Mechanical, Permit Application, Permit Record, and Road Construction Permit, are created using the Permits links in Progress page.

You can add the above Permit records on clicking the Add action in the Required Permits Section bar. The system displays the respective window, wherein you can perform the following steps:

- Provide the mandatory information.
- Click the Create action.

A new line item (displaying the ID, Date, Name, Jurisdiction, and Status) will be added to the Required Permits section.

Use the Find action in this section to select existing Permit records. The system displays the available permits in a Query window. Select the required permit and click OK. The selected permit is displayed in this section as line item.

Use the Remove action to delete the selected line item(s).

Schedule Tab

Using the Schedule tab, you can associate Schedule Task records with the Design Package record. Once the selected Schedule Task records have been associated with the Design Package record, the basic details from each record will be displayed in a line item format. The columns for each line item are populated with data from the associated Schedule Task record. If data is not displayed in the columns, then the field in the Schedule Task record corresponding to the column does not have data in it.

Schedule Section

Use the Find action in this section to select the existing Schedule Task records. The system displays the available Tasks of type Submittal, Punchlist, Inspection and Schedule Task records in a Query window. Select the required schedule task and click OK. The selected schedule task is displayed in this section as line item.

Use the Remove action to delete the selected line item(s).

Other Tabs

The details about the Notifications tab and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
Design Review

The Design Review record is created when a review process is necessary for design drawings, design specifications, or design packages.

Design documents are added to the Document Manager and once the record is created, they can be associated with the respective record in the Design page. For example, a design drawing is created and added to the Document Manager, and then a Design Drawing record is created specifically for that drawing, and the drawing is associated with the record. Anyone opening the record will have access to basic details about the drawing and the drawing itself.

Once an approval process or a review is necessary, a Design Review record is created. Review instructions can be added, and the specifications, drawings, and/or packages can be associated with the record (assuming records have been created for them). Once the necessary review information has been added, the Design Review record is routed through the distribution list, which can add comments directly into the Design records created for the drawings, specifications, or packages, or they can add comments in the Review Comments tab of the Design Review record.

Creating a Design Review Record

Use the following procedure to create a Design Review record.

To Create a Design Review Record

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>From the Design page above, click Design Reviews in the Related Links - Capital Project Design portal section.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays a list of Design Review records. Click Add to add a new Design Review record.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Review the form that appears. Specify the details regarding the Design Review record.</td>
</tr>
</tbody>
</table>

General Tab

<table>
<thead>
<tr>
<th>General Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number identifying Design Review record being created. If this field is left blank, the system automatically generates this number at the time of creating the Design Review record.</td>
</tr>
</tbody>
</table>
**Revision**
The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the **Revise** action that is displayed on the Action bar.

*Note* - Each time you revise or modify the record, the value displayed in this field is incremented by one.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draft</strong></td>
<td>Indicates that the Design Review record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.</td>
</tr>
<tr>
<td><strong>Review In Progress</strong></td>
<td>Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Issue action in the Action bar.</td>
</tr>
<tr>
<td><strong>Issued</strong></td>
<td>Indicates that the record is active. The system generates this status when the user selects the Issue action in the Action bar.</td>
</tr>
<tr>
<td><strong>Revision in Progress</strong></td>
<td>Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.</td>
</tr>
<tr>
<td><strong>Retired</strong></td>
<td>Indicates that the record is retired. The system generates this status when the user selects the Retire action in the Action bar.</td>
</tr>
<tr>
<td><strong>Completed</strong></td>
<td>Indicates that the record has been processed and all the tasks associated with the record has been completed. The system generates this status when the user selects the Complete action in the Action bar.</td>
</tr>
<tr>
<td><strong>History</strong></td>
<td>When the Design Review record is revised, for each revision a copy of the record gets saved in the History state.</td>
</tr>
</tbody>
</table>

*Note* - On selecting the History option in the Related Reports drop-down status list (displayed in the Design Review results page), the system retrieves and displays all the records that are revised at different stages.
General Section

Date
Use the Calendar icon to select the date on which the Design Review record is being created.

Note - By default, the system displays the current date in this field.

Name
Enter a unique name to identify the Design Review record that is being created.

To Be Reviewed Section

The To Be Reviewed section displays the list of all the Design Drawing, Design Specification, and Design Package records that are to be reviewed.

Use the Find action in this section to select the existing Design Package, Design Specification, and Design Drawing records. The system displays the available records in a Query window. Select the required record and click OK. The selected record is displayed in this section as line item.

The line item provides basic details about the record such as the type, ID, date, name, status, review status, and comment. On clicking the hyperlinked line item, you can view/modify the record details.

Use the Remove action to delete the selected line item(s).

Review Instructions Section

Use this section to provide appropriate review instructions regarding the Design Review record. The details about the review instructions may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
Recorded By Section

This section displays the login ID of the current user who is creating the Design Review record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records that are retrieved from the People page. Select the required record and click OK. The selected person’s name is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.

Copy          | Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required. |
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list. On clicking <strong>Issue</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Issued</strong>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record. The system changes the status of the record from <strong>Issued</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the [Notifications tab](#), [Notes & Documents tab](#), and [Reports tab](#) are available in previous sections. Click the respective hyperlinks to read the details.

**Design Change Notice**

You can record changes regarding the design document/drawings in the **Design Change Notice** business object. The record enables you to type a description of the change and the documents/drawings that will be affected by the change. The records created for those documents/drawings are associated with the **Design Change Notice** record. The record is submitted to a distribution list for review before being sent to the **To** person, who can make response notes and return the record to the originator.

**Creating a Design Change Notice Record**

Use the following procedure to create a **Design Change Notice** record.

**To Create a Design Change Notice Record**

**Step 1** From the **Design** page above, click **Design Change Notices** in the **Related Links** - **Capital Project Design** portal section.
To Create a Design Change Notice Record

Step 2 Review the page that appears. The page displays a list of Design Change Notice records. Click Add to add a new Design Change Notice record.

Step 3 Review the form that appears. Specify the details regarding the Design Change Notice record.

General Tab

General Section

ID
Enter a unique number identifying the Design Change Notice record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Design Change Notice record.

Revision
The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status
The system displays the current status of the Design Change Notice record being created. This field is a read-only field. The different statuses of the Design Change Notice are explained below.

Draft - Indicates that the Design Change Notice record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Issue action in the Action bar.

Issued - The system automatically changes the record from Review In Progress state to Issued state when all the members in the distribution list have approved the record.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.
### General Section

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the *Design Change Notice* record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

**Completed** - The system automatically changes the status of the record from **Routing In Progress** to **Completed** state when the contact person in the *Design Change Notice* record has responded.

- **Note** - The system generates this status only if the *Response Required* field (in the *Details* section of the *Design Change Notice* record) is checked.

- **Note** - If the *Response Required* field is not checked, on clicking the **Complete** action, the system automatically changes the status of the record from **Issued** to **Completed**.

**History** - When the *Design Change Notice* record is revised, for each revision a copy of the record gets saved in the **History** state.

- **Note** - On selecting the **History** option in the Related Reports drop-down status list (displayed in the *Design Change Notice* results page), the system retrieves and displays all the records that are revised at different stages.

#### Date

**Use the Calendar** icon to select the date on which the *Design Change Notice* record is created.

- **Note** - By default, the system displays the current date in this field.

#### Name

**Enter a unique name to identify the Design Change Notice record that is being created.**
Details Section

The Details section is used to add details about the contact person to whom the design change notice is sent for his/her response.

Note - Use this section only if you require a response for Design Change Notice record.

Response Required  
Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Home portal (of the To person) the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By  
Use the Calendar icon to select the date on which the response is required.

To Section

This section provides details about the person to whom the Design Change Notice record is sent for his/her comments. The information includes the first name, last name, name of the organization, and address regarding the To person.

Note - The record is sent for approval to the person in the To Section only if the Response Required field is checked in the Details section.

To Look Up  
Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person's name is displayed in the To Look Up field.

Note - Based on the To Look Up selected, the system auto-populates the corresponding First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal from the associated record.

First Name  
The system displays the first name of the selected person.

Last Name  
The system displays the last name of the selected person.
### To Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Use the Search icon to select an organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address details of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon to specify the country regarding the address selected in the Address field of the current record. The system displays all the names of the country that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>

### Description Section

Use this section to provide appropriate description regarding the Design Change Notice record. The details about the design change notice may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
Affected Drawings and Specifications Section

In this section, you can associate the drawings and specification to the Design Change Notice record being created.

Use the Add action in the Section bar to add a new Design Specification/Design Package/Design Drawing record. Click the respective hyperlink for further information.

You also can add a new record by clicking the Find action in the Section bar. A Query window is displayed. Based on the Related Reports (Design Drawing/Design Specification/Design Package) selected from the drop-down list, the respective records are displayed. Select the required record and click OK. The selected record is displayed in this section as line item.

By using these actions a new line item will be added to the Drawings and Specifications Affected section displaying the type, ID, date, name, discipline, and status.

Use the Remove action to delete the selected record(s).

Recorded By Section

This section displays the login ID of the current user who is creating the Design Change Notice record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a Query window that displays the list of available records in the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
</tbody>
</table>

© Copyright IBM Corporation 2011, 2013.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the <strong>X</strong> (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Clicking the <strong>Cancel</strong> action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <em>Draft</em> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Issue</strong></td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking <strong>Issue</strong> action, the system changes the status of the record to <em>Review In Progress</em> and after all the members in the distribution list have approved the record, the record status becomes <em>Issued</em>.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td><strong>Complete</strong></td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Complete</strong> action, the system changes the status of the record from <em>Issued</em> to <em>Routing In Progress</em>.</td>
</tr>
<tr>
<td></td>
<td>If the <em>Response Required</em> field in the <strong>General</strong> tab is checked, the record will be sent to the person selected in the <em>To</em> section for his/her response. The record appears as an Action item in the <em>To</em> person's <em>Home</em> portal. The selected person can add the response by clicking the hyperlinked text of the Action item.</td>
</tr>
<tr>
<td></td>
<td>Once the response is sent by the contact person, the system changes the status of the record from <em>Routing In Progress</em> to <em>Completed</em>.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>
**Notifications Tab**

The **Notifications** tab contains basic information relating to the approval process, such as the entire list of individuals who should approve the record, the current individual reviewing the record, date on which the record was sent for approval, status, and additional comments added by the reviewers while reviewing the record.

This tab displays the following sections - **Manual Approvers, Approval Reviews and Status Change Notifications**. Information regarding each of these sections is explained below.

### Manual Approvers (In Addition to Approved Requirements) Section

This section gives information about the list of individuals who should approve the record, the role assigned to each person who is approving the record, and review type. The records are displayed in a line item format in this section.

You can add approver(s) to this section by clicking the **Add Person** action in the **Approval Routing Rules** Section bar. On clicking this action, the system displays the available records that are retrieved from the **People** page. You can select the persons you want to add to the distribution list and click **OK**. The records that are selected will be added as line items to this section. You also can set advanced approval options by clicking any of the displayed hyperlinked text of the line item.

**Note** - For more information about setting up advanced options for the approval process, go to the IBM TRIRIGA 10 Information Center and select **Administering IBM TRIRIGA**.

### Approval Reviews Section

This section gives information about the review details regarding the record. The information includes the approval status of the record, approver’s name, review status of the record, date on which the record was sent for review, date on which the review was completed, comments added by the reviewer, and type of review used.

The information in this section gets auto populated on adding persons to the distribution list using the **Manual Approvers (In Addition to Approval Requirements)** section.
Status Change Notifications Section

Using this section, you can send notifications to selected individuals when the record changes to a specific status. For example, if a subcontractor wants to inform the Project Manager role about the completion of a project, he/she can send a notification when the record attains the Complete status. The notification is displayed in the Home portal of the Project Manager role.

To add a notification for a specific status, click the Add Status action in the Section bar. Select the status/statuses in which you want the notification to be sent from the displayed options and click OK. The selected records will be added as line items to this section. Click the hyperlinked text of the On Status field to add the notification details. On clicking the hyperlinked text, a Notification Details window appears wherein you can add the persons to whom the notification should be sent. Enter all the necessary details in the Notification Details window and click the Save & Close action. The system auto populates the fields of the line items in this section with the details from the corresponding Notification Details records.

Note - To remove a line item from this section, click the hyperlinked text of the On Status field and click the Delete action in the Notification Details record Action bar. The selected line item will be removed from this section.

Responses Section

This section displays the list of all Response Log records as hyperlinked line items. You can click the hyperlinked text of the line item to view the record.

On clicking the Complete action, system sends the record to selected individual(s) from whom a response is required (only if the record is approved). The record that is sent will appear as an Action Item in the individual(s)’ Portal Home Page. On clicking the hyperlinked Action Item, the current record appears in a new window. To enter the comments regarding the record, click the Respond action in the Action bar. The Response Log window appears, wherein the individual(s) can enter his/her comments in the Comments section. The response that is sent by the selected individual(s) is added as a line item in this section of the Notification tab.

Other Tabs

The details about the Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
Value Engineering Proposal

The Value-Engineering Proposal record is used when a design change is suggested in order to reduce cost. For example, if there is a proposed change in a specified material that corresponds to a reduction in cost, then you would create a value engineering proposal, describing the original scope, proposed scope, advantages, and disadvantages of the change and possible risks associated with the change.

When the Value Engineering Proposal record is created, it is routed to the approvers added in the distribution list to obtain a feedback that may result in possible changes to the proposal. When all the members in the notifications list have approved the proposal, it is returned to the originator, who forwards the record to the To person (e.g., Project Manager role), who makes the corresponding changes based on the data entered in the Value Engineering Proposal record.

Creating a Value Engineering Proposal Record

Use the following procedure to create a Value Engineering Proposal record.

**To Create a Value Engineering Proposal Record**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>From the Design page above, click Value Engineering Proposals in the Related Links - Capital Project Design portal section.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays a list of Value Engineering Proposal records. Click Add to add a new Value Engineering Proposal record.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Review the form that appears. Specify the details regarding the Value Engineering Proposal record.</td>
</tr>
</tbody>
</table>

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>ID</th>
<th>Enter a unique number identifying the Value Engineering Proposal record being created. If this field is left blank, the system automatically generates this number at the time of creating the Value Engineering Proposal record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision</td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.</td>
</tr>
</tbody>
</table>

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one.

| Status            | The system displays the current status of the Value Engineering Proposal record being created. This field is a read-only field. The different statuses |
of the **Value Engineering Proposal** are explained below.

**Draft** - Indicates that the **Value Engineering Proposal** record is yet to be created. The system generates this status when the user selects the **Create Draft** action in the Action bar.

**Review In Progress** - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the distribution list. The system generates this status on clicking the **Issue** action in the Action bar.

**Issued** - The system automatically changes the record from **Review In Progress** state to **Issued** state when all the members in the distribution list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the **Value Engineering Proposal** record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

**Note** - The system generates this status only if the **Response Required** field (in the **Details** section of the **Value Engineering Proposal** record) is checked.

**Completed** - The system automatically changes the status of the record from **Routing In Progress** to **Completed** state when the contact person in the **Value Engineering Proposal** record has responded.

**Note** - If the **Response Required** field is not checked, on clicking the **Complete** action, the system automatically changes the status of the record from **Issued** to **Completed** state.

**History** - When the **Value Engineering Proposal** record is revised, for each revision a copy of the record gets saved in the **History** state.

**Note** - On selecting the **History** option in the **Related Reports** drop-down status list (displayed in the **Value Engineering Proposal** results page), the system retrieves
General Section

and displays all the records that are revised at different stages.

Date

Use the Calendar icon to select the date on which the Value Engineering Proposal record is being created.

Note - By default, the system displays the current date in this field.

Name

Enter a unique name to identify the Value Engineering Proposal record that is being created.

Details Section

The Details section is used to add details about the contact person to whom the value engineering proposal is sent for his/her response.

Note - Use this section only if you require a response for the Value Engineering Proposal record.

Response Required

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Home portal (of the To person) the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By

Use the Calendar icon to select the date before which the response is required.

Approval date to achieve savings

Use the Calendar icon to select the date on/before which the proposal must be approved in order to obtain cost reduction (savings).
This section provides details about the person to whom the Value Engineering Proposal record is sent for his/her comments. The information that is displayed includes the first name, last name, name of the organization and address details regarding the person selected in this section.

**Note** - The record is sent to the person in the To Section only if the Response Required field is checked in the Details section.

### To Look Up

Use the **Search** icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click **OK**. The selected person’s name is displayed in the To Look Up field.

**Note** - Based on the To Look Up selected, the system auto-populates the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the <strong>Search</strong> icon to select the organization to which the selected person belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click <strong>Accept</strong>. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the organization to which the selected person belongs.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected person is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected person is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the <strong>List</strong> icon to specify the country in which the organization is located. The system displays all the names of the countries that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
The Reference section displays the priority and classification information to assist the user in grouping the records. When you set the priorities and classifications in this section, you can generate reports based on the specified information.

**Construction Class**
In general, all the Value Engineering Proposal records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

**Section**
The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

**Discipline**
Use the Search icon to select a specific discipline for the Value Engineering Proposal record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

**Work Location**
Use the Search icon to select a specific work location for the Value Engineering Proposal record being created. In the Query window, the system displays a list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.
Anticipated Costs/Savings Section

This section provides details about the expected cost/savings for the Value Engineering Proposal record that is being created. The information that is displayed includes the cost code, contract name, amount, and description.

Use the Add action in this Section bar to select the existing records associated with cost/savings. The system displays the available costs/savings records in a Query window. Select the required cost/savings record and click OK. The selected record is displayed as line item in the Anticipated Costs/Savings section.

Note - Use the Add action in the Query window to include a new Cost/Savings record.

Use the Linked Record icon to view and modify the record. Use the Remove action to delete the selected line item(s).

Recorded By Section

This section displays the login ID of the current user who is creating the Value Engineering Proposal record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the associated business object in the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the <strong>X</strong> (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td><strong>Issue</strong></td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list.</td>
</tr>
<tr>
<td><strong>Complete</strong></td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Note** - Clicking the **Cancel** action without saving the record will erase all the data you have entered in the record.
Proposal Tab

The Proposal tab is used to define the proposal or to give a description of the changes to be made and the drawing and specification documents that will be affected by the change. In giving scope to the change, the sections in this tab enable you to define the original scope, the changes, the advantages and disadvantages of making the changes, and risks associated with the change. The individual suggesting the change and submitting the proposal for review typically enters the data in the Proposal tab.

Required Information Section

This section displays a list of questions that must be answered by the person who is submitting the proposal. The field to the right of the line item displays the answer to the question, which can be typed or selected using the List icon. Using the List icon, you can select the answer for close-ended questions (Yes, No). For open-ended questions, you can click the cursor in the answer field and type the appropriate answer.

Affected Drawings and Specifications Section

This section displays the Design Drawing and Design Specification records that are affected by the proposed change.

Use the Add action in the Action bar to add a new record. The system lists the following option Design Drawing, Design Package, and Design Specification. On selecting the required option the system displays a new window, wherein you can perform the following steps:

- Provide the necessary details.
- Click the Create action.

A new line item will be added to the Affected Drawings and Specifications section. You also can add existing records by clicking the Find action in the Section bar. A Query window listing all associated records in the Design page will be displayed. From the displayed records, you can select a record to associate with this section.

By selecting the Remove action, you can remove a specific record from the list.

Remarks Section

Use this section to provide appropriate remarks regarding the proposal from the perspective of the person submitting the proposal. The remarks would be useful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
Description of the ORIGINAL (before change) contract condition: Section

This section enables you to enter a brief note about the scope of the original contract before the proposed change was suggested.

Note - Formatting options are also available.

Description of AFTER Change to contract requirements: Section

This section enables you to enter a brief note about the scope of the contract after the proposed change is implemented.

Note - Formatting options are also available.

Describe ADVANTAGES of making changes: Section

This section enables you to enter a brief note about the benefits/advantages in making the proposed change to the scope or requirements of the contract.

Note - Formatting options are also available.

Describe DISADVANTAGES of making change: Section

This section enables you to enter a brief note about the disadvantages in making the proposed change to the scope or requirements of the contract.

Note - Formatting options are also available.
Describe any Known or Foreseen RISKS associated in Making Change: Section

This section enables you to enter a brief note about the various risk factors or liabilities that are associated in making the proposed change.

Note - Formatting options are also available.

Evaluation Tab

Once the Value Engineering Proposal record is created and sent to the distribution list for review, the individuals performing the review can use the Evaluation tab to answer required questions, provide remarks, and type additional descriptions about advantages, disadvantages, and risks involved in implementing the changes defined in the proposal.

Many of the fields in the Evaluation tab are also displayed in the Proposal tab. The difference between the two is that the data in the Proposal tab is entered by the person submitting the proposal, while the person reviewing the proposal enters the data in the Evaluation tab. Typically, the person submitting the proposal will give detailed information about the advantages, disadvantages, etc., but the person evaluating the proposal may have more insight into the project and may see other advantages, disadvantages, etc., that may not be apparent to the person submitting the proposal.

Required Section

This section displays a list of questions that must be answered by the person reviewing the proposal. The field to the right of the line item displays the answer to the question, which can be typed or selected using the List icon. Using the List icon you can select a Yes/No answer for close-ended questions. For open-ended questions, you can click the cursor in the answer field and type the appropriate answer.

Remarks Section

Use this section to provide appropriate remarks regarding the proposal. The details about the design specification may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
Description of the ORIGINAL (before change) contract condition: Section

This section enables you to enter a brief note about the scope of the original contract before the proposed change was suggested.

Note - Formatting options are also available.

Description of AFTER Change to contract requirements: Section

This section enables you to enter a brief note about the scope of the contract after the proposed change is implemented.

Note - Formatting options are also available.

Describe ADVANTAGES of making changes: Section

This section enables you to enter a brief note about the benefits/advantages in making the proposed change to the scope or requirements of the contract.

Note - Formatting options are also available.

Describe DISADVANTAGES of making change: Section

This section enables you to enter a brief note about the disadvantages in making the proposed change to the scope or requirements of the contract.

Note - Formatting options are also available.
Describe any Known or Foreseen RISKS associated in Making Change: Section

This section enables you to enter a brief note about the various risk factors or liabilities that are associated in making the proposed changes.

Note - Formatting options are also available.

Other Tabs

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Request For Information

Request For Information (RFI) plays an important role in the Project Management process. The Request For Information business object is used for communication between a subcontractor and the Project Manager role after the contract has been awarded. If either the Project Manager role or the subcontractor has questions about the project, a Request for Information record is created. The clarifications that are needed are added in this record and then the record is sent to the intended individual.

The RFI link within the Design page is used to create, manage, and track information records. It is used to obtain information after the contract has been awarded. If the Project Manager role has awarded a contract to a subcontractor for a certain part of the project, he/she sends out the required design specifications, drawings, or any other required documents to the subcontractor. If the subcontractor has any questions about the design or anything else regarding the contract, he can submit a request for information to the Project Manager role in order to clear up any issues or misconceptions regarding the project.

Creating a Request For Information Record

Use the following procedure to create a Request For Information record.

To Create a Request For Information Record

Step 1 From the Design page above, click Request For Information in the Related Links - Capital Project Design portal section.

Step 2 Review the page that appears. The page displays a list of Request For Information records. Click Add to add a new Request For Information record.
To Create a Request For Information Record

Step 3  Review the form that appears. Specify the details regarding the Request For Information record.

General Tab

General Section

ID
Enter a unique number identifying the Request For Information record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Request For Information record.

Revision
The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status
The system displays the current status of the Request For Information record being created. This field is a read-only field. The different statuses of the Request For Information are explained below.

Draft - Indicates that the Request For Information record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Submit action in the Action bar.

Submitted - The system automatically changes the record from Review In Progress state to Submitted state when all the members in the distribution list have approved the record.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the
### General Section

**Action bar.**

*Routing In Progress* - Indicates that the record is sent to the contact person in the *Request For Information* record for his/her response. The system generates this status on clicking the *Complete* action in the Action bar.

**Note** - The system generates this status only if the *Response Required* field (in the *Details* section of the *Request For Information* record) is checked.

*Completed* - The system automatically changes the status of the record from *Routing In Progress* to *Completed* state when the contact person in the *Request For Information* record has responded.

**Note** - If the *Response Required* field is not checked, on clicking the *Complete* action, the system automatically changes the status of the record from *Submitted* to *Completed*.

*History* - When the *Request For Information* record is revised, for each revision a copy of the record gets saved in the *History* state.

**Note** - On selecting the *History* option in the *Related Reports* drop-down status list (displayed in the *Request For Information* results page), the system retrieves and displays all the records that are revised at different stages.

#### Date

Use the *Calendar* icon to select the date on which the *Request For Information* record is being created.

**Note** - By default, the system displays the current date in this field.

#### Name

Enter a unique name to identify the *Request For Information* record that is being created.
Details Section

The Details section is used to add details about the contact person to whom the request for information is sent for his/her response.

**Note** - Use this section only if you require a response for the Request For Information record.

Response Required  
Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the person selected in the To section for his/her response. In the Home portal (of the To person) the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By  
Use the Calendar icon to select the date on/before which the response is required.

Reference Section

The Reference section displays the priority and classification information to assist the user in grouping the records. When you set the priorities and classifications in this section, you can generate reports based on the specified information.

Construction Class  
In general, all the Request For Information records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

**Note** - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section  
The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.
Reference Section

**Discipline**
Use the Search icon to select a specific discipline for the Request For Information record being created. In the search list, the system retrieves the available discipline (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

**Work Location**
Use the Search icon to select a specific work location for the Request For Information record being created. In the Query window, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

To Section

This section provides details about the person to whom the record is sent for clarifications. The information includes the first name, last name, name of the organization, and address details of the selected person.

**Note** - The record is sent to the person selected in this section, only if the Response Required field is checked in the Details section.

**To Look Up**
Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person's name is displayed in the To Look Up field.

**Note** - Based on the To Look Up selected, the system auto-populates the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal (from the Employee record) details from the selected People record.

**First Name**
The system displays the first name of the selected person.

**Last Name**
The system displays the last name of the selected person.

**Organization**
Use the Search icon to select an organization regarding the person selected for response. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.

**Address**
Enter the address of the selected organization.

© Copyright IBM Corporation 2011, 2013.
To Section

City
Enter the name of the city where the selected organization is located.

State/Province
Enter the name of the state/province where the selected organization is located.

Country
Use the List icon to specify the country in which the organization is located. The system displays all the names of the countries that are defined in the Tools > Lists page.

Zip/Postal Code
Enter the zip/postal code regarding the above address.

Question Section

You can type all the queries regarding the subcontract in this section. After the record is approved by the members in the distribution list, it is sent to the person selected in the To field of this record. The selected person will respond to the questions added in this section.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the Request For Information record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays the list of available records retrieved from the associated business object in the People page. Select the required record and click OK. The selected person’s name is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Create Draft** | Click the Create Draft action to save all initial data entered in the new record.  

The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Submit, Save, Save & Close, More, Copy, Delete, and X (Cancel). |
| **Save**     | Click the Save action to save the changes made.                                                                                               |
| **Save & Close** | Click the Save & Close action to save the changes and close the active window.                                                               |
| **X**        | Click the X (Cancel) action to terminate the changes made and also to close the active window.                                               |
| **Note**     | - Clicking the Cancel action without saving the record will erase all the data you have entered in the record. |
| **Copy**     | Click the Copy action to create a copy of the selected record.  

On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required. |
| **Submit**   | Click the Submit action to add the record to the active management list.  

On clicking Submit action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Submitted.  

If the Response Required field in the General tab is checked, the record will be sent to the person selected in the To section for his/her response. The record appears as an Action item in the To person’s Home portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  

The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire. |
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Complete** | Click the **Complete** action to complete the tasks associated with the record.  

On clicking the **Complete** action, the system changes the status of the record from **Submitted** to **Routing In Progress**.  

If the **Response Required** field in the **General** tab is checked, the record will be sent to the person selected in the **To** section for his/her response. The record appears as an Action item in the **To** person’s **Home** portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  

Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**. |
| **Delete** | Click the **Delete** action to remove the record permanently from the active management list. |
| **More** | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Impact Tab**

This tab enables you to add the changes that may occur in the cost, schedule, or in the layout of the project that is subcontracted, due to queries rose by the vendor/subcontractor.

**Cost Impact Section**

A question that is submitted to the Project Manager role may have an impact on the cost on a part of the project being subcontracted or in the overall cost. This section enables you to define the cost impact, including amount, and any additional comments that relate to it.

**Cost impact**  
Use the **List** icon to specify the impact on the project cost that is being analyzed because of the query that is entered in the current **Request For Information** record. The system displays the available options (Yes or No) that are defined in the **Tools > Lists** page.

**Amount**  
Enter the total amount that is required/not required in the original estimated cost. By default, the system displays the amount in US dollars. You can use the **List** icon to select a different UOM for currency.

**Comment**  
Provide a brief comment about the cost impact.
### Schedule Impact Section

A question that is submitted to the Project Manager role may have an impact on the predefined project schedule. This section enables you to define the schedule impact, based on a set measurement (i.e., days, weeks, months, etc.) and any additional comments that relate to it.

<table>
<thead>
<tr>
<th>Time impact</th>
<th>Use the List icon to specify the delay/advancement in the project schedule because of the query that is entered in the current record. The system displays the available options (Yes or No) that are defined in the Tools &gt; Lists page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact Days</td>
<td>Enter the number of days by which you are ahead/behind the planned project schedule.</td>
</tr>
<tr>
<td>Comment</td>
<td>Provide a brief comment about the impact on the schedule.</td>
</tr>
</tbody>
</table>

### Drawing Impact Section

A question that is submitted to the Project Manager role will have an impact on the defined drawings in the project. This section enables you to flag changes to the documents and to type any additional comments that relate to it.

<table>
<thead>
<tr>
<th>Drawing Impact</th>
<th>Use the List icon to specify if the query has impacted a change in the design drawing regarding the project. The system displays the available options (Yes or No) that are defined in the Tools &gt; Lists page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Provide a brief comment about the impact on the design drawing.</td>
</tr>
</tbody>
</table>

### Impact Note Section

In this section, you can type any additional comment that you would like to add apart from the information covered in the other sections of this tab.

Note - Formatting options are also available.

### Other Tabs

The details about the [Notifications tab], [Notes & Documents tab], and [Reports tab] are available in previous sections. Click the respective hyperlinks to read the details.
Submittal Management

Submittals, in particular, use approval as a formalized process ensuring that qualified professionals certify the quality of items used in the project. For example, if a construction project requires the use of tiles for the floors, then the quality and type of tile to be used has to be approved by the architect or qualified professionals (responsible for that particular project).

These records require the approval of certain persons (distribution list) before being sent to the originator (To person), who acknowledges the receipt of the record and performs actions that are specified. In the Approval section, you can add additional persons to the distribution list. The record is routed to the individuals in the list in the order set in the order column of the Approval section.

Note - Make sure that you do not duplicate numbers, or the application will automatically select the routing of the record.

When the distribution list is created and the To person is selected, click the Issue action to send the record to the first person set in the routing order. The person to whom the record is sent will receive an action item in their Home portal requiring a response to the record.

If the person approves it, the record is sent to the next person in the distribution list until all of the individuals in the list have received and approved it.

If any individual in the distribution list rejects the record, it does not move to the next person in the list. Instead, the record is returned to the originator as rejected. When the last person in the list approves the record, it is sent back to the originator as approved and the Send action in the Action bar becomes available. By clicking this link, the originator can send it to the To person. The originator can only send it to the To person if it has been approved by all individuals in the distribution list.

Submittals Links

The Submittals links enable you to submit a specified item for approval before the item is procured and used. For example, there are many types of floor tiles available, but the architect may require a specific type of tile to be used on the first floor. In such case, the Project Manager role can access the Submittal links to submit a record to the architect or appropriate approver in the distribution list for approval.

Accessing the Submittals Links

The Submittals links in the Design page are used to create, manage and track Submittal records.

Use the following procedure to access the Submittals links.
To Access the Submittals Links

Step 1 To select a project, click the Project Selector icon (beside the Company|Project Toggle) above the Menu Bar. Then select the radio button for a project and click OK.

Step 2 Review the page that appears. The page displays the selected Project and corresponding Project Menu Bar.

Step 3 In the selected project, click Design to view the Design page.

Step 4 Review the Design page that appears.

Submittal Task

A Submittal Task is a sample of an item that is suggested for use in a project. This sample is typically submitted to various individuals for approval prior to its addition to a project.

For example, a hotel construction may require tiles in the lobby. However, there are many different sizes, shapes, colors, and textures of tiles. A Project Manager role may have 3 or 4 sample tiles from which he would like approval for one of them. He will submit those tile samples to individuals in the distribution list and if it is approved, he will send the submittal tasks to the intended individual.

Note - The process of creating Submittal Task Template is the same as that of Submittal Task. The purpose of creating the template is to add more Submittal Task records within the single Submittal Task Template.

Creating a Submittal Task Record

Use the following procedure to create a Submittal Task record.

To Create a Submittal Task Record

Step 1 From the Design page above, click Submittal Task in the Related Links - Capital Project Design portal section.

Step 2 Review the page that appears. The page displays a list of Submittal Task records. Click Add to add a new Submittal Task record.

Step 3 Review the form that appears. Specify the details regarding the Submittal Task record.
### General Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Task ID** | Enter a unique number identifying the *Submittal Task* record being created.  
If this field is left blank, the system automatically generates this number at the time of creating the *Submittal Task* record. |
| **Revision** | The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the *Revise* action that is displayed on the Action bar.  
**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one. |
### General Section

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draft</strong></td>
<td>Indicates that the Submittal Task record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.</td>
</tr>
<tr>
<td><strong>Review In Progress</strong></td>
<td>Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Activate action in the Action bar.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Indicates that the record is active. The system automatically changes the status of the record from Review In Progress to Active state after all the members in the distribution list have approved the record.</td>
</tr>
<tr>
<td><strong>Retired</strong></td>
<td>Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.</td>
</tr>
<tr>
<td><strong>Revision in Progress</strong></td>
<td>Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.</td>
</tr>
<tr>
<td><strong>Completed</strong></td>
<td>Indicates that the record is being processed and all the tasks associated with the record is complete. The system generates this status when the user selects the Complete action in the Action bar.</td>
</tr>
</tbody>
</table>

**History** - When the Submittal Task record is revised, for each revision a copy of the record gets saved in the History state.

**Note** - On selecting the History option in the Related Reports drop-down status list (displayed in the Submittal Task results page), the system retrieves and displays all the records that are revised at different stages.

| Task Name | Enter a name for the Submittal Task record being created. |
## General Section

### Assignment Status
Indicates the resource assignment status for the current task. The system displays the following statuses:

- **Assigned** - if the resources (required to complete the task) are added in the Resource tab of the current record.
- **Unassigned** - if the resources are not allocated for completing the current task.

### Description
Provide a brief description about the Submittal Task record being created.

### Task ReIssue Reason
If a Task is reopened, the user selects a ReIssue Reason.

### Recurrence Pattern Type
Certain tasks associated with the project might have to be done frequently or in regular intervals.

You can select the recurrence type (for performing the task) by clicking the header field of the Recurrence Pattern Type field. The system displays the Event window. In the Event window, the Recurrence Type section displays a set of options (such as Single Occurrence, Daily, Weekly, Monthly, Yearly, and Ad hoc). On selecting the required option, the recurrence type for the Submittal Task record is displayed.

**Note** - Based on the recurrence type selected you have to enter the necessary information in the Event window.

### Currency
Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

## Reference Section

### Type
Use the List icon to specify the type for the Submittal Task record being created. The system displays all the available project type (such as Calculation, Drawing, Sketch, Sample, etc.) as defined in the Tools > Lists page.
Reference Section

Deviation
If the Submittal Task is a deviation from the Specification, the check-box will flag this submittal. The system will allow users to report on all Submittal Tasks that are flagged as a deviation.

Construction Class
In general, all the Submittal Task records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section
The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

Discipline
Use the Search icon to select a specific discipline for the Submittal Task record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

Work Location
Use the Search icon to select the location in which the task has to be performed. In the Query window, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

Contract Section

Using this section, you can provide information regarding the contract associated with the current task. Use the Find action in this section to select the required contract. A Query window listing the available Contract records will appear. Select the required Contract record and click OK. The system auto populates the ID and Contract Name fields with the details from the selected record.

Use the Clear action to erase the displayed information.
**Designs to be Submitted Section**

This section enables you to provide information regarding the Design records that have to be submitted for approval.

Click the **Add** action in this section to add a new Design record. On clicking the **Add** action the system displays the available options such as Design Drawing, Design Package, Design Specification, and Supplemental Design Document in a new window. Select the required option and the system displays the respective record in a new window, wherein you can perform the following steps:

- Provide the necessary information.
- Click the **Create** action.

A new line item (of the selected design type) will be added to this section.

You also can use the **Find** action in this section to select the Design record. A Query window listing the available Design records will appear. Select the required Design record and click **OK**. The selected Design record is displayed in this section as line item.

Use the **Remove** action to delete the selected line item(s).

**Responsible Organization Section**

This section enables you to provide information regarding the organization that is responsible for managing the activities associated with the current task.

Use the **Find** action in this section to select the responsible organization. A Query window listing all the associated records from the Organization hierarchy will appear. Select the required organization and click **OK**. The Name, Organization Type, and Hierarchical Path fields are auto populated with the information from the selected record.

Use the **Clear** action to erase the displayed information.
**Responsible Person Section**

This section enables you to provide information about the person responsible for managing all the activities associated with the task.

Use the Find action in this section to select the responsible person. A Query window listing all the available Employee/Consultant/External Contact records retrieved from the People page will appear. Select the required person’s name and click Accept. The system auto populates the Full Name, Functional Role, Status, Email, and Work Phone fields of this section with the information from the selected record.

Use the Clear action to erase the displayed information.

**Baseline Section**

When this task is first saved, if the Baseline fields are empty they are copied from the Planned fields. Baseline fields are used in metrics.

- **Baseline Start**
  - The original Planned Start.

- **Baseline End**
  - The original Planned End.

- **Baseline Duration**
  - The original Planned Duration.

- **A. Baseline Working Days**
  - The original Planned Working Days.

- **B. Baseline Working Hours**
  - The original Planned Working Hours, beyond the original Planned Working Days.

- **Total Baseline Working Hours (A+B)**
  - The original Planned Working Days plus the original Planned Working Hours.

- **Baseline Cost**
  - The original Planned Cost.

**Planned Section**

This section provides the details about the scheduled start and end dates for completing the task.

- **Planned Start**
  - Use the Calendar icon \(\text{Calendar}\) to select the planned start date and time.
### Planned Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned End</td>
<td>Use the <em>Calendar</em> icon to select the planned end date and time.</td>
</tr>
<tr>
<td>Planned Duration</td>
<td>The planned duration in days, months or years.</td>
</tr>
<tr>
<td>C. Planned Working Days</td>
<td>Enter the planned working days.</td>
</tr>
<tr>
<td>D. Planned Working Hours</td>
<td>Enter the planned working hours, beyond the planned working days.</td>
</tr>
<tr>
<td>Total Planned Working Hours (C+D)</td>
<td>The Planned Working Days plus the Planned Working Hours.</td>
</tr>
<tr>
<td>Planned Cost</td>
<td>Enter the estimated cost for completing the task. By default the UOM is US Dollars.</td>
</tr>
<tr>
<td>Estimated</td>
<td>Select this check box if the project cost is not final and can be modified by the approver.</td>
</tr>
</tbody>
</table>

### Actual Section

This section provides the actual date and cost details regarding the *Submittal Task* record being created.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Start</td>
<td>Use the <em>Calendar</em> icon to select the actual start date and time.</td>
</tr>
<tr>
<td>Actual End</td>
<td>Use the <em>Calendar</em> icon to select the actual end date and time.</td>
</tr>
<tr>
<td>Actual Duration</td>
<td>The actual duration in days, months or years.</td>
</tr>
<tr>
<td>E. Actual Working Days</td>
<td>Enter the actual working days.</td>
</tr>
<tr>
<td>F. Actual Working Hours</td>
<td>Enter the actual working hours, beyond the actual working days.</td>
</tr>
<tr>
<td>Total Actual Working Hours (E+F)</td>
<td>The Actual Working Days plus the Actual Working Hours.</td>
</tr>
<tr>
<td>Actual Percent Complete</td>
<td>Enter the actual percentage of work completed from the start date of the submittal task.</td>
</tr>
</tbody>
</table>
Actual Section

Actual Cost

Enter the actual cost incurred by the organization in getting the work done. By default the UOM is US Dollars.

Recorded By Section

This section displays the login ID of the current user who is creating the Submittal Task record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.

Copy

Click the Copy action to create a copy of the selected record.

On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply Template</strong></td>
<td>Click the <strong>Apply Template</strong> action to copy the contents of the selected template to the current record. On clicking the <strong>Apply Template</strong> action, the system displays a list of templates retrieved from the associated business objects. Select a template and click the <strong>OK</strong> action. The system copies the contents of the selected template to the current record.</td>
</tr>
<tr>
<td><strong>Baseline</strong></td>
<td>Click the <strong>Baseline</strong> action to set the dates defined as the Planned Start and Planned End dates as the base date for the task.</td>
</tr>
<tr>
<td><strong>Activate</strong></td>
<td>Click the <strong>Activate</strong> action to add the record to the active management list. On clicking the <strong>Activate</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Active</strong>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td><strong>Complete</strong></td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record. The system changes the status of the record from <strong>Active</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>Re-Open</strong></td>
<td>Click the <strong>Re-Open</strong> action if the work that was performed is not satisfactory. On clicking the <strong>Re-Open</strong> action, the system displays a <strong>Task ReIssue</strong> window. Click the <strong>Search</strong> icon and select the appropriate <strong>Task ReIssue Reason</strong> and click <strong>Continue</strong>.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Click the <strong>Close</strong> action to change the status of the task to <strong>Closed</strong>. Only <strong>Completed</strong> status task can be closed.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>
**Resources Tab**

Defining project resources is the most important part of a project plan. When developing a project plan, it is important to carefully define the available resources. There are two types of resources involved in the *Submittal Task* - Work and Material. Work is the resource type that you will use for almost all of your resource requirements. A work resource is anyone or anything that works on a task in your project. The work resources are classified as assets, locations, people, and organizations.

Material resources are often confusing for new project users. It is better to use the Material resources type for things that are consumed by a task, not the things that perform the task. Material resources are things that are kept on hand and used up by the tasks in a project.

**Resources Section**

This section displays a list of resources that are required to perform the Submittal Task. Resources that are required can be assets, location, organization, and individuals (employees).

Use the *Add* action in this section to add resources required for executing the work task. The system displays the *Resource* window, wherein you can perform the following steps:

- Provide the mandatory information such as resource type, resource requirement, percentage allocation, construction type, etc., in the *Details* section.
- Click the *Create* action.

A new *Resource* line item will be added to the *Resources* section.

You also can use *Find Assets, Find People, Find Locations,* and *Find Organization* actions in the Section bar to add the required resource to the *Resource* section. On clicking one of these actions, a *Query* window listing the available records will appear. Select the required record and click *OK*. The information regarding the selected resource will be displayed as line items.

Use the *Remove* action to delete the selected line item(s).

**Work Time Section**

This section displays the scheduled start date, end date and total hours for completing the task, based on the Planned section (General tab). In addition, this section displays the Assigned and Unassigned work time information.

**Resource Allocations Section**

This section displays a list of resources and their work time allocations, based on the Percent Allocated (Resources section) and Work Time section information above.
**Material List Section**

This section enables you to provide information about the list of materials that are required to perform the submittal task.

Click the **Add** action in this section to add a new *Material List* record. On clicking the **Add** action, the system displays a new window, wherein you can perform the following steps:

- Provide the necessary information.
- Click the **Create** action.

A new line item will be added to this section.

You also can use the **Find** action in this section to select the material. A *Query* window listing the available specifications regarding the material will appear. Select the required *Specification* record and click **OK**. The selected record will be added as a line item to this section.

Use the **Remove** action to delete the selected line item(s).

**Material Orders Section**

This section enables you to select the required materials from the available *Product* and *Request* catalogs.

Use the **Find** action in the section to select the required materials. The system displays the Material Order Task window, wherein you can perform the following steps:

- Identify the catalog, select the materials from the catalog and enter the quantity required.
- Click the **Add Item** action.
- After you have completed adding all the items, click the **Done** action in the Action bar to close the active window. The selected materials will be added to this section as line items.

Use the **Remove** action to delete the selected line item(s).

**Procedures Tab**

The *Submittal Task* has a set of procedures that should be performed one after the other. There are different types of procedures such as Inspection procedure, Lock-Out/Tag-Out procedure, Safety Hazards procedure, Safety Precautions procedure, and Work procedure. You can create any one of the above procedures based on the necessity.
Procedures Section

You can add details regarding the procedures for which the Submittal Task record is being created. To enter these details, click the Add action in this section. The system displays a list of procedures (such as the Inspection Procedure, Lock-Out/Tag-Out Procedure, Safety Hazards Procedure, Safety Precautions Procedure, and Work Procedure). On selecting one of these options, the respective window is displayed, wherein you can perform the following steps:

- Provide the mandatory information.
- Click the Create action.

The Procedure record that is created will be added as a line item to the Procedures section.

You also can use Find action in the Section bar to associate existing Procedure records. In a Query window, the system displays the list of available Procedure records. Select the required Procedure record and click OK. The selected procedure will be displayed as line item in this section.

Use the Remove action to delete the selected line item(s).

Regulations Section

Using this section, you can provide details about the rules and regulations that must be followed while performing the selected procedure. You can use the Find action in the Section bar to add the regulations regarding the procedure. A Query window listing the available Regulations records will appear. Select the required Regulations record and click OK. The system displays the created Regulations record as a line item to this section.

Use the Remove action to delete the selected line item(s).

Dependencies Tab

When the work task is assigned to the respective service provider, the entire work task may be subdivided into number of sub tasks and each task may depend on the other tasks.
### Dependencies Section

The **Dependencies** tab is used to add the existing tasks which can be associated with the *Submittal Task Template*.

Use the **Find Tasks** action in the Section bar to add the tasks regarding the dependencies. A *Query* window listing the available *Task* records will appear. Select the required *Dependencies Tasks* record and click **OK**. A new line item is added to this section and displays the *Predecessor Task ID*, *Predecessor Task Name*, *Planned Start*, *Planned Duration*, *Planned End*, *Dependency Relationship*, *Lead/Lag*, and *Duration* details.

Use the **Remove** action to delete the selected line item(s).

### Advanced Tab

The **Advanced** tab gives advanced information regarding the current task (such as priority, priority rating, constraint type, and constraint date and time that is assigned to the task) that is involved in the reservation work task process.

### Details Section

This section gives the details regarding the current task that is performed.

<table>
<thead>
<tr>
<th>Ignore Resource Calendar</th>
<th>If a resource is assigned to perform a specific task on a weekly/monthly basis, then the dates on which the resource has to perform the work task will be highlighted in the resource calendar.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select the check box, if the task calendar has to be merged with the resource calendar. On performing this, the system ignores the previous work task (assigned in the resource calendar) and assigns the new work task as per the date and time scheduled in the task calendar.</td>
</tr>
<tr>
<td>Task Priority</td>
<td>You can specify the priority (Emergency, High, Medium, Low) of the work task. Use the <em>Search</em> icon to select the priority for the task. In the search list, the system displays the available priorities that are retrieved from the <em>Priority</em> business object in the <em>Classification hierarchy</em>.</td>
</tr>
<tr>
<td>Priority Rating</td>
<td>Enter a value that denotes the priority rating of the work task.</td>
</tr>
</tbody>
</table>

© Copyright IBM Corporation 2011, 2013.
### Details Section

**Constraint Type**
You can specify the constraint type applicable for the task.

Use the **List** icon to select a constraint type for the task. In the search list, the system displays the available types that are defined in the **Tools > Lists** page.

**Constraint Date/Time**
The system displays the constraint date and time (as defined in the **Start Time** field of the **Dates** section) of the work task. For example, if the constraint type is selected as **Must Start On**, then the system indicates the constraint start date and time of the work task that has to be performed for the assets.

### Rollup To Task Section

In this section, you can specify the name and ID of the main task to which all the sub tasks get rolled up.

Use the **Find** action, to select the main task. In the search list, the system displays the available tasks that are retrieved from the associated business object in the **Tasks** page. Select a specific task and click **OK**. The selected task is displayed as record in a line item format in this section.

Use the **Clear** action to erase the displayed information in this section.

### Linked Projects Section

Using this section, you can associate the projects with which the current work task is associated. Click the **Find** action in the Section bar to associate the **Project** records. In the Query window, the system displays a list of all records from the associated business object in the **Real Estate Project** page. Select a record and click **OK**. The system displays the selected record as a line item in this section.

Select the check box beside the line item and click the **Remove** action to eliminate a record from this section.

### Other Tabs

The details about the **Notifications tab**, **Notes & Documents tab**, and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.
Submittal Package

The Submittal Package is used to group submittal tasks together so that they can be forwarded to the approvers in the distribution list, and eventually to the To person (e.g., Project Manager role). A submittal task is a sample item that requires the utility approval within the project. Many Submittal Task records can be combined and associated with a Submittal Package record, and sent for review to the distribution list. The approvers in the distribution list will compare the items as they review the record. Additionally, they can reference documents and drawings that have been associated with the Submittal Package.

Creating a Submittal Package Record

Use the following procedure to create a Submittal Package record.

To Create a Submittal Package Record

Step 1  From the Design page above, click Submittal Package in the Related Links - Capital Project Design portal section.

Step 2  Review the page that appears. The page displays a list of Submittal Package records. Click Add to add a new Submittal Package record.

Step 3  Review the form that appears. Specify the details regarding the Submittal Package record.

General Tab

General Section

ID  Enter a unique number identifying the Submittal Package record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Submittal Package record.

Revision  The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status  The system displays the current status of the Submittal Package record being created. This field is a read-only field. The different statuses of the
*General Section*

Submittal Package record are explained below.

*Draft* - Indicates that the Submittal Package record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

*Review In Progress* - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Issue action in the Action bar.

*Issued* - The system automatically changes the record from Review In Progress state to Issued state when all the members in the distribution list have approved the record.

*Retired* - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the Unretire or Revise action in the Action bar.

*Routing In Progress* - Indicates that the record is sent to the contact person in the Submittal Package record for his/her response. The system generates this status on clicking the Complete action in the Action bar.

**Note** - The system generates this status only if the Response Required field (in the Details section of the Submittal Package record) is checked.

*Completed* - The system automatically changes the status of the record from Routing In Progress to Completed state when the contact person in the Submittal Package record has responded.

**Note** - If the Response Required field is not checked, on clicking the Complete action, the system automatically changes the status of the record from Issued to Completed.

*History* - When the Submittal Package record is revised, for each revision a copy of the record gets saved in the History state.

**Note** - On selecting the History option in the Related Reports drop-down status list (displayed in the Submittal Package results page), the system retrieves
### General Section

and displays all the records that are revised at different stages.

**Date**

Use the Calendar icon to select the date on which the **Submittal Package** record is being created.

**Note** - By default, the system displays the current date in this field.

**Name**

Enter a unique name to identify the **Submittal Package** record that is being created.

### Details Section

The **Details** section is used to add details about the contact person to whom the submittal package is sent for his/her response.

**Note** - Use this section only if you require a response for **Submittal Package** record.

**Response Required**

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the **To** section.

Only if this field is checked, on clicking the **Complete** action, the record is sent to the **To** person for his/her response. In the **Home** portal (of the **To** person) the record is displayed as an **Action Item**. The **To** person can send his/her comment by clicking the hyperlinked **Action Item**.

**Required By**

Use the Calendar icon to select the date on which the response is required.
Submitted By Section

The Submitted By section provides the details about the person who is submitting the Submittal Package record for approval.

Use the Find action in this section to select the required person. A Query window listing the available records from the associated business object in the People page will be displayed. Select the required record and click OK. The system auto populates the fields of this section with the information from the selected record.

By clicking the hyperlinked header field, you can view/modify the record details in a new window. By selecting the Clear action, you can remove all the information displayed in this section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>First Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>The system displays the name of the organization to which the selected person belongs.</td>
</tr>
</tbody>
</table>

To Section

This section provides details about the person to whom the Submittal Package record is sent for his/her comments. The information includes the first name, last name, and name and address of the organization.

Note - The record is sent for approval to the person in the To section, only if the Response Required field is checked in the Details section of the current record.

To Look Up

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person's name is displayed in the To Look Up field.

Note - Based on the person (People record) who is selected, the system auto-populates the fields of this section such as the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the respective People record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
</tbody>
</table>
To Section

Last Name
The system displays the last name of the selected person.

Organization
Use the Search icon 🔄 to select the organization to which the selected person belongs. In the search list, the system displays the records that are retrieved from the associated business object in the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.

Address
Enter the address of the selected organization.

City
Enter the name of the city where the organization is located.

State/Province
Enter the name of the state/province where the organization is located.

Country
Use the List icon ⏩ to specify the country in which the organization is located. The system displays all the country names that are defined in the Tools > Lists page.

Zip/Postal Code
Enter the zip/postal code regarding the above address.

Dates Section

Received Date
Use the Calendar icon 📅 to select the date on which the Submittal Package record is received for review.

Returned Date
Use the Calendar icon 📅 to select the date on which the Submittal Package record is returned back to the originator after review.

Reference Section

The Reference section displays the priority and classification information to assist the user in grouping the records. When you set the priorities and classifications in this section, you can generate reports based on the specified information.
## Reference Section

<table>
<thead>
<tr>
<th><strong>Construction Class</strong></th>
<th>In general, all the <strong>Submittal Package</strong> records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in <strong>CSI - Construction Class</strong> that is selected. Use the <strong>Search</strong> icon to select the construction class. The system displays the available construction classes (e.g., <em>General Requirements</em>, <em>Masonry</em>, etc.) that are retrieved from the <strong>CSI-Construction Class</strong> business object in the <strong>Classification hierarchy</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section</strong></td>
<td>The <strong>Section</strong> field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.</td>
</tr>
<tr>
<td><strong>Discipline</strong></td>
<td>Use the <strong>Search</strong> icon to select a specific discipline for the <strong>Submittal Package</strong> record being created. In the search list, the system retrieves the available disciplines (such as <em>Architectural</em>, <em>Civil</em>, <em>Equipment</em>, etc.) from the <strong>Project</strong> business object in the <strong>Classification hierarchy</strong>.</td>
</tr>
<tr>
<td><strong>Work Location</strong></td>
<td>Use the <strong>Search</strong> icon to select a specific work location for the <strong>Submittal Package</strong> record being created. In the <strong>Query</strong> window, the system displays the list of available records that are retrieved from the <strong>Space</strong> business object in the <strong>Location hierarchy</strong>. Select the required location and click <strong>OK</strong>. The selected work location will be displayed in this field.</td>
</tr>
</tbody>
</table>

*Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.*
**Items Section**

In this section, you can associate the items related to the *Submittal Package* record to which changes have to be made.

Use the Add action in the Section bar to add a new record. The system displays the *Submittal Task* record in a new window, wherein you can perform the following steps:

- Provide the necessary details.
- Click the Create action.

A new line item will be added to this section displaying the ID, name, type, current status, and review status.

You also can use the Find action on the Section bar. A *Query* window listing all *Submittal Task* records will be displayed. Select the required record and click OK. The system displays the selected record as line item in this section.

**Note** - Use the Add action in the Query window to include a new *Submittal Task* record.

Use the Remove action to delete the selected record(s).

**Recorded By Section**

This section displays the login ID of the current user who is creating the *Submittal Package* record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the *People* page. Select the required record and click OK. The selected record is displayed in this section.
**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Draft</strong></td>
<td>Click the <em>Create Draft</em> action to save all initial data entered in the new record. The system changes the status of the record to <em>Draft</em> and displays additional actions on the Action bar. The actions include <em>Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel)</em>.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Click the <em>Save</em> action to save the changes made.</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the <em>Save &amp; Close</em> action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the <em>X (Cancel)</em> action to terminate the changes made and also to close the active window. <strong>Note</strong> - Clicking the <em>Cancel</em> action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <em>Copy</em> action to create a copy of the selected record. On clicking the <em>Copy</em> action, a copy of the record is created (in the <em>Draft</em> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Issue</strong></td>
<td>Click the <em>Issue</em> action to add the record to the active management list. On clicking <em>Issue</em> action, the system changes the status of the record to <em>Review In Progress</em> and after all the members in the distribution list have approved the record, the record status becomes <em>Issued</em>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <em>Complete, Revise and Retire</em>.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Complete** | Click the **Complete** action to complete the tasks associated with the record.  

On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Routing In Progress**.  

If the **Response Required** field in the **General** tab is checked, the record will be sent to the person selected in the **To** section for his/her response. The record appears as an Action item in the **To** person’s **Home** portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  

Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**. |
| **Delete** | Click the **Delete** action to remove the record permanently from the active management list. |
| **More** | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Other Tabs**

The details about the **Notifications tab**, **Notes & Documents tab**, and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.

**Procurement Management**

Note - For more information on the procurement management process, see the *IBM TRIRIGA 10 Procurement Management User Guide*.

**Schedule Management**

A project is a large goal that is achieved by the completion of many smaller tasks. These smaller tasks can be defined by using the records in the **Schedule** page. The tasks can be **Work Task**, **Reserve Task**, **Inspection Task**, **Condition Assessment Work Task**, or any of the other tasks listed in the **Schedule** page.

Any **Task** record enables you to define the basic task description, priority, deadline, baseline, planned start/end dates, planned cost, and actual cost details. By filling in these fields of the record, any
individual who opens the record can have a clear understanding of what the task is and basic information about it. The baseline gives timeline and cost information about the original project plan. Hence, the baseline marks the beginning of the project.

Note - At the beginning of a project, the baseline and planned timelines and costs should be the same. They may change during the course of the project.

Schedule Page

Accessing the Schedule Page

Use the following procedure to access the Schedule page.

To Access the Schedule Page

1. To select a project, click the Project Selector icon (beside the Company|Project Toggle) above the Menu Bar. Then select the radio button for a project and click OK.
2. Review the page that appears. The page displays the selected Project and corresponding Project Menu Bar.
3. In the selected project, click Schedule to view the Schedule page.
4. Review the Schedule page that appears.

Gantt Scheduler & Project Tasks

The Gantt Scheduler is a section that can be inserted into any IBM TRIRIGA business object. This Gantt is a true scheduling engine that shows any IBM TRIRIGA task business object along with its scheduling information. This scheduling information includes early start dates, late start dates, percentage complete, critical path, baseline info, associated resources, umbrella tasks, and dependent Task business objects.

The type of tasks that may be created in the scheduling Gantt is determined by the form selection from within the query (e.g., the tasks include Work Task, Reserve Task, Inspection Task, and Condition Assessment Work Task).

Accessing the Gantt Scheduler

Note - For more information on reviewing Gantt-view Projects and Project tasks within a Program record, refer to the Schedule tab of a Program record.
Creating Project Tasks via the Gantt Scheduler

After a *Capital Project* record has been created, submitted and approved, you can create new tasks and task dependencies via the Gantt Scheduler (Schedule Tab).

Note - For more information on scheduling tasks within a *Project* record, refer to the *Schedule tab* of a *Capital Project* record.

Note - You can also create new tasks from the *Menu Bar* by clicking *Tasks* > *Manage Tasks*. Select the desired Task Type, and then click *Add* in the respective results page.

Use the following procedure to create new tasks and task dependencies via the Gantt Scheduler. This example will select a *Work Task* type.

**To Create Project Tasks via the Gantt Scheduler**

**Step 1** Navigate to an existing *Capital Project* record. On the Schedule tab of the *Capital Project* record, click the *Search* icon for the *Time Zone* field and select the required time zone for this project.

Note - If necessary, click the *Revise* action to edit the record.

**Step 2** Click the *List* icon for the *Calculate Project From* field and select the required calculation point for this project: *Start*, *End*, or *Both*.

**Step 3** In the Project Tasks Gantt section, click the *Expand Section* icon or the *Open Gantt In New Window* action.

**Step 4** To create a new task, select a Task Type from the *Add* drop-down menu. This example will select a *Work Task* type.

**Step 5** Review the Gantt Scheduler.

Tip - If necessary, you also can switch to Create mode by right-clicking within the white space area to open the popup menu. The check boxes allow you to toggle between Create mode (checked) and Select mode (unchecked).
To Create Project Tasks via the Gantt Scheduler

Step 6 In the white space area of the Gantt Scheduler, drag-and-drop a box from left to right to create the task. Drag-and-drop from right to left to create a milestone task.

Step 7 Select a new Task Type, if necessary. Then continue creating tasks for all common tasks for this template. Red boxes denote the critical path for this project.

Step 8 Next, create dependencies between tasks by dragging-and-dropping a line from one task’s start/finish (SF) point to another task’s start/finish (SF) point.

During the drag-and-drop process, a screen tip shows the type of dependency being created: SS, SF, FS, or FF (where S = Start and F = Finish).

Tip - Task and dependency forms can be opened from the Gantt via a double-click only if they have been saved. Newly created tasks and dependencies have to be saved via the Gantt Save button before attempting to modify them from a form.

Step 9 Click Save to save your Gantt changes. You also can save your Gantt changes by clicking the Save action in the upper-right corner of the record.

Step 10 Edit the details of each task by double-clicking a task box.

Step 11 In the task window that appears, enter the desired information for this task.

Step 12 Click the Save & Close action.

Step 13 Return to the Project Tasks Gantt section. Once the task is updated, edit the details of the remaining tasks.

Step 14 Click Save to save your Gantt changes. You also can save your Gantt changes by clicking the Save action in the upper-right corner of the record.

Step 15 From here, enter any remaining details for the Capital Project record.

Using the Gantt Scheduler Toolbar

The Gantt Scheduler Toolbar allows you to interact with the display of existing tasks, and to create and select existing tasks. The Gantt Scheduler Toolbar controls the visibility of the Gantt. This is an internal toolbar whereas the Platform only controls visibility and enable/disable modes. The Hourly / Daily / Weekly / Monthly icon buttons control the Graphic scale.

The Gantt Scheduler Toolbar consists of the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="hour_icon.png" alt="Hour Icon" /></td>
<td><strong>Hour</strong> - Select this icon to view the hourly calendar in the right panel.</td>
</tr>
<tr>
<td><img src="day_icon.png" alt="Day Icon" /></td>
<td><strong>Day</strong> - Select this icon to view the daily calendar in the right panel.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Week</strong> - Select this icon to view the weekly calendar in the right panel.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Month</strong> - Select this icon to view the monthly calendar in the right panel.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Upper Timescale</strong> - Select this toggle icon to hide/show the calendar displayed in the upper part of the right panel.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Lower Timescale</strong> - Select this toggle icon to hide/show the calendar displayed in the lower part of the right panel.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Left Row Header</strong> - Select this toggle icon to hide/show the left panel row header.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Left Table</strong> - Select this toggle icon to hide/show the left panel that displays the name of the tasks.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Toggle Float Layer</strong> - Select this toggle icon to display the amount of time a task can slip before it affects another task's dates or the project finish date. Also referred to as slack.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Toggle Baseline Layer</strong> - Select this toggle icon to view the baseline start and end dates of the selected tasks.</td>
</tr>
</tbody>
</table>

The system also displays other standard toolbar icons such as the **Layout Sheet(s)**, **Print Preview**, **Print Sheet(s)**, **Zoom In**, and **Zoom Out** icons.

**Entering Work Task Details**

From the Gantt view, you can double-click into a specific task to view the individual task record.

**General Tab**

Review the **General** tab of the **Work Task** record.

**General Section**

<table>
<thead>
<tr>
<th>Task ID</th>
<th>Enter a unique number identifying the <strong>Work Task</strong> record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this field is left blank, the system automatically generates this number at the time of creating the <strong>Work Task</strong> record.</td>
</tr>
</tbody>
</table>

| Status | The system displays the current status of the **Work Task** record being created. This field is a read-only field. The different statuses of the **Work Task** are explained below. |
Draft - Indicates that the Work Task record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and is yet to be approved by all the members in the distribution list. The system generates this status on clicking the Activate action in the Action bar.

Active - Indicates that the record is active. The system automatically changes the status of the record from Review In Progress to Active state after all the members in the distribution list have approved the record.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

Completed - Indicates that the record is being processed and all the tasks associated with the record is complete. The system generates this status when the user selects the Complete action in the Action bar.

History - When the Work Task record is revised, for each revision a copy of the record gets saved in the History state.

Note - On selecting the History option in the Related Reports drop-down status list (displayed in the Tasks > Manage Tasks > Work Task results page), the system retrieves and displays all the records that are revised at different stages.

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Enter a name for the Work Task record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Status</td>
<td>Indicates the resource assignment status for the current task. The system displays the following statuses:</td>
</tr>
<tr>
<td>Assigned</td>
<td>if the resources (required to complete the task) are added in the Resource tab of the current record.</td>
</tr>
<tr>
<td>Unassigned</td>
<td>if the resources are not allocated for completing the current task.</td>
</tr>
</tbody>
</table>
### General Section

<table>
<thead>
<tr>
<th>Description</th>
<th>Provide a brief description about the Work Task record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task ReIssue Reason</td>
<td>If a Task is reopened, the user selects a ReIssue Reason.</td>
</tr>
<tr>
<td>Currency</td>
<td>Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency in the Tools &gt; Lists page. By default, the system displays the currency of the project that this task belongs to, but you can change it.</td>
</tr>
</tbody>
</table>

### Details Section

<table>
<thead>
<tr>
<th>Task Type</th>
<th>Use the Search icon to specify the type for the Work Task record being created. The system displays all the available project type (such as Calculation, Drawing, Sketch, Sample, etc.) as defined in the Tools &gt; Lists page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Priority</td>
<td>You can specify the priority (Emergency, High, Medium, Low) of the work task. Use the Search icon to select the priority for the task. In the search list, the system displays the available priorities that are retrieved from the Priority business object in the Classification hierarchy.</td>
</tr>
<tr>
<td>Request Class</td>
<td>You can classify service requests into different types. Each of these requests is defined in the Classification page. Use the Search icon to select a specific Request Class option. The system displays a list of options that are defined for the corresponding service request business object (e.g., “Electrical Outlets Out”, “Lights Out”, “Power Out”, etc.) in the Classification page.</td>
</tr>
<tr>
<td>Service Class</td>
<td>Use the Search icon to select the appropriate service assignment class. This field displays the class of the service (e.g. “Conference Services”, “Facilities”, “Information Technology”, “Office Services”, “Project”, etc.)</td>
</tr>
</tbody>
</table>
Details Section

Primary Work Location
Use the Search icon 🕵️ to select the location in which the task has to be performed. In the Query window, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

Customer Organization
Use the Search icon 🕵️ to select the customer organization that is associated with this Work Task. In the search list, the system displays the available records that are retrieved from the associated business object in the Organization page.

Requests Section

This section enables you to provide the request associated with this Work Task record. Use the Find action in this section to select the desired request. A Query window listing the available Request records will appear. Select the required record and click OK. The selected request is displayed in this section as line item.

Use the Remove action to delete the selected line items from this section.

Facilities Project Section

If applicable, this section displays the Facilities Project record associated with this Work Task record. Use the Find action in this section to associate a Facilities Project. A Query window will appear, listing the available Facilities Project records. Select the appropriate Facilities Project record and click OK. The system auto populates the ID, Status and Name fields with the details from the selected record.

Use the Clear action to erase the displayed information.
**Contract Section**

Using this section, you can provide information regarding the contract associated with the current task. Use the **Find** action in this section to select the required contract. A **Query** window listing the available **Contract** records will appear. Select the required **Contract** record and click **OK**. The system auto populates the **ID** and **Contract Name** fields with the details from the selected record.

Use the **Clear** action to erase the displayed information.

---

**Responsible Organization Section**

This section enables you to provide information regarding the organization that is responsible for managing the activities associated with the current task.

Use the **Find** action in this section to select the responsible organization. A **Query** window listing all the associated records from the **Organization hierarchy** will appear. Select the required organization and click **OK**. The **Name**, **Organization Type**, and **Hierarchical Path** fields are auto populated with the information from the selected record.

Use the **Auto-Assign** action to automatically assign the responsible organization based on your Service Assignment Matrix (SAM). The assignment may be based on a service level agreement, blanket purchase order, or even a real estate lease contract. Otherwise, use the **Assign** action to open the **Task Service Assignment Matrix Action Form** to select the responsible organization manually. Select the required organization and click **Assign to Task**.

**Note** - For more information about service assignment matrix records, go to the IBM TRIRIGA 10 Information Center and select **Maintaining operations and services**.

Use the **Clear** action to erase the displayed information.
**Responsible Person Section**

This section enables you to provide information about the person responsible for managing all the activities associated with the task.

Use the **Find** action in this section to select the responsible person. A *Query* window listing all the available Employee/Consultant/External Contact records retrieved from the *People* page will appear. Select the required person’s name and click **OK**. The system auto populates the *Full Name*, *Functional Role*, *Status*, *Email*, and *Work Phone* fields of this section with the information from the selected record.

Use the **Clear** action to erase the displayed information.

**Baseline Section**

When this task is first saved, if the Baseline fields are empty they are copied from the Planned fields. Baseline fields are used in metrics.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline Start</td>
<td>The original Planned Start.</td>
</tr>
<tr>
<td>Baseline End</td>
<td>The original Planned End.</td>
</tr>
<tr>
<td>Baseline Duration</td>
<td>The original Planned Duration.</td>
</tr>
<tr>
<td>A. Baseline Working Days</td>
<td>The original Planned Working Days.</td>
</tr>
<tr>
<td>B. Baseline Working Hours</td>
<td>The original Planned Working Hours, beyond the original Planned Working Days.</td>
</tr>
<tr>
<td>Total Baseline Working Hours (A+B)</td>
<td>The original Planned Working Days plus the original Planned Working Hours.</td>
</tr>
<tr>
<td>Baseline Cost</td>
<td>The original Planned Cost.</td>
</tr>
</tbody>
</table>

**Planned Section**

This section provides the details about the scheduled start and end dates for completing the task.

Planned Start  
Use the *Calendar* icon to select the planned start date and time.
### Planned Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned End</td>
<td>Use the Calendar icon to select the planned end date and time.</td>
</tr>
<tr>
<td>Planned Duration</td>
<td>The planned duration in days, months or years.</td>
</tr>
<tr>
<td>C. Planned Working Days</td>
<td>Enter the planned working days.</td>
</tr>
<tr>
<td>D. Planned Working Hours</td>
<td>Enter the planned working hours, beyond the planned working days.</td>
</tr>
<tr>
<td>Total Planned Working Days</td>
<td>The Planned Working Days plus the Planned Working Hours.</td>
</tr>
<tr>
<td>Planned Cost</td>
<td>Enter the estimated cost for completing the task. By default the UOM is US</td>
</tr>
<tr>
<td>Estimated</td>
<td>Select this check box if the project cost is not final and can be modified</td>
</tr>
<tr>
<td></td>
<td>by the approver.</td>
</tr>
</tbody>
</table>

### Actual Section

This section provides the actual date and cost details regarding the Work Task record being created.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Start</td>
<td>Use the Calendar icon to select the actual start date and time.</td>
</tr>
<tr>
<td>Actual End</td>
<td>Use the Calendar icon to select the actual end date and time.</td>
</tr>
<tr>
<td>Actual Duration</td>
<td>The actual duration in days, months or years.</td>
</tr>
<tr>
<td>E. Actual Working Days</td>
<td>Enter the actual working days.</td>
</tr>
<tr>
<td>F. Actual Working Hours</td>
<td>Enter the actual working hours, beyond the actual working days.</td>
</tr>
<tr>
<td>Total Actual Working Days</td>
<td>The Actual Working Days plus the Actual Working Hours.</td>
</tr>
<tr>
<td>Actual Percent Complete</td>
<td>Enter the actual percentage of work completed from the start date of the</td>
</tr>
<tr>
<td></td>
<td>Work Task.</td>
</tr>
</tbody>
</table>

© Copyright IBM Corporation 2011, 2013.
### Actual Section

**Actual Cost**
- Enter the actual cost incurred by the organization in getting the work done. By default, the UOM is **US Dollars**.

### Cost Summary Section

In this section, the system displays the various cost-related data from any inventory, purchase order, service provider and/or invoice records associated to this *Work Task* record.

### Accounting Section

- **Labor Account Code**: Use the *Search* icon to specify the Labor Account Code for this *Work Task* record.
- **Material Account Code**: Use the *Search* icon to specify the Material Account Code for this *Work Task* record.
- **Service Provider Account Code**: Use the *Search* icon to specify the Service Provider Account Code for this *Work Task* record.

### Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Draft</strong></td>
<td>Click the <em>Create Draft</em> action to save all initial data entered in the new record. The system changes the status of the record to <em>Draft</em> and displays additional actions on the Action bar. The actions include <em>Activate</em>, <em>Save</em>, <em>Save &amp; Close</em>, <em>More</em>, <em>Copy</em>, <em>Delete</em>, and X (Cancel).</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Click the <em>Save</em> action to save the changes made.</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the <em>Save &amp; Close</em> action to save the changes and close the active window.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Note</td>
<td>Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Apply Template</td>
<td>Click the Apply Template action to copy the contents of the selected template to the current record. On clicking the Apply Template action, the system displays a list of templates retrieved from the associated business objects. Select a template and click the OK action. The system copies the contents of the selected template to the current record.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Click the Baseline action to set the dates defined as the Planned Start and Planned End dates as the base date for the task.</td>
</tr>
<tr>
<td>Activate</td>
<td>Click the Activate action to add the record to the active management list. On clicking Activate action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Active. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete action to complete the tasks associated with the record. The system changes the status of the record from Active to Completed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>Re-Open</td>
<td>Click the Re-Open action if the work that was performed is not satisfactory. On clicking the Re-Open action, the system displays a Task ReIssue window. Click the Search icon and select the appropriate Task ReIssue Reason and click Continue.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Close</td>
<td>Click the <strong>Close</strong> action to change the status of the task to <strong>Closed</strong>. Only <strong>Completed</strong> status task can be closed.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the *Resources tab*, *Procedures tab*, *Dependencies tab*, *Advanced tab*, *Notifications tab*, *Notes & Documents tab*, and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.

**Additional Task Details**

**Planned Dates**

The graph item is drawn from the information contained inside the Planned section. Formulas calculate the **Planned End** date by taking the **Planned Start** date and adding the value from the **Planned Duration** field.

The individual that is designated in the Responsible Person section will be responsible for assigning Resources on the next tab. The contact list that is used for this section is for contacts of the Organization identified in the Responsible Organization section.

**Resources**

IBM TRIRIGA allows users to assign multiple sources of various types to each task. Users are able to leverage Portfolio data (Assets, People, Locations, and Organizations) for use as a resource. In addition, users are able to select materials from the Materials List section on the Resource tab.

Tasks can have one or more resources assigned to them. Inside the Gantt section, resource names are displayed to the right of the assigned task.

**Dependencies**

Tasks can have dependencies to other tasks. The dependency relationship will define if the tasks are sequential (with a finish-to-start linkage) or if they can be done in parallel (with a start-to-start linkage).
For example, there might be a Schedule Task called “Design”. This task might have two sub-tasks - as it is an umbrella for the “Design Review” and “Complete Working Drawings” tasks. These umbrella tasks can be created from within the Gantt by selecting the desired tasks and promoting/demoting accordingly.

The Create/Select mode determines whether the Gantt graphics area will allow you to modify or create an object. While in Create mode, the type of task is selected from the Task Type Selection pull down menu.

**Task Types**

Here are the following Task Type definitions and their intended use. Depending upon your established business practices, your specific Task Type list may vary:

- **Condition Assessment Work Task** - The condition assessment process involves inspecting building systems, assets, and locations for maintenance and environmental opportunities. This task is generated as part of the process to coordinate the inspector’s evaluation of submitted building systems, assets, and locations for inspection.

- **Contract Review Task** - Created from a RE data change request. Captures the contract and the description of the contract change. Assigned to the contract’s appropriate contact role.

- **Inspection Task** - Represents an inspection time frame. Intended to be used in capital or facility projects where the inclusive tasks include internal/external inspection activities. Refer to the Inspection Task section.

- **Inventory Count Work Task** - Initiated by the Inventory Manager role to verify actual amounts of inventory for specific locations. Can provide justification for adjusting inventory amounts.

- **Inventory Pick Work Task** - Initiated by the Inventory Manager role. Indicates the type of inventory, specific location, and staging location for pickup by customer.

- **Key Work Task** - User submits a key request to create this key task indicating the requested key ring and appropriate key cut.

- **Material Order Task** - Created to satisfy a request for a specific type and quantity of material. Can be an integration point to inventory or procurement management where the satisfaction of the requested material can be an asset or product obtained through inventory or procurement processes. Initiated from tasks (i.e. maintenance technician needs to request air filter or belt) or from product requests.

- **Punchlist Task** - Part of the Capital Project close-out. Completing a punchlist with included punchlist tasks indicates the item description, responsibility, and duration. When completed, these items (punchlist tasks) indicate that the project is nearing completion. Refer to the Punchlist Task section.

- **Reserve Work Task** - Generated from a room, equipment, or vehicle reservation. Tasks can include room setup, room breakdown, room cleanup, equipment delivery, equipment pickup, vehicle delivery, or vehicle pickup.

- **Schedule Task** - Used as part of a project to assign responsible roles (from the project) for task activities. Not intended to be work or data intensive (i.e. no time entry, material resources, etc.). Created manually in the project or from a project template.

- **Submittal Task** - Created within the project container to represent submittals of drawings, materials, and other content, for approval by the architect/owner. Refer to the Submittal Task section.
• **Work Task** - Work and data intensive tasks coordinating all resources, including people, time entry, materials and costs to complete a request. Intended to be used with move, facility assessment inspection, preventive/corrective maintenance, and many other request types. Work tasks can be the genesis for facility assessment, inventory, procurement, environmental sustainability, time management, and preventive maintenance processes.

---

**Risk Management**

*Risk Management* offers a multi-faceted approach. It transforms the work of monitoring, impact mitigation, and process management by identifying the risk items from across the project in a single, centralized location. Using the historical knowledge base of the past issues, variances, corrective actions, and all other lessons learned, this management tool helps users gain a comprehensive understanding of project risks and enables future planning and mitigation.

Cost, schedule, and quality are the key measurements for any project. There is a distinct relationship between the three criteria; if any one changes (once initially established in the project goals/plan) then the other two are directly impacted. Visually this is represented as the “project triangle”. Geometry tells us that we cannot change one side without impacting the other two.

The IBM TRIRIGA application is therefore structured to provide the tools to define the sides of the triangle, monitor their status, and manage any and all changes to them, while managing the risk of change. Different organizations have varying opinions and approaches to handle risk with respect to their projects. Therefore the tool is flexible and not intended to be applied or used in any one particular manner.

**Risk Links**

*Risk Management* is about optimizing the process with which risks are taken. It has become a critical issue because organizations have recently suffered spectacular losses from risks they never should have taken in the first place.

The Risks links enables you to manage any risks associated with the project. Risks become apparent in the planning stages of a project. By managing these risks, you can increase the chance of project success by identifying, addressing, and eliminating risks before they become threats to the success of the project.

**Accessing the Risk Links**

The Risk links in the Progress page are used to create, manage, and track Risk records.

Use the following procedure to access the Risk links.
To Access the Risk Links

Step 1  To select a project, click the Project Selector icon (beside the Company|Project Toggle) above the Menu Bar. Then select the radio button for a project and click OK.

Step 2  Review the page that appears. The page displays the selected Project and corresponding Project Menu Bar.

Step 3  In the selected project, click Progress to view the Progress page.

Step 4  Review the Progress page that appears.

Risk Item

A Risk Item record refers to a single item that becomes a project liability. In this tab, you can record a single item that is liable to risk. All details regarding the risk item and the resolution that can be taken to avoid such risks are further entered in this tab. This record also enables you to enter the details regarding the approver to whom the record is sent for approval.

Creating a Risk Item Record

Use the following procedure to create a Risk Item record.

To Create a Risk Item Record

Step 1  From the Progress page above, click Risk Item in the Related Links - Capital Project Progress portal section.

Step 2  Review the page that appears. The page displays a list of Risk Item records. Click Add to add a new Risk Item record.

Step 3  Review the form that appears. Specify the details regarding the Risk Item record.

General Tab

<table>
<thead>
<tr>
<th>General Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
</tr>
</tbody>
</table>
| Enter a unique number identifying the Risk Item record being created. 
If this field is left blank, the system automatically generates this number at the time of creating the Risk Item record. |
### General Section

<table>
<thead>
<tr>
<th>Status</th>
<th>The system displays the current status of the <em>Risk Item</em> record being created. This field is a read-only field. The status of the <em>Risk Item</em> is explained below.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>Active</em> - Indicates that the record is active. The system generates this status when the user selects the <strong>Create</strong> action in the Action bar.</td>
</tr>
<tr>
<td>Date</td>
<td>Use the <em>Calendar</em> icon <img src="calendar-icon.png" alt="Calendar" /> to select the date on which the <em>Risk Item</em> record is being created.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a unique name to identify the <em>Risk Item</em> record that is being created.</td>
</tr>
</tbody>
</table>

### Risk Statement Section

Use this section to provide appropriate description regarding the risk item. The details about the risk item may be helpful in exchanging information between users viewing or reviewing a record.

*Note* - Formatting options are also available.

### Risk Detail Section

The *Risk Detail* section enables you to define the granular details about the risk.

<table>
<thead>
<tr>
<th>Risk Category</th>
<th>Use the <em>Search</em> icon <img src="search-icon.png" alt="Search" /> to specify the category to which the risk item belongs. In the search list, the system displays the different types of risk categories such as <em>Construction</em>, <em>Design</em>, and <em>Resource</em> that are defined in the <em>Risk Category</em> business object under <em>Classification hierarchy</em>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Phase</td>
<td>Use the <em>Search</em> icon <img src="search-icon.png" alt="Search" /> to specify the specific project phase in which the risk becomes apparent. In the search list, the system displays the different types of project phase such as <em>Construction</em>, <em>Design</em>, <em>Development</em>, and <em>Procurement</em> that are defined in the <em>Project Phase</em> business object under <em>Classification hierarchy</em>.</td>
</tr>
<tr>
<td>Recommended Action</td>
<td>Use the <em>List</em> icon <img src="list-icon.png" alt="List" /> to mention the recommended action. In the search list, the system displays the different actions that can be performed. They are <em>Accept</em>, <em>Resolved</em>, <em>Mitigate</em>, <em>Research</em>, <em>Transfer</em>, <em>Watch</em>, and <em>Occurred</em> that are defined in the <em>Tools &gt; Lists</em> page.</td>
</tr>
</tbody>
</table>
Risk Detail Section

Latest Review

Use the Calendar icon to select the date on which the risk item was previously reviewed.

Resolution Notes Section

Use this section to provide appropriate description for resolving a risk. The detailed explanation about the risk resolution may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the Risk Item record.

The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Click the Create action to save all initial data entered in the new record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to Active and displays additional actions on the Action bar. The actions include Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

**Note** - Clicking the **Cancel** action without saving the record will erase all the data you have entered in the record.

<table>
<thead>
<tr>
<th>Copy</th>
<th>Click the <strong>Copy</strong> action to create a copy of the selected record.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <strong>Draft</strong> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
</tbody>
</table>

| Delete      | Click the **Delete** action to remove the record permanently from the active management list. |

| More        | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Risk Analysis Tab**

In the **Risk Analysis** tab, you can give details about the level of severity of the risk. This is accomplished by describing the effect of the risk on the cost and schedule of the project. You also can associate the **Schedule Activity** records (in this tab) that will be affected by the risk. The **General** tab contains a **Risk Statement** that gives in depth details about the risk. You can provide much detailed explanation about the risk in the sections of this tab.

**Analysis Section**

**Impact**

The system displays the impact of the risk on the cost and schedule of the project.

Use the **List** icon to specify the severity level. In the search list, the system displays the different levels (such as **Very High, High, Moderate, Low, and Very Low**) that are defined in the **Tools > Lists** page.

**Source**

The system displays the source of risk.

Use the **List** icon to specify the cause or source of risk. In the search list, the system displays the different options (**Both, External, Internal, and Other**) that are defined in the **Tools > Lists** page.
<table>
<thead>
<tr>
<th>Analysis Section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Risk Probability</strong></td>
</tr>
<tr>
<td><strong>Time Frame</strong></td>
</tr>
<tr>
<td><strong>Cost Impact</strong></td>
</tr>
<tr>
<td><strong>Schedule Impact</strong></td>
</tr>
</tbody>
</table>
**Affected Tasks Section**

There may be specific activities that are affected by the risk. These activities would have *Task* records created for them. *Task* records are created in the *Task* page. Using the actions in the section bar, you can associate multiple *Task* records to this section.

Use the **Add** action in the Section bar to add a new *Task* record. The system displays the list of tasks that are impacted due to the risk item. Select the required task you want to add, the system displays the respective window, wherein you can perform the following steps:

- Provide the necessary details.
- Click the **Create** action.

The selected record is added as a line item to this section. You also can use the **Find** action in this section to select the affected tasks. On clicking the **Find** action, the system displays a *Query* window listing the available *Task* records. Select the required task which is affected and click **OK**. The selected record will be displayed as a line item in this section.

Use the **Remove** action to delete the selected line item(s).

**Analysis Comments Section**

Use this section to provide appropriate description regarding the risk analysis. The details about the risk item may be helpful for exchanging information between users viewing or reviewing a record.

- **Note** - Formatting options are also available.

**Mitigation Options Tab**

Mitigation options are created when a risk exists. These mitigation options are used to decrease the possible level of liability or damage created by the risk item. There are four types of mitigation options, which include avoidance, transfer, control, and research.
Avoidance Section

In this section, you can type the ways in which you can avoid the risk item as a means of mitigating possible damages caused by the item. The details about the risk item avoidance may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Transfer Section

In this section, you can type the different ways to transfer the risk item to another entity as a means of mitigating possible damages caused by the item. The details about the risk item transfer may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Control Section

In this section, you can type different ways to control the risk item as a means of mitigating possible damages caused by the item. The details about the risk item control may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Research Section

In this section, you can type any additional research ideas that can be used as a means of mitigating possible damages caused by the item. The details about the research ideas may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
Contingency Plan Tab

A contingency plan is a backup plan that can be used in case of failure of the original plan. In this instance, a risk may result in a failure and ultimately end up as an issue. In this tab, you can type the description for a contingency plan if that failure occurs.

Contingency Section

This section enables you to enter a brief note about the contingency plan that is prepared to solve the crisis. The details regarding the contingency may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Other Tabs

The details about the Notes & Documents tab and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Risk Review

The Risk Review record is used to group Risk Item records together and send them to the distribution list for review. The Risk Review record is also referred to as a package because the risk items are grouped into a single entity. Additionally, You also can associate a Group Meeting record from the Meeting to the Risk Review record. This is done when risk items are discussed in that meeting.

Creating a Risk Review Record

Use the following procedure to create a Risk Review record.

To Create a Risk Review Record

Step 1 From the Progress page above, click Risk Review in the Related Links - Capital Project Progress portal section.

Step 2 Review the page that appears. The page displays a list of Risk Review records. Click Add to add a new Risk Review record.

Step 3 Review the form that appears. Specify the details regarding the Risk Review record.
## General Tab

### General Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td>Enter a unique number identifying the <em>Risk Review</em> record being created. If this field is left blank, the system automatically generates this number at the time of creating the <em>Risk Review</em> record.</td>
</tr>
<tr>
<td><strong>Revision</strong></td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the <strong>Revise</strong> action that is displayed on the Action bar.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>The system displays the current status of the <em>Risk Review</em> record being created. This field is a read-only field. The different statuses of the <em>Risk Review</em> are explained below.</td>
</tr>
</tbody>
</table>

**Draft** - Indicates that the *Risk Review* record is yet to be created. The system generates this status when the user selects the **Create Draft** action in the Action bar.

**Review In Progress** - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the distribution list. The system generates this status on clicking the **Issue** action in the Action bar.

**Issued** - The system automatically changes the record from **Review In Progress** state to **Issued** state when all the members in the distribution list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the *Risk Review* record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

### Note

Each time you revise or modify the record, the value displayed in this field is incremented by one.
### General Section

**Note** - The system generates this status only if the *Response Required* field (in the *Details* section of the *Risk Review* record) is checked.

*Completed* - The system automatically changes the status of the record from *Routing In Progress* to *Completed* state when the contact person in the risk review has responded.

**Note** - If the *Response Required* field is not checked, on clicking the *Complete* action, the system automatically changes the status of the record from *Issued* to *Completed*.

*History* - When the *Risk Review* record is revised, for each revision a copy of the record gets saved in the *History* state.

**Note** - On selecting the *History* option in the *Related Reports* drop-down list (displayed in the *Risk Review* results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the *Calendar* icon to select the date on which the *Risk Review* is created.

**Note** - By default, the system displays the current date in this field.

**Name**

Enter a unique name to identify the *Risk Review* record that is being created.

---

### Details Section

The *Details* section is used to add details about the contact person to whom the *Risk Review* record is sent for his/her response.

**Note** - Use this section only if you require a response for *Risk Review* record.
**Details Section**

**Response Required**

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Home portal (of the To person) the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

**Required By**

Use the Calendar icon to select the date on/before which the response is required.

---

**To Section**

This section provides details about the person to whom the Risk Review record is sent for approval. The information includes the first name, last name, name of the organization, and address regarding the approval person.

**Note** - The record is sent for approval to the person in the To Section only if the Response Required field is checked in the Details section.

**To Look Up**

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

**Note** - Based on the To Look Up selected, the system auto-populates the respective fields such as the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated People record. You also can select a different organization, if required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
</tbody>
</table>
To Section

Organization
Use the Search icon to select the organization to which the contact person belongs. In the search list, the system displays the records that are retrieved from the associated business object in the Organization hierarchy. Select the required organization and click Accept. The details of the selected organization are displayed in the respective fields of this section.

Address
Enter the address of the selected organization.

City
Enter the name of the city where the organization is located.

State/Province
Enter the name of the state/province where the organization is located.

Country
Use the List icon to specify the country in which the organization is located. The system displays all the country names that are defined in the Tools > Lists page.

Zip/Postal Code
Enter the zip/postal code regarding the above address.

Items to be Reviewed Section

The Items to be Reviewed section enables you to associate Risk Item records that should be reviewed by the selected person.

To add a new record to this section, click the Add action in the Section bar. The system displays the Risk Item record in a new window, wherein you can perform the following steps:

- Provide the mandatory details.
- Click the Create action.

A new line item will be added to this section displaying the ID, name, impact, probability, timeframe, last review, risk action, and comment regarding the risk item selected.

You also can use the Find action on the Section bar to select the required risk item for review. A Query window listing all Risk Item records in the Risk page will be displayed. Select the required record and click OK. The selected record is displayed as line item.

Use the Linked Record icon to view and modify the record. Use the Remove action to delete the selected record(s).
Reviewed at the following Meeting Section

This section displays the list of all Meeting Record records that are associated with the Risk Review record.

Use the Find action in the Section bar to select the required Meeting Record record for review. A Query window listing all Meeting Record records in the Meeting page will be displayed. Select the required record and click OK. The details regarding the record are displayed in the respective fields.

Use the Clear action to erase the contents of this section.

Recorded By Section

This section displays the login ID of the current user who is creating the Risk Review record.

The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Copy**    | Click the Copy action to create a copy of the selected record.  
On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required. |
| **Issue**   | Click the Issue action to add the record to the active management list.  
On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire. |
| **Complete**| Click the Complete action to complete the tasks associated with the record.  
On clicking the Complete action, the system changes the status of the record from Issued to Routing In Progress.  
If the Response Required field in the General tab is checked, the record will be sent to the person selected in the To section for his/her response.  
The record appears as an Action item in the To person’s Home portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  
Once the response is sent by the contact person, the system changes the status of the record from Routing In Progress to Completed. |
| **Delete**  | Click the Delete action to remove the record permanently from the active management list. |
| **More**    | Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action. |

**Other Tabs**

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
Permit Management

Permits are required from jurisdictions for performing certain activities such as construction, demolition, installation of elevators, installation of mechanical equipments, road construction, etc. For any construction project, it is imperative to get the permit from the concerned authorities before actually starting the work. Depending upon the jurisdiction, you may be required to get one or more permits.

The Permit links enables you to create customizable permits for the following cases:

- When deconstructing or demolishing a structure as part of a project, you must apply for a Demolition Permit prior to the demolition.
- If an elevator is being used in the project, you must apply for an Elevator Permit prior to elevator installation.
- If a mechanical item, such as heating and air conditioning equipment, is being installed for the project, you must apply for a Mechanical Permit prior to installation.
- If road construction is required for the project, you must apply for a Road Construction Permit prior to construction.

Note - You can add multiple permit applications to the system using the Document Manager.

Prior to the approval of a permit, an inspection may be required. You can create an Inspection Requirement record in the Inspection links that gives details about the exact scope of the inspection. This Inspection Requirement record, in turn, can be associated with the Permit record, so that all the information relating to a permit can be stored in a single location. The forthcoming section provides details about the Permits and their associated business objects.

Permit Links

The Permit links enables you to create, manage, and track the Permit records. After creating permit forms, you can submit them to a notification group for review. After approval, the permit form with the correct data will be submitted to proper authorities for review. The permit can also be printed for submittal to entities that are not contained in the IBM TRIRIGA system.
Accessing the Permit Links

Use the following procedure to access the Permit links.

**To Access the Permit Links**

**Step 1** To select a project, click the *Project Selector* icon (beside the *Company|Project Toggle*) above the *Menu Bar*. Then select the radio button for a project and click *OK*.

**Step 2** Review the page that appears. The page displays the selected Project and corresponding Project *Menu Bar*.

**Step 3** In the selected project, click *Design* to view the *Design page*.

**Step 4** Review the *Design page* that appears.

Permit Application

A *Permit Application* record provides details about the site plan showing the compliance with the zoning by-laws and all set-backs regarding the project. Hence, a permit is a written authorization to build, install, modify, replace, or operate equipment. When the request for permit is approved through the *Permit Application* record, a new *Permit Record* record is created, which can be associated with the other permits such as *Construction Permit*, *Demolition Permit*, etc., used in a project.

Creating a Permit Application Record

Use the following procedure to create a *Permit Application* record.

**To Create a Permit Application Record**

**Step 1** From the *Design page* above, click *Application* in the *Related Links - Capital Project Design* portal section.

**Step 2** Review the page that appears. The page displays a list of *Permit Application* records. Click *Add* to add a new *Permit Application* record.

**Step 3** Review the form that appears. Specify the details regarding the *Permit Application* record.
### General Tab

#### General Section

**ID**

Enter a unique number identifying the *Permit Application* record being created.

If this field is left blank, the system automatically generates this number at the time of creating the *Permit Application* record.

**Revision**

The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the **Revise** action that is displayed on the Action bar.

> **Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one.

**Status**

The system displays the current status of the *Permit Application* record being created. This field is a read-only field. The different statuses of the *Permit Application* are explained below.

- **Draft** - Indicates that the *Permit Application* record is yet to be created. The system generates this status when the user selects the **Create Draft** action in the Action bar.

- **Review In Progress** - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the **Issue** action in the Action bar.

- **Issued** - The system automatically changes the record from **Review In Progress** state to **Issued** state when all the members in the notification list have approved the record.

- **Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

- **Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

- **Routing In Progress** - Indicates that the record is sent to the contact person in the *Permit Application* record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.
### General Section

**Note** - The system generates this status only if the *Response Required* field (in the *Details* section of the *Permit Application* record) is checked.

*Completed* - The system automatically changes the status of the record from *Routing In Progress* to *Completed* state when the contact person in the *Permit Application* record has responded.

**Note** - If the *Response Required* field is not checked, on clicking the *Complete* action, the system automatically changes the status of the record from *Issued* to *Completed*.

*History* - When the *Permit Application* record is revised, for each revision a copy of the record gets saved in the *History* state.

**Note** - On selecting the *History* option in the *Related Reports* drop-down status list (displayed in the *Permit Application* results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the *Calendar* icon to select the date on which the *Permit Application* record is being created.

**Note** - By default, the system displays the current date in this field.

**Name**

Enter a unique name to identify the *Permit Application* record that is being created.

### Details Section

The *Details* section is used to add details about the contact person to whom the *Permit Application* record is sent for his/her response.

**Note** - Use this section only if you require a response for the *Permit Application* record.
## Details Section

### Response Required
Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Home portal of the To person the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

### Required By
Use the Calendar icon to select the date on/before which the response is required.

### Jurisdiction
Use the Search icon to select the jurisdiction for the Permit Application record. In the search list, the system displays all the available jurisdictions (such as Country, Federal, Local/Other, State, etc.) that are defined for the Regulatory Jurisdiction business object in the Classification hierarchy.

### Approved
Use the Calendar icon to select the date on which the response is approved.

### Fee Estimate
Enter the estimated charge for obtaining the requested permit from the concerned authorities.

Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency business object in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

### Fee Actual
Enter the actual fee that is charged by the authorities for sanctioning the requested permit.

Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency business object in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

### Date Submitted
Use the Calendar icon to select the date on which the record is submitted for obtaining the permit.
Details Section

Date Returned
Use the Calendar icon 28 to select the date on which the response is obtained from the concerned authorities.

To Section

This section provides details about the person to whom the Permit Application record is sent for approval.

Note - The record is sent for approval to the person in the To Section only if the Response Required field is checked in the Details section of the current record.

To Look Up
Use the Search icon 29 to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

Note - Based on the person selected, the system auto-populates the fields of this section such as First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the respective record.

First Name
The system displays the first name of the selected person.

Last Name
The system displays the last name of the selected person.

Organization
Use the Search icon 29 to select an organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.

Address
Enter the address details of the selected organization.

City
Enter the name of the city where the selected organization is located.

State/Province
Enter the name of the state/province where the selected organization is located.

Country
Use the List icon 30 to specify the country regarding the address selected in the Address field of the current record. The system displays all the names of the countries that are defined in the Tools > Lists page.
To Section

Zip/Postal Code
Enter the zip/postal code regarding the above address.

From Section

This section provides details about the person to whom the Permit Application record is sent. The information includes the first name, last name, name of the organization, and address regarding the sender.

From Look Up
Use the Search icon to select the person from whom the incoming correspondences (such as mail, letter, fax, courier, etc.) are sent. In the search list, the system displays the available People records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the From Look Up field.

Note - Based on the person selected, the system auto-populates the corresponding First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code fields from the associated record.

First Name
The system displays the first name of the selected person.

Last Name
The system displays the last name of the selected person.

Organization
Use the Search icon to select the organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the associated business object in the Organization hierarchy. Select the required organization and click Accept. The details of the selected organization are displayed in the fields of this section.

Address
Enter the address of the selected organization.

City
Enter the name of the city where the selected organization is located.

State/Province
Enter the name of the state/province where the selected organization is located.

Country
Use the List icon to specify the country regarding the address selected in the Address field of the current record. The system displays all the names of the countries that are defined in the Tools > Lists page.
### From Section

| Zip/Postal Code | Enter the zip/postal code regarding the above address. |

### Reference Section

<table>
<thead>
<tr>
<th>Construction Class</th>
<th>In general, the Permit Application records are categorized into different types based on their construction and utility. The type of permit that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected. Use the Search icon 🌐 to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.</td>
</tr>
<tr>
<td>Section</td>
<td>The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.</td>
</tr>
<tr>
<td>Discipline</td>
<td>Use the Search icon 🌐 to select a specific discipline for the Permit Application record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.</td>
</tr>
<tr>
<td>Work Area</td>
<td>Use the Search icon 🌐 to select a specific work area where the permit is required. On clicking the icon, the system displays a Query window that displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work area will be displayed in this field.</td>
</tr>
</tbody>
</table>
Notes Section

Use this section to provide appropriate description regarding the *Permit Application* record. The details about the permit may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the *Permit Application* record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays Query window that displays a list of available records in the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Copy**    | Click the **Copy** action to create a copy of the selected record.  
  On clicking the **Copy** action, a copy of the record is created (in the *Draft* status) and displayed in the appropriate page wherein the details can be modified as required. |
| **Issue**   | Click the **Issue** action to add the record to the active management list.  
  On clicking **Issue** action, the system changes the status of the record to *Review In Progress* and after all the members in the distribution list have approved the record, the record status becomes *Issued*.  
  The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| **Complete**| Click the **Complete** action to complete the tasks associated with the record.  
  On clicking the **Complete** action, the system changes the status of the record from *Issued* to *Routing In Progress*.  
  If the *Response Required* field in the *General* tab is checked, the record will be sent to the person selected in the *To* section for his/her response. The record appears as an Action item in the *To* person’s *Home* portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  
  Once the response is sent by the contact person, the system changes the status of the record from *Routing In Progress* to *Completed*. |
| **Delete**  | Click the **Delete** action to remove the record permanently from the active management list. |
| **More**    | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Other Tabs**

The details about the *Drawings & Specifications Tab*, *Notifications tab*, *Notes & Documents tab*, and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.
Permit

A Permit Record record is an authorized form used after the approval of the Permit Application record, which provides details about the approval provided by the concerned authorities for constructing or demolishing a building or structure, installing an elevator, or installing the mechanical equipments, etc. Once the Permit Application is approved by the concerned authorities, the Permit Record is created. On creating the Permit Record record, you can associate the same with the different Permit records which is been created in a project.

Creating a Permit Record

Use the following procedure to create a Permit Record record.

To Create a Permit Record

Step 1  From the Design page above, click Record in the Related Links - Capital Project Design portal section.

Step 2  Review the page that appears. The page displays a list of Permit Record records. Click Add to add a new Permit Record.

Step 3  Review the form that appears. Specify the details regarding the Permit Record record.

General Tab

**General Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number identifying the Permit record being created. If this field is left blank, the system automatically generates this number at the time of creating the Permit Record record.</td>
</tr>
<tr>
<td>Status</td>
<td>The system displays the current status of the Permit Record record being created. This field is a read-only field. The status of the Permit Record is explained below.</td>
</tr>
</tbody>
</table>

*Active* - Indicates that the record is active. The system generates this status when the user selects the Create action in the Action bar.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Use the Calendar icon to select the date on which the Permit Record record is being created.</td>
</tr>
</tbody>
</table>

**Note** - By default, the system displays the current date in this field.
General Section

Name
Enter a unique name to identify the Permit Record record that is being created.

Details Section

Actual Fee
Enter the actual cost for the Permit Record which is being created.

Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency business object in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

Permit Type
Use the List icon to select the required permit type. The system displays all the options (such as Construction Permit, Demolition Permit, etc.) that are defined for the Permit Type business object in the Tools > Lists page.

Note – Depending upon the Permit Type selected, the Permit Record details are associated with the respective permit record (in the Permit Record section).

Issue Date
Use the Calendar icon to select the date on which the permit is issued.

Expiration Date
Use the Calendar icon to select the date on which the permit is expired.
Reference Section

Construction Class
In general, all the Permit Record record is categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section
The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

Discipline
Use the Search icon to select a specific discipline for the Permit Record record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

Work Location
Use the Search icon to select a specific work location for the Permit Record record being created. In the Query window, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work area will be displayed in this field.

Permit Application Section

In this section, you can provide details regarding the Permit Application record for which the Permit Record is been created.

Use the Find action in this section to select the required Permit Application record. In the Query window, the system displays a list of the available Permit Application records. Select the required record and click OK. The system auto populates the fields in this section with the information from the selected record.

Use the Clear action to erase the displayed information.
Inspections Section

This section provides details regarding the records that are to be inspected for granting the permit. To associate a new Inspection Task record, use the Add action in the Section bar. The system displays the Inspection Task window, wherein you can perform the following steps:

- Provide the necessary information.
- Click the Create action.

The system displays the added record as a line item in this section.

You also can use the Find action in this section to select the existing Inspection Task records. The system displays the available records in a Query window. Select the required Inspection Task record and click OK. The selected record is displayed in this section as line items.

Use the Remove action to delete the selected line item(s).

Notes Section

Use this section to provide appropriate description regarding the Permit Record record. The details about the permit may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the Permit Record record.

The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.
Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create</strong></td>
<td>Click the Create action to save all initial data entered in the new record. The system changes the status of the record to Active and displays additional actions on the Action bar. The actions include Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window. Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

Other Tabs

The details about the Notes & Documents tab and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
Construction Permit

For any construction project, it is imperative to get the permit from the concerned authorities before actually starting the work. Depending on jurisdiction, you have to get one or more permits.

**Note** - You can add multiple permit applications to the system using the Document Manager.

Using the Construction Permit business object, you can create the actual fields of the permit to create an online form. Since permit forms vary from jurisdiction to jurisdiction, the Construction Permit record does not have, by default, any permit forms created in it.

You can create your own Permit record using the Application tab. Permit authorization frequently requires an inspection. Therefore, you can create an Inspection Requirements record in the Inspection tab in order to define the exact scope of the permit, and then apply it to the Construction Permit record. The Construction Permit record is used to define and consolidate all data relating to the construction permit.

**Creating a Construction Permit Record**

Use the following procedure to create a Construction Permit record.

**To Create a Construction Permit Record**

**Step 1** From the Design page above, click Construction in the Related Links - Capital Project Design portal section.

**Step 2** Review the page that appears. The page displays a list of Construction Permit records. Click Add to add a new Construction Permit record.

**Step 3** Review the form that appears. Specify the details regarding the Construction Permit record.

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>ID</th>
<th>Enter a unique number identifying the Construction Permit record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this field is left blank, the system automatically generates this number at the time of creating the Construction Permit record.</td>
</tr>
</tbody>
</table>
### General Section

**Revision**
The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the **Revise** action that is displayed on the Action bar.

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one.

**Status**
The system displays the current status of the Construction Permit record being created. This field is a read-only field. The different statuses of the Construction Permit are explained below.

- **Draft** - Indicates that the Construction Permit record is yet to be created. The system generates this status when the user selects the **Create Draft** action in the Action bar.

- **Review In Progress** - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the distribution list. The system generates this status on clicking the **Issue** action in the Action bar.

- **Issued** - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.

- **Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

- **Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Unretire or Revise** action in the Action bar.

- **Routing In Progress** - Indicates that the record is sent to the contact person in the Construction Permit record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

**Note** - The system generates this status only if the **Response Required** field (in the Details section of the Construction Permit record) is checked.

- **Completed** - The system automatically changes the status of the record from Routing In Progress to Completed state when the contact person in the Construction Permit record has responded.
General Section

**Note** - If the *Response Required* field is not checked, on clicking the **Complete** action, the system automatically changes the status of the record from **Issued** to **Completed**.

**History** - When the *Construction Permit* record is revised, for each revision a copy of the record gets saved in the *History* state.

**Note** - On selecting the *History* option in the *Related Reports* drop-down status list (displayed in the *Construction Permit* results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the **Calendar** icon to select the date on which the *Construction Permit* record is being created.

**Note** - By default, the system displays the current date in this field.

**Name**

Enter a unique name to identify the *Construction Permit* record that is being created.

Details Section

The *Details* section is used to add details about the contact person to whom the *Construction Permit* record is sent for his/her response.

**Note** - Use this section only if you require a response for *Construction Permit* record.

**Response Required**

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the *To* section.

Only if this field is checked, on clicking the **Complete** action, the record is sent to the *To* person for his/her response. In the *Home* portal of the *To* person the record is displayed as an *Action Item*. The *To* person can send his/her comment by clicking the hyperlinked *Action Item*.

**Required By**

Use the **Calendar** icon to select the date on/before which the response is required.
### Details Section

#### Jurisdiction
Use the Search icon 🕵️ to select the jurisdiction from which the Construction Permit is required. In the search list, the system displays all the available jurisdictions (e.g., Country, Federal, Local/Other, State, etc.) that are defined for the Regulatory Jurisdiction business object in the Classification hierarchy.

#### Approved
Use the Calendar icon 🕒 to select the date on which the response is approved.

#### Fee Estimate
Enter the estimated fee charged by the authorities for sanctioning the Construction Permit.

Use the List icon 📚 to select the currency type that will be used for all the cost related fields. The system displays all the options that are defined for the Currency business object in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

#### Fee Actual
Enter the actual fee that is charged by the jurisdiction authorities for providing the permit.

Use the List icon 📚 to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency business object in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

#### Date Submitted
Use the Calendar icon 🕒 to select the date on which the record is submitted for review.

#### Date Returned
Use the Calendar icon 🕒 to select the date on which the response is returned.
To Section

This section provides details about the person to whom the Construction Permit record is sent for approval. The information includes the first name, last name, name of the organization, and address regarding the approval person.

**Note** - Only if the Response Required field is checked in the Details section, the record is sent for approval to the person in the To Section.

To Look Up

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person's name is displayed in the To Look Up field.

**Note** - Based on the To Look Up selected, the system auto-populates the corresponding First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon to select an organization regarding which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon to specify the country regarding the address. The system displays all the names of the countries that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
From Section

This section provides details about the person from whom the *Incoming Correspondence* record is sent. The information includes the first name, last name, name of the organization, and address regarding the sender.

From Look Up

Use the Search icon \( \text{🔍} \) to select the person from whom the incoming correspondences (such as mail, letter, fax, courier, etc.) are sent. In the search list, the system displays the available People records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click **OK**. The selected person's name is displayed in the *From Look Up* field.

- **Note** - Based on the person selected, the system auto-populates the corresponding fields of this section such as the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon ( \text{🔍} ) to select the organization to which the person selected in the <em>To</em> section belongs. In the search list, the system displays the records that are retrieved from the associated business object in the Organization hierarchy. Select the required organization and click <strong>Accept</strong>. The details of the selected organization are displayed in the fields of this section.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon ( \text{⬇️} ) to specify the country regarding the address. The system displays all the names of the countries that are defined in the <em>Tools &gt; Lists</em> page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
Reference Section

Construction Class

In general, all the Construction Permit record is categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section

The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

Discipline

Use the Search icon to select a specific discipline for the Construction Permit record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

Work Area

Use the Search icon to select a specific work area for which the permit is requested. In the search list, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work area will be displayed in this field.

Notes Section

Use this section to provide appropriate description regarding the Construction Permit record. The details about the construction permit may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
Permit Record Section

Use this section to provide the details regarding the Permit Record record for which the Construction Permit record is been created.

Use the Find action in this section to select the required Permit Record record. In the Query window, the system displays a list of the available Permit Record records. Select the required record and click OK. The system auto populates the fields in this section with the information from the selected record.

Use the Clear action to erase the contents of this section.

Recorded By Section

This section displays the login ID of the current user who is creating the Construction Permit record.

The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete action to complete the tasks associated with the record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the Complete action, the system changes the status of the record from Issued to Routing In Progress.</td>
</tr>
<tr>
<td></td>
<td>If the Response Required field in the General tab is checked, the record will be sent to the person selected in the To section for his/her response. The record appears as an Action item in the To person’s Home portal. The selected person can add the response by clicking the hyperlinked text of the Action item.</td>
</tr>
<tr>
<td></td>
<td>Once the response is sent by the contact person, the system changes the status of the record from Routing In Progress to Completed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>
**Application Tab**

By completing the information contained in the Application tab, you can create an online application that can be used for projects requiring various permits. By default, the application does not contain any fields, which enables you to design your own application by adding the fields that you need. This section lacks fields because the terms and clauses that are required for obtaining the permit vary based on jurisdiction. When the fields are added and the permit application is complete, you can send the application to the individuals in the notification list.

**Inspections Tab**

Frequently, an inspection is required in order for a permit to be issued. The Inspection tab enables you to associate an Inspection Task record to the Permit record.

**Inspection Requirement Section**

The Inspection Requirement section displays the list of all the Inspection Task record that is associated with the Construction Permit record.

Use the Add action in the Section bar to add the records to the Inspection Requirement section. On clicking the Add action the system displays the Inspection Task window, wherein you can perform the following steps:

- Provide the necessary information.
- Click the Create action.

The system displays the added record as a line item.

You also can use the Find action in this section to select the existing Inspection Task records. The system displays the available records in a Query window. Select the required Inspection Task record and click OK. The selected record is displayed in this section as line items.

Use the Remove action to delete the selected line item(s).

**Other Tabs**

The details about the Drawings & Specifications Tab, Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
Demolition Permit

For any demolition project, it is imperative to get the permit from the concerned authorities before actually starting the destruction work. Depending on jurisdiction, you have to get one or more permits.

All the specifications regarding this record are same as the Construction Permit record.

Elevator Permit

If elevators are to be used in constructions, you have to get prior permit from the concerned authorities. Depending upon the jurisdiction, you have to get one or more permits.

All the specifications regarding this record are same as the Construction Permit record.

Mechanical Permit

Mechanical equipments such as heating and air conditioning systems may be installed for the project. This requires you to apply for a Mechanical Permit prior to installation. Depending on the jurisdiction, you have to get one or more permits.

All the specifications regarding this record are same as the Construction Permit record.

Road Construction Permit

Sometimes road construction or modifications to a specific road may be required for the project, for which you must apply for a Road Construction Permit. Depending on the jurisdiction, you have to get one or more permits.

All the specifications regarding this record are same as the Construction Permit record.
5. Tracking Projects

Project Tracking Tools

In Project Management process, tracking a project involves recording all types of correspondence which includes the transmittals, minutes of the meeting, etc. This chapter details the process of creating, tracking, and managing the aforesaid tracking objects. All the parties involved as well as their actions are documented for accountability. Response times and requirements are automatically tracked and monitored to help expedite critical matters. Project administration is designed to automate and centralize the traditionally manual tasks involved in project administration.

The following diagram depicts the various elements involved in tracking projects:

![Diagram of tracking projects](image-url)

**Elements involved in tracking projects**

- Checklist
  - Contract Award
  - Project Review
  - Site Review
- Meeting
  - Meeting Item
  - Meeting Record
  - Meeting Series
- Correspondence
  - Accident Report
  - Safety Notice
  - Conversation Record
  - Field Instruction
  - Incoming
  - Outgoing
  - Transmittal
  - Notice to Comply
- Daily Journal
  - Daily Details
  - Daily Events
  - Daily Journal
- Inspections
  - Punchlist Task
  - Punchlist
  - Inspection Task
  - Quality Assurance Plan
- Issue and Change
  - Issue Item
  - Potential Change
- Progress Report
  - Project Report
  - Contract Report

**Note** - While the diagram above depicts a general flow, the specific activities represented above can happen anytime within the scope of the project.

**Checklist**

The Checklists links enable you to review and evaluate various stages of a project and monitor the activities at the project site. These links also enable you to set milestones to determine whether the project is financially on track and adheres to the scheduled dates and scope. If there is a significant change in any of these, then adjustments can be made accordingly.
Meeting

The Meetings links enable you to track all the meetings regarding the project that are conducted periodically. These links also enable you to record all the meeting events and details about the attendees.

Correspondence

The Correspondence links enable you to track the details regarding the communication that exists between two or more persons who are using the telephone for conversation. These links also enable you to record all the information that includes the conversation time, date, and number of participants. The Transmit business object details about all the information regarding the conversation, if the communication exists between the transmitter and sender through email or fax.

Daily Journal

The Daily Journal links enable you to track day-to-day events that are happening at the project site. The information includes the different people visiting the project site, weather forecast for each day, and cost code and financial details regarding each activity that is scheduled for the day.

Issue and Change

The Issue and Change links enable you to identify and resolve all the problems that exist within the project. These links also provide elaborate details about the communication that exists between the individuals who are working on the problem and potential changes that is stemming from the issues and the corresponding resolution.

Inspections

The Inspection links enable you to scrutinize periodically the various developments that are taking place in the project. With these links, you can examine the various tasks that are performed for the project in order to ensure that the project activities are happening on the right track.

Progress Reports

The Progress Reports links provide access to continual updates of the project or certain tasks involved in the project. Thus, these links act as the last step towards tracking the projects.

More Details

Additional details regarding Checklist, Meeting, Correspondence,
Daily Journal, Issue and Change, Inspections, and
Progress Reports are explained in the following sections. Click the respective hyperlinks to read the information.

Checklist

The checklists help reviewers to make a fair assessment and approval of the project. The Checklists links enable you to verify all the specifications regarding the project. The Project Manager role can use this checklist to ensure that the bid (proposal) selected for a specific contract follows certain standards. These links are also used during the project closeout to ensure that all aspects of the project are completed. Using this checklist, the Project Manager role will be able to walk through the site in order to determine whether the project is running smoothly based on the questions and answers that are mentioned in the checklist.

Business Objects

The Checklists links are organized based on the contract, project, and site review. This module comprises of the following business objects:

- Closeout Checklist
- Contract Award Checklist
- Project Review Checklist
- Site Review Checklist

The Project Manager role uses the Contract Award Checklist record to ensure that bids that generate a contract follow the defined standards. While reviewing a bid, the Project Manager role can simultaneously review the checklist. If the bid follows the desired specifications from the checklist, then it can be awarded. If not, the bid can be rejected. Additionally, the Project Manager role can use the Contract Award record after the contract has been awarded to ensure that the vendor is following the specifications set forth for the project.

The Project Review Checklist record is used during the project closeout to ensure that various aspects of the project have been completed. For example, all financials or scheduled activities must be completed per the specification in order for the project to be complete. The record also can be used at certain milestones to determine if the project is financially on track and adheres to the schedule and scope. If there is a change in any of these, then adjustments can be made accordingly.

The Site Review Checklist record is used to ensure that the activities on the project site meet jurisdictional or environmental codes, or other specifications set forth in the project plan. The Project Manager role will be able to walk through the site and determine if the project is running smoothly and according to plan based on the answers to the questions in the checklist. The checklists are completely customizable and can be changed based on the project.

The Closeout Checklist record is used for closing projects. The checklist prepared here is used to check whether the items are completed before the project formally closes.
Accessing the Checklists Links

The Checklists links enable you to create, manage, and track the records. You also can organize the records by business objects, reports, construction class, or discipline.

Use the following procedure to access the Checklists links.

<table>
<thead>
<tr>
<th>To Access the Checklists Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
</tr>
<tr>
<td>Step 2</td>
</tr>
<tr>
<td>Step 3</td>
</tr>
<tr>
<td>Step 4</td>
</tr>
<tr>
<td>Step 5</td>
</tr>
</tbody>
</table>

In general, the above Checklists links enable you to manage records. The various activities involved in managing records are explained below.

Contract Award Checklist

The Project Manager role uses the Contract Award Checklist record in order to ensure that a bid is selected for the contract and it follows certain standards. While reviewing a bid, the Project Manager role can simultaneously review the checklist. If the bid follows the desired specifications from the checklist, then it can be awarded, else the bid can be rejected. Additionally, the Project Manager role can use the Contract Award Checklist record after the contract is awarded, in order to make sure that the vendor is following the defined specifications.

Creating a Contract Award Checklist Record

Use the following procedure to create a Contract Award Checklist record.

<table>
<thead>
<tr>
<th>To Create a Contract Award Checklist Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
</tr>
<tr>
<td>Step 2</td>
</tr>
<tr>
<td>Step 3</td>
</tr>
</tbody>
</table>
### General Tab

#### General Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number to identify the <em>Contract Award Checklist</em> record being created. If this field is left blank, the system automatically generates this number at the time of creating the <em>Contract Award Checklist</em> record.</td>
</tr>
</tbody>
</table>
| Revision | The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the **Revise** action that is displayed on the Action bar.  

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one. |
General Section

Status

The system displays the current status of the Contract Award Checklist record being created. This field is a read-only field. The different statuses of the Contract Award Checklist are explained below.

**Draft** - Indicates that the Contract Award Checklist record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

**Review In Progress** - Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.

**Issued** - Indicates that the record is active. The system automatically changes the status of the record to Issued after all the members in the notification list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

**Completed** - Indicates that the record is being processed and all the tasks associated with the record is complete. The system generates this status when the user selects the Complete action in the Action bar.

**History** - When the Contract Award Checklist record is revised, for each revision a copy of the record gets saved in the History state.

Note - On selecting the History option in the Related Reports drop-down status list (displayed in the Contract Award Checklist results page), the system retrieves and displays all the records that are revised at different stages.

Date

Use the Calendar icon to select the date on which the Contract Award Checklist record is created.

Note - By default, the system displays the current date in this field.

Name

Enter a unique name to identify the Contract Award Checklist record that is being created.
Contract Section

This section enables you to provide information about the associated contract. You can associate only one *Contract* record to this section.

Use the **Find** action in this section to select the required contract. A *Query* window listing the available *Contract* records will appear. Select the required *Contract* record and click **OK**. The system auto populates the ID and contract name fields with the information from the selected record. On clicking the hyperlinked text fields, you can view/modify the associated contract details.

Use the **Clear** action to erase the displayed information.

Reference Section

**Construction Class**

In general, all the *Contract Award Checklist* records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in *CSI - Construction Class* that is selected.

Use the **Search** icon to select the construction class. The system displays the available construction classes (e.g., *General Requirements*, *Masonry*, etc.) that are retrieved from the *CSI-Construction Class* business object in the *Classification hierarchy*.

**Note** - *CSI* (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

**Section**

The *Section* field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

**Discipline**

Use the **Search** icon to select a specific discipline for the *Contract Award Checklist* record being created. In the search list, the system retrieves the available disciplines (such as *Architectural*, *Civil*, *Equipment*, etc.) from the *Project* business object in the *Classification hierarchy*.

**Work Location**

Use the **Search** icon to select a specific work location for the *Contract Award Checklist* record being created. In the *Query* window, the system displays the list of available records that are retrieved from the *Space* business object in the *Location hierarchy*. Select the required location and click **OK**. The selected work location will be displayed in this field.
1.0 Pre-solicitation Section

In this section, you can provide answers regarding the pre-solicitation of a contract.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

2.0 Solicitation Section

In this section, you can provide answers regarding the solicitation of a contract before the contract is confirmed.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

3.0 Evaluation Section

In this section, you can provide answers regarding the evaluation of the contract.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

4.0 Negotiation Section

In this section, you can provide answers about the negotiations that were made regarding the contract.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.
5.0 Award Section

In this section, you can provide answers regarding awarding the contract.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

6.0 Recorded By Section

This section displays the login ID of the current user who is creating the Contract Award Checklist record. The Search icon in this section allows you to select a different user ID, if required. On clicking the Search icon, the system displays a Query window that displays the list of available records in the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

**Note** - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Copy**    | Click the **Copy** action to create a copy of the selected record.  
On clicking the **Copy** action, a copy of the record is created (in the **Draft** status) and displayed in the appropriate page wherein the details can be modified as required. |
| **Issue**   | Click the **Issue** action to add the record to the active management list.  
On clicking **Issue** action, the system changes the status of the record to **Review In Progress** and after all the members in the distribution list have approved the record, the record status becomes **Issued**.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| **Complete**| Click the **Complete** action to complete the tasks associated with the record.  
On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Completed**. |
| **Delete**  | Click the **Delete** action to remove the record permanently from the active management list. |
| **More**    | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Other Tabs**

The details about the **Notifications tab**, **Notes & Documents tab**, and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.

**Project Review Checklist**

The **Project Review Checklist** record is used before the project closeout to ensure that all aspects of project have been completed. For example, all financial or scheduled activities must be completed according to the specifications in order to complete the project successfully. This record can also be used at different milestones to determine whether the project is financially in track and it adheres to the schedule and scope. If there is change in any of these, then adjustments are made accordingly.
Creating a Project Review Checklist Record

Use the following procedure to create a Project Review Checklist record.

To Create a Project Review Checklist Record

**Step 1** From the Progress page above, click Checklists > Project Review in the Related Links - Capital Project Progress portal section.

**Step 2** Review the page that appears. The page displays a list of Project Review Checklist records. Click Add to add a new Project Review Checklist record.

**Step 3** Review the form that appears. Specify the details regarding the Project Review Checklist record.

General Tab

**General Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number to identify the Project Review Checklist record being created. If this field is left blank, the system automatically generates this number at the time of creating the Project Review Checklist record.</td>
</tr>
<tr>
<td>Revision</td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar. Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.</td>
</tr>
<tr>
<td>Status</td>
<td>The system displays the current status of the Project Review Checklist record being created. This field is a read-only field. The different statuses of the Project Review Checklist are explained below. Draft - Indicates that the Project Review Checklist record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar. Review In Progress - Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar. Issued - Indicates that the record is active. The system automatically changes the status of the record to Issued after all the members in the notification list have approved it.</td>
</tr>
</tbody>
</table>
### General Section

notification list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Unretire** or **Revise** action in the Action bar.

**Completed** - Indicates that the record is being processed and all the tasks associated with the record is completed. The system generates this status when the user selects the **Complete** action in the Action bar.

**History** - When the **Project Review Checklist** record is revised, for each revision a copy of the record gets saved in the **History** state.

#### Date

Use the **Calendar** icon to select the date on which the **Project Review Checklist** record is being created.

#### Name

Enter a unique name to identify the **Project Review Checklist** record being created.
## Reference Section

### Construction Class
In general, all the Project Review Checklist records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon 🕵️‍♂️ to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

**Note** - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

### Section
The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

### Discipline
Use the Search icon 🕵️‍♂️ to select a specific discipline for the Project Review Checklist record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

### Work Location
Use the Search icon 🕵️‍♂️ to select a specific work location for the Project Review Checklist record being created. In the Query window, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

## Project Management Section

In this section, you can provide answers regarding the management of the project.

Use the List icon 🕵️‍♂️ to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.
Quality Control/Assurance Section

In this section, you can provide answers regarding the quality control/assurance of the project.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Client Section

In this section, you can provide answers regarding the project client.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Project Scope Section

In this section, you can provide answers regarding the scope of the project.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Project Schedule Section

In this section, you can provide answers regarding the project schedule.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.
Project Financials Section

In this section, you can provide answers regarding the project finance.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Contract Section

In this section, you can provide answers regarding the project contract.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Recorded By Section

This section displays the login ID of the current user who is creating the Project Review Checklist record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list. On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete action to complete the tasks associated with the record. On clicking the Complete action, the system changes the status of the record from Issued to Completed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
Site Review Checklist

The *Site Review* record enables you to ensure that all the activities regarding the project site meet the required jurisdictional or environmental codes, or other specifications that are set forth in the project plan. The Project Manager role will be able to walk through the site and determine whether the project is running smoothly and according to plan, based on the answers to the questions in this checklist.

Creating a Site Review Checklist Record

Use the following procedure to create a *Site Review Checklist* record.

<table>
<thead>
<tr>
<th>To Create a Site Review Checklist Record</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
</tr>
</tbody>
</table>

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>ID</th>
<th>Enter a unique number to identify the <em>Site Review Checklist</em> record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this field is left blank, the system automatically generates this number at the time of creating the <em>Site Review Checklist</em> record.</td>
</tr>
</tbody>
</table>

| Revision | The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the *Revise* action that is displayed on the Action bar. |

*Note* - Each time you revise or modify the record, the value displayed in this field is incremented by one.
### General Section

**Status**

The system displays the current status of the *Site Review Checklist* record being created. This field is a read-only field. The different statuses of the *Site Review Checklist* are explained below.

**Draft** - Indicates that the *Site Review Checklist* record is yet to be created. The system generates this status when the user selects the **Create Draft** action in the Action bar.

**Review In Progress** - Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the **Issue** action in the Action bar.

**Issued** - Indicates that the record is active. The system automatically changes the status of the record to **Issued** after all the members in the notification list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

**Completed** - Indicates that the record is being processed and all the tasks associated with the record is completed. The system generates this status when the user selects the **Complete** action in the Action bar.

**History** - When the *Site Review Checklist* record is revised, for each revision a copy of the record gets saved in the **History** state.

**Note** - On selecting the **History** option in the Related Reports drop-down status list (displayed in the *Site Review Checklist* results page), the system retrieves and displays all the records that are revised at different stages.

### Date

Use the *Calendar* icon to select the date on which the *Site Review Checklist* record is been created.

**Note** - By default, the system displays the current date in this field.

### Name

Enter a unique name to identify the *Site Review Checklist* record being created.
Reference Section

Construction Class
In general, all the Site Review Checklist records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI - Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section
The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

Discipline
Use the Search icon to select a specific discipline for the Site Review Checklist record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

Work Location
Use the Search icon to select a specific work location for the Site Review Checklist record being created. In the Query window, the system displays a list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

Job Information Section

In this section, you can provide the answers regarding the type of job that is undertaken.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.
House Keeping Section

In this section, you can provide the answers regarding all housekeeping queries in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Fire Prevention Section

In this section, you can provide the answers regarding fire prevention in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Electrical Section

In this section, you can provide the answers regarding queries related with electricity in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Hand, Power & Powder Actuated Tools Section

In this section, you can provide the answers regarding the hand, power, and powder-actuated tools used in the project.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.
Ladder Section

In this section, you can provide the answers regarding the use of ladders in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Scaffolding Section

In this section, you can provide the answers regarding the erection of poles and planks in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Floor and Wall Openings Section

In this section, you can provide the answers regarding floor and wall openings in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Trenchers, Excavations & Shoring Section

In this section, you can provide the answers regarding the trenches, excavations, and/or shoring activities undertaken in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.
Material Handling Section

In this section, you can provide the answers regarding the handling of materials in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Welding & Burning Section

In this section, you can provide the answers regarding the welding and burning activities undertaken in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Cranes Section

In this section, you can provide the answers regarding the use of cranes in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Concrete Construction Section

In this section, you can provide the answers regarding construction with concrete in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.
Personal Protection Equipment Section

In this section, you can provide the answers regarding the use of personal protection equipment in the project site.

Use the List icon to select a specific option for the questions in this section. In the search list, the system displays the available options such as Yes/No that is defined in the Tools > Lists page.

Provide a brief description in the Comment field regarding the option selected.

Recorded By Section

This section displays the login ID of the current user who is creating the Site Review Checklist record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Copy**    | Click the **Copy** action to create a copy of the selected record.  
On clicking the **Copy** action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required. |
| **Issue**   | Click the **Issue** action to add the record to the active management list.  
On clicking **Issue** action, the system changes the status of the record to **Review In Progress** and after all the members in the distribution list have approved the record, the record status becomes **Issued**.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| **Complete**| Click the **Complete** action to complete the tasks associated with the record.  
On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Completed**. |
| **Delete**  | Click the **Delete** action to remove the record permanently from the active management list. |
| **More**    | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Other Tabs**

The details about the **Notifications tab**, **Notes & Documents tab**, and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.
Closeout Checklist

To close the project properly, the Project Manager role needs to ask a few questions. The project closure checklist will remind him/her of the items that need to be completed before the project formally closes.

Creating a Closeout Checklist Record

Use the following procedure to create a Closeout Checklist record.

To Create a Closeout Checklist Record

Step 1 From the Progress page above, click Checklists > Closeout in the Related Links - Capital Project Progress portal section.

Step 2 Review the page that appears. The page displays a list of Closeout Checklist records. Click Add to add a new Closeout Checklist record.

Step 3 Review the form that appears. Specify the details regarding the Closeout Checklist record.

General Tab

General Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number identifying the Closeout Checklist record being created. If this field is left blank, the system automatically generates this number at the time of creating the Contract Award Checklist record.</td>
</tr>
<tr>
<td>Revision</td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar. Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.</td>
</tr>
<tr>
<td>Status</td>
<td>The system displays the current status of the Closeout Checklist record being created. This field is a read-only field. The different statuses of the Closeout Checklist are explained below. Draft - Indicates that the Closeout Checklist record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.</td>
</tr>
</tbody>
</table>
### General Section

**Review In Progress** - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the **Issue** action in the Action bar.

**Issued** - The system automatically changes the record from **Review In Progress** state to **Issued** state when all the members in the notification list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

**Completed** - Indicates that the record is being processed and all the tasks associated with the record is completed. The system generates this status when the user selects the **Complete** action in the Action bar.

**History** - When the **Closeout Checklist** record is revised, for each revision a copy of the record gets saved in the **History** state.

---

**Date**

Use the **Calendar** icon to select the date on which the **Closeout Checklist** record is created.

**Note** - By default, the system displays the current date in this field.

---

**Name**

Enter a name for the **Closeout Checklist** record being created.
Checklist Items Section

This section is initially populated with the items in the Closeout Checklist Template.

To respond to the questions in the checklist, in Checklist Response, click the Search icon and select from the survey response choices.

To clear a response, click the Clear icon. Note any Comments in the text box.

Recorded By Section

This section displays the login ID of the current user who is creating the Closeout Checklist record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record. On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <strong>Draft</strong> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Issue</strong></td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list. On clicking the <strong>Issue</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Issued</strong>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td><strong>Complete</strong></td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record. On clicking the <strong>Complete</strong> action, the system changes the status of the record from <strong>Issued</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the **Notifications tab** and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.

**Meeting**

Meetings are the most important proceedings for tracking any project. Starting with planning details, (such as cost, risk, schedule, etc.) all the important aspects can be discussed in meetings. Recording of meeting minutes is also imperative so that they can be used for future reference.
Business Objects

Meetings are important proceedings for tracking various activities involved in a project. By conducting meetings periodically, you can track the project planning activity, cost code details, project schedule, and various risks involved in the project. This module comprises of the following business objects:

- **Meeting Item**
- **Meeting Record**
- **Meeting Series**

The **Meeting Item** refers to the elements that have occurred within or are specified for a meeting. There can be many meeting items contained in a **Meeting record**.

The **Meeting Record** is the actual record describing the events of the meeting, including the meeting items covered, attendees, discussions and outcome. It is a detailed record that provides information about the meeting.

The **Meeting Series** organizes certain **Meeting** records into groups for easy access. For example, if there are three weekly meetings that are similar, or they fall into a certain category, they can be grouped into a meeting series. Additionally, certain specifications, such as time or date can apply to a series. When the series is associated with a **Meeting** record, those specifications will be automatically set to the new record.

Accessing the Meetings Links

The **Meetings** links enable you to create, manage, and track the **Meeting** records. You also can organize the records by business objects, reports, construction class, or discipline.

Use the following procedure to access the **Meetings** links.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>To select a project, click the <strong>Project Selector</strong> icon (beside the **Company</td>
</tr>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays the selected Project and corresponding Project <strong>Menu Bar</strong>.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the selected project, click <strong>Progress</strong> to view the <strong>Progress page</strong>.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Review the <strong>Progress page</strong> that appears.</td>
</tr>
<tr>
<td>Step 5</td>
<td>From the <strong>Progress page</strong> above, access the <strong>Meetings</strong> links in the <strong>Related Links - Capital Project Progress</strong> portal section.</td>
</tr>
</tbody>
</table>
**Meeting Item**

The *Meeting Item* record provides details about the meeting, including individual elements that are discussed or reviewed in a *Meeting* record. Meeting items are associated with *Meeting* records. For example, in a specific meeting, a topic of discussion may be electrical issues. A *Meeting Item* record can be created that provides details about the electrical issues discussed in the meeting.

**Creating a Meeting Item Record**

Use the following procedure to create a *Meeting Item* record.

<table>
<thead>
<tr>
<th>To Create a Meeting Item Record</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
</tr>
</tbody>
</table>

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>ID</th>
<th>Enter a unique number to identify the <em>Meeting Item</em> record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this field is left blank, the system automatically generates this number</td>
</tr>
<tr>
<td></td>
<td>at the time of creating the <em>Meeting Item</em> record.</td>
</tr>
</tbody>
</table>

| Status | The system displays the current status of the *Meeting Item* record being |
|        | created. This field is a read-only field. The status of the *Meeting Item* is |
|        | explained below. |
|        | *Active* - Indicates that the record is active. The system generates this |
|        | status when the user selects the **Create** action in the Action bar. |

| Name | Enter a name for the *Meeting Item* record being created. |
### Details Section

**Topic List**

Enter the list of topics (subject matter of a conversation or discussion) discussed in the meeting.

Use the *List* icon to specify the topic list. The system displays all the available topics (such as *Cost*, *Labor*, *Material*, and *Schedule*) that are defined in the *Tools > Lists* page.

**Closed**

Select the check box to represent the closure of the meeting item (topic) that was discussed in the meeting.

**Required Date**

Use the *Calendar* icon to select the required start date of the meeting.

**Completed Date**

Use the *Calendar* icon to select the completed date of the meeting.

### Discussion Section

Use this section to provide appropriate description regarding the *Meeting Item* record being created. The details about the discussion in the meeting may be helpful for exchanging information between users viewing or reviewing a record.

> **Note** - Formatting options are also available.

### Responsible Party Section

**Responsible Party Look up**

Use the *Search* icon to select the responsible party (person) who convenes the meeting for which the *Meeting Item* record is being created. In the *Query* window, the system displays the available *External Contact* records in the *People* page. Select the required record and click *OK*. The selected record is displayed.

> **Note** - Based on the person selected, the system auto-populates the fields of this section such as the *First Name* and *Last Name* from the associated record.

**First Name**

Enter the first name of the selected person.

**Last Name**

Enter the last name of the selected person.
Recorded By Section

This section displays the login ID of the current user who is creating the Meeting Item record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Click the Create action to save all initial data entered in the new record. The system changes the status of the record to Active and displays additional actions on the Action bar. The actions include Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Note: Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>
**Other Tabs**

The details about the *Notes & Documents tab* and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.

---

**Meeting Record**

The *Meeting Record* consists of all information regarding a meeting. It includes the attendees of the meeting, meeting time, place, and meeting items that are selected for discussion. The meeting items are associated with a *Meeting Record* as the items are discussed or reviewed in the meeting. Any issue regarding a meeting item that is not resolved in one meeting can be passed to another meeting. The details that were discussed in the subsequent meetings regarding the same meeting item are recorded in the respective *Meeting Record* records. The history of a meeting item in various *Meeting Record* records is displayed in the *History* tab of the *Meeting Item* record.

Often, there are many meetings that are similar, meaning that the topic of discussion in the meetings is a recurring task or theme. In that case, you can associate a *Meeting Series* to the *Meeting Record*. In the case of *Meeting Record(s)* that are associated with the meeting series, the data from the fields in the meeting series auto-populate the fields of the corresponding *Meeting Record(s)*. For example, you can create a *Meeting Series* that contains specific information about a project. Any time a meeting relating to that project arises, you can associate the *Meeting Series* record to it, in order to save the time and energy required to manually enter the data directly into the *Meeting Record* records related to that project.

---

**Creating a Meeting Record**

Use the following procedure to create a *Meeting Record* record.

<table>
<thead>
<tr>
<th><strong>To Create a Meeting Record</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
</tr>
</tbody>
</table>
**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number to identify the <em>Meeting Record</em> record being created. If this field is left blank, the system automatically generates this number at the time of creating the <em>Meeting Record</em> record.</td>
</tr>
</tbody>
</table>
| Revision  | The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the **Revise** action that is displayed on the Action bar.  

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one. |
| Status    | The system displays the current status of the *Meeting Record* record being created. This field is a read-only field. The different statuses of the *Meeting Record* are explained below.  

*Draft* - Indicates that the *Meeting Record* record is yet to be created. The system generates this status when the user selects the **Create Draft** action in the Action bar.  

*Review In Progress* - Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the **Issue** action in the Action bar.  

*Issued* - Indicates that the record is active. The system automatically changes the status of the record to *Issued* after all the members in the notification list have approved the record.  

*Retired* - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.  

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.  

*Completed* - Indicates that the record is being processed and all the tasks associated with the record is completed. The system generates this status when the user selects the **Complete** action in the Action bar.  

*History* - When the *Meeting Record* record is revised, for each revision a copy of the record gets saved in the *History* state. |
### General Section

**Note** - On selecting the *History* option in the *Related Reports* drop-down status list (displayed in the *Meeting Record* results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the *Calendar* icon to select the date on which the *Meeting Record* record is being created.

**Note** - By default, the system displays the current date in this field.

**Name**

Enter a unique name for the *Meeting Record* record being created.

### Meeting Series Section

In this section, you can organize *Meeting Record* records into groups, for users to easily access them. The *Meeting Series* section displays the series with which the *Meeting Record* record is associated (if any).

**Note** - The actions in the section bar are enabled once you click the *Create Draft* action in the Action bar.

Use the *Find* action in this section bar to select the desired meeting series. A *Query* window listing the available *Meeting Series* records will appear. Select the required *Meeting Series* record and click *OK*. The ID, status, and name field are auto populated in the *Meeting Series* Section.

Use the *Clear* action to erase the displayed information.

### Details Section

This section displays the details regarding the schedule of the *Meeting Record*.

**Start**

Use the *Calendar* icon to enter the start date and time of the meeting.

**Finish**

The system displays the end date and time of the meeting.

**Note** - The value is generated by system based on the time calculated between the start time and event duration.
### Details Section

**Event Duration**

Use the *Calendar* icon to enter the duration of the meeting in year(s)/Month(s)/week(s)/days(s)/hour(s)/minutes(s)/second(s).

**Next Meeting**

Use the *Calendar* icon to enter the date and time for the next meeting which is planned.

### Meeting Location Section

**Meeting Location Lookup**

Use the *Search* icon to select the location for conducting the meeting. In the *Query* window, the system displays the available *Building*, *Retail Location*, and *Structure* records in the *Location hierarchy*. Select the required record and click **OK**. The selected record is displayed. Click the hyperlinked text field to view the details regarding the location.

**Note** - Based on the *Meeting Location Lookup* selected, the system auto-populates the respective fields such as *Address*, *City*, *State/Province*, *Country*, and *Zip/Postal Code* from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address</strong></td>
<td>Enter the address regarding the location.</td>
</tr>
<tr>
<td><strong>City</strong></td>
<td>Enter the name of the city where the meeting is held.</td>
</tr>
<tr>
<td><strong>State/Province</strong></td>
<td>Enter the state/province where the meeting is held.</td>
</tr>
<tr>
<td><strong>Country</strong></td>
<td>Use the <em>List</em> icon to specify the country where the meeting is held. The system displays all the names of the countries that are defined in the <em>Tools &gt; Lists</em> page.</td>
</tr>
<tr>
<td><strong>Zip/Postal Code</strong></td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
<tr>
<td><strong>Room</strong></td>
<td>Use the <em>Search</em> icon to select the room where the meeting is conducted. In the <em>Query</em> window, the system displays the available <em>Space</em> records in the <em>Location hierarchy</em>. Select the required room and click <strong>OK</strong>. The selected room name is displayed. Click the hyperlinked text field to view the details regarding the room space.</td>
</tr>
</tbody>
</table>
Attendees Section

This section includes the individuals who are invited and the individuals who are going to attend the meeting.

Use the Find action in this section to select the persons who have attended the meeting. A Query window listing the available records from the People page will appear. Select the associated record and click OK. The selected People record is displayed as line item in this section.

Use the Linked Record icon to view and modify the record. Use the Remove action to delete the selected line item(s).

General Notes Section

Use this section to provide appropriate notes regarding the Meeting Record record. The details about the Meeting Record record may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the Meeting Record record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.
Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new</td>
</tr>
<tr>
<td></td>
<td>record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to Draft and displays</td>
</tr>
<tr>
<td></td>
<td>additional actions on the Action bar. The actions include Issue, Save,</td>
</tr>
<tr>
<td></td>
<td>Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active</td>
</tr>
<tr>
<td></td>
<td>window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close</td>
</tr>
<tr>
<td></td>
<td>the active window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - Clicking the Cancel action without saving the record will erase</td>
</tr>
<tr>
<td></td>
<td>all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the Copy action, a copy of the record is created (in the Draft</td>
</tr>
<tr>
<td></td>
<td>status) and displayed in the appropriate page wherein the details can be</td>
</tr>
<tr>
<td></td>
<td>modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking the Issue action, the system changes the status of the record to</td>
</tr>
<tr>
<td></td>
<td>Review In Progress and after all the members in the distribution list have</td>
</tr>
<tr>
<td></td>
<td>approved the record, the record status becomes Issued.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on</td>
</tr>
<tr>
<td></td>
<td>the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete action to complete the tasks associated with the record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the Complete action, the system changes the status of the record</td>
</tr>
<tr>
<td></td>
<td>from Issued to Completed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the</td>
</tr>
<tr>
<td></td>
<td>active management list.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Meeting Items Tab**

The **Meeting Items** tab enables you to associate Meeting Item records with the Meeting Record record. You can associate as many new Meeting Item records as required. Each record describes the decisions and discussions that are happening in a meeting. A Meeting Item can be used in multiple Meeting Record records.

**Meeting Items Section**

Use the Add action in the Section bar to add a new Meeting Item record. The system displays the Meeting Item window where you can perform the following actions.

- Enter the necessary information.
- Click the Create Draft action.

The added Meeting Item record is displayed as a line item.

You also can associate an existing record by clicking the Find action in the Section bar. A Query window listing the available records is displayed. Select the required record and click OK. The selected record will be added as a line item in this section.

Use the Linked Record icon to view/modify the record. Use the Remove action to delete the selected line item(s).

**Other Tabs**

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

**Meeting Series**

The purpose of the meeting series is to group similar Meeting Record records thereby, minimizing the time required to enter similar data into multiple records. As such, the meeting series contains data that is transferable to a Meeting Record record if the meeting series and Meeting Record record are associated with each other.
Creating a Meeting Series Record

Use the following procedure to create a Meeting Series record.

**To Create a Meeting Series Record**

**Step 1**  From the Progress page above, click Meetings > Meeting Series in the Related Links - Capital Project Progress portal section.

**Step 2**  Review the page that appears. The page displays a list of Meeting Series records. Click Add to add a new Meeting Series record.

**Step 3**  Review the form that appears. Specify the details regarding the Meeting Series record.

---

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>ID</th>
<th>Enter a unique number to identify the Meeting Series record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this field is left blank, the system automatically generates this number at the time of creating the Meeting Series record.</td>
</tr>
</tbody>
</table>
General Section

Status
The system displays the current status of the Meeting Series record being created. This field is a read-only field. The different statuses of the Meeting Series are explained below.

Draft - Indicates that the Meeting Series record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the Activate action in the Action bar.

Active - The system automatically changes the status of the record from Review in Progress to Active state when the person in the notification has approved.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Unretire or Revise action in the Action bar.

Date
Use the Calendar icon to select the date on which the Meeting Series record is being created.

Note - By default, the system displays the current date in this field.

Name
Enter a name for the Meeting Series record being created.

Details Section

Start Time
Enter the start time (in hours/minutes/seconds) of the meeting.

Finish Time
Enter the end time (in hours/minutes/seconds) of the meeting.
### Details Section

**Recurrence Pattern Type**  
Certain meetings related to a project can be arranged in a periodic/recurring pattern (such as weekly, bi-weekly, monthly, etc.).

You can select the recurrence type on clicking the header field of the *Recurrence Pattern Type*. An *Event* window is displayed. In the *Event* window the *Recurrence Type* section displays a set of options (such as *Single Occurrence*, *Daily*, *Weekly*, *Monthly*, *Yearly*, and *Ad hoc*). On selecting the required option the recurrence type for the *Meeting Series* record is displayed.

**Note** - Based on the recurrence type selected (the meeting is held accordingly) you have to enter the necessary information in the *Event* window.

### Description Section

Use this section to provide appropriate description regarding the *Meeting Series* record. The details about the meeting series may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.

### Location Section

**Location Lookup**  
Use the *Search* icon to select the location where the meeting is conducted. In the *Query* window, the system displays the available *Building*, *Retail Location*, and *Structure* records that are retrieved from the *Location hierarchy*. Select the required record and click *OK*. The selected record is displayed. Click the hyperlinked text field to view the details regarding the location.

**Note** - Based on the location that is selected, the system auto-populates the corresponding fields of this section such as the *Address*, *City*, *State/Province*, *Country*, and *Zip/Postal Code* from the associated record.

**Address**  
Enter the address regarding the location.

**City**  
Enter the name of the city where the meeting is held.
### Location Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province in which the meeting is held.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon to specify the country where the meeting is held. The system displays all names of the country that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
<tr>
<td>Room</td>
<td>Use the Search icon to select the room where the meeting is conducted. In the search list, the system displays the available Space records that are retrieved from the Location hierarchy. Select the required room and click OK. The selected room name is displayed. Click the hyperlinked text field to view the details regarding the room space.</td>
</tr>
</tbody>
</table>

### Meeting Organizer Section

This section displays the name of the person who organizes the meeting.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting Organizer Lookup</td>
<td>This field displays the name of the person who convenes the meeting. By default the system displays the current user.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address regarding the selected person.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city for this address.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province for this address.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon to specify the country for this address. The system displays all names of the countries that are defined in the Tools &gt; Lists page.</td>
</tr>
</tbody>
</table>

**Note** - Based on the person selected, the system auto-populates the corresponding fields of this section such as the Address, City, State/Province, Country, Zip/Postal, Phone number, and Email ID from the associated record.
Meeting Organizer Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zip/Postal</td>
<td>Enter the zip/postal code regarding the selected location.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the work phone number for the selected person.</td>
</tr>
<tr>
<td>Email</td>
<td>Enter the email ID of the selected person.</td>
</tr>
</tbody>
</table>

Attendees Section

The attendees include all of the individuals who are invited to and who attend the meeting. Use the Find action in this section to select the persons who have attended the meeting. A Query window listing the available records from the People page will appear. Select the required record and click OK. The selected people record is displayed as line item.

Use the Linked Record icon to view/modify the record. Use the Remove action to delete the selected line item(s).

Recorded By Section

This section displays the login ID of the current user who is creating the Meeting Series record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the <strong>X</strong> (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td><strong>Activate</strong></td>
<td>Click the <strong>Activate</strong> action to add the record to the active management list.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Meeting History Tab**

The **Meeting History** tab is a system-generated tab that displays a history of all the meetings that were conducted regarding the project. Each line item displays the serial number assigned to the meeting record, date on which the meeting was held, and name of the meeting.

**Meeting Record History Section**

This section provides a brief history about the **Meeting Record** records as line items. The details such as the meeting ID, meeting date, and meeting name are displayed in this section.
Meeting Item History Section

This section provides a brief history about the Meeting Item records as line items. The details regarding the meeting item such as the ID, name, closed (status of the meeting), topic, discussion of the meeting, person responsible for conducting the meeting, and date on which the meeting was held are displayed in this section.

Other Tabs

The details about the Notes & Documents tab and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Correspondence

The Correspondence management process provides details about the ways of exchanging project specific information between the members associated with the project. Handling correspondences in a project is the most vital part of IBM TRIRIGA application. Correspondences can be exchanging information (important discussions) between individuals. In general, the different modes of correspondence are through telephone, documents, e-mails, fax, etc.

Business Objects

Correspondence can be either internal or external communication. In the IBM TRIRIGA application, the Correspondence links are used to create, manage, track Correspondence records, and organize them by business object or report. You can utilize these links to track and record all the communication details regarding the project. This module comprises of the following business objects:

- Accident Report
- Safety Notice
- Conversation
- Field Instruction
- Incoming Correspondence
- Outgoing Correspondence
- Transmittal
- Notice to Comply

The Conversation record is created when there is a conversation between two or more individuals (belonging to the project) using telephone as the medium. You can use this record to describe the
conversation and give other specific details, such as the date and time of conversation, and list of participants.

The incoming and outgoing records are similar because they both relate to documents, with the exception that incoming correspondence refers to documents that are received and outgoing correspondence refers to documents that are sent. Incoming correspondence is typically stored or a response is sent from the record. If the response is sent, the incoming document becomes an outgoing document. A record for both the incoming and outgoing correspondences is maintained.

The Transmittal record is used when an electronic correspondence, such as an e-mail or fax, is sent or received.

The Notice to Comply record enables you to notify the workers about the rules and regulations that have been violated in the work place. It is also used to send notice to the workers to follow the rules that are set forth by the concerned authorities.

Accessing the Correspondence Links

The Correspondence links enable you to create, manage, and track the Correspondence records. You also can organize the records by business objects, reports, construction class, or discipline.

Use the following procedure to access the Correspondence links.

<table>
<thead>
<tr>
<th>To Access the Correspondence Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
</tr>
</tbody>
</table>

Accident Report

When an accident or injury occurs in a workplace, no matter what the reason is, an accident report is issued. This report details the events and reasons that led to the accident. The report also contains details about the measures that were taken to reduce the impact of the accident.

For example, in the United States, accident reports are submitted to OSHA on a monthly basis. They are reviewed in order to update existing policies and procedures regarding the workplace safety. This
helps organizations to follow safety precautions that are set forth by OSHA to minimize injury to employees in the future.

Creating an Accident Report Record

Use the following procedure to create an Accident Report record.

To Create an Accident Report Record

**Step 1** From the Progress page above, click Correspondence > Accident Report in the Related Links - Capital Project Progress portal section.

**Step 2** Review the page that appears. The page displays a list of Accident Report records. Click Add to add a new Accident Report record.

**Step 3** Review the form that appears. Specify the details regarding the Accident Report record.

General Tab

**General Section**

**ID**
Enter a unique number identifying the Accident Report record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Accident Report record.

**Revision**
The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

*Note* - Each time you revise or modify the record, the value displayed in this field is incremented by one.

**Status**
The system displays the current status of the Accident Report record being created. This field is a read-only field. The different statuses of the Accident Report record are explained below.

*Draft* - Indicates that the Accident Report record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

*Review In Progress* - Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.
## General Section

**Issued** - Indicates that the record is active. The system automatically changes the status of the record from Review In Progress to Active state after all the members in the notifications list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

**Completed** - Indicates that the record is being processed and all the tasks associated with the record is complete. The system generates this status when the user selects the Complete action in the Action bar.

**History** - When the Accident Report record is revised, for each revision a copy of the record gets saved in the History state.

### Note
- On selecting the History option in the Related Reports drop-down status list (displayed in the Accident Report results page), the system retrieves and displays all the records that are revised at different stages.

---

**Date**

Use the Calendar icon to select the date on which the Accident Report record is being created.

### Note
- By default, the system displays the current date in this field.

**Name**

Enter a unique name for the Accident Report record being created.

---

## OSHA 300 Reporting Information Section

This section gives details about all the general information regarding the incident that is recorded in the OSHA form. This section is not added to the OSHA Form 300 unless you click the corresponding check box. Further details about the incident are added in other sections in the General tab.

### Note
- All the information in this section can be used only by the people living in America and the people living outside the United States may need to modify this section to meet local reporting requirements, if any.
OSHA 300 Reporting Information Section

Include in OSHA Form 300?
Select the check box to include the accident report to OSHA Form 300.

Accident Class
Accidents are classified based on the location where it happened, effect of the accident and certain other criteria.

Use the List icon to select the accident class under which the currently reported incident falls. In the search list, the system displays the available accident classes (such as Days Away, From Work, Job Transfer or Restriction, Death, etc.) that are defined in the Tools > Lists page.

Accident Type
Accidents are classified based on the location where it happened, effect of the accident and certain other criteria.

Use the List icon to select the impact of the accident. In the search list, the system displays the available accident types (such as Hearing Loss, Injury, Respiratory Condition, Skin Disorder, Poisoning, etc.) that are defined in the Tools > Lists page.

Days Away from Work
Enter the number of days that the injured employee is away from work.

Days Restricted
Enter the number of restricted holidays the organization has provided for the injured person.

Employee Section
This section provides the details regarding the employee who is injured in the accident.

Employee Lookup
Use the Search icon to select the employee who met with the accident. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) record in the People page. Select the required employee and click OK. The selected employee name is displayed in the Employee Look Up field.

Note - Based on the person selected in the Employee Look Up field, the system auto-populates the corresponding fields of this section such as the First Name, Last Name, Title, Address, City, State/Province, and Zip/Postal Code from the associated record.

First Name
The system displays the first name of the selected employee.
## Employee Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected employee.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter the designation (title/role) of the selected employee.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected employee.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the employee is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the employee is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon to specify the country where the selected employee is located (location of the project). The system displays all the names of the countries that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>Use the Calendar icon to specify the date of birth of the selected employee.</td>
</tr>
<tr>
<td>Hire Date</td>
<td>Use the Calendar icon to select the date on which the employee was hired in the organization.</td>
</tr>
<tr>
<td>Gender</td>
<td>Use the List icon to select the gender of the employee.</td>
</tr>
</tbody>
</table>

## Information about the treatment provided Section

In this section, you can enter all the specifications regarding the treatment (for the injury) that was given to the employee after the accident happened. Information like the location of the treatment and the caregiver is also available.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the Physician or health care professional</td>
<td>Enter the name of the physician or health care professional that has treated the injured employee.</td>
</tr>
<tr>
<td>If treatment was given away from worksite:</td>
<td></td>
</tr>
<tr>
<td>Facility</td>
<td>Enter the name of the facility centre (e.g., Medical Center) where the injured employee was treated (if the worker is not treated at the worksite).</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the facility centre.</td>
</tr>
</tbody>
</table>
### Information about the treatment provided Section

**Was Employee treated in an employee room?**

Use the *List* icon to select a specific answer for the question. In the search list, the system displays the available options (such as *Yes*, *No*) that are defined in the *Tools > Lists* page.

**Was Employee hospitalized overnight?**

Use the *List* icon to select a specific answer for the question. In the search list, the system displays the available options (such as *Yes*, *No*) that are defined in the *Tools > Lists* page.

**First Aid Provided By**

Enter the name of the person who provided first aid for the injured employee.

### Information about the case Section

This section displays all the general information regarding the date and time of the accident. The date entered here can be different from the date selected for the employee at the time of expiration. This is due to the reason that the date of injury and date on which the employee died may be different.

**Note** - This case number is recorded in a log by OSHA as a tracking number of the incident.

**Case number from the log**

Enter a numerical value that represents the case number that is filed in the log by the OSHA.

**Work Location**

Use the *Search* icon to select a specific work location for the *Accident Report* record being created. The system displays a *Query* window that displays the list of available records that are retrieved from the *Space* business object in the *Location hierarchy*. Select the required location and click *OK*. The selected work location will be displayed in this field.

**Date of injury or illness**

Use the *Calendar* icon to select the date on which the employee got injured/ill.

**Time employee begun to work**

Specify the time (in hours/minutes/seconds) from which the employee started work.

**Time of Event**

Enter the time (in hours/minutes/seconds) at which the incident occurred.
What was the employee doing just before the incident occurred? - Section

In this section, you can provide appropriate description about the event that occurred prior to the incident. The details about the activities performed by the employee prior to the incident may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Description Section

Use this section to provide appropriate description regarding the Accident Report record. The details about the accident report may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

What was the injury or illness? - Section

In this section, you can type a crisp description of the injury or illness that befell the employee. The detailed description may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

What object or substance directly harmed the employee? - Section

In this section, you can provide details about an object or substance that actually caused harm to the employee.

Note - Formatting options are also available.
If employee died, when did death occur? Section

Occasionally, incidents occurring on worksites may result directly in death or the injured party may be succumbed to death due to the injuries. In either of these cases, provide the date on which the person (employee) expired.

Use the Calendar icon to select the date on which the employee expired.

Recorded By Section

This section displays the login ID of the current user who is creating the Accident Report record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records that are retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record. On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <em>Draft</em> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list. On clicking the <strong>Issue</strong> action, the system changes the status of the record to <em>Review In Progress</em> and after all the members in the distribution list have approved the record, the record status becomes <em>Issued</em>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record. On clicking the <strong>Complete</strong> action, the system changes the status of the record from <em>Issued</em> to <em>Completed</em>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the *Notifications tab*, *Notes & Documents tab*, and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.

**Safety Notice**

*Safety Notice* records are created to notify all the workers about the safety measures that have to be followed in order to prevent accidents in the work site. They are typically used when an accident is viewed or when an accident has already occurred. These records detail you about the procedures that must be followed in order to prevent the expected accident from ever occurring or prevent the occurrence of another accident.

Safety notices are also used to inform certain individuals who are not in compliance with safety measures that are set forth for the project. Breaking safety rules increases the chance of injury or...
death, and by issuing individuals safety notices, the Project Manager role is helping them to prevent injury and is limiting liability by having a record of it.

**Creating a Safety Notice Record**

Use the following procedure to create a *Safety Notice* record.

**To Create a Safety Notice Record**

1. From the *Progress* page above, click *Correspondence > Safety Notice* in the *Related Links - Capital Project Progress* portal section.
2. Review the page that appears. The page displays a list of *Safety Notice* records. Click *Add* to add a new *Safety Notice* record.
3. Review the form that appears. Specify the details regarding the *Safety Notice* record.

**General Tab**

<table>
<thead>
<tr>
<th>General Section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
</tr>
<tr>
<td><strong>Revision</strong></td>
</tr>
<tr>
<td><strong>Status</strong></td>
</tr>
</tbody>
</table>
### General Section

**Progress** state to **Issued** state when all the members in the notification list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Unretire or Revise** action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the **Safety Notice** record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

- **Note** - The system generates this status only if the **Response Required** field (in the **Details** section of the **Safety Notice** record) is checked.

**Completed** - The system automatically changes the status of the record from **Routing In Progress** to **Completed** state when the contact person in the **Safety Notice** record has responded.

- **Note** - If the **Response Required** field is not checked, on clicking the **Complete** action, the system automatically changes the status of the record from **Issued** to **Completed**.

**History** - When the **Safety Notice** record is revised, for each revision a copy of the record gets saved in the **History** state.

- **Note** - On selecting the **History** option in the **Related Reports** drop-down status list (displayed in the **Safety Notice** results page), the system retrieves and displays all the records that are revised at different stages.

#### Date

Use the **Calendar icon** to select the date on which the **Safety Notice** record is being created.

- **Note** - By default, the system displays the current date in this field.

#### Name

Enter a name for the **Safety Notice** record being created.
To Section

This section gives details about the person to whom the Safety Notice record is sent for his/her comments.

**Note** - The record is sent to for approval to the person in the To Section only if the Response Required field is checked in the Details section.

**To Look Up**

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

**Note** - Based on the person selected in the To Look Up field, the system auto-populates the corresponding fields of this section such as the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon to select an organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon to specify the country in which the organization is located. The system displays all the names of the countries that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
Details Section

The Details section is used to add details about the contact person to whom the Safety Notice record is sent for his/her response.

Note - Use this section only if you require a response for Safety Notice record.

Response Required

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Portal Home Page of the To person, the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By

Use the Calendar icon to select the date on/before which the response is required.

Permission to work restricted until condition is corrected

Check this box to clarify if work can continue while the condition is corrected.

Request that condition be corrected immediately

Check this box to notify the recipient that the condition be corrected immediately.

Reference Section

The Reference section displays the severity and classification information regarding the Safety Notice record which assists the user in grouping the records. When you set the severity and classifications in this section, you can generate reports based on the specified information.

Violation Type

Use the List icon to select a specific violation type. In the search list, the system displays the available violation types (such as Smoking, Improper Clothing, Dangerous Chemicals, etc.) that are defined in the Tools > Lists page.
Reference Section

Severity
Use the Search icon 🕵️ to assign a severity value for the selected reference. The system displays the values as 1-Critical, 2-High, 3-Medium, and 4-Low that are defined in the Tools > Lists page. The value Critical indicates the top most priority, High indicates the next level, Medium indicates the intermediate stage, and Low indicates the least priority.

Safety Jurisdiction
Use the Search icon 🕵️ to assign the jurisdiction for the selected reference. The system displays the available safety jurisdiction types (such as Country, Federal, Local/Other, and State) that are defined for the Regulatory Jurisdiction record in the Classification hierarchy.

Safety Code
Use the Safety Code field to identify any local safety codes that are violated by the identified safety condition.

Discipline
Use the Search icon 🕵️ to select a specific discipline for the Safety Notice record being created. The system displays the list of available disciplines (such as Conference Services, Inventory, Security, etc.) that are retrieved from the Service Assignment Class business object in the Classification hierarchy.

Work Location
Use the Search icon 🕵️ to select a specific work location for the Safety Notice record being created. In the Query window, the system displays the list of available records that are retrieved from the Space record in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

Accident Report Section

In this section, you can associate all the Accident Report records with the Safety Notice record being created.

Use the Find action on the section to select the required Accident Report record for review. A Query window listing all the Accident Report records will be displayed. Select the required record and click OK. The selected record is displayed as line item.

Use the Clear action to erase the contents of this section.
### Directive Section

Use this section to provide appropriate description regarding the Safety Notice record. The instructions about the safety notice may be helpful for exchanging information between users viewing or reviewing a record.

**Note** – Formatting options are also available.

### Recorded By Section

This section displays the login ID of the current user who is creating the Safety Notice record. The Search icon in this section allows you to select a different user ID, if required. The system displays a Query window that displays the list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

### Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

**Note** – Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
### Action Name | Description
--- | ---
**Copy** | Click the **Copy** action to create a copy of the selected record. 
On clicking the **Copy** action, a copy of the record is created (in the **Draft** status) and displayed in the appropriate page wherein the details can be modified as required.

**Issue** | Click the **Issue** action to add the record to the active management list. 
On clicking **Issue** action, the system changes the status of the record to **Review In Progress** and after all the members in the distribution list have approved the record, the record status becomes **Issued**.

The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**.

**Complete** | Click the **Complete** action to complete the tasks associated with the record.
On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Routing In Progress**.

If the **Response Required** field in the **General** tab is checked, the record will be sent to the person selected in the **To** section for his/her response. The record appears as an Action item in the **To** person’s **Home** portal. The selected person can add the response by clicking the hyperlinked text of the Action item.

Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**.

**Delete** | Click the **Delete** action to remove the record permanently from the active management list.

**More** | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action.

### Other Tabs

The details about the **Notifications tab**, **Notes & Documents tab**, and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.
Conversation Record

The Conversation Record record is created when a telephone conversation takes place between two or more people involved in the project. You can use this record to describe the conversation and give additional details about the conversation such as the conversation date, time, and number of persons involved in the conversation.

Creating a Conversation Record

Use the following procedure to create a Conversation Record record.

To Create a Conversation Record

Step 1  From the Progress page above, click Correspondence > Conversation Record in the Related Links - Capital Project Progress portal section.

Step 2  Review the page that appears. The page displays a list of Conversation Record records. Click Add to add a new Conversation Record record.

Step 3  Review the form that appears. Specify the details regarding the Conversation Record record.

General Tab

General Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number identifying the Conversation Record record being created. If this field is left blank, the system automatically generates this number at the time of creating the Conversation Record record.</td>
</tr>
<tr>
<td>Revision</td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.</td>
</tr>
<tr>
<td>Status</td>
<td>The system displays the current status of the Conversation Record record being created. This field is a read-only field. The different statuses of the Conversation Record are explained below.</td>
</tr>
</tbody>
</table>

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Draft - Indicates that the Conversation Record record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.
**General Section**

*Review In Progress* - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the **Issue** action in the Action bar.

*Issued* - The system automatically changes the record from *Review In Progress* state to *Issued* state when all the members in the notification list have approved the record.

*Retired* - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

*Routing In Progress* - Indicates that the record is sent to the contact person in the *Conversation Record* record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

**Note** - The system generates this status only if the *Response Required* field (in the Details section of the *Conversation Record* record) is checked.

*Completed* - The system automatically changes the status of the record from *Routing In Progress* to *Completed* state when the contact person in the *Conversation Record* record has responded.

**Note** - If the *Response Required* field is not checked, on clicking the **Complete** action, the system automatically changes the status of the record from *Issued* to *Completed*.

*History* - When the *Conversation Record* record is revised, for each revision a copy of the record gets saved in the *History* state.

**Note** - On selecting the *History* option in the *Related Reports* drop-down status list (displayed in the *Conversation Record* results page), the system retrieves and displays all the records that are revised at different stages.
### General Section

**Date**
Use the Calendar icon to select the date on which the Conversation Record record being created.

*Note* - By default, the system displays the current date in this field.

**Name**
Enter a name for the Conversation Record record being created.

### To Section

This section gives details about the person to whom the Conversation Record record is sent for his/her comments. The information includes the first name, last name, name of the organization, and official address of the selected person.

*Note* - The record is sent to for approval to the person in the To section only if the Response Required field is checked in the Details section.

**To Look Up**
Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

*Note* - Based on the person selected in the To Look Up field, the system auto-populates the fields of this section such as the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

<table>
<thead>
<tr>
<th>First Name</th>
<th>The system displays the first name of the selected person.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon to select an organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
</tbody>
</table>
To Section

State/Province
Enter the name of the state/province where the selected organization is located.

Country
Use the List icon to specify the country in which the selected organization is located. The system displays all the names of the countries that are defined in the Tools > Lists page.

Zip/Postal Code
Enter the zip/postal code regarding the above address.

Details Section

The Details section is used to add details about the contact person to whom the Conversation Record is sent for his/her response.

Note - Use this section only if you require a response for Conversation Record record.

Response Required
Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Portal Home Page (of the To person), the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By
Use the Calendar icon to select the date on which the response is required.

Other Participants Section

In this section, you can provide the details related to the individuals who are involved in the correspondence. Use the Find action in this section to select the persons who have participated in the conversation. A Query window listing the available (Employee/Consultant/External Employee) records from the People page will appear. Select the associated record and click OK. The selected people record is displayed as line items.

Use the Remove action to delete the selected line item(s).
Call Details Section

Start Date Time
Use the Calendar icon to select the date/time of the commencement of the conversation.

Note - By default, the system displays the current date in this field.

End Date Time
Use the Calendar icon to select end date and time of the conversation.

Conversation Record Section

Use this section to provide appropriate description regarding the Conversation Record record. The details about the Conversation Record record may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the Conversation Record record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
</tbody>
</table>

© Copyright IBM Corporation 2011, 2013.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save &amp; Close</td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>
| Copy | Click the **Copy** action to create a copy of the selected record.  
On clicking the **Copy** action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required. |
| Issue | Click the **Issue** action to add the record to the active management list.  
On clicking **Issue** action, the system changes the status of the record to **Review In Progress** and after all the members in the distribution list have approved the record, the record status becomes **Issued**.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| Complete | Click the **Complete** action to complete the tasks associated with the record.  
On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Routing In Progress**.  
If the **Response Required** field in the General tab is checked, the record will be sent to the person selected in the To section for his/her response. The record appears as an Action item in the To person’s Home portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  
Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**. |
| Delete | Click the **Delete** action to remove the record permanently from the active management list. |
| More | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |
**Other Tabs**

The details about the *Notifications tab*, *Notes & Documents tab*, and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.

**Field Instruction**

The project scope is defined before a project begins in order to set budgets and timelines. Occasionally, changes are required that may affect the budget and/or timeline. In order to implement the changes, the Project Manager role or subcontractor usually uses a change order to define the changes to the project and the corresponding changes to the timeline and budget. Though the application contains a business object to create a change order, there are instances in which the project changes require a high level of immediacy. The change order can sometimes take substantial time to pass through the approval phase. If the changes require immediate action and there is no time to complete the change order, then the Project Manager role or contractor would submit a field instruction.

The field instruction grants approval for the project changes without going through the formal approval channels. This limits liability on the part of the individual performing the changes, but it enables the project to move forward. Many times, the field instruction will be used if the project is in jeopardy of being stalled unless the recommended work is completed. The *Field Instruction* module comprises of one business object namely *Field Instruction*.

Though the field instruction is used to authorize work to be accomplished in order to move the project forward, it can also be used to halt work. For example, if cement is being poured and there is a difference between the design specification and the actual project that was unforeseen, the architect can issue a field instruction to halt the work until the difference can be reviewed in order to establish that the differences are detrimental to the project.

**Creating a Field Instruction Record**

Use the following procedure to create a *Field Instruction* record.

**To Create a Field Instruction Record**

**Step 1**  From the *Progress* page above, click *Correspondence > Field Instruction* in the Related Links - Capital Project Progress portal section.

**Step 2**  Review the page that appears. The page displays a list of *Field Instruction* records. Click *Add* to add a new *Field Instruction* record.

**Step 3**  Review the form that appears. Specify the details regarding the *Field Instruction* record.
### General Tab

### General Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td>Enter a unique number identifying the Field Instruction record being created. If this field is left blank, the system automatically generates this number at the time of creating the Field Instruction record.</td>
</tr>
</tbody>
</table>
| **Revision** | The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the **Revise** action that is displayed on the Action bar.  

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one. |
| **Status** | The system displays the current status of the Field Instruction record being created. This field is a read-only field. The different statuses of the Field Instruction are explained below.  

_Draft_ - Indicates that the Field Instruction record is yet to be created. The system generates this status when the user selects the **Create Draft** action in the Action bar.  

_Review In Progress_ - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the **Issue** action in the Action bar.  

_Issued_ - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.  

_Retired_ - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.  

_Revision in Progress_ - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.  

_Routing In Progress_ - Indicates that the record is sent to the contact person in the Field Instruction record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar. |
General Section

**Note** - The system generates this status only if the *Response Required* field (in the *Details* section of the *Field Instruction* record) is checked.

**Completed** - The system automatically changes the status of the record from *Routing In Progress* to *Completed* state when the contact person in the *Field Instruction* record has responded.

**Note** - If the *Response Required* field is not checked, on clicking the *Complete* action, the system automatically changes the status of the record from *Issued* to *Completed*.

**History** - When the *Field Instruction* record is revised, for each revision a copy of the record gets saved in the *History* state.

**Note** - On selecting the *History* option in the *Related Reports* drop-down status list (displayed in the *Field Instruction* results page), the system retrieves and displays all the records that are revised at different stages.

**Date**
Use the *Calendar* icon to select the date on which the *Field Instruction* record is being created.

**Note** - By default, the system displays the current date in this field.

**Name**
Enter a name for the *Field Instruction* record being created.

Details Section
The *Details* section is used to add details about the contact person to whom the field instruction is sent for his/her response.

**Note** - Use this section only if you require a response for *Field Instruction* record.
### Details Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Response Required</strong></td>
<td>Check this box to obtain the response from the person (employee/consultant/external contact) selected in the To section. Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Portal Home Page of the To person the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.</td>
</tr>
<tr>
<td><strong>Required By</strong></td>
<td>Use the Calendar icon to select the date on/before which the response is required.</td>
</tr>
<tr>
<td><strong>Estimated Cost</strong></td>
<td>Enter the estimated cost for the proposed changes. Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency record in the Tools &gt; Lists page. By default, the system displays the currency set by your administrator.</td>
</tr>
<tr>
<td><strong>Cost Type</strong></td>
<td>Use the Search icon to select a specific cost type for the Field Instruction record being created. In the search list, the system retrieves the available cost types (such as Estimated, GMP, Lump Sum, Not to Exceed, and Undefined) from the Cost Rule record that is defined in the Classification hierarchy.</td>
</tr>
<tr>
<td><strong>Reason</strong></td>
<td>Use the List icon to select the reason for the change. The system displays all the options (Back Charge, Contingency, Engineers Directive, and Field Condition) that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td><strong>Reference</strong></td>
<td>Use the Reference field to identify any specific reference for classification and logging purposes.</td>
</tr>
</tbody>
</table>

### To Section

This section gives details about the person to whom the Field Instruction record is sent for his/her comments. The information includes the first name, last name, name of the organization and address regarding the approval person.

**Note** - The record is sent to for approval to the person in the To section only if the Response Required field is checked in the Details section.
### To Section

**To Look Up**

Use the Search icon 📱 to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) record in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

Note - Based on the person selected in the To Look Up field, the system auto-populates the corresponding First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon 📱 to select an organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon 📊 to specify the country where the organization is located. The system displays all the names of the countries that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
## Reference Section

### Construction Class

In general, all the *Field Instruction* records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in *CSI-Construction Class* that is selected.

Use the *Search* icon to select the construction class. The system displays the available construction classes (e.g., *General Requirements*, *Masonry*, etc.) that are retrieved from the *CSI-Construction Class* business object in the *Classification hierarchy*.

---

**Note** – CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

### Section

The *Section* field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

### Discipline

Use the *Search* icon to select a specific discipline for the *Field Instruction* record being created. In the search list, the system retrieves the available disciplines (such as *Architectural*, *Civil*, *Equipment*, etc.) from the *Project record* business object in the *Classification hierarchy*.

### Work Location

Use the *Search* icon to select a specific work location for the *Field Instruction* record being created. The system displays a *Query window* displaying the list of records that are retrieved from the *Space* business object in the *Location hierarchy*. Select the required location and click *OK*. The selected work location will be displayed in this field.

## Instruction Section

Use this section to provide appropriate instruction regarding the *Field Instruction* record. The details about the *Field Instruction* record may be helpful for exchanging information between users viewing or reviewing a record.

---

**Note** – Formatting options are also available.

© Copyright IBM Corporation 2011, 2013.
Recorded By Section
This section displays the login ID of the current user who is creating the Field Instruction record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records that are retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions
The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

**Note** - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.

Copy          | Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required. |
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list. On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete action to complete the tasks associated with the record. On clicking the Complete action, the system changes the status of the record from Issued to Routing In Progress. If the Response Required field in the General tab is checked, the record will be sent to the person selected in the To section for his/her response. The record appears as an Action item in the To person’s Home portal. The selected person can add the response by clicking the hyperlinked text of the Action item. Once the response is sent by the contact person, the system changes the status of the record from Routing In Progress to Completed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

**Incoming Correspondence**

An Incoming Correspondence record refers to a document that has been received by an individual in a format other than a fax or e-mail (the Transmittal record is used for these formats). In this case, an individual will receive a document, and create an Incoming Correspondence record for it. After reviewing the document, they may decide that the document should be sent to another individual. After sending it, they will create an Outgoing Correspondence record. The incoming correspondence tracks the receipt of the document, while the outgoing document tracks the sending of the document.
Creating an Incoming Correspondence Record

Use the following procedure to create an Incoming Correspondence record.

To Create an Incoming Correspondence Record

**Step 1** From the Progress page above, click Correspondence > Incoming Correspondence in the Related Links - Capital Project Progress portal section.

**Step 2** Review the page that appears. The page displays a list of Incoming Correspondence records. Click Add to add a new Incoming Correspondence record.

**Step 3** Review the form that appears. Specify the details regarding the Incoming Correspondence record.

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number identifying the Incoming Correspondence record being created. If this field is left blank, the system automatically generates this number at the time of creating the Incoming Correspondence record.</td>
</tr>
<tr>
<td>Revision</td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar. Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.</td>
</tr>
<tr>
<td>Status</td>
<td>The system displays the current status of the Incoming Correspondence record being created. This field is a read-only field. The different statuses of the Incoming Correspondence are explained below. Draft - Indicates that the Incoming Correspondence record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar. Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.</td>
</tr>
</tbody>
</table>
**General Section**

**Issued** - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the Incoming Correspondence record for his/her response. The system generates this status on clicking the Complete action in the Action bar.

**Note** - The system generates this status only if the Response Required field (in the Details section of the Incoming Correspondence record) is checked.

**Completed** - The system automatically changes the status of the record from Routing In Progress to Completed state when the contact person in the Incoming Correspondence record has responded.

**Note** - If the Response Required field is not checked, on clicking the Complete action, the system automatically changes the status of the record from Issued to Completed.

**History** - When the Incoming Correspondence record is revised, for each revision a copy of the record gets saved in the History state.

**Note** - On selecting the History option in the Related Reports drop-down status list (displayed in the Incoming Correspondence results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the Calendar icon to select the date on which the Incoming Correspondence record is being created.

**Note** - By default, the system displays the current date in this field.
### General Section

**Name**
Enter a name for the *Incoming Correspondence* record being created.

### Details Section

The *Details* section is used to add details about the contact person to whom the incoming correspondence is sent for his/her response.

**Note** – Use this section only if you require a response for *Incoming Correspondence* record.

**Response Required**
Check this box to obtain the response from the person (employee/consultant/external contact) selected in the *To* section.

Only if this field is checked, on clicking the *Complete* action, the record is sent to the *To* person for his/her response. In the Portal Home Page of the *To* person the record is displayed as an *Action Item*. The *To* person can send his/her comment by clicking the hyperlinked *Action Item*.

**Required By**
Use the *Calendar* icon to select the date on/before which the response is required.

**Delivery Method**
Use the *List* icon to specify the delivery method for the incoming correspondence. The system displays all the available delivery types (such as TRIRIGA, Mail, Fax, Courier, and Others) that are defined in the Tools > Lists page.

**Date Received**
Use the *Calendar* icon to select the date on which the correspondence is received.

**Document Type**
Use the *List* icon to specify the type of incoming correspondence. The system displays all the available documents (such as Letter, Fax, and Memo.) that are defined in the Tools > Lists page.

**Intended Use**
Use the *List* icon to specify the use regarding the incoming correspondence. The system displays all the available options (such as Final Approval, As Requested, For Information Only, Review and Comment, Signature, Submission, and Other.) that are defined in the Tools > Lists page.
To Section

This section gives details about the person to whom the Incoming Correspondence record is sent for his/her comments. The information includes the first name, last name, name of the organization, and official address of the selected person.

Note - Only if the Response Required field is checked in the Details section, the record is sent for approval to the person in the To section.

To Look Up

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

Note - Based on the person selected in the To Look Up field, the system auto-populates the corresponding First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

First Name

The system displays the first name of the selected person.

Last Name

The system displays the last name of the selected person.

Organization

Use the Search icon to select the organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.

Address

Enter the address of the selected organization.

City

Enter the name of the city where the selected organization is located.

State/Province

Enter the name of the state/province where the selected organization is located.

Country

Use the List icon to specify the country where the selected organization is located. The system displays all the names of the countries that are defined in the Tools > Lists page.

Zip/Postal Code

Enter the zip/postal code regarding the above address.
**From Section**

This section gives details about the person who has sent the *Incoming Correspondence* record. The information includes the first name, last name, name of the organization, and official address of the sender.

**From Look Up**

Use the *Search* icon to select the person who has sent the incoming correspondences (such as mail, letter, fax, courier, etc.). In the search list, the system displays the available *People* records that are retrieved from the associated *(Employee/Consultant/External Contact)* business object in the *People* page. Select the required person and click *OK*. The selected person’s name is displayed in the *From Look Up* field.

**Note** - Based on the person selected in the *From Look Up* field, the system auto-populates the corresponding fields of this section such as the *First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code* from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First Name</strong></td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td><strong>Last Name</strong></td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td>Use the <em>Search</em> icon to select the organization to which the selected person belongs. The system displays the records that are retrieved from the <em>Organization hierarchy</em>. Select the required organization and click <em>Accept</em>. The selected organization is displayed.</td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td><strong>City</strong></td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td><strong>State/Province</strong></td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td><strong>Country</strong></td>
<td>Use the <em>List</em> icon to specify the country where the selected organization is located. The system displays all the names of the countries that are defined in the <em>Tools &gt; Lists</em> page.</td>
</tr>
<tr>
<td><strong>Zip/Postal Code</strong></td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
In Response To Section

In Response To Lookup  
This field displays the ID of the Incoming Correspondence record for which the response is sent.

Use the Search icon to select the ID regarding the Correspondence record (such as mail, letter, fax, courier, etc.). In the search list, the system displays a Query window in which the records are displayed from the associated (Conversation Records, Correspondence - All, Incoming, and Outgoing) business object. Select the required correspondence and click OK. The selected record displays the id in the In Response To Lookup field.

You also can add the Correspondence records by using the Add action in the Query window.

Note - Based on the In Response To Lookup selected, the system auto-populates the corresponding Outgoing ID, Outgoing Date, and Outgoing Name from the associated record.

Outgoing ID  
Enter the outgoing correspondence ID of the selected record.

Outgoing Date  
Use the Calendar icon to select the outgoing correspondence date for the selected record.

Outgoing Name  
Enter the outgoing correspondence name of the selected record.

Reference Section

The Reference section displays the priority and classification information to assist the user in grouping the records. When you set the priorities and classifications in this section, you can generate reports based on the specified information.
### Reference Section

#### Construction Class

In general, all the *Incoming Correspondence* records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in *CSI-Construction Class* that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., *General Requirements*, *Masonry*, etc.) that are retrieved from the *CSI-Construction Class* business object in the *Classification hierarchy*.

**Note** - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

#### Section

The *Section* field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

#### Discipline

Use the Search icon to select a specific discipline for the *Incoming Correspondence* record being created. In the search list, the system retrieves the available disciplines (such as *Architectural*, *Civil*, *Equipment*, etc.) from the *Project* business object in the *Classification hierarchy*.

#### Work Location

Use the Search icon to select a specific work location for the *Incoming Correspondence* record being created. The system displays a *Query window* that displays the list of available records that are retrieved from the *Space* business object in the *Location hierarchy*. Select the required location and click **OK**. The selected work location will be displayed in this field.

### Body Section

Use this section to provide appropriate instruction regarding the *Incoming Correspondence* record. The details about the *Incoming Correspondence* record may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.
Recorded By Section

This section displays the login ID of the current user who is creating the Incoming Correspondence record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.

Copy   Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Issue</strong></td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list. On clicking <strong>Issue</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Issued</strong>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td><strong>Complete</strong></td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record. On clicking the <strong>Complete</strong> action, the system changes the status of the record from <strong>Issued</strong> to <strong>Routing In Progress</strong>. If the <strong>Response Required</strong> field in the <strong>General</strong> tab is checked, the record will be sent to the person selected in the <strong>To</strong> section for his/her response. The record appears as an Action item in the <strong>To</strong> person’s <strong>Home</strong> portal. The selected person can add the response by clicking the hyperlinked text of the Action item. Once the response is sent by the contact person, the system changes the status of the record from <strong>Routing In Progress</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the *Notifications tab*, *Notes & Documents tab*, and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.

**Outgoing Correspondence**

An **Outgoing Correspondence** record refers to details regarding a document that is sent by a person in a specific format other than a fax or e-mail. After creating the **Outgoing Correspondence** record, you can associate a specific document contained in the **Document Manager**. The record can be sent to another person in the distribution list for further review.
Creating an Outgoing Correspondence Record

Use the following procedure to create an Outgoing Correspondence record.

To Create an Outgoing Correspondence Record

Step 1 From the Progress page above, click Correspondence > Outgoing Correspondence in the Related Links - Capital Project Progress portal section.

Step 2 Review the page that appears. The page displays a list of Outgoing Correspondence records. Click Add to add a new Outgoing Correspondence record.

Step 3 Review the form that appears. Specify the details regarding the Outgoing Correspondence record.

General Tab

General Section

| ID | Enter a unique number identifying the Outgoing Correspondence record being created. If this field is left blank, the system automatically generates this number at the time of creating the Outgoing Correspondence record. |
| Revision | The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar. |

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status | The system displays the current status of the Outgoing Correspondence record being created. This field is a read-only field. The different statuses of the Outgoing Correspondence are explained below. |

Draft - Indicates that the Outgoing Correspondence record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.

Issued - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list...
General Section

have approved the record.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

Routing In Progress - Indicates that the record is sent to the contact person in the Outgoing Correspondence record for his/her response. The system generates this status on clicking the Complete action in the Action bar.

**Note** - The system generates this status only if the Response Required field (in the Details section of the Outgoing Correspondence record) is checked.

Completed - The system automatically changes the status of the record from Routing In Progress to Completed state when the contact person in the Outgoing Correspondence record has responded.

**Note** - If the Response Required field is not checked, on clicking the Complete action, the system automatically changes the status of the record from Issued to Completed.

History - When the Outgoing Correspondence record is revised, for each revision a copy of the record gets saved in the History state.

**Note** - On selecting the History option in the Related Reports drop-down status list (displayed in the Outgoing Correspondence results page), the system retrieves and displays all the records that are revised at different stages.

Date

Use the Calendar icon to select the date on which the Outgoing Correspondence record is being created.

**Note** - By default, the system displays the current date in this field.

Name

Enter a name for the Outgoing Correspondence record that is being created.
To Section

This section gives details about the person to whom the *Outgoing Correspondence* record is sent for his/her comments.

**Note** - The record is sent for approval to the person in the *To* section only if the *Response Required* field is checked in the *Details* section.

**To Look Up**

Use the *Search* icon  to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (*Employee/Consultant/External Contact*) business object in the *People* page. Select the required person and click *OK*. The name of the selected person is displayed in the *To Look Up* field.

**Note** - The system auto populates the other fields in this section such as the *First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal* based on the *People* record selected in the *To Look Up* field.

**First Name**
The system displays the first name of the selected person.

**Last Name**
The system displays the last name of the selected person.

**Organization**
Use the *Search* icon  to select the organization to which the person selected in the *To* section belongs. In the search list, the system displays the records that are retrieved from the *Organization hierarchy*. Select the required organization and click *Accept*. The selected organization is displayed.

**Address**
Enter the address of the selected organization.

**City**
Enter the name of the city where the selected organization is located.

**State/Province**
Enter the name of the state/province where the selected organization is located.

**Country**
Use the *List* icon  to specify the country where the selected organization is located. The system displays all the names of the countries that are defined in the *Tools > Lists* page.

**Zip/Postal Code**
Enter the zip/postal code regarding the above address.
In Response To Section

The Response section contains the official response to the outgoing correspondence. This response is entered here by the To person, who sends it to the originator. The outgoing correspondence can be done either by mail, fax, or email.

This section displays the details regarding the Outgoing Correspondence record (such as Conversation Records, Correspondence - All, Incoming, and Outgoing) received.

In Response To Lookup

This field displays the id of the Outgoing Correspondence record for which the response is sent.

Use the Search icon 📜 to select the ID regarding the Correspondence record (such as mail, letter, fax, courier, etc.). In the search list, the system displays a Query window in which the records are displayed from the associated (Conversation Records, Correspondence - All, Incoming, and Outgoing) business object. Select the required correspondence and click OK. The selected record displays the id in the In Response To Lookup field.

Note - Based on the person selected in the In Response To Lookup field, the system auto-populates the corresponding ID, date, and name from the associated record.

ID
Enter the ID of the selected record.

Date
Use the Calendar icon 📅 to select the date on which the Outgoing Correspondence record is created.

Name
Enter a name for the Outgoing Correspondence record.

Details Section

The Details section is used to add details about the contact person to whom the outgoing correspondence is sent for his/her response.

Note - Use this section only if you require a response for Outgoing Correspondence record.
### Details Section

**Response Required**
Check this box to obtain a response from the person (employee/consultant/external contact) selected in the *To* section.

Only if this field is checked, on clicking the **Complete** action, the record is sent to the *To* person for his/her response. In the *Portal Home Page* of the *To* person, the record is displayed as an *Action Item*. The *To* person can send his/her comment by clicking the hyperlinked *Action Item*.

**Required By**
Use the *Calendar* icon to select the date on/before which the response is required.

**Intended Use**
The details regarding the project can be sent to concerned persons for various purposes such as for getting approval, comment, signature, etc.

Use the *List* icon to specify the reason for which the record is sent. The system displays all the available options (such as *Final Approval*, *As Requested*, *For Information Only*, *Review and Comment*, *Signature*, *Submission*, and *Other*.) that are defined in the *Tools > Lists* page.

**Delivery Method**
Use the *List* icon to specify the delivery method for the *Outgoing Correspondence* record. The system displays all the available delivery types (such as *TRIRIGA*, *Mail*, *Fax*, *Courier*, and *Others*) that are defined in the *Tools > Lists* page.

**Document Type**
Use the *List* icon to specify the document type of the *Outgoing Correspondence* record. In the search list, the system displays all the available documents (such as *Letter*, *Fax*, and *Memo*) that are defined in the *Tools > Lists* page.

**Date Sent**
Use the *Calendar* icon to select the date on which the response is sent.
### Reference Section

**Construction Class**

In general, all *Outgoing Correspondence* records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in *CSI-Construction Class* that is selected.

Use the *Search* icon to select the construction class. The system displays the available construction classes (e.g., *General Requirements*, *Masonry*, etc.) that are retrieved from the *CSI-Construction Class* business object in the *Classification hierarchy*.

**Note** - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

**Section**

The *Section* field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

**Discipline**

Use the *Search* icon to select a specific discipline for the *Outgoing Correspondence* record being created. In the search list, the system retrieves the available disciplines (such as *Architectural*, *Civil*, *Equipment*, etc.) from the *Project* business object in the *Classification hierarchy*.

**Work Location**

Use the *Search* icon to select a specific work location for the *Outgoing Correspondence* record being created. In the *Query* window, the system displays the list of available records that are retrieved from the *Space* business object in the *Location hierarchy*. Select the required location and click **OK**. The selected work location will be displayed in this field.

### Body Section

Use this section to provide appropriate instruction regarding the *Outgoing Correspondence* record. The details about the outgoing correspondence may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.
**From Section**

This section gives details about the person from whom the *Outgoing Correspondence* record is sent. The information includes the details regarding the sender.

**From Look Up**

Use the *Search* icon to select the person who has sent the outgoing correspondences (such as mail, letter, fax, courier, etc.). In the search list, the system displays the available records that are retrieved from the associated (*Employee/Consultant/External Contact*) business object in the *People* page. Select the required person and click *OK*. The selected person’s name is displayed in the *From Look Up* field.

> ![](note_icon.png)
>
> **Note** - Based on the person selected in the *From Look Up* field, the system auto-populates the corresponding fields of this section such as the *First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code* from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the <em>Search</em> icon to select the organization to which the person selected in the <em>To</em> section belongs. In the search list, the system displays the records that are retrieved from the <em>Organization hierarchy</em>. Select the required organization and click <em>Accept</em>. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the <em>List</em> icon to specify the country in which the selected organization is located. The system displays the names of the countries that are defined in the <em>Tools &gt; Lists</em> page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
Recorded By Section

This section displays the login ID of the current user who is creating the Outgoing Correspondence record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list. On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the Complete action to complete the tasks associated with the record. On clicking the Complete action, the system changes the status of the record from Issued to Routing In Progress. If the Response Required field in the General tab is checked, the record will be sent to the person selected in the To section for his/her response. The record appears as an Action item in the To person’s Home portal. The selected person can add the response by clicking the hyperlinked text of the Action item. Once the response is sent by the contact person, the system changes the status of the record from Routing In Progress to Completed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the Delete action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the More action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

**Transmittal**

A Transmittal record refers to the communication that exists between individuals using fax or e-mail as the medium. The Transmittal record should be created only for correspondence that is through electronic medium while the Incoming Correspondence record, Outgoing Correspondence record, and Conversation record are specifically created for other types of correspondence that are used in a specific project.
Creating a Transmittal Record

Use the following procedure to create a Transmittal record.

**To Create a Transmittal Record**

**Step 1** From the Progress page above, click Correspondence > Transmittal in the Related Links - Capital Project Progress portal section.

**Step 2** Review the page that appears. The page displays a list of Transmittal records. Click Add to add a new Transmittal record.

**Step 3** Review the form that appears. Specify the details regarding the Transmittal record.

**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>ID</th>
<th>Enter a unique number identifying the Transmittal record being created. If this field is left blank, the system automatically generates this number at the time of creating the Transmittal record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision</td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar. <strong>Note</strong> - Each time you revise or modify the record, the value displayed in this field is incremented by one.</td>
</tr>
</tbody>
</table>
| Status | The system displays the current status of the Transmittal record being created. This field is a read-only field. The different statuses of the Transmittal are explained below.     

**Draft** - Indicates that the Transmittal record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

**Review In Progress** - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.

**Issued** - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record. |
**General Section**

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the current (Transmittal) record for his/her response. The system generates this status on clicking the Complete action in the Action bar.

**Note** - The system generates this status only if the Response Required field (in the Details section of the Transmittal record) is checked.

**Completed** - The system automatically changes the status of the record from Routing In Progress to Completed state when the contact person in the Transmittal record has responded.

**Note** - If the Response Required field is not checked, on clicking the Complete action, the system automatically changes the status of the record from Issued to Completed.

**History** - When the Transmittal record is revised, for each revision a copy of the record gets saved in the History state.

**Note** - On selecting the History option in the Related Reports drop-down status list (displayed in the Transmittal results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the Calendar icon to select the date on which the Transmittal record is being created.

**Note** - By default, the system displays the current date in this field.

**Name**

Enter a name for the Transmittal record being created.
Details Section

The Details section is used to add details about the contact person to whom the transmittal is sent for his/her response.

Note - Use this section only if you require a response for Transmittal record.

Response Required

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Portal Home Page of the To person, the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By

Use the Calendar icon to select the date on which the response is required.

Delivery Method

Use the List icon to specify the delivery method for the Transmittal record being created. The system displays all the available delivery types (such as TRIRIGA, Mail, Fax, Courier, and Others) that are defined in the Tools > Lists page.

Intended Use

The details regarding the project can be sent to concerned persons for various purposes such as for getting approval, comment, signature, etc.

Use the List icon to specify the reason for creating the Transmittal record. The system displays all the available options (such as Final Approval, As Requested, For Information Only, Review and Comment, Signature, Submission, and Other.) that are defined in the Tools > Lists page.

To Section

This section gives details about the person to whom the Transmittal record is sent for his/her comments. The information includes details regarding the approval person.

Note - The record is sent for approval to the person in the To section, only if the Response Required field is checked in the Details section.
To Section

To Look Up

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

Note – Based on the person selected in the To Look Up field, the system auto-populates the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

First Name
The system displays the first name of the selected person.

Last Name
The system displays the last name of the selected person.

Organization
Use the Search icon to select the organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.

Address
Enter the address of the selected organization.

City
Enter the name of the city where the selected organization is located.

State/Province
Enter the name of the state/province where the selected organization is located.

Country
Use the List icon to specify the country in which the organization is located. The system displays all the names of the countries that are defined in the Tools > Lists page.

Zip/Postal Code
Enter the zip/postal code regarding the above address.

From Section

This section gives details about the person from who has sent the Transmittal record. The information includes the first name, last name, name of the organization, and official address of the sender.
From Section

From Look Up

Use the Search icon to select the person from whom the transmittals (such as mail, letter, fax, courier, etc.) are sent. In the search list, the system displays the available People records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person name is displayed in the From Look Up field.

Note - Based on the person selected in the From Look Up field, the system auto-populates the First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon to select the organization regarding the person in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon to specify the country in which the selected organization is located. The system displays all the names of the country that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
<tr>
<td>Reference Section</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Construction Class</strong></td>
<td>In general, all the <em>Transmittal</em> records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in <em>CSI - Construction Class</em> that is selected. Use the <em>Search</em> icon  to select the construction class. The system displays the available construction classes (e.g., <em>General Requirements</em>, <em>Masonry</em>, etc.) that are retrieved from the <em>CSI-Construction Class</em> business object in the <em>Classification hierarchy</em>.</td>
</tr>
<tr>
<td><strong>Section</strong></td>
<td>The <em>Section</em> field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.</td>
</tr>
<tr>
<td><strong>Discipline</strong></td>
<td>Use the <em>Search</em> icon  to select a specific discipline for the <em>Transmittal</em> record being created. In the search list, the system retrieves the available disciplines (such as <em>Architectural</em>, <em>Civil</em>, <em>Equipment</em>, etc.) from the <em>Project</em> business object in the <em>Classification hierarchy</em>.</td>
</tr>
<tr>
<td><strong>Work Location</strong></td>
<td>Use the <em>Search</em> icon  to select the specific work location. In the search list, the system displays a <em>Query</em> window that displays the list of available records that are retrieved from the <em>Space</em> business object in the <em>Location hierarchy</em>. Select the required location and click <em>OK</em>. The selected work location will be displayed in this field.</td>
</tr>
</tbody>
</table>
**Items Section**

The *Items* section contains a grouping of individual items that are being discussed or sent in the selected *Transmittal record*. Each item in this section is displayed in line item format.

Items are added to the section using the *Quick Add* method. By clicking *Add*, a new line item is created, but there is no data in the new item record. By clicking the *Linked Record* icon at the left of the line item, a *Transmittal Line Item* window will open, wherein you can perform the following steps:

- Provide the necessary details.
- Click the *Create* action.

The details are added to the line item.

By selecting the *Remove* action, you can remove selected record(s) from the list.

**Notes Section**

Use this section to provide appropriate notes regarding the *Transmittal record*. The details about the transmittal may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.

**Recorded By Section**

This section displays the login ID of the current user who is creating the *Transmittal record*. The *Search* icon in this section allows you to select a different user ID, if required. In the *Query* window, the system displays a list of available records that are retrieved from the *People* page. Select the required record and click *OK*. The selected record is displayed in this section.
Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the <strong>Create Draft</strong> action to save all initial data entered in the new record. The system changes the status of the record to <em>Draft</em> and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the <strong>Save</strong> action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Note</td>
<td>- Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking Issue action, the system changes the status of the record to <em>Review In Progress</em> and after all the members in the distribution list have approved the record, the record status becomes Issued.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Complete    | Click the **Complete** action to complete the tasks associated with the record.  

On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Routing In Progress**.

If the **Response Required** field in the **General** tab is checked, the record will be sent to the person selected in the **To** section for his/her response. The record appears as an Action item in the **To** person’s **Home** portal. The selected person can add the response by clicking the hyperlinked text of the Action item.

Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**. |
| Delete      | Click the **Delete** action to remove the record permanently from the active management list. |
| More        | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Other Tabs**

The details about the [Notifications tab](#), [Notes & Documents tab](#), and [Reports tab](#) are available in previous sections. Click the respective hyperlinks to read the details.

**Notice to Comply**

The State or Federal regulations set forth specific requirements for any aspect of work or project. For example, the process of digging in the construction site requires an Inspector’s approval prior to starting the project. Every individual must comply with the above-mentioned requirements, failing which the **Notice to Comply** is issued to inform about the non-conformance. In the case of the above example, if the foreman begins the digging process without the inspector approving the site, a notice of compliance is sent informing the foreman to halt the digging process until the inspector approves the site. Violating the notice may result in further serious actions.

Besides informing the individuals of their “out-of-compliance” status and requesting the return to compliance, the **Notice to Comply** is also used as a proof by the Project Manager role. The Project Manager role can record the notice to comply document as a proof to inform the concerned authorities that a document has already been issued so that the individuals will follow the compliance rules and regulations.
Moreover, it is a document that informs an individual or a group that an aspect of their work or project is out of compliance with requirements set forth in the contract, by state or federal regulations. Besides informing the individuals their out of compliance state, the record also directs specific action that is required to comply with contract or regulatory rules.

Creating a Notice to Comply Record

Use the following procedure to create a Notice to Comply record.

To Create a Notice to Comply Record

Step 1 From the Progress page above, click Correspondence > Notice to Comply in the Related Links - Capital Project Progress portal section.

Step 2 Review the page that appears. The page displays a list of Notice to Comply records. Click Add to add a new Notice to Comply record.

Step 3 Review the form that appears. Specify the details regarding the Notice to Comply record.

General Tab

General Section

ID Enter a unique number identifying the Notice to Comply record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Notice to Comply record.

Revision The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status The system displays the current status of the Notice to Comply record being created. This field is a read-only field. The different statuses of the Notice to Comply are explained below.

Draft - Indicates that the Notice to Comply record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the
General Section

notification list. The system generates this status on clicking the Issue action in the Action bar.

**Issued** - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the Notice to Comply record for his/her response. The system generates this status on clicking the Complete action in the Action bar.

- **Note** - The system generates this status only if the Response Required field (in the Details section of the Notice to Comply record) is checked.

**Completed** - The system automatically changes the status of the record from Routing In Progress to Completed state when the contact person in the Notice to Comply record has responded.

- **Note** - If the Response Required field is not checked, on clicking the Complete action, the system automatically changes the status of the record from Issued to Completed.

**History** - When the Notice to Comply record is revised, for each revision a copy of the record gets saved in the History state.

- **Note** - On selecting the History option in the Related Reports drop-down status list (displayed in the Notice to Comply results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the Calendar icon to select the date on which the Notice to Comply record is being created.

- **Note** - By default, the system displays the current date in this field.
### General Section

**Name**

Enter a name for the *Notice to Comply* record being created.

---

### Details Section

The *Details* section is used to add details about the contact person to whom the *Notice to Comply* record is sent for his/her response.

**Note** - Use this section only if you require a response for *Notice to Comply* record.

**Response Required**

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the *To* section.

Only if this field is checked, on clicking the *Complete* action, the record is sent to the *To* person for his/her response. In the *Portal Home Page* of the *To* person the record is displayed as an *Action Item*. The *To* person can send his/her comment by clicking the hyperlinked *Action Item*.

**Required By**

Use the *Calendar* icon to select the date on/before which the response is required.

---

### To Section

This section gives details about the person to whom the *Notice to Comply* record is sent for his/her comments. The information includes address details regarding the selected person.

**Note** - The record is sent for approval to the person in the *To Section*, only if the *Response Required* field is checked in the *Details* section.
### To Section

**To Look Up**

Use the Search icon 📦 to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (*Employee/Consultant/External Contact*) business object in the *People* page. Select the required person and click OK. The selected person name is displayed in the *To Look Up* field.

#### Note

- Based on the person selected in the *To Look Up* field, the system auto-populates the corresponding *First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code* from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon 📦 to select the organization regarding the person in the <em>To</em> section belongs. In the search list, the system displays the records that are retrieved from the <em>Organization hierarchy</em>. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon 🌍 to specify the country in which the selected organization is located. The system displays all the names of the countries that are defined in the <em>Tools &gt; Lists</em> page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
### Reference Section

**Construction Class**
In general, all the Notice to Comply records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in *CSI-Construction Class* that is selected.

Use the *Search* icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the *CSI-Construction Class* business object in the *Classification hierarchy*.

**Note** - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

**Section**
The *Section* field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

**Discipline**
Use the *Search* icon to select a specific discipline for the Notice to Comply record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the *Project* business object in the *Classification hierarchy*.

**Work Location**
Use the *Search* icon to select the specific work location where the notice to comply is issued. In the *Query* window, the system displays the list of available records that are retrieved from the *Space* business object in the *Location hierarchy*. Select the required location and click **OK**. The selected work location will be displayed in this field.

### Description Section

Use this section to provide appropriate notes regarding the Notice to Comply record being created. The details about the record may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.
Recorded By Section

This section displays the login ID of the current user who is creating the Notice to Comply record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.

Copy            | Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required. |
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Issue       | Click the **Issue** action to add the record to the active management list.  
On clicking **Issue** action, the system changes the status of the record to **Review In Progress** and after all the members in the distribution list have approved the record, the record status becomes **Issued**.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| Complete    | Click the **Complete** action to complete the tasks associated with the record.  
On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Routing In Progress**.  
If the **Response Required** field in the **General** tab is checked, the record will be sent to the person selected in the **To** section for his/her response. The record appears as an Action item in the **To** person’s **Home** portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  
Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**. |
| Delete      | Click the **Delete** action to remove the record permanently from the active management list. |
| More        | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Other Tabs**

The details about the [Notifications tab](#), [Notes & Documents tab](#), and [Reports tab](#) are available in previous sections. Click the respective hyperlinks to read the details.
Daily Journal

The *Daily Journal* module is used to create, manage, and track *Daily Journal* records and organize them by business object or report.

Business Objects

The *Daily Journal* links enable you to manage the daily activities that take place at the project site. Using these links, you can update all the daily events and record the weather details in the project site. This module includes the following business objects:

- Daily Details
- Daily Events
- Daily Reports

Using the *Daily Details* business object, you can create records in which you describe the weather for a single day. Severe changes in weather occasionally affect project schedules negatively, and ability to document those changes can limit liability. The weather data from a *Daily Details* record auto-populates the corresponding fields of a *Daily Journal* record. The *Daily Details* record is also used to track the individuals who visit the site.

The *Daily Events* business object enables you to create records in which you describe single events that occur in the worksite. Events can relate to any activity in the worksite. You can describe cost-related activities in the record, and associate cost codes and amounts to a specific activity. Any record describing an activity in the worksite can be associated with a *Daily Journal* record, in which you define all the activities and weather data relating to the project.

The *Daily Journal* record compiles information from the selected *Daily Details* and *Daily Events* records in addition to data that you add to the journal, describing summary data for a particular day. The *Daily Journal* is used to assess worksite details on a daily basis. The Project Manager role can use the daily journal as a record of events as they occur in the worksite.

Accessing the Daily Journal Links

The *Daily Journal* links enable you to create, manage, and track the *Daily Journal* records. You also can organize the records by business objects, reports, construction class, or discipline.

Use the following procedure to access the *Daily Journal* links.

**To Access the Daily Journal Links**

1. **Step 1** To select a project, click the Project Selector icon (beside the Company|Project Toggle) above the Menu Bar. Then select the radio button for a project and click OK.
2. **Step 2** Review the page that appears. The page displays the selected Project and corresponding Project Menu Bar.
To Access the Daily Journal Links

Step 3  In the selected project, click Progress to view the Progress page.

Step 4  Review the Progress page that appears.

Step 5  From the Progress page above, access the Daily Journal links in the Related Links - Capital Project Progress portal section.

Daily Details

The Daily Details record displays all the information regarding the weather and visitors for a single day at the project site. Weather information includes the direction of the wind, precipitation, percentage of humidity in the air, visibility, and other common atmospheric characteristics.

In addition to weather, the Daily Details record also provides details about the individuals who are visiting the worksite. Visitors are those individuals who visit the project site occasionally and not on a regular basis. This record can be associated with Daily Journal record to give a complete definition of all the activities on a single day.

Creating a Daily Details Record

Use the following procedure to create a Daily Details record.

To Create a Daily Details Record

Step 1  From the Progress page above, click Daily Journal > Daily Details in the Related Links - Capital Project Progress portal section.

Step 2  Review the page that appears. The page displays a list of Daily Details records. Click Add to add a new Daily Details record.

Step 3  Review the form that appears. Specify the details regarding the Daily Details record.

General Tab

General Section

ID  Enter a unique number identifying the Daily Details record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Daily Details record.
General Section

Status

The system displays the current status of the *Daily Details* record being created. This field is a read-only field. The different statuses of the *Daily Details* record are explained below.

*Active* - Indicates that the record is active. The system generates this status when the user selects the Create action in the Action bar.

Date

Use the *Calendar* icon to select the date on which the *Daily Details* record is created.

**Note** - By default, the system displays the current date in this field.

Name

The system displays the name for the *Daily Details* record being created. The name field is a combination of the work location and the current date.

Job Site Section

Work Location

Use the *Search* icon to select a specific work location for the *Daily Details* record being created. In the search list, the system displays a *Query* window listing all the associated records that are retrieved from the *Location hierarchy*. Select the required record and click OK. The selected location is displayed in this field.

Work Day

Check this box if the present day is an official working day.

Weather Section

This section describes the weather condition for a particular day. Weather describes the state of the atmosphere at a given time and place, with respect to variables such as temperature, moisture, wind velocity, and barometric pressure. Weather for a particular day is described by typical characteristics such as precipitation, dew point, low/high temperatures, wind speed, and visibility. Various fields of this section enable you to define the measurement type in addition to the amount.

Use the *List* icon in this section to select details regarding the weather.

For example, in the *Low Temperature* field, you can enter the degrees as Kelvin, Fahrenheit, or Celsius (in addition to other measurements) and then type the actual degrees in the selected scale. Any characteristic related to the weather that cannot be defined by the fields of the section can be described with a brief note in the *Weather* field.
Notes Section

Use this section to provide appropriate notes regarding the Daily Details record. The details about the record may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the Daily Details record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Click the Create action to save all initial data entered in the new record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to Active and displays additional actions on the Action bar. The actions include Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record. On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <strong>Draft</strong> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Visitors Tab**

Using the **Visitors** tab, you can record details about the individuals who visited the worksite. A visitor is any person who comes to the worksite occasionally but not on a regular basis.

**Visitors Section**

This section displays the details regarding the visitor. Use the **Add** action in the Section bar to add visitors to this section. The system displays the Visitor log window, wherein you can perform the following steps:

- Provide the necessary details.
- Click the **Create** action.

In addition to entering the names of the visitors, you can add other information, including the time of arrival/departure, reasons for visiting, and any other information that might be important.

The system displays the added record as a line item in this section.

By selecting the **Remove** action, you can remove a specific record(s) from the list.

**Other Tabs**

The details about the **Notes & Documents tab** and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.
Daily Events

A Daily Events record describes all the activities that occurred on a single day at a worksite. Each Daily Events record is used to describe a single event or a single activity. Multiple daily events records can be created and associated with a Daily Journal record in order to define all the events that occur on a single day.

Creating a Daily Events Record

Use the following procedure to create a Daily Events record.

To Create a Daily Events Record

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>From the Progress page above, click Daily Journal &gt; Daily Events in the Related Links - Capital Project Progress portal section.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays a list of Daily Events records. Click Add to add a new Daily Events record.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Review the form that appears. Specify the details regarding the Daily Events record.</td>
</tr>
</tbody>
</table>

General Tab

General Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number identifying Daily Events record being created. If this field is left blank, the system automatically generates this number at the time of creating the Daily Events record.</td>
</tr>
<tr>
<td>Status</td>
<td>The system displays the current status of the Daily Events record being created. This field is a read-only field. The different statuses of the Daily Events record are explained below. Active - Indicates that the record is active. The system generates this status when the user selects the Create action in the Action bar.</td>
</tr>
<tr>
<td>Date</td>
<td>Use the Calendar icon to select the date on which the Daily Events record is being created. Note - By default, the system displays the current date in this field.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the Daily Events record being created.</td>
</tr>
</tbody>
</table>
Details Section

**Event Type**
Use the List icon 🔄 to specify the event type for the Daily Events record being created. The system displays all the types (such as Delay, Inspection, Overtime, Sign off, etc.) that are defined in the Tools > Lists page.

**Time**
Enter the time (in hours/minutes/seconds) of occurrence of the event described in the current record.

**Reference**
Use this field to provide additional reference regarding the Daily Events record being created.

Cost Code Section

**Cost Code Lookup**
Use the Search icon 🕵️‍♂️ to select the cost code related to the daily events. In the search list, the system displays the records that are retrieved from the associated business object in the Contracts > Set Up > Cost Codes page. Select the required cost code and click OK. The selected person name is displayed in the Cost Code Look Up field.

**Material Quantity**
Enter the quantity of the material purchased.

Use the List icon 🔄 to specify the quantity. The system displays lists (such as Dozen, Gallons, etc.) which are defined in the Tools > Lists page.

**Code Name**
The system displays the name of the cost code as selected above.

Notes Section

Use this section to provide appropriate notes regarding the Daily Events record being created. The details about the events may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.
**Recorded By Section**

This section displays the login ID of the current user who is creating the *Daily Events* record. The *Search* icon  in this section allows you to select a different user ID, if required. In the *Query* window, the system displays a list of available records retrieved from the *People* page. Select the required record and click *OK*. The selected record is displayed in this section.

**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create</strong></td>
<td>Click the <strong>Create</strong> action to save all initial data entered in the new record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to <strong>Active</strong> and displays additional actions on the Action bar. The actions include <strong>Save</strong>, <strong>Save &amp; Close</strong>, <strong>More</strong>, <strong>Copy</strong>, <strong>Delete</strong>, and <strong>X</strong> (Cancel).</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Click the <strong>Save</strong> action to save the changes made.</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Click the <strong>X</strong> (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

**Note** - Clicking the **Cancel** action without saving the record will erase all the data you have entered in the record.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Copy</strong> action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>
Other Tabs

The details about the Notes & Documents tab and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Daily Report

The Daily Reports record provides details about all the events that occurred on a single day. The data regarding the events are added by associating the related Daily Events records to the Daily Reports record. A Daily Reports record can have multiple Daily Events records associated with it. Each Daily Events record relates to one incident only. Additionally, you also can associate a scheduled activity from the Task page to the Daily Report record.

Often, labor and equipment are necessary part of the worksite activities. The labor refers to the various types of individuals working on projects, and their head count (e.g., 4 journeymen) and equipment refers to machinery or other devices that are used to assist the laborers in the completion of their work (e.g., 2 dump trucks).

Creating a Daily Report Record

Use the following procedure to create a Daily Report record.

To Create a Daily Report Record

<table>
<thead>
<tr>
<th>Step 1</th>
<th>From the Progress page above, click Daily Journal &gt; Daily Report in the Related Links - Capital Project Progress portal section.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays a list of Daily Report records. Click Add to add a new Daily Report record.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Review the form that appears. Specify the details regarding the Daily Report record.</td>
</tr>
</tbody>
</table>

General Tab

General Section

| ID | Enter a unique number identifying the Daily Reports record being created. 
If this field is left blank, the system automatically generates this number at the time of creating the Daily Reports record. |
General Section

Revision

The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status

The system displays the current status of the Daily Reports record being created. This field is a read-only field. The different statuses of the Daily Reports are explained below.

Draft - Indicates that the Daily Reports record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.

Issued - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

Completed - Indicates that the record is being processed and all the tasks associated with the record is complete. The system generates this status when the user selects the Complete action in the Action bar.

History - When the Daily Reports record is revised, for each revision a copy of the record gets saved in the History state.

Note - On selecting the History option in the Related Reports drop-down status list (displayed in the Daily Reports results page), the system retrieves and displays all the records that are revised at different stages.
General Section

Date

Use the Calendar icon to select the date on which the Daily Reports record is being created.

Note - By default, the system displays the current date in this field.

Name

The system displays the name for the Daily Reports record being created. The Name field is the combination of the user name and current date.

Daily Details Section

The Daily Details section displays the weather data for the date on which the Daily Reports record has been created. The weather data applies to that date only. By using the actions in the section bar, you can select a Daily Details record to associate with the Daily Report record.

Use the Find action in the Action bar to associate the existing Daily Detail records. On clicking the Find action a Query window listing the available records are displayed. Select the required record and click Accept. The fields in this section are auto populated with the details.

You also can use Add action to add a new Daily Details record. The system displays the Daily Details window where you can perform the following actions.

- Enter the necessary information.
- Click Create action.

The details such as the ID, location, precipitation, low temp, high temp, humidity, dew point, wind direction, visibility, and weather are displayed in the respective fields. You also can view and modify the record details by clicking the hyperlinked text fields.

Use the Clear action to erase the displayed information.

Activity Section

Use this section to provide appropriate actions regarding the Daily Reports record being created. The details about the daily reports may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
Recorded By Section

This section displays the login ID of the current user who is creating the Daily Reports record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Note – Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Complete** | Click the **Complete** action to complete the tasks associated with the record.  
On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Completed**. |
| **Delete** | Click the **Delete** action to remove the record permanently from the active management list. |
| **More** | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Events Tab**

The **Events** tab enables you to associate *Daily Events* records and *Scheduled Task* records to the *Daily Reports* record. *Daily Events* records are used to describe various activities that occur in the project site on the selected date. You can associate multiple *Daily Events* records to one *Daily Reports* record. The scheduled activities are associated with the record in order to show that the activities are performed as per schedule.

**Events Section**

The **Events** section contains *Daily Events* records that correspond to activities that have occurred in the worksite on a specified date. A single *Daily Event* record is used to record a single activity on a specific day. You can associate multiple *Daily Events* records to this record.

Use the **Add** action in the Section bar to add a new *Daily Event* record. The system displays a new window, wherein you can perform the following steps:

- Provide the necessary details.
- Click the **Create** action.

A new line item will be added to the **Events** section.

You also can add the existing records by clicking the **Find** action on the Section bar. A **Query** window listing all *Daily Report* records will be displayed. Select the required record and click **OK**. The selected record is displayed as a line item.

By selecting the **Remove** action, you can remove a specific record(s) from the list.
Schedule Section

The Schedule section contains Scheduled Task records from the Tasks page. The Schedule section contains Daily Events records that correspond to activities that have occurred in the worksite on a specified date. These records are used to define activities, milestones, phases, or tasks within a set timeframe. You can associate multiple records to this record.

Use the Add action in the Section bar to add a new Schedule Task record. The system displays a new window, wherein you can perform the following steps:

- Provide the necessary details.
- Click the Create action.

A new line item will be added to the Schedule section.

You also can add the existing records by clicking the Find action on the Section bar. A Query window listing all Schedule Task records in the Tasks page will be displayed. Select the required record and click OK. The selected record is displayed as the line item.

By selecting the Remove action, you can remove a specific record(s) from the list.

Resources Tab

The Resources tab enables you to define the crew that is working at the worksite on a specific day (e.g., the number of journeymen). In addition to the number of employees, you can define their origin (e.g., organization) and work area where they are assigned to work. There can be more than one crew associated with a daily journal. You also can define the equipment being used at the worksite for the same date (e.g., the number of forklifts).
**Labor Section**

The *Labor* section defines the crew that is working at the project site on a specific day.

Use the **Add** action in the Section bar to add a new record. The system displays a *Crew* window, wherein you can perform the following steps:

- Provide the necessary details (such as the source and work area).
- Click the **Create** action.

A new line item is added to this section. The line item displays details about the apprentices, foreman, journey man, supervisor, source name, and work location.

Use the **Linked Record** icon to view/modify the record. Use the **Remove** action to delete the selected line item(s).

**Equipments Section**

The *Equipments* section defines the machinery or other equipment that were used on the specified date. This section also gives details about the measurement scale that is used for measuring the equipment. (e.g., 2 pair of fire hoses).

Use the **Add** action in the Section bar to add a new *Equipment* record. The system displays a *Equipment* window, wherein you can perform the following steps:

- Provide the necessary details (such as the equipment and work area).
- Click the **Create** action.

A new line item is added to this section.

Use the **Linked Record** icon to view/modify the record. Use the **Remove** action to delete the selected line item(s).

**Other Tabs**

The details about the *Notifications tab*, *Notes & Documents tab*, and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.
Issue and Change

Issues refer to problems that arise during the lifecycle of the project. Hence, changes may be required to find appropriate resolutions to solve these problems.

Business Objects

The Issues and Change links are used to track the details about the issue, potential changes that are made to the original project plan, and about the individuals who are working on the issues.

Issue records enable you to manage all aspects of an issue. Using this record, you can enter a detailed description about a specific issue. You also can include changes to the original costs, schedules, documents, and drawings stemming from an issue (referred to as impacts). Finally, you can enter the name of the person who is managing the issues. This module comprises of the following business objects:

- Issue Item
- Potential Change Order

When an issue is broken down into smaller tasks or issues, it is called an issue item. As such, there can be multiple issue items associated with an Issue record. These issue items are defined in the Issue Item record, which is used to assign the task to a specific individual. The Issue and Change links can then use the Issue Item records to communicate with the person assigned the task of resolving the issue. Each communication entry is kept in a log, which displays a historical record of all communications.

Additionally, you can create issue items and associate them to the record. You can use issue items to instruct persons to perform a specific action on an issue or to ask a question about an issue and to submit it to the specific person. The person can respond to the directives or questions, and a log of the communication between the individuals is maintained and reviewed when decisions on resolution are discussed.

Occasionally, changes to the project scope, budget, schedule, etc., may occur from an issue or from suggested resolutions to that issue. Potential changes do not refer to changes that will occur. They are conceivable changes that may result in a standard contract change order, which is used to make changes to the project. Approved Potential Change Order records can turn into change orders, which typically result in changes to project scope.

Accessing the Issue and Change Links

An issue refers to a problem in the project that requires a proper resolution. Issues can arise at any level in the project. Issues can affect costs, schedules, drawings, documents, or other factors regarding the project. Any change to the project can be identified in the Issue record, and can be further described in a Potential Change record.

In addition to the issues and potential impacts that affect the project, an Issue record also can have multiple issue items associated with it. An issue item contains the communication between the Issue Manager role and other persons who are involved in solving the issue item. For example, the Issue Manager role can give a direction to the concrete subcontractor to take out a piece of sidewalk in
order to make it 1 inch thicker. The subcontractor can respond by telling the Issue Manager role when
the work will take place or that it has been corrected.

The Issue and Change links enable you to create, manage, and track the Issue and Change records. You
also can organize the records by business objects, reports, construction class, or discipline.

Use the following procedure to access the Issue and Change links.

To Access the Issue and Change Links

Step 1  To select a project, click the Project Selector icon (beside the Company|Project
Toggle) above the Menu Bar. Then select the radio button for a project and click OK.

Step 2  Review the page that appears. The page displays the selected Project and
corresponding Project Menu Bar.

Step 3  In the selected project, click Progress to view the Progress page.

Step 4  Review the Progress page that appears.

Step 5  From the Progress page above, access the Issue and Change links in the Related Links
- Capital Project Progress portal section.

Issue Item

Sometimes, an issue can be broken down into smaller tasks or issues, called issue items. As such, there
can be multiple issues items associated with an Issue record. These issue items are defined in the Issue
Item record, which is used by the Issue Manager role to assign the task to an individual, also called the
Assigned person. The Issue Manager role can then use the Issue Item record to open communications
with the person who can also use the record to communicate back to the Issue Manager role. Each
communication entry is maintained as a log, which displays a historical record of all communications.

For example, if the scope of the project is to construct a new building, and the project is in its final
stages, and the blast requirements on the exterior of the building are to be changed, then the overall
issue is to make sure that the blast requirements are met. Within this issue there are number of
smaller issues that are broken down into issue items. One of the issue items may be contacting the
architect to find out the additional amount of money that is required for the changes. The Issue
Manager role can create an Issue Item record, asking the architect for the additional amount. The
architect can send a response using the same record. A log of all communication regarding the issue
item is maintained in the current record.
Creating an Issue Item Record

Use the following procedure to create an Issue Item record.

To Create an Issue Item Record

Step 1  From the Progress page above, click Issues and Change > Issue Item in the Related Links - Capital Project Progress portal section.

Step 2  Review the page that appears. The page displays a list of Issue Item records. Click Add to add a new Issue Item record.

Step 3  Review the form that appears. Specify the details regarding the Issue Item record.

General Tab

General Section

ID  Enter a unique number identifying the Issue Item record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Issue Item record.

Revision  The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status  The system displays the current status of the Issue Item record being created. This field is a read-only field. The different statuses of the Issue Item are explained below.

Draft - Indicates that the Issue Item record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.

Issued - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.
General Section

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.

Routing In Progress - Indicates that the record is sent to the contact person in the Issue Item record for his/her response. The system generates this status on clicking the Complete action in the Action bar.

Note - The system generates this status only if the Response Required field (in the Details section of the Issue Item record) is checked.

Completed - The system automatically changes the status of the record from Routing In Progress to Completed state when the contact person in the Issue Item record has responded.

Note - If the Response Required field is not checked, on clicking the Complete action, the system automatically changes the status of the record from Issued to Completed.

History - When the Issue Item record is revised, for each revision a copy of the record gets saved in the History state.

Note - On selecting the History option in the Related Reports drop-down status list (displayed in the Issue Item results page), the system retrieves and displays all the records that are revised at different stages.

Date
Use the Calendar icon to select the date on which the Issue Item record is being created.

Note - By default, the system displays the current date in this field.

Name
Enter a name for the Issue Item record being created.
## Assigned To Section

This section provides details about the person to whom the Issue Item record is sent for his/her comments.

Note - The record is sent for approval to the person in the To Section, only if the Response Required field is checked in the Details section of the current record.

### To Look Up

Use the Search icon 📦 to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

Note - Based on the person selected in the To Look Up field, the system auto-populates the corresponding Name, ID, Organization, eMail, Mobile, Work Phone, and Work Fax from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The system displays the name of the selected person.</td>
</tr>
<tr>
<td>ID</td>
<td>The system displays the ID of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon 📦 to select the organization to which the person</td>
</tr>
<tr>
<td></td>
<td>selected in the To section belongs. In the search list, the system displays</td>
</tr>
<tr>
<td>eMail</td>
<td>Enter the email ID of the selected person.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Enter the mobile number of the selected person.</td>
</tr>
<tr>
<td>Work Phone</td>
<td>The system displays the work phone number of the selected person.</td>
</tr>
<tr>
<td>Work Fax</td>
<td>Enter the work fax number of the selected person.</td>
</tr>
</tbody>
</table>
Details Section

The Details section is used to add details about the contact person to whom the Issue Item record is sent for his/her response.

Note - Use this section only if you require a response for Issue Item record.

Response Required

Check this box to obtain the response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Portal Home Page of the To person the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By

Use the Calendar icon to select the date on/before which the response is required.

Source Type

Use the List icon to specify the type of project. The system displays all the available project types (such as Claim, Design Meeting, Meeting, Request For Information, and Value Engineering) that are defined in the Tools > Lists page.

Reference Section

Construction Class

In general, all Issue Item records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in the CSI-Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.
Reference Section

**Section**
The *Section* field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

**Discipline**
Use the *Search* icon to select a specific discipline for the *Issue Item* record being created. In the search list, the system retrieves the available disciplines (such as *Architectural*, *Civil*, *Equipment*, etc.) from the *Project* business object in the *Classification hierarchy*.

**Work Location**
Use the *Search* icon to select work location where the issue has been identified. In the *Query* window, the system displays the list of available records that are retrieved from the *Space* business object in the *Location hierarchy*. Select the required location and click OK. The selected work location will be displayed in this field.

Please enter a question or a response Section

Use this section to provide appropriate notes regarding the *Issue Item* record being created. The details about the record may be helpful for exchanging information between users viewing or reviewing a record.

*Note* - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the *Issue Item* record. The *Search* icon in this section allows you to select a different user ID, if required. In the *Query* window, the system displays a list of available records retrieved from the *People* page. Select the required record and click OK. The selected record is displayed in this section.
Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list. On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Complete** | Click the *Complete* action to complete the tasks associated with the record.  
On clicking the *Complete* action, the system changes the status of the record from *Issued* to *Routing In Progress*. 
If the *Response Required* field in the *General* tab is checked, the record will be sent to the person selected in the *To* section for his/her response. The record appears as an Action item in the *To* person’s *Home* portal. The selected person can add the response by clicking the hyperlinked text of the Action item. 
Once the response is sent by the contact person, the system changes the status of the record from *Routing In Progress* to *Completed*. |
| **Delete** | Click the *Delete* action to remove the record permanently from the active management list. |
| **More** | Depending on the record and its status, clicking the *More* action displays several more actions including those discussed above. Click the preferred action. |

**Impact Tab**

The *Impact* tab is used to describe the impact of the issue, including details about risk, cost, schedule, and drawings.

**Impact Notes Section**

Use this section to include notes describing the impact of the *Issue Item* record being created. Note the editing tools available just below the section bar.

**Risk Items Section**

This section lists the Risk Items associated with the *Issue Item* record being created. To add risk items, click *Find* and select from the choices presented. To remove risk items from the list, click the check box to the left of the risk item(s) and click *Remove*.  

© Copyright IBM Corporation 2011, 2013.
Cost Impact Section

Click the List icon next to Cost Impact and select the value to establish whether there is a cost impact associated with the Issue Item record being created. If there is, also enter the Impact Amount and click the List icon to indicate the currency. Put an explanation of the cost impact in the text box next to Comment.

Schedule Impact Section

Click the List icon next to Time Impact and select the value to establish whether there is a time impact associated with the Issue Item record being created. If there is, also enter the number of days of schedule impact in Impact Days. Put an explanation of the schedule impact in the text box next to Comment.

Drawing Impact Section

Click the List icon next to Drawing Impact and select the value to establish whether there is a drawing impact associated with the Issue Item record being created. If there is, also put a description of the drawing impact in the text box next to Comment.

Other Tabs

The details about the Notifications tab and Notes & Documents tab are available in previous sections. Click the respective hyperlinks to read the details.

Potential Change Order

Changes occur in the scope, budget, schedule, etc., of a project because of an issue or due to resolutions that are suggested to the issue. Potential changes do not refer to changes that will occur. They are conceivable changes that may result in a standard contract change order, which is used to make changes to the project.
Creating a Potential Change Order Record

Use the following procedure to create a Potential Change Order record.

To Create a Potential Change Order Record

Step 1 From the Progress page above, click Issues and Change > Potential Change Order in the Related Links - Capital Project Progress portal section.

Step 2 Review the page that appears. The page displays a list of Potential Change Order records. Click Add to add a new Potential Change Order record.

Step 3 Review the form that appears. Specify the details regarding the Potential Change Order record.

General Tab

General Section

ID

Enter a unique number identifying the Potential Change Order record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Potential Change Order record.

Revision

The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status

The system displays the current status of the Potential Change Order record being created. This field is a read-only field. The different statuses of the Potential Change Order are explained below.

Draft - Indicates that the Potential Change Order record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.

Issued - The system automatically changes the record from Review In
General Section

Progress state to Issued state when all the members in the notification list have approved the record.

Retired - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.

Revision in Progress - Indicates that the record is being modified. The system generates this status when the user selects the Unretire or Revise action in the Action bar.

Routing In Progress - Indicates that the record is sent to the contact person in the Potential Change Order for his/her response. The system generates this status on clicking the Complete action in the Action bar.

Note - The system generates this status only if the Response Required field (in the Details section of the Potential Change Order record) is checked.

Completed - The system automatically changes the status of the record from Routing In Progress to Completed state when the contact person in the Potential Change Order record has responded.

Note - If the Response Required field is not checked, on clicking the Complete action, the system automatically changes the status of the record from Issued to Completed.

History - When the Potential Change Order record is revised, for each revision a copy of the record gets saved in the History state.

Note - On selecting the History option in the Related Reports drop-down status list (displayed in the Potential Change Order results page), the system retrieves and displays all the records that are revised at different stages.

Name
Enter a name for the Potential Change Order record being created.

Date
Use the Calendar icon to select the date on which the Potential Change Order record is created.

Note - By default, the system displays the current date in this field.
Reference Section

Construction Class

In general, all the Potential Change Order records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI-Construction Class that is selected.

Use the Search icon to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section

The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

Discipline

Use the Search icon to select a specific discipline for the Potential Change Order record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.

Work Location

Use the Search icon to select a work location where the issue is identified. In the Query window, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

To Section

This section details the person to whom the Potential Change Order record is sent for his/her comments.

Note - The record is sent for approval to the person selected in this section only if the Response Required field is checked in the Details section of the current record.
To Section

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person name is displayed in the To Look Up field.

Note – Based on the person selected in the To Look Up field, the system auto-populates the corresponding person’s fields in this section from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>If needed, correct the name auto-populated by the system.</td>
</tr>
<tr>
<td>Last Name</td>
<td>If needed, correct the name auto-populated by the system.</td>
</tr>
<tr>
<td>ID</td>
<td>The system displays the ID number of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon to select the organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Work Phone</td>
<td>The system displays the work phone number of the selected person.</td>
</tr>
<tr>
<td>Work Fax</td>
<td>Enter the work fax number of the selected person.</td>
</tr>
<tr>
<td>eMail</td>
<td>Enter the email id of the selected person.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected person.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code of the selected person.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the city of the selected person.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the state/province of the selected person.</td>
</tr>
<tr>
<td>Country</td>
<td>Enter the country of the selected person.</td>
</tr>
</tbody>
</table>
Details Section

The *Details* section is used to add details about the contact person to whom the *Potential Change Order* record is sent for his/her response.

**Note** - Use this section only if you require a response for *Potential Change Order* record.

Response Required

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the *To* section.

Only if this field is checked, on clicking the *Complete* action, the record is sent to the *To* person for his/her response. In the *Portal Home Page* of the *To* person the record is displayed as an *Action Item*. The *To* person can send his/her comment by clicking the hyperlinked *Action Item*.

**Required By**

Use the *Calendar* icon to select the date on/before which the response is required.

**Reason**

Use the *List* icon to specify the reason for the change. The system displays all the available reasons (such as *Back Charge*, *Contingency*, *Engineers Directive*, and *Field Condition*) that are defined in the *Tools > Lists* page.

**Justification**

Use the *List* icon to select the reason for the Proposed Change Order. Values include “Design Error”, “Documentation Issue”, “Engineering Error”, “Price Adjustment”, “Requested by Client”, and “Other”.

Change Order Note Section

Use this section to provide appropriate notes regarding the *Potential Change Order* record being created. The details about the record may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.
## Currency Section

<table>
<thead>
<tr>
<th><strong>Currency</strong></th>
<th>The currency unit of measure of the <em>Potential Change Order</em> is the same as the currency of the project that the change order belongs to.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Currency Exchange Date</strong></td>
<td>Use the <em>Calendar</em> icon to select the date on which the currency is traded.</td>
</tr>
<tr>
<td><strong>Conversion Group</strong></td>
<td>Use the <em>List</em> icon to specify the conversion group. The system displays all the available groups (such as <em>Default</em>, <em>LIBA</em>, and <em>Wall Street</em>.) that are defined in the <em>Tools &gt; Lists</em> page.</td>
</tr>
</tbody>
</table>

The following section is divided into Cost Impact, Schedule Impact, and Drawing Impact sub-tabs. The details in these sub-tabs are explained below.

### Cost Impact Sub-Tab & Section

Often, project changes can have a negative impact on the costs associated with the project. The original costs of the project are defined in the *Budget* page. Changes to that budget stemming from the issue can be defined in this sub tab.

- In this section, you can provide details about the change in cost due to the potential change.
- Use the *Add* action in the Section bar to add a new *Cost Impact* record. The system displays a *Forecast Change Line Item* window, wherein you can perform the following steps:
  - Enter the necessary details.
  - Click *Create* action.
- A new record is added as a line item to the *Cost Impact* section.
- You also can use the *Find* action in this Section bar to select the existing records associated with cost/savings. The system displays the available costs/savings records in a *Query* window. Select the required *Cost Impact* records and click *OK*. The selected record is displayed in this section as line items.
- Use the *Linked Record* icon to view/modify the record. Use the *Remove* action to delete the selected line item(s).
Drawing Impact Sub-Tab & Section

Project changes can impact the drawings associated with the project. These can include design documents and specification documents. Within this section, you can select whether changes to drawings will occur and add comments about the changes and documents.

**Drawing Impact Sub-Tab & Section**

| Drawing Impact | Use the List icon to specify if the design drawings are affected due to the suggested change. The system displays all the options (Yes, No) that are defined in the Tools > Lists page. |

Use this section to provide appropriate description regarding drawing. The details about the drawing impact may be helpful for exchanging information between users viewing or reviewing a record.

---

Note - Formatting options are also available.

---

Schedule Impact Sub-Tab & Section

Project changes can have a negative impact on the schedule associated with the project. Scheduled activities within the project are defined in the Tasks page. Changes to those activities, stemming from the change, can be defined in this sub tab.

**Schedule Impact Sub-Tab & Section**

| Time Impact | Use the List icon to specify the impact on time due to the change. The system displays all the options (Yes, No) that are defined in the Tools > Lists page. If the project schedule is affected due to the change, select the option as Yes or else select No. |

| Impact Days | Enter the number of days the Potential Change Order record is impacted. |

Use this section to provide appropriate description regarding the schedule. The details about the schedule in the Potential Change Order record may be helpful for exchanging information between users viewing or reviewing a record.

---

Note - Formatting options are also available.

---

© Copyright IBM Corporation 2011, 2013.
Recorded By Section

This section displays the login ID of the current user who is creating the Potential Change Order record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window. <strong>Note</strong> - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list. On clicking <strong>Issue</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Issued</strong>. The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record. On clicking the <strong>Complete</strong> action, the system changes the status of the record from <strong>Issued</strong> to <strong>Routing In Progress</strong>. If the <strong>Response Required</strong> field in the <strong>General</strong> tab is checked, the record will be sent to the person selected in the <strong>To</strong> section for his/her response. The record appears as an Action item in the <strong>To</strong> person’s <strong>Home</strong> portal. The selected person can add the response by clicking the hyperlinked text of the Action item. Once the response is sent by the contact person, the system changes the status of the record from <strong>Routing In Progress</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the **Notifications tab** and **Notes & Documents tab** are available in previous sections. Click the respective hyperlinks to read the details.

**Inspections**

Throughout the project development lifecycle, inspections are required in order to ensure safety and proper development of the product. Hence, inspections are performed regularly either in the overall project or in a certain part of the project.
Business Objects

Inspections are made up of inspection requirements. An inspection requirement refers to one item that must be completed or pass inspection. The Inspection Requirements records are created using the Inspection Requirements business object. After the inspection requirements are created, they are associated with an Inspection record.

As the inspection progresses, the inspector uses the Inspection record to evaluate all the inspection requirements. Completion of the inspection depends on whether these inspection requirements pass or fail. Those that pass are considered complete, while those that fail are considered incomplete and can be associated with another Inspection record scheduled on a future date.

The Inspection module is used to create, manage, and track Inspection records and organize them by business object or report. This module comprises of the following business objects:

- Punchlist Task
- Punchlist
- Inspection Task
- Quality Assurance Plan

Each inspection is made up of inspection requirements, which are used to define the inspection. As the inspection is being completed, the inspection requirements are reviewed. Sometimes, during an inspection, certain requirements pass while others fail. When an inspection requirement fails, it can be moved forward to another inspection and checked again until it passes.

Towards the end of a project, a specialized inspection called a Punchlist is created. The purpose of the Punchlist is to ensure that certain tasks are completed before the project is considered to be finished. Each Punchlist is made up of multiple Punchlist Items. Each item is a task that must be completed before the project is completed.

Accessing the Inspections Links

The Inspections links enable you to create, manage, and track Inspection records. You also can organize the records by business objects, reports, construction class, or discipline.

Use the following procedure to access the Inspections links.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>To select a project, click the Project Selector icon (beside the Company</td>
</tr>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays the selected Project and corresponding Project Menu Bar.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the selected project, click Progress to view the Progress page.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Review the Progress page that appears.</td>
</tr>
</tbody>
</table>
To Access the Inspections Links

**Step 5** From the *Progress* page above, access the *Inspections* links in the *Related Links - Capital Project Progress* portal section.

### Punchlist Task

A *Punchlist Task* refers to the important elements of a project that must be fixed before the project is considered to be finished. A single item is added to a *Punchlist Task* record. The *Punchlist Task* record defines exactly what needs to be fixed and the manner in which it has to be fixed in addition to any notes about the item. When the *Punchlist Task* records have been created, they are attached to a *Punchlist* record.

The inspector takes the *Punchlist* and performs an inspection on all of the items in the *Punchlist*. Some will pass and some may fail. The *Punchlist Items* that do not pass inspection have notes added to them, detailing the reasons for their failure and the steps required to pass inspection. The *Punchlist Task* that does not pass inspection can be fixed and attached to another *Punchlist* for another inspection.

*Punchlist Task* records are different from inspection requirements. The *Punchlist Task* only refers to items that need to be fixed at the conclusion of a project and inspection requirements refer to items that can be attached to an *Inspection* record and inspected at any point in the project.

### Creating a Punchlist Task Record

Use the following procedure to create a *Punchlist Task* record.

<table>
<thead>
<tr>
<th>To Create a Punchlist Task Record</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> From the <em>Progress</em> page above, click <em>Inspections &gt; Punchlist Task</em> in the <em>Related Links - Capital Project Progress</em> portal section.</td>
</tr>
<tr>
<td><strong>Step 2</strong> Review the page that appears. The page displays a list of <em>Punchlist Task</em> records. Click <em>Add</em> to add a new <em>Punchlist Task</em> record.</td>
</tr>
<tr>
<td><strong>Step 3</strong> Review the form that appears. Specify the details regarding the <em>Punchlist Task</em> record.</td>
</tr>
</tbody>
</table>
**General Tab**

**General Section**

<table>
<thead>
<tr>
<th>Task ID</th>
<th>Enter a unique number identifying the <em>Punchlist Task</em> record being created. If this field is left blank, the system automatically generates this number at the time of creating the <em>Punchlist Task</em> record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision</td>
<td>The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the <em>Revise</em> action that is displayed on the Action bar.</td>
</tr>
</tbody>
</table>

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one.

<table>
<thead>
<tr>
<th>Status</th>
<th>The system displays the current status of the <em>Punchlist Task</em> record being created. This field is a read-only field. The different statuses of the <em>Punchlist Task</em> are explained below.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Indicates that the <em>Punchlist Task</em> record is yet to be created. The system generates this status when the user selects the <em>Create Draft</em> action in the Action bar.</td>
</tr>
<tr>
<td>Review In Progress</td>
<td>Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the <em>Activate</em> action in the Action bar.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates that the record is active. The system automatically changes the record from <em>Review In Progress</em> state to <em>Active</em> state when all the members in the notification list have approved the record.</td>
</tr>
<tr>
<td>Retired</td>
<td>Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the <em>Retire</em> action in the Action bar.</td>
</tr>
<tr>
<td>Revision in Progress</td>
<td>Indicates that the record is being modified. The system generates this status when the user selects the <em>Revise</em> action in the Action bar.</td>
</tr>
<tr>
<td>Completed</td>
<td>Indicates that the record is being processed and all the tasks associated with the record is completed. The system generates this status when the user selects the <em>Complete</em> action in the Action bar.</td>
</tr>
<tr>
<td>History</td>
<td>When the <em>Punchlist Task</em> record is revised, for each revision a copy of the record gets saved in the <em>History</em> state.</td>
</tr>
</tbody>
</table>
### General Section

**Note** - On selecting the History option in the Related Reports drop-down status list (displayed in the Punchlist Task results page), the system retrieves and displays all the records that are revised at different stages.

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Enter a name for the Punchlist Task record being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Status</td>
<td>Indicates the resource assignment status for the current task. The system displays the following statuses:</td>
</tr>
<tr>
<td></td>
<td><strong>Assigned</strong> - if the resources (required to complete the task) are added in the Resource tab of the current record.</td>
</tr>
<tr>
<td></td>
<td><strong>Unassigned</strong> - if the resources are not allocated for completing the current task.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a brief description about the Punchlist Task record being created.</td>
</tr>
<tr>
<td>Task ReIssue Reason</td>
<td>If a Task is reopened, the user selects a ReIssue Reason.</td>
</tr>
<tr>
<td>Recurrence Pattern Type</td>
<td>Certain tasks associated with the project might have to be done frequently or in regular intervals.</td>
</tr>
<tr>
<td></td>
<td>You can select the recurrence type (for performing the task) by clicking the header field of the Recurrence Pattern Type field. The system displays the Event window. In the Event window, the Recurrence Type section displays a set of options (such as Single Occurrence, Daily, Weekly, Monthly, Yearly, and Ad hoc). On selecting the required option, the recurrence type for the Punchlist Task record is displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - Based on the recurrence type selected, enter the necessary information in the Event window.</td>
</tr>
<tr>
<td>Currency</td>
<td>Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency record in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td></td>
<td>By default, the system displays the currency set by your administrator.</td>
</tr>
</tbody>
</table>
### Reference Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Construction Class</td>
<td>In general, all the Punchlist Task record is categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI-Construction Class that is selected. Use the Search icon (\mathcal{O}) to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.</td>
</tr>
<tr>
<td>Note</td>
<td>Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.</td>
</tr>
<tr>
<td>Section</td>
<td>The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.</td>
</tr>
<tr>
<td>Discipline</td>
<td>Use the Search icon (\mathcal{O}) to select a specific discipline for the Punchlist Task record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) from the Project business object in the Classification hierarchy.</td>
</tr>
<tr>
<td>Work Location</td>
<td>Use the Search icon (\mathcal{O}) to select a work area where the task has to be performed. In the Query window, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work area will be displayed in this field.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the value for the task created. By default, the system displays the unit to be US Dollars.</td>
</tr>
</tbody>
</table>

### Contract Section

Using this section, you can provide information regarding the contract associated with the current task. Use the Find action in this section to select the required contract. A Query window listing the available Contract records will appear. Select the required Contract record and click OK. The system auto populates the ID and Contract Name fields with the details from the selected record.

Use the Clear action to erase the displayed information.
Responsible Organization Section

This section enables you to provide information regarding the organization that is responsible for managing the activities associated with the current task.

Use the Find action in this section to select the responsible organization. A Query window listing all the associated records from the Organization hierarchy will appear. Select the required organization and click OK. The Name, Organization Type, and Hierarchical Path fields are auto populated with the information from the selected record.

Use the Clear action to erase the displayed information.

Responsible Person Section

This section enables you to provide information about the person responsible for managing all the activities associated with the task.

Use the Find action in this section to select the responsible person. A Query window listing all the available Employee/Consultant/External Contact records retrieved from the People page will appear. Select the required person’s name and click Accept. The system auto populates the Full Name, Functional Role, Status, Email, and Work Phone fields of this section with the information from the selected record.

Use the Clear action to erase the displayed information.

Baseline Section

When this task is first saved, if the Baseline fields are empty they are copied from the Planned fields. Baseline fields are used in metrics.

Baseline Start          The original Planned Start.
Baseline End            The original Planned End.
Baseline Duration       The original Planned Duration.
A. Baseline Working Days The original Planned Working Days.
B. Baseline Working Hours The original Planned Working Hours, beyond the original Planned Working Days.
### Baseline Section

<table>
<thead>
<tr>
<th>Total Baseline Working Hours (A+B)</th>
<th>The original Planned Working Days plus the original Planned Working Hours.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline Cost</td>
<td>The original Planned Cost.</td>
</tr>
</tbody>
</table>

### Planned Section

This section provides the details about the scheduled start and end dates for completing the task.

<table>
<thead>
<tr>
<th>Planned Start</th>
<th>Use the <em>Calendar icon</em> to select the planned start date and time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned End</td>
<td>Use the <em>Calendar icon</em> to select the planned end date and time.</td>
</tr>
<tr>
<td>Planned Duration</td>
<td>Use the <em>Calendar icon</em> to enter the planned duration in days, months or in years.</td>
</tr>
<tr>
<td>C. Planned Working Days</td>
<td>Enter the planned working days.</td>
</tr>
<tr>
<td>D. Planned Working Hours</td>
<td>Enter the planned working hours, beyond the planned working days.</td>
</tr>
<tr>
<td>Total Planned Working Hours (C+D)</td>
<td>The Planned Working Days plus the Planned Working Hours.</td>
</tr>
<tr>
<td>Planned Cost</td>
<td>Enter the estimated cost for completing the task. By default the UOM is US Dollars.</td>
</tr>
<tr>
<td>Estimated</td>
<td>Select this check box if the project cost is not final and can be modified by the approver.</td>
</tr>
</tbody>
</table>

### Actual Section

This section provides the actual date and cost details regarding the *Punchlist Task* record being created.

<table>
<thead>
<tr>
<th>Actual Start</th>
<th>Use the <em>Calendar icon</em> to select the actual start date and time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual End</td>
<td>Use the <em>Calendar icon</em> to select the actual end date and time.</td>
</tr>
</tbody>
</table>
Actual Section

Actual Duration  Use the Calendar icon to enter the actual duration in days/months/years.

E. Actual Working Days  Enter the actual working days.

F. Actual Working Hours  Enter the actual working hours, beyond the actual working days.

Total Actual Working Hours (E+F)  The Actual Working Days plus the Actual Working Hours.

Actual Percent Complete  Enter the actual percentage of work completed from the start date of the Punchlist task.

Actual Cost  Enter the actual cost incurred by the organization in getting the work done. By default the UOM is US Dollars.

Recorded By Section

This section displays the login ID of the current user who is creating the Punchlist Task record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Activate, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Save &amp; Close</strong></td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <strong>Draft</strong> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td><strong>Apply Template</strong></td>
<td>Click the <strong>Apply Template</strong> action to copy the contents of the selected template to the current record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Apply Template</strong> action, the system displays a list of templates retrieved from the associated business objects. Select a template and click the <strong>OK</strong> action. The system copies the contents of the selected template to the current record.</td>
</tr>
<tr>
<td><strong>Baseline</strong></td>
<td>Click the <strong>Baseline</strong> action to set the dates defined as the Planned Start and Planned End dates as the base date for the task.</td>
</tr>
<tr>
<td><strong>Activate</strong></td>
<td>Click the <strong>Activate</strong> action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking <strong>Activate</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Active</strong>.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td><strong>Complete</strong></td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record from <strong>Active</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Re-Open</strong></td>
<td>Click the <strong>Re-Open</strong> action if the work that was performed is not satisfactory. On clicking the <strong>Re-Open</strong> action, the system displays a <strong>Task ReIssue</strong> window. Click the <strong>Search</strong> icon and select the appropriate <strong>Task ReIssue Reason</strong> and click <strong>Continue</strong>.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Click the <strong>Close</strong> action to change the status of the task to <strong>Closed</strong>. Only <strong>Completed</strong> status task can be closed.</td>
</tr>
<tr>
<td><strong>More</strong></td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>

**Other Tabs**

The details about the **Resources tab**, **Procedures tab**, **Dependencies tab**, **Advanced tab**, **Notifications tab**, **Notes & Documents tab**, and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.

**Punchlist**

A Punchlist is used at the end of a project in order to ensure that certain tasks are completed before the project is considered to be finished. The **Punchlist** is made up of **Punchlist Tasks**, which define those items that require fixing before the project is considered complete. The **Punchlist Tasks** are only considered complete following a successful inspection in which they are proven as completed. Multiple **Punchlist Tasks** can be attached to a **Punchlist**. As the items are inspected, some of them may fail the inspection. These items can be forwarded to other **Punchlists** until they pass inspection.

A **Punchlist** record is different from a regular inspection in that the regular inspection can be done any time, whereas the Punchlist only contains items to be fixed at the end of the project. For example, the Project Manager role will not consider a project completed until three items have been fixed. Each one of the items will be created as **Punchlist Item** records and attached to the **Punchlist record**. The inspector will take the **Punchlist** record and perform the inspection. If two of the **Punchlist Tasks** pass inspection, but the third one does not, the record corresponding to the third item can be attached to a new **Punchlist** record and another inspection can be performed at some point in the future.
Creating a Punchlist Record

Use the following procedure to create a Punchlist record.

To Create a Punchlist Record

- **Step 1** From the Progress page above, click Inspections > Punchlist in the Related Links - Capital Project Progress portal section.

- **Step 2** Review the page that appears. The page displays a list of Punchlist records. Click Add to add a new Punchlist record.

- **Step 3** Review the form that appears. Specify the details regarding the Punchlist record.

General Tab

**General Section**

**ID** Enter a unique number identifying the Punchlist record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Punchlist record.

**Revision** The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

**Status** The system displays the current status of the Punchlist record being created. This field is a read-only field. The different statuses of the Punchlist record are explained below.

- **Draft** - Indicates that the Punchlist record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

- **Review In Progress** - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.

- **Issued** - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.
### General Section

**Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the Punchlist record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

- **Note** - The system generates this status only if the **Response Required** field (in the Details section of the Punchlist record) is checked.

**Completed** - The system automatically changes the status of the record from **Routing In Progress** to **Completed** state when the contact person in the Punchlist record has responded.

- **Note** - If the **Response Required** field is not checked, on clicking the **Complete** action, the system automatically changes the status of the record from **Issued** to **Completed**.

**History** - When the Punchlist record is revised, for each revision a copy of the record gets saved in the **History** state.

- **Note** - On selecting the **History** option in the Related Reports drop-down status list (displayed in the Punchlist results page), the system retrieves and displays all the records that are revised at different stages.

<table>
<thead>
<tr>
<th>Date</th>
<th>Use the <strong>Calendar icon</strong> to select the date on which the Punchlist record is being created.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note</strong></td>
<td>By default, the system displays the current date in this field.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the Punchlist record being created.</td>
</tr>
</tbody>
</table>
### Details Section

The *Details* section is used to add details about the contact person to whom the *Punchlist* record is sent for his/her response.

**Note** - Use this section only if you require a response for *Punchlist* record.

**Response Required**

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the *To* section.

Only if this field is checked, on clicking the *Complete* action, the record is sent to the *To* person for his/her response. In the *Portal Home Page* of the *To* person the record is displayed as an *Action Item*. The *To* person can send his comment by clicking the hyperlinked *Action Item*.

**Required By**

Use the *Calendar* icon [26] to select the date on which the response is required.

### To Section

This section gives details about the person to whom the *Punchlist* record is sent for his/her comments.

**Note** - The record is sent for approval to the person in the *To Section*, only if the *Response Required* field is checked in the *Details* section.

**To Look Up**

Use the *Search* icon [28] to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (*Employee/Consultant/External Contact*) business object in the *People page*. Select the required person and click *OK*. The selected person’s name is displayed in the *To Look Up* field.

**Note** - Based on the person selected in the *To Look Up* field, the system auto-populates the corresponding *First Name*, *Last Name*, *Address*, *City*, *State/Province*, *Country*, and *Zip/Postal Code* from the associated record.

**First Name**

The system displays the first name of the selected person.

**Last Name**

The system displays the last name of the selected person.
To Section

Organization: Use the Search icon 🕵️‍♂️ to select the organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.

Address: Enter the address of the selected organization.

City: Enter the name of the city where the selected organization is located.

State/Province: Enter the name of the state/province where the selected organization is located.

Country: Use the List icon 🔄 to specify the country in which the selected organization is located. The system displays all the names of the countries that are defined in the Tools > Lists page.

Zip/Postal Code: Enter the zip/postal code regarding the above address.

Reference Section

Construction Class: In general, all the Punchlist records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in CSI-Construction Class that is selected.

Use the Search icon 🕵️‍♂️ to select the construction class. The system displays the available construction classes (e.g., General Requirements, Masonry, etc.) that are retrieved from the CSI-Construction Class business object in the Classification hierarchy.

Note - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

Section: The Section field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

Discipline: Use the Search icon 🕵️‍♂️ to select a specific discipline for the Punchlist record being created. In the search list, the system retrieves the available disciplines (such as Architectural, Civil, Equipment, etc.) that are retrieved from the Project record in the Classification hierarchy.
Reference Section

Work Location

Use the Search icon 📚 to select a specific work location associated with the Punchlist record being created. In the search list, the system displays the list of available records that are retrieved from the Space business object in the Location hierarchy. Select the required location and click OK. The selected work location will be displayed in this field.

Items Section

In this section, you can associate the punchlist tasks that define the Punchlist record. Punchlist tasks refer to items in the project that require fixing before it is considered complete. As the Punchlist inspection is done, the inspector reviews each item, which passes or fails based on the requirements set in the Punchlist Task records. There can be multiple Punchlist Tasks record, which are attached to a Punchlist record.

Use the Add action in the Action bar to add a new Punchlist Task record. The system displays the Punchlist Task window, wherein you can perform the following steps:

- Provide the address details.
- Click the Create action.

The system displays the selected record in a line item format.

You also can use the Find action on the Section bar. A Query window listing all Punchlist records will be displayed. Select the required record and click OK. A new line item will be added to the Items section.

Use the Linked Record icon 🌐 to view/modify the record. Use the Remove action to delete the selected line item(s).

Recorded By Section

This section displays the login ID of the current user who is creating the Punchlist record. The Search icon 📚 in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.
Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list. On clicking Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Complete** | Click the **Complete** action to complete the tasks associated with the record.  
On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Routing In Progress**.  
If the **Response Required** field in the **General** tab is checked, the record will be sent to the person selected in the **To** section for his/her response. The record appears as an Action item in the **To** person’s **Home** portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  
Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**. |
| **Delete** | Click the **Delete** action to remove the record permanently from the active management list. |
| **More** | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Other Tabs**

The details about the **Notifications tab**, **Notes & Documents tab**, and **Reports tab** are available in previous sections. Click the respective hyperlinks to read the details.

**Inspection Task**

Inspections are used to review projects or part of projects to ensure compliance, safety, and for other important reasons. Inspections occur on a regular basis in a worksite and can be required by state, city, or country regulations, or stated in the contract.

The items which are to be inspected are associated with the **Items** section in the **Inspection Task** record. The inspection items are added to this section as line items. On clicking the line item, you can view or modify the records.

**Note** - The process of creating the **Inspection Task** record is the same as the **Punchlist Task** record.
Creating an Inspection Task Record

Use the following procedure to create an Inspection Task record.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>From the Progress page above, click Inspections &gt; Inspection Task in the Related Links - Capital Project Progress portal section.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays a list of Inspection Task records. Click Add to add a new Inspection Task record.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Review the form that appears. Specify the details regarding the Inspection Task record.</td>
</tr>
</tbody>
</table>

General Tab

The sections and fields in the General tab of the Inspection Task record are the same as those in the Punchlist Task record. Click the hyperlink to know more details about the General tab in the Punchlist Task record.

Form Actions

The form actions of the Inspection Task record are the same as those in the Punchlist Task record. Click the hyperlink to know more details about the Form Actions in the Punchlist Task record.

Other Tabs

The details about the Resources tab, Procedures tab, Dependencies tab, Advanced tab, Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Quality Assurance Plan

The Quality Assurance Plan record enables you to maintain the quality of items used in the project. In this record, you can enter all the specifications regarding the quality plan. The information includes the name of the author who is creating the plan, reference information related to the plan, a brief description about the plan, and Inspection records that are attached to the plan.
Creating a Quality Assurance Plan Record

Use the following procedure to create a Quality Assurance Plan record.

To Create a Quality Assurance Plan Record

**Step 1** From the Progress page above, click Inspections > Quality Assurance Plan in the Related Links - Capital Project Progress portal section.

**Step 2** Review the page that appears. The page displays a list of Quality Assurance Plan records. Click Add to add a new Quality Assurance Plan record.

**Step 3** Review the form that appears. Specify the details regarding the Quality Assurance Plan record.

General Tab

**General Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Enter a unique number identifying the Quality Assurance Plan record being created. If this field is left blank, the system automatically generates this number at the time of creating the Quality Assurance Plan record.</td>
</tr>
</tbody>
</table>
| Revision | The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar. 

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one. |
| Status | The system displays the current status of the Quality Assurance Plan record being created. This field is a read-only field. The different statuses of the Quality Assurance Plan record are explained below. 

*Draft* - Indicates that the Quality Assurance Plan record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar. 

*Review In Progress* - Indicates that the record has been sent for approval and is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar. 

*Issued* - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list... |
have approved the record.

*Retired* - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

*Routing In Progress* - Indicates that the record is sent to the contact person in the Quality Assurance Plan record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

**Note** - The system generates this status only if the *Response Required* field (in the Details section of the Quality Assurance Plan record) is checked.

*Completed* - The system automatically changes the status of the record from *Routing In Progress* to *Completed* state when the contact person in the Quality Assurance Plan record has responded.

**Note** - If the *Response Required* field is not checked, on clicking the **Complete** action, the system automatically changes the status of the record from **Issued** to **Completed**.

*History* - When the Quality Assurance Plan record is revised, for each revision a copy of the record gets saved in the *History* state.

**Note** - On selecting the *History* option in the Related Reports drop-down status list (displayed in the Quality Assurance Plan results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the Calendar icon to select the date on which the Quality Assurance Plan record is being created.

**Note** - By default, the system displays the current date in this field.

**Name**

Enter a name for the Quality Assurance Plan record being created.
Details Section

The Details section is used to add details about the contact person to whom the Quality Assurance Plan record is sent for his/her response.

Note - Use this section only if you require a response for Quality Assurance Plan record.

Response Required

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Portal Home Page of the To person the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By

Use the Calendar icon to select the date on which the response is required.

Plan Author Section

This section gives details about the person to whom the Quality Assurance Plan record is sent for his/her comments. The information includes the first name, last name, name of the organization, and official address of the contact person.

Note - The record is sent for approval to the person in the To Section only if the Response Required field is checked in the Details section of the current record.

Plan Author Look Up

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the plan Author Look Up field.

Note - Based on the person selected in the Plan Author Look Up field, the system auto-populates the fields of this section such as the First Name, Last Name, and Organization from the associated record.

First Name

The system displays the first name of the selected person.

Last Name

The system displays the last name of the selected person.
### Plan Author Section

**Organization**

Use the **Search** icon to select the organization to which the person selected in the **To** section belongs. In the search list, the system displays the records that are retrieved from the **Organization hierarchy**. Select the required organization and click **Accept**. The selected organization is displayed.

### Reference Section

**Construction Class**

In general, all the **Quality Assurance Plan** records are categorized into different types based on their construction and utility. The type of work area outlet that should be used can be specified from the standard options that are defined in **CSI-Construction Class** that is selected.

Use the **Search** icon to select the construction class. The system displays the available construction classes (e.g., **General Requirements**, **Masonry**, etc.) that are retrieved from the **CSI-Construction Class** business object in the **Classification hierarchy**.

**Note** - CSI (Construction Specifications Institute) is an organization that has set standards for all constructions based on the technical specifications. The technical specifications are classified into 16 divisions.

**Section**

The **Section** field is used to reference a hard-copy design document that is produced outside of the IBM TRIRIGA system.

**Discipline**

Use the **Search** icon to select a specific discipline for the **Quality Assurance Plan** record being created. In the search list, the system retrieves the available disciplines (such as **Architectural**, **Civil**, **Equipment**, etc.) that are retrieved from the **Project** record in the **Classification hierarchy**.

**Work Location**

Use the **Search** icon to select a specific work location associated with the **Quality Assurance Plan** record being created. In the **Query** window, the system displays a list of available records that are retrieved from the **Space** business object in the **Location hierarchy**. Select the required location and click **OK**. The selected work location will be displayed in this field.
Description Section

Use this section to provide appropriate description regarding the Quality Assurance Plan record being created. The details about the quality assurance plan may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

 Recorded By Section

This section displays the login ID of the current user who is creating the Quality Assurance Plan record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Copy** | Click the **Copy** action to create a copy of the selected record.  
On clicking the **Copy** action, a copy of the record is created (in the *Draft* status) and displayed in the appropriate page wherein the details can be modified as required. |
| **Issue** | Click the **Issue** action to add the record to the active management list.  
On clicking **Issue** action, the system changes the status of the record to *Review In Progress* and after all the members in the distribution list have approved the record, the record status becomes *Issued*.  
The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| **Complete** | Click the **Complete** action to complete the tasks associated with the record.  
On clicking the **Complete** action, the system changes the status of the record from *Issued* to *Routing In Progress*.  
If the *Response Required* field in the *General* tab is checked, the record will be sent to the person selected in the *To* section for his/her response. The record appears as an Action item in the *To* person’s *Home* portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  
Once the response is sent by the contact person, the system changes the status of the record from *Routing In Progress* to *Completed*. |
| **Delete** | Click the **Delete** action to remove the record permanently from the active management list. |
| **More** | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |
Details Tab

The Details tab enables you to attach the Inspection Task records. These records give information about the requirements of a specific inspection process.

Inspection Requirements Section

This section enables you to provide information regarding the Inspection Task records assigned to the users for whom the Quality Assurance Plan record is being created.

Use the Add action in the Section bar to add a new Inspection Task record. The system displays an Inspection Task window, wherein you can perform the following steps:

- Enter the necessary details.
- Click Create action.

A new record is added as line item to the Inspection Requirements section.

You also can use the Find action in this Section bar to select the existing records associated with cost/savings. The system displays all the Inspection Task records in a Query window. Select the required Inspection Task record and click OK. The selected record is displayed in this section as line items.

The line item displays the id, task name, planned start, planned end, planned duration, actual start, actual end, actual duration, and status of the task.

Use the Remove action to delete the selected line item(s).

Other Tabs

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.
**Progress Reports**

The last step towards tracking a project is to generate the progress report to check the current status of the project.

**Business Objects**

The *Progress Report* module provides updates about the progress of a project or tasks involved in the project. This module comprises of the following business objects:

- Project Report
- Contract Report
- Closeout Report

Each of these business objects provides details about the progress of the project at a specific stage.

The *Project Report* gives incremental updates on the progress, plans, and areas of concern for the project. When the project is coming to a close, the *Closeout Report* is used in addition to the *Project Report*.

The *Contract Report* is used when contractors are involved in the project. This type of report gives incremental updates on the progress, plans, and areas of concern for the specified contract(s).

The *Closeout Report* is used when the project is coming to a close and when certain items must be completed in order to complete the project and enable final payments to be sent out.

**Accessing the Progress Report Links**

The *Progress Report* links enable you to create, manage, and track the *Progress Report* records. You also can organize the records by business objects, reports, construction class, or discipline.

Use the following procedure to access the *Progress Report* links.

<table>
<thead>
<tr>
<th>Step</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>To select a project, click the <em>Project Selector</em> icon 🌐 (beside the *Company</td>
</tr>
<tr>
<td>Step 2</td>
<td>Review the page that appears. The page displays the selected Project and corresponding Project <em>Menu Bar</em>.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the selected project, click <em>Progress</em> to view the <em>Progress page</em>.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Review the <em>Progress page</em> that appears.</td>
</tr>
</tbody>
</table>
To Access the Progress Report Links

**Step 5** From the *Progress* page above, access the *Progress* links in the *Related Links - Capital Project Progress* portal section.

---

**Request For Information**

The details about the *Request For Information record* are available in a previous section. Click the hyperlink to read the details.

---

**Project Report**

The *Project Report* record provides details about the development or completion of a specific task involved in the project. This report defines the progress of the project within a specific period of time, or for the next specified period, and also about the other areas of concern.

**Creating a Project Report Record**

Use the following procedure to create a *Project Report* record.

---

**To Create a Project Report Record**

**Step 1** From the *Progress* page above, click *Progress > Project Report* in the *Related Links - Capital Project Progress* portal section.

**Step 2** Review the page that appears. The page displays a list of *Project Report* records. Click *Add* to add a new *Project Report* record.

**Step 3** Review the form that appears. Specify the details regarding the *Project Report* record.

---

**General Tab**

**General Section**

**ID** Enter a unique number identifying the *Project Report* record being created.

If this field is left blank, the system automatically generates this number at the time of creating the *Project Report* record.
### General Section

#### Revision

The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the **Revise** action that is displayed on the Action bar.

**Note** - Each time you revise or modify the record, the value displayed in this field is incremented by one.

#### Status

The system displays the current status of the *Project Report* record being created. This field is a read-only field. The different statuses of the *Project Report* are explained below.

- **Draft** - Indicates that the *Project Report* record is yet to be created. The system generates this status when the user selects the **Create Draft** action in the Action bar.

- **Review In Progress** - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the **Issue** action in the Action bar.

- **Issued** - The system automatically changes the record from **Review In Progress** state to **Issued** state when all the members in the notification list have approved the record.

- **Retired** - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the **Retire** action in the Action bar.

- **Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

- **Routing In Progress** - Indicates that the record is sent to the contact person in the *Project Report* record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

**Note** - The system generates this status only if the **Response Required** field (in the **Details** section of the *Project Report* record) is checked.

- **Completed** - The system automatically changes the status of the record from **Routing In Progress** to **Completed** state when the contact person in the *Project Report* record has responded.
### General Section

**Note** - If the *Response Required* field is not checked, on clicking the Complete action, the system automatically changes the status of the record from *Issued* to *Completed*.

*History* - When the *Project Report* record is revised, for each revision a copy of the record gets saved in the *History* state.

**Note** - On selecting the *History* option in the *Related Reports* drop-down list (displayed in the *Project Report* results page), the system retrieves and displays all the records that are revised at different stages.

**Date**

Use the *Calendar* icon to select the date on which the *Project Report* record is being created.

**Note** - By default, the system displays the current date in this field.

**Name**

Enter a name for the *Project Report* record being created.

### Details Section

The *Details* section is used to add details about the contact person to whom the *Project Report* record is sent for his/her response.

**Note** - Use this section only if you require a response for *Project Report* record.

**Response Required**

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the *To* section.

Only if this field is checked, on clicking the *Complete* action, the record is sent to the *To* person for his/her response. In the *Portal Home Page* of the *To* person the record is displayed as an *Action Item*. The *To* person can send his/her comment by clicking the hyperlinked *Action Item*.

**Required By**

Use the *Calendar* icon to select the date on/before which the response is required.

**Currency**

The currency unit of measure of the *Project Report* is the same as project currency.
To Section

This section gives details about the person to whom the Project Report record is sent for his/her comments. The information includes the first name, last name, name of the organization and address of the contact person.

Note - The record is sent for approval to the person in the To Section, only if the Response Required field is checked in the Details section.

To Look Up

Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

Note - Based on the person selected in the To Look Up field, the system auto-populates the corresponding First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

First Name

The system displays the first name of the selected person.

Last Name

The system displays the last name of the selected person.

Organization

Use the Search icon to select the organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.

Address

Enter the address of the selected organization.

City

Enter the name of the city where the selected organization is located.

State/Province

Enter the name of the state/province where the selected organization is located.

Country

Use the List icon to specify the country in which the selected organization is located. The system displays all the names of the countries that are defined in the Tools > Lists page.

Zip/Postal Code

Enter the zip/postal code regarding the above address.
**Recorded By Section**

This section displays the login ID of the current user who is creating the Project Report record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

**Form Actions**

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the Copy action to create a copy of the selected record. On clicking the Copy action, a copy of the record is created (in the Draft status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the Issue action to add the record to the active management list. On clicking the Issue action, the system changes the status of the record to Review In Progress and after all the members in the distribution list have approved the record, the record status becomes Issued. The system refreshes the record and displays a different set of actions on the Action bar. These actions include Complete, Revise and Retire.</td>
</tr>
</tbody>
</table>

*Note* - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
**Action Name** | **Description**
---|---
**Complete** | Click the **Complete** action to complete the tasks associated with the record.

On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Routing In Progress**.

If the **Response Required** field in the **General** tab is checked, the record will be sent to the person selected in the **To** section for his/her response. The record appears as an Action item in the **To** person’s **Home** portal. The selected person can add the response by clicking the hyperlinked text of the Action item.

Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**.

**Delete** | Click the **Delete** action to remove the record permanently from the active management list.

**More** | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action.

**Progress Tab**

The **Progress** tab enables you to enter a brief note about the progress of the project at various stages. You can select this tab to view the progress of the project at a specific period. This tab displays the sections that give details about the activity performed during a specific period, the activity planned for the next specified period, and areas of concern for that period of time.

**Activity this Period Section**

Use this section to provide appropriate description regarding the project related activities that have occurred during a specific period for which the project report is generated. The details about the project may be helpful for exchanging information between users viewing or reviewing a record.

**Note** - Formatting options are also available.
Planned Next Period Section

Use this section to provide appropriate description regarding the project related activities that are planned for the next period for which the project report is generated. The details about the project may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Areas of Concern Section

Use this section to provide appropriate description areas of concern in the current project. The details about the project may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Budget Tab

The Budget tab contains auto-populated data from the cost codes associated with a budget. Budgets at various levels in the hierarchy will be rolled up to the highest level and sum of all of the costs between budgets and associated cost codes will be displayed. When a cost code is associated with a Budget record, automatically budget data will be associated with the cost code. Data from the associated budgets will automatically display in this section. In addition to the auto-populated cost data, you can type a general overview of the budget set forth for the particular project.

Summary Section

The Summary section contains cost related data for budgets, commitments, incurred costs, and forecast costs. The budget data is auto-populated from Budget business object that contains Budget records that are associated with cost codes.

When the data from the Original Budget, Budget Transfer, and Budget Changes is displayed, the sum of those amounts is displayed as the Budget Current record. The Commitments sub section is same as the Budget sub section except that the data auto-populates from commitment codes associated with Purchase Orders and Contract records. The Incurred sub section auto-populates from payment, invoice, and contract invoice. Finally, the system auto populates the details in the Forecast sub section from the budget forecast.
Cost Overview Section

Use this section to provide appropriate description regarding the cost that is associated with the project. The details about the cost may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Schedule Tab

The Schedule tab enables you to enter a brief note about the schedules regarding the project.

Schedule Section

Use this section to provide appropriate description regarding the schedule of the project. The details about the schedule may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Other Tabs

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Contract Report

The Contract Report record provides details about the development or completion of a specific task regarding the contract. This report defines the progress of the contract within a specific period of time, plans for the next specified period, and the areas of concern.

Creating a Contract Report Record

Use the following procedure to create a Contract Report record.
To Create a Contract Report Record

Step 1  From the Progress page above, click Progress > Contract Report in the Related Links - Capital Project Progress portal section.

Step 2  Review the page that appears. The page displays a list of Contract Report records. Click Add to add a new Contract Report record.

Step 3  Review the form that appears. Specify the details regarding the Contract Report record.

General Tab

General Section

ID  Enter a unique number identifying the Contract Report record being created.

If this field is left blank, the system automatically generates this number at the time of creating the Contract Report record.

Revision  The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.

Note - Each time you revise or modify the record, the value displayed in this field is incremented by one.

Status  The system displays the current status of the Contract Report record being created. This field is a read-only field. The different statuses of the Contract Report are explained below.

Draft - Indicates that the Contract Report record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.

Review In Progress - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.

Issued - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.

Retired - Indicates that the record is temporarily removed from the active
General Section

management list. The system generates this status when the user selects the **Retire** action in the Action bar.

**Revision in Progress** - Indicates that the record is being modified. The system generates this status when the user selects the **Revise** action in the Action bar.

**Routing In Progress** - Indicates that the record is sent to the contact person in the *Contract Report* record for his/her response. The system generates this status on clicking the **Complete** action in the Action bar.

**Completed** - The system automatically changes the status of the record from **Routing In Progress** to **Completed** state when the contact person in the *Contract Report* record has responded.

Note - The system generates this status only if the **Response Required** field (in the **Details** section of the *Contract Report* record) is checked.

**History** - When the *Contract Report* record is revised, for each revision a copy of the record gets saved in the **History** state.

Note - If the **Response Required** field is not checked, on clicking the **Complete** action, the system automatically changes the status of the record from **Issued** to **Completed**.

Note - On selecting the **History** option in the Related Reports drop-down status list (displayed in the *Contract Report* results page), the system retrieves and displays all the records that are revised at different stages.

Date

Use the **Calendar** icon to select the date on which the *Contract Report* record is being created.

Note - By default, the system displays the current date in this field.

Name

Enter a name for the *Contract Report* record being created.

Details Section
Details Section

The Details section is used to add details about the contact person to whom the Contract Report record is sent for his/her response.

Note - Use this section only if you require a response for Contract Report record.

Response Required

Check this box to obtain a response from the person (employee/consultant/external contact) selected in the To section.

Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Portal Home Page of the To person the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.

Required By

Use the Calendar icon to select the date on/before which the response is required.

Currency

Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency business object in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

Contract Section

This section gives information about the contract that has been signed between the organization and the external vendor who offers services based on the contract.

Use the Add action in this Section bar to select the associated contract. The system displays the available Contract records in a Query window. Select the required Contract record and click OK. When the selected record is selected the Status, Contract ID, and Name fields in this section is auto populated.

Use the Clear action to erase the contents of this section.
To Section

This section gives details about the person to whom the Contract Report record is sent for his/her comments. The information includes the first name, last name, name of the organization, and address regarding the approval person.

**Note** - The record is sent for approval to the person in the To Section, only if the Response Required field is checked in the Details section of the current record.

**To Look Up**

Use the Search icon ⌉ to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

**Note** - Based on the person selected in the To Look Up field, the system auto-populates the corresponding First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The system displays the first name of the selected person.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The system displays the last name of the selected person.</td>
</tr>
<tr>
<td>Organization</td>
<td>Use the Search icon ⌉ to select the organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the Organization hierarchy. Select the required organization and click Accept. The selected organization is displayed.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the address of the selected organization.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the name of the city where the selected organization is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enter the name of the state/province where the selected organization is located.</td>
</tr>
<tr>
<td>Country</td>
<td>Use the List icon ⬇️ to specify the country where the organization is located. The system displays all the names of the country that are defined in the Tools &gt; Lists page.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the zip/postal code regarding the above address.</td>
</tr>
</tbody>
</table>
Letter Body Section

Use this section to provide appropriate description regarding the Contract Report record. The details about the contract may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the Contract Report record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record. The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Save</td>
<td>Click the Save action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the X (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
</tbody>
</table>

Note - Clicking the Cancel action without saving the record will erase all the data you have entered in the record.
<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Copy**    | Click the **Copy** action to create a copy of the selected record.  
  On clicking the **Copy** action, a copy of the record is created (in the **Draft** status) and displayed in the appropriate page wherein the details can be modified as required. |
| **Issue**   | Click the **Issue** action to add the record to the active management list.  
  On clicking **Issue** action, the system changes the status of the record to **Review In Progress** and after all the members in the distribution list have approved the record, the record status becomes **Issued**.  
  The system refreshes the record and displays a different set of actions on the Action bar. These actions include **Complete**, **Revise** and **Retire**. |
| **Complete**| Click the **Complete** action to complete the tasks associated with the record.  
  On clicking the **Complete** action, the system changes the status of the record from **Issued** to **Routing In Progress**.  
  If the **Response Required** field in the **General** tab is checked, the record will be sent to the person selected in the **To** section for his/her response. The record appears as an Action item in the **To** person’s **Home** portal. The selected person can add the response by clicking the hyperlinked text of the Action item.  
  Once the response is sent by the contact person, the system changes the status of the record from **Routing In Progress** to **Completed**. |
| **Delete**  | Click the **Delete** action to remove the record permanently from the active management list. |
| **More**    | Depending on the record and its status, clicking the **More** action displays several more actions including those discussed above. Click the preferred action. |

**Progress Tab**

The details about the **Progress tab** are available in a previous section. Click the hyperlink to read the details.
Cost Tab

The Cost tab gives a summary of all the costs associated with the contract. The information includes the total amount spent for goods or services and labor. The details in this section are auto-populated from the Budget record.

### Currency

Use the List icon to select the currency type that will be used for all the cost-related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency record in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

### Cost Summary Section

In this section, the system displays the cost-related data only after you associate a Contract record to the Contract Report record. This is accomplished in the Contract section in the General tab of the Contract Report record. If data are not displayed in this section, then the corresponding Contract record may not have a budget code associated with it.

### Cost Analysis Section

Use this section to provide appropriate description regarding the cost that is associated with the project. The details about the cost may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.
**Schedule Tab**

The **Schedule** tab enables you to schedule a specific task regarding the contract. The sections in this tab enable you to schedule a specific activity and also record all the scheduled dates regarding the task.

### Summary Section

This section enables you to select the appropriate date for the scheduled activities for which the **Contract Report** being created. Use the **Calendar icon** to select the date for the respective fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Notice To Proceed</td>
<td>The system displays the date on which the task is scheduled to progress.</td>
</tr>
<tr>
<td>B. First Chargeable day</td>
<td>The system displays the date from which the organization will be charged for acquiring the services.</td>
</tr>
<tr>
<td>C. Substantial Completion</td>
<td>The system displays the date on which the contract is substantially closed.</td>
</tr>
<tr>
<td>D. Baseline Start Date</td>
<td>The system displays the date on which the contract starts.</td>
</tr>
<tr>
<td>E. Baseline Duration</td>
<td>Enter the total duration of the contract.</td>
</tr>
<tr>
<td>F. Nonworking Days</td>
<td>Enter the total number of nonworking days covered during the contract period.</td>
</tr>
<tr>
<td>G. Change Order Days</td>
<td>Enter the total number of days that Change Orders are expected to impact the delivery of the Project.</td>
</tr>
<tr>
<td>H. Planned Duration</td>
<td>Enter the planned number of days required to complete the contract.</td>
</tr>
<tr>
<td>I. Contract End Date</td>
<td>The system displays the date on which the contract was planned to be completed.</td>
</tr>
<tr>
<td>J. Actual End Date</td>
<td>The system displays the date on which the contract was actually completed.</td>
</tr>
</tbody>
</table>
Schedule Analysis Section

Use this section to provide appropriate description regarding the schedule that is associated with the project. The details about the schedule may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Other Tabs

The details about the Notifications tab, Notes & Documents tab, and Reports tab are available in previous sections. Click the respective hyperlinks to read the details.

Closeout Report

The Closeout Report is used at the end of a project, when the final tasks for the project are performed and the project reaches the completion stage. You can generate a Closeout Report at any point in the closeout cycle.

Creating a Closeout Report Record

Use the following procedure to create a Closeout Report record.

To Create a Closeout Report Record

Step 1  From the Progress page above, click Progress > Closeout Report in the Related Links - Capital Project Progress portal section.

Step 2  Review the page that appears. The page displays a list of Closeout Report records. Click Add to add a new Closeout Report record.

Step 3  Review the form that appears. Specify the details regarding the Closeout Report record.
### General Tab

#### General Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td>Enter a unique number identifying the Closeout Report record being created. If this field is left blank, the system automatically generates this number at the time of creating the Closeout Report record.</td>
</tr>
</tbody>
</table>
| **Revision** | The system displays the revision number indicating the number of times the current record is revised. You can revise/modify the record by clicking the Revise action that is displayed on the Action bar.  

*Note* - Each time you revise or modify the record, the value displayed in this field is incremented by one. |
| **Status** | The system displays the current status of the Closeout Report record being created. This field is a read-only field. The different statuses of the Closeout Report are explained below.  

*Draft* - Indicates that the Closeout Report record is yet to be created. The system generates this status when the user selects the Create Draft action in the Action bar.  

*Review In Progress* - Indicates that the record has been sent for approval and it is yet to be approved by all the members in the notification list. The system generates this status on clicking the Issue action in the Action bar.  

*Issued* - The system automatically changes the record from Review In Progress state to Issued state when all the members in the notification list have approved the record.  

*Retired* - Indicates that the record is temporarily removed from the active management list. The system generates this status when the user selects the Retire action in the Action bar.  

*Revision in Progress* - Indicates that the record is being modified. The system generates this status when the user selects the Revise action in the Action bar.  

*Routing In Progress* - Indicates that the record is sent to the contact person in the Closeout Report record for his/her response. The system generates this status on clicking the Complete action in the Action bar. |
## General Section

**Note** - The system generates this status only if the *Response Required* field (in the Details section of the Closeout Report record) is checked.

*Completed* - The system automatically changes the status of the record from *Routing In Progress* to *Completed* state when the contact person in the Closeout Report record has responded.

**Note** - If the *Response Required* field is not checked, on clicking the *Complete* action, the system automatically changes the status of the record from *Issued* to *Completed*.

<table>
<thead>
<tr>
<th>Date</th>
<th>Use the Calendar icon to select the date on which the Closeout Report record is being created. <strong>Note</strong> - By default, the system displays the current date in this field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the Closeout Report record being created.</td>
</tr>
</tbody>
</table>

## Details Section

The *Details* section is used to add details about the contact person to whom the Closeout Report record is sent for his/her response.

**Note** - Use this section only if you require a response for Closeout Report record.

<table>
<thead>
<tr>
<th>Response Required</th>
<th>Check this box to obtain the response from the person (employee/consultant/external contact) selected in the To section. Only if this field is checked, on clicking the Complete action, the record is sent to the To person for his/her response. In the Portal Home Page of the To person the record is displayed as an Action Item. The To person can send his/her comment by clicking the hyperlinked Action Item.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required By</td>
<td>Use the Calendar icon to select the date on/before which the response is required.</td>
</tr>
</tbody>
</table>
Details Section

Currency
Use the List icon to select the currency type that will be used for all the cost related fields. The system displays all the options (such as US Dollars, Canadian Dollars, Euros, etc.) that are defined for the Currency record in the Tools > Lists page.

By default, the system displays the currency set by your administrator.

To Section
This section gives details about the person to whom the Closeout Report record is sent for his/her comments.

Note - The record is sent for approval to the person in the To Section, only if the Response Required field is checked in the Details section.

To Look Up
Use the Search icon to select the person whose response is required. In the search list, the system displays the records that are retrieved from the associated (Employee/Consultant/External Contact) business object in the People page. Select the required person and click OK. The selected person’s name is displayed in the To Look Up field.

Note - Based on the person selected in the To Look Up field, the system auto-populates the corresponding First Name, Last Name, Address, City, State/Province, Country, and Zip/Postal Code from the associated record.

First Name
The system displays the first name of the selected person.

Last Name
The system displays the last name of the selected person.

Organization
Use the Search icon to select the organization to which the person selected in the To section belongs. In the search list, the system displays the records that are retrieved from the associated business object in the Organization hierarchy. Select the required organization and click Accept. The details of the selected organization are displayed.

Address
Enter the address of the selected organization.

City
Enter the name of the city where the selected organization is located.
To Section

State/Province
Enter the name of the state/province where the selected organization is located.

Country
Use the List icon to specify the country in which the selected organization is located. The system displays all the names of the countries that are defined in the Tools > Lists page.

Zip/Postal Code
Enter the zip/postal code regarding the above address.

Letter Body Section

Use this section to provide appropriate description regarding the Closeout Report record. The details about the contract may be helpful for exchanging information between users viewing or reviewing a record.

Note - Formatting options are also available.

Recorded By Section

This section displays the login ID of the current user who is creating the Closeout Report record. The Search icon in this section allows you to select a different user ID, if required. In the Query window, the system displays a list of available records retrieved from the People page. Select the required record and click OK. The selected record is displayed in this section.

Form Actions

The following table lists the common actions available and a description of each.

<table>
<thead>
<tr>
<th>Action Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Draft</td>
<td>Click the Create Draft action to save all initial data entered in the new record.</td>
</tr>
<tr>
<td></td>
<td>The system changes the status of the record to Draft and displays additional actions on the Action bar. The actions include Issue, Save, Save &amp; Close, More, Copy, Delete, and X (Cancel).</td>
</tr>
<tr>
<td>Action Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Save</td>
<td>Click the <strong>Save</strong> action to save the changes made.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Click the <strong>Save &amp; Close</strong> action to save the changes and close the active window.</td>
</tr>
<tr>
<td>X</td>
<td>Click the <strong>X</strong> (Cancel) action to terminate the changes made and also to close the active window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - Clicking the <strong>Cancel</strong> action without saving the record will erase all the data you have entered in the record.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click the <strong>Copy</strong> action to create a copy of the selected record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Copy</strong> action, a copy of the record is created (in the <strong>Draft</strong> status) and displayed in the appropriate page wherein the details can be modified as required.</td>
</tr>
<tr>
<td>Issue</td>
<td>Click the <strong>Issue</strong> action to add the record to the active management list.</td>
</tr>
<tr>
<td></td>
<td>On clicking <strong>Issue</strong> action, the system changes the status of the record to <strong>Review In Progress</strong> and after all the members in the distribution list have approved the record, the record status becomes <strong>Issued</strong>.</td>
</tr>
<tr>
<td></td>
<td>The system refreshes the record and displays a different set of actions on the Action bar. These actions include <strong>Complete</strong>, <strong>Revise</strong> and <strong>Retire</strong>.</td>
</tr>
<tr>
<td>Complete</td>
<td>Click the <strong>Complete</strong> action to complete the tasks associated with the record.</td>
</tr>
<tr>
<td></td>
<td>On clicking the <strong>Complete</strong> action, the system changes the status of the record from <strong>Issued</strong> to <strong>Routing In Progress</strong>.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Response Required</strong> field in the <strong>General</strong> tab is checked, the record will be sent to the person selected in the <strong>To</strong> section for his/her response. The record appears as an Action item in the <strong>To</strong> person’s <strong>Home</strong> portal. The selected person can add the response by clicking the hyperlinked text of the Action item.</td>
</tr>
<tr>
<td></td>
<td>Once the response is sent by the contact person, the system changes the status of the record from <strong>Routing In Progress</strong> to <strong>Completed</strong>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the <strong>Delete</strong> action to remove the record permanently from the active management list.</td>
</tr>
<tr>
<td>More</td>
<td>Depending on the record and its status, clicking the <strong>More</strong> action displays several more actions including those discussed above. Click the preferred action.</td>
</tr>
</tbody>
</table>
**Budget & Contracts Tab**

The **Budget & Contracts** tab is used to associate the budget cost structure from the **Contracts > Set Up > Cost Code** page to the **Progress Report** record. Once this association is made, all contracts and change orders associated with that budget will be associated to the **Progress Report** record. As a result, all the cost data specified in those records will display in this section.

**Cost Summary Section**

In this section, you can associate the cost summary details regarding the **Closeout Report** record being created. By clicking the **Search** icon to the right of the **Budget Code Structure** field, you can select a **Budget Code Structure** and associate it with the **Progress Report** record. When this association is made, cost data from the **Contract** records and **Change Order** records associated with that budget code structure will auto-populate the fields of this section.

**Contracts Section**

In this section, you can associate the contracts associated with the **Closeout Report** record. When the budget code structure is selected in the **Cost Summary** section, the line items corresponding to the **Contract** records associated with that budget code structure will auto-populate this section. By clicking a line item, the corresponding **Contract** record will display in a secondary window.

**Change Orders Tab**

In this tab, the system displays the **Change Order** records associated with the selected budget code structure in the **Budget & Contracts** tab. These records will be categorized into a **Closed** state and all states other than **Closed**.

**Change Orders Section**

In this section, you can associate the **Potential Change Order** records with the **Closeout Report** records. When the budget code structure is selected in the **Cost Summary** section, line items corresponding to the **Change Order** records associated with that budget code structure will auto-populate this section. Only **Change Order** records in the **Closed** state will display in this section. All records in any other state will display in the **Change Orders Outstanding** section.

By clicking a line item, the corresponding **Change Order** record will display in a secondary window where you can view/modify the details.
Change Order Outstanding Section

In this section, you can associate the *Change Orders Outstanding* records. When the budget code structure is selected in the *Cost Summary* section, line items corresponding to the *Change Order* records associated with that budget code structure will auto-populate this section. Only *Change Order* records not in the *Closed* state will display in this section. All records in the *Closed* state will display in the *Change Orders* section.

By clicking a line item, the corresponding *Change Order* record will display in a secondary window wherein you can view/modify the details regarding the record.

Other Tabs

The details about the *Notifications tab*, *Notes & Documents tab*, and *Reports tab* are available in previous sections. Click the respective hyperlinks to read the details.
6. Closing Projects

Closing a specific project is often a misleading process. Obligations such as payments to vendors and services from vendors may remain open even after the closing date of the project. The IBM TRIRIGA application encompasses features that can handle issues regarding project closeout. Depending on the type of project and the contractual agreement, the closeout of a project may include the issuance and submission of closeout documents to verify the accomplishments and quality.

By keeping track of all the liabilities and documents (manuals and other project records) that have to be included in closing the project, the Project Closeout process enables the Project Manager role to avoid unexpected costs, events, and liabilities. Additionally, the Closeout Checklist and Closeout Report links ensures that the finance and accounting departments are provided with accurate data.

The first step toward closing a project is to generate the Closeout Checklist. In turn, this checklist is used to check the current status to the project and to create a Closeout Report.

Note - For more information on the Closeout Checklist, refer to the Closeout Checklist sub-chapter.

Note - For more information on the Closeout Report, refer to the Closeout Report sub-chapter.
7. Funding Source, Program and Project Reports

This chapter shows the procedures for viewing Funding Source, Program, and Project reports.

**Funding Source Reports**

Follow the procedure below to view the Funding Source reports.

<table>
<thead>
<tr>
<th>Step</th>
<th>To View Funding Source Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select <strong>My Reports</strong> from the Menu Bar. The <strong>My Reports</strong> page appears.</td>
</tr>
<tr>
<td>2</td>
<td>Click the <strong>Community</strong> tab. The list of available Community reports appears.</td>
</tr>
<tr>
<td>3</td>
<td>In the <strong>Business Object</strong> filter, enter “Funding Source”. The list of available Funding Source reports appears.</td>
</tr>
<tr>
<td>4</td>
<td>Click the <strong>Run Report</strong> icon beside the desired Funding Source report.</td>
</tr>
<tr>
<td>5</td>
<td>If required, enter any query parameters. Click <strong>Submit</strong>.</td>
</tr>
<tr>
<td>6</td>
<td>If required, enter any prompt values. Click <strong>OK</strong>. The report opens.</td>
</tr>
</tbody>
</table>

**Program Reports**

Follow the procedure below to view the Program reports.

<table>
<thead>
<tr>
<th>Step</th>
<th>To View Program Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select <strong>My Reports</strong> from the Menu Bar. The <strong>My Reports</strong> page appears.</td>
</tr>
<tr>
<td>2</td>
<td>Click the <strong>Community</strong> tab. The list of available Community reports appears.</td>
</tr>
<tr>
<td>3</td>
<td>In the <strong>Business Object</strong> filter, enter “Program”. The list of available Program reports appears.</td>
</tr>
<tr>
<td>4</td>
<td>Click the <strong>Run Report</strong> icon beside the desired Program report.</td>
</tr>
<tr>
<td>5</td>
<td>If required, enter any query parameters. Click <strong>Submit</strong>.</td>
</tr>
<tr>
<td>6</td>
<td>If required, enter any prompt values. Click <strong>OK</strong>. The report opens.</td>
</tr>
</tbody>
</table>
Capital Project Reports

Follow the procedure below to view the Capital Project reports.

To View Capital Project Reports

Step 1 Select My Reports from the Menu Bar. The My Reports page appears.
Step 2 Click the Community tab. The list of available Community reports appears.
Step 3 In the Business Object filter, enter “Capital Project”. The list of available Capital Project reports appears.
Step 4 Click the Run Report icon beside the desired Capital Project report.
Step 5 If required, enter any query parameters. Click Submit.
Step 6 If required, enter any prompt values. Click OK. The report opens.

Facilities Project Reports

Follow the procedure below to view the Facilities Project reports.

To View Facilities Project Reports

Step 1 Select My Reports from the Menu Bar. The My Reports page appears.
Step 2 Click the Community tab. The list of available Community reports appears.
Step 3 In the Business Object filter, enter “Facilities Project”. The list of available Facilities Project reports appears.
Step 4 Click the Run Report icon beside the desired Facilities Project report.
Step 5 If required, enter any query parameters. Click Submit.
Step 6 If required, enter any prompt values. Click OK. The report opens.
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

Privacy Policy Considerations

IBM Software products, including software as service solutions, ("Software Offerings") may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to collect
personally identifiable information. If this Software Offering uses cookies to collect personally identifiable information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect personally identifiable information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for notice and consent.


**Trademarks**

IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at [www.ibm.com/legal/copytrade.shtml](http://www.ibm.com/legal/copytrade.shtml).